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IV3 Series
Vision Sensor



Introduction
Read this manual before using the product in order to achieve maximum performance.
Keep this manual in a safe place after reading it so that it can be used at any time.

Symbols
The following symbols alert you to important messages.
Be sure to read these messages carefully.

It indicates a hazardous situation which, if not avoided, will result in death or serious injury.

It indicates a hazardous situation which, if not avoided, could result in death or serious injury.

It indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

It indicates a situation which, if not avoided, could result in product damage as well as property damage.

It indicates cautions and limitations that must be followed during operation.

It indicates additional information on proper operation.

It indicates tips for better understanding or useful information.

 It indicates the reference pages in this manual or the reference pages in separate manuals.

Cautions
(1)	 Unauthorized reproduction of this manual in whole or part is prohibited.
(2)	� The contents of this manual may be changed for improvements without prior notice.
(3)	 �An utmost effort has been made to ensure the contents of this manual are as complete as possible. If there are any 

mistakes or questions, please contact a KEYENCE office listed in the back of the manual.
(4)	 Regardless of item (3), KEYENCE will not be liable for any effect resulting from the use of this unit.
(5)	 Any manuals with missing pages or other paging faults will be replaced.

The company names and product names used in this manual are registered trademarks or the trademarks of their 
respective companies.
“SD memory card” is a trademark of SD Association.
Ethernet/IP is a trademark of ODVA, inc.
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Safety Information for IV3 Series

General Precautions

	yDo not use this product for the purpose to protect a human body or a part of a human body.
	yDo not use this product in a hazardous location and/or potentially explosive atmosphere.
	yDo not use this product in an application that may cause death, serious injury or serious property damage 
due to a failure  with this product should occur, such as nuclear power plants, on aircraft, trains, ships, or 
vehicles, used within medical equipment, playground equipment, roller coasters and other rides, etc.

	y If the equipment is used in a manner not specified by the manufacturer, the protection provided by the 
equipment may be impaired.
	y You must perform a sufficient risk assessment for the machine where this product is to be installed prior 
to installing this product. Provide appropriate protective fail-safe measures on the machine independent 
from this product in case a failure with this product should occur.

You must verify that the IV3 Series are operating correctly in terms of functionality and performance before 
the start and the operation of the IV3 Series.

	yKEYENCE never warrants the function or performance of the IV3 Series if it is used in manner that differs 
from the IV3 Series specifications contained in this instruction manual or if the IV3 Series are modified by 
yourself.
	yWhen the IV3 Series is used in combination with other instruments, functions and performance may be 
degraded, depending on operating conditions and the surrounding environment.
	yDo not place the instruments, including peripherals, under the rapid temperature change. It may cause 
condensation and may damage instruments or peripherals.
	yRemove the power cable from the power supply if you do not use this product for a long time.

H03GB
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Important Instructions

Important Instructions

Observe the following precautions to prevent malfunction of the IV3 series and to ensure that it is 
used properly.

Precautions on use

The power of this product and instruments connected to this product must be turned off when the cable is 
to be installed or removed. Failure to do so may cause an electric shock or product damage.

	yUse this product with the correct supply voltage. Failure to do so may cause product damage.
	y For instructions

	yDo not turn OFF the power while setting the items or saving the settings. Otherwise, all or part of the 
setting data may be lost.
	yDo not let water, dust or oil stick to the camera/light of the sensor head/sensor. Failure to do so may 
cause a malfunction.
	yWhen this product becomes dirty, do not rub it with a wet cloth, benzene, thinner, or alcohol. Doing so 
may change the color or shape of the unit.
	y If the unit is heavily contaminated, disconnect all the cables including the power supply cable, wipe off 
the dirt with a cloth soaked with mild detergent, and then wipe with a soft dry cloth.

	y For external master image registration
If the external master image registration is to be performed frequently, set [Write to ROM when using Ext. 
Master Save] of the input option to [Disable] to protect the nonvolatile memory of the internal sensor. 
When the option is set to [Enable], the nonvolatile memory is guaranteed to write for 100,000 times.
	y For automatic focus function

	yAutomatic focus function is used for adjusting the focusing position at the time of installation. Disabled 
during the operation.
	y Focusing position can be registered in each program. The program configurations are guaranteed to 
switch for 100,000 times. If the focusing position does not need to be changed in each program, set [Auto 
Focus Adj Pos] to [Common] to extend its duration.
	yDo not apply shock or vibration to the sensor head/sensor during the focusing position adjustment. 
Failure to do so may cause product damage.

	yAbout SD Card
	yUse the KEYENCE recommended product.
	yClose the cover of the SD card slot while in use.
	yWhen removing the SD card, be sure to perform [SD Card Removal] before removing. 
	yDo not remove the SD card while accessing the SD card. Also, do not turn off the power while accessing 
the SD card. Otherwise, all or part of the setting data may be lost or damage may occur to the memory.
	y To prevent data loss, periodically backing up to another storage device is recommended.
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Important Instructions

Measures to be taken when an abnormality occurs

In the following cases, turn the power OFF immediately. Using the IV3 Series in an abnormal condition could 
cause fire, electric shock, or malfunction.
Contact our office for repair.

	y If water or debris enters the IV3 Series.
	y If the IV3 Series is dropped or the case is damaged.
	y If abnormal smoke or odor emanates from the IV3 Series.

Precautions on installation

To use this product correctly and safely, avoid installing it in the following locations. Failure to do so may 
cause fire, electric shock, or malfunction.

	yOutdoors
	yAltitude above 2500 m (built-in amplifier models)
	yAltitude above 2500 m (ultra-compact models)
	y Locations that are humid, dusty or poorly ventilated
	y Locations where the temperature is high such as those exposed to direct sunlight
	y Locations where there are flammable or corrosive gases
	y Locations where the unit may be directly subjected to vibration or impact
	y Locations where water, oil, or chemicals may splash onto the unit

	yWhen mounting the sensor with the built-in amplifier type and sensor head of the ultra-compact model 
which is connected with the AI Lighting unit, use them by mounting them on a metal plate. Failure to do so 
may cause burn injuries due to the high surface temperature.

	y To improve the anti-noise feature, install the unit following the precautions below. Otherwise, malfunction 
may occur.

	yGround the FG cable of the sensor amplifier.
	yDo not mount the unit in a cabinet where high-voltage equipment is already installed.
	yMount the unit as far from power lines as possible.
	y Separate the unit as far as possible from the devices that emit strong electric or magnetic field (such as 
solenoid or chopper).
	y Separate the I/O signal line from the power line or high-voltage line.

	y For power supply
	yNoise superimposed on the power supply could cause malfunction. Use a stabilized DC power supply 
configured with an isolation transformer.
	yWhen using a commercially available switching regulator, be sure to ground the frame ground terminal.

	yDevices including this unit are precision components. Do not apply shock or vibration.
	yWhen connecting to a network, let engineers who are knowledgeable about networks handle it.
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Safety Precautions on LED Product

Safety Precautions on LED Product

The degree of risk of this product is shown below.

Product Model Light source Risk group*

Ultra-compact model  
sensor head

IV3-G500CA
White LED Risk Group 1

IV3-G600CA

IV3-G500MA
Infrared LED Exempt Group

IV3-G600MA

Built-in amplifier  
type sensor

IV3-400CA

White LED Risk Group 1IV3-500CA

IV3-600CA

IV3-400MA

Infrared LED Exempt GroupIV3-500MA

IV3-600MA

AI Lighting unit

IV3-L4C

White LED Risk Group 1

IV3-L5C

IV3-L6C

IV3-LG5C

IV3-LG6C

IV3-L4M

Infrared LED Exempt Group

IV3-L5M

IV3-L6M

IV3-LG5M

IV3-LG6M

* LED product is classified as shown below according to IEC 62471.

	y Exempt Group Does not pose any photobiological hazard.
	yRisk Group 1 (Low-Risk) Does not pose a hazard due to normal behavioral limitations on exposure.

	yRisk Group 2 (Moderate-Risk) Does not pose a hazard due to the aversion response to very bright light sources or 
due to thermal discomfort.

	yRisk Group 3 (High-Risk) May pose a hazard even for momentary or brief exposure.
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Precautions on Regulations and Standards

CE and UKCA Markings
KEYENCE Corporation has confirmed that this product 
complies with the essential requirements of the applicable 
EU Directive(s) and UK regulations, based on the 
following specifications. Be sure to consider the following 
specifications when using this product in the Member 
States of European Union and in the United Kingdom.

	z EMC Directive (CE) and Electromagnetic 
Compatibility Regulations (UKCA)

	yApplicable standard	 : (BS) EN61326-1, Class A
	yWhen using the built-in amplifier types (IV3-400CA/
IV3-400MA/IV3-500CA/IV3-500MA/IV3-600CA/
IV3‑600MA), make sure the length of the power cable, 
I/O cable and Ethernet cable are less than 30 meters 
long.
	yWhen using the ultra-compact model (IV3-G500CA/
IV3-G500MA/IV3-G600CA/IV3-G6000MA), make sure 
the length of the power cable, I/O cable and Ethernet 
cable are less than 30 meters long.
	yWhen using the AI Lighting unit for Ultra small type 
(IV3-LG5C/IV3-LG5M/IV3-LG6C/IV3-LG6M), attach 
the recommended ferrite core or equivalent to the 
position shown in the figure 1. (2 places)

	yModel : ESD-SR-150 (TOKIN Corporation)
	yFerrite core mounting position:

60 mm or less

60 mm or 
less

AI Lighting unit

Sensor head

These specifications do not give any guarantee that the 
end-product with this product incorporated complies 
with the essential requirements of EMC Directive and
Electromagnetic Compatibility Regulations. The 
manufacturer of the end-product is solely responsible 
for the compliance on the end-product itself according 
to EMC Directive.

CSA Certificate
This product complies with the following CSA and UL 
standards and has been certified by CSA.

	yApplicable standard: �CAN/CSA C22.2 No. 61010-1 
UL61010-1

Be sure to consider the following specifications when using 
this product as a product certified by CSA.

	�Built-in amplifier types (IV3-400CA/IV3-400MA/
IV3-500CA/IV3-500MA/IV3-600CA/IV3-600MA)

	yOvervoltage category I
	yUse this product under pollution degree 3.
	yUse this product at the altitude of 2500 m or lower.
	y Indoor use only.
	yBe sure to consider the following specifications 
when using the optional Ethernet cable as a product 
certified by North American certification body. The 
Ethernet cable (OP-88664/OP-88665/OP-88666) 
does not comply with North American standards if it is 
used in the voltage rating required for PoE.
To supply power via PoE electric power supply, 
prepare an Ethernet cable that supports PoE.
When not used as PoE, it can be used as an Ethernet 
communication cable.

	�Ultra-compact model (IV3-G500CA/IV3-G500MA/
IV3-G600CA/IV3-G600MA)

	yUse the following power supply.
CSA/UL certified power supply that provides Class 
2 output as defined in the CEC (Canadian Electrical 
Code) and NEC (National Electrical Code)
	yConnect the sensor amplifier power supply and I/O 
connector to the same power supply that has Class 2 
output.
	yOvervoltage category I
	yUse this product under pollution degree 3.
	yUse this product at the altitude of 2500 m or lower.
	y Indoor use only.

	�AI Lighting unit (IV3-L4C/IV3-L4M/IV3-L5C/
IV3‑L5M/IV3-L6C/IV3‑L6M/IV3-LG5C/IV3-LG5M/
IV3-LG6C/IV3‑LG6M)

	yOvervoltage category I
	yUse this product under pollution degree 3.
	yUse this product at the altitude of 2500 m or lower 
(IV3-L**).
	yUse this product at the altitude of 2500 m or lower 
(IV3-LG**).
	y Indoor use only.
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Software License Agreement
NOTICE TO USER: PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (THIS “AGREEMENT”) CAREFULLY. 
BY USING ALL OR ANY PORTION OF THE [IV3-H1] (THIS “SOFTWARE”), YOU ARE AGREEING TO BE BOUND BY 
ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ANY TERMS OF THIS 
AGREEMENT, DO NOT USE THIS SOFTWARE.

1. Definition
1.1	 �“use” or “using” means to access, install, download, copy or otherwise benefit from using the functionality of this 

Software.
1.2	� “This Software” means the software and all associated documentation provided by KEYENCE.

2. Grant of License.
Conditioned upon compliance with all of the terms and conditions of this Agreement, KEYENCE grants you a 
nonexclusive and nontransferable license to install this Software on all computers in order to use the KEYENCE 
product. You may make one copy of this Software for backup or archive purposes only.

3. Restrictions.
3.1	� Except for installation of updates or new functions provided by KEYENCE, you may not modify or add any 

function to this Software.
3.2	� You may not reverse engineer, decompile or disassemble this Software.
3.3	� You may not create derivative works based on this Software.
3.4	� Other than expressly stated by KEYENCE, you may not resell, retransfer, rent or otherwise redistribute this 

Software to any third parties.

4. Intellectual Property Rights.
Except as expressly stated herein, KEYENCE reserves all right, title and interest in this Software, and all associated 
copyrights, trademarks, and other intellectual property rights therein.

5. Disclaimer.
Keyence is licensing this Software to you “AS IS” and without any warranty of any kind. In no event will KEYENCE or its 
suppliers be liable to you for any damages,
claims, costs or any lost profits caused by using this Software.

6. Termination.
6.1	� Your license under this Agreement will terminate automatically if you destroy this Software and the copy of this 

Software in your possession or voluntarily return this Software to us.
6.2	� Your license under this Agreement will terminate automatically without any notice from KEYENCE if you fail to 

comply with any of the terms and conditions of this Agreement. Promptly upon termination, you shall cease all use 
of this Software and destroy all copies, full or partial, of this Software in your possession or control.

6.3	 �You will compensate KEYENCE for costs or any lost profits caused by your violation or breach of any term of this 
Agreement.

7. Governing Law.
7.1	 �This Agreement will be governed by and construed in accordance with the substantive laws of Japan without 

regards to the principles of conflicts of law.
7.2	 �If any part of this Agreement is found void and unenforceable, it will not affect the validity of the balance of this 

Agreement, which shall remain valid and enforceable according to its terms and conditions.
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Version of the IV3 Series

You can download the most recent operation software for the sensor (IV3-G120, IV3-400CA, IV3-400MA, IV3-500CA, 
IV3‑500MA, IV3-600CA, IV3-600MA) and PC software for the IV3 Series IV3-Navigator (IV3-H1) from the KEYENCE web 
site.
Please refer to the description on the homepage for the introduction method.
URL: www.keyence.com/glb

Operation Software for the Sensor

Version Description

R1.30.** This is the version of this document.

PC Software for IV3 Series IV3-Navigator (IV3-H1)

Version Description

R1.30.** This is the version of this document.

Revision history of Software Version

Version Description

R1.00.** The initial version.

R1.10.**

	y Adds the following functions
	yMultiple Position Adjustments
	yMultiple Master images
	yHigh-Speed Program Switching
	y Program Auto-Switching (Standard Mode)
	yMultiple units connection, list display, display switch (IV3-Navigator only)
	y Supports SFTP

	y Supports the 4 pin cable (for the built-in amplifier type)

R1.20.**

	y Adds the following functions
	y Expands the number of installed tools (total of 65 tools)
	y Expands the types of supported tools in sorting mode
	y Program auto-switching (sorting mode)
	y Automatic backup and restoration of settings
	yChange of thresholds while running
	y PROFINET
	yMaster status result output
	y Languages

R1.30.** Supports IV3-400CA/400MA

Version of the IV3 Series
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Version of the IV3 Series
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Structure of This Manual

1 Getting Started This chapter explains the system configuration and overview of the IV3 Series, 
package contents, and names and functions of each part.

2 Installation and 
Connection

This chapter explains the procedures for installing and connecting the sensor 
and for setting up the PC.

3 Basic Operation This chapter explains the basic operation and operation flow of the IV3 Series.

4 Settings Navigator This chapter explains how to set the sensors using the Settings Navigator.

5 Running This chapter explains how to operate the IV3 Series.

6 Adjusting This chapter explains how to adjust the IV3 Series.

7 Various Functions This chapter explains the detailed features of the IV3 Series.

8 Saving Settings and  
Images, SD Card

This chapter explains how to save the sensor setup or image, and how to set 
the SD card to use.

9 Connecting to a Network This chapter explains how to connect and use the network.

10 Simulator This chapter explains the functions and operations of the Simulator.

11 Controlling with the  
Input/Output Line

This chapter explains how the input and output terminals control each 
operation.

12 Specifications This chapter explains specifications and dimensions.

A Appendices This chapter explains error messages and troubleshooting, etc.

Structure of This Manual

1
2
3
4
5
6
7
8
9
10
11
12
A
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1 

Getting Started

This chapter explains the system configurations and overview 
of the IV3 Series, how to check package contents, and the 
name and function of each part.

System Configuration..........................................................1-2
IV3 Series Overview.............................................................1-6
Checking the package contents.........................................1-9
Name and Function of Each Part......................................1-13
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System Configuration

System Configuration

Basic Configurations of the IV3 Series

Basic configuration of the ultra-compact model

Photoelectric/proximity 
sensor etc.
Sends a signal to the 
trigger input and timing 
input when the target is 
detected.

Indicator light/buzzer etc.
Alarm can be output using 
the status output.

PLC
PLC can control the trigger input and 
timing input, and the status output, and 
can switch the program number.

SD card
CA-SD16G (16 GB)
KV-M4G (4GB)

24 V DC power

PC Software for IV3 Series  IV3-Navigator
IV3-H1

Ultra-compact model
Sensor head
IV3-G500CA
IV3-G500MA
IV3-G600CA
IV3-G600MA

I/O cable

Ultra-compact model
Sensor amplifier
IV3-G120

Sensor head 
/amplifier cable
OP-88648 (2 m)
OP-88649 (5 m)
OP-88650 (10 m)

LAN cable
OP-87950 (1m)
OP-87951 (3m)
OP-87952 (5m)
OP-87953 (10m)

Communication Unit DL Series
(ultra-compact model only)
This unit supports communication 
units. Status results can be 
obtained and control of trigger 
input can be performed.
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System Configuration

Basic configuration of the built-in amplifier type

Photoelectric/proximity 
sensor etc.
Sends a signal to the 
trigger input and timing 
input when the target is 
detected.

Indicator light/buzzer etc.
Alarm can be output using 
the status output.

PLC
PLC can control the trigger input and 
timing input, and the status output, and 
can switch the program number.

SD card
IV3-MSD8G
(microSD 8 GB)

24 V DC power

PC Software for IV3 Series  IV3-Navigator
IV3-H1

Built-in amplifier type
Sensor
IV3-400CA
IV3-400MA
IV3-500CA
IV3-500MA
IV3-600CA
IV3-600MA

I/O cable

Power I/O cable
OP-88654 (2 m)
OP-88655 (5 m)
OP-88656 (10 m)

Ethernet cable
OP-88664 (2m)
OP-88665 (5m)
OP-88666 (10m)
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System Configuration

Connecting the PC and multiple sensors
When connecting multiple sensors with a network, the PC can select a single sensor from among the multiple sensors to 
connect.

Ethernet switch
(Example) NE-Q05

Sensor head 
/amplifier cable
OP-88648 (2 m)
OP-88649 (5 m)
OP-88650 (10 m)

Ultra-compact model
Sensor head
IV3-G500CA
IV3-G500MA
IV3-G600CA
IV3-G600MA

Ultra-compact model
Sensor amplifier

IV3-G120

LAN cable
OP-87950 (1m)
OP-87951 (3m)
OP-87952 (5m)
OP-87953 (10m)

LAN cable
OP-87950 (1m)
OP-87951 (3m)
OP-87952 (5m)
OP-87953 (10m)

PLC  
(Communication network)
FTP/SFTP server

PC Software for IV3 Series  IV3-Navigator
IV3-H1

Built-in amplifier type
Sensor
IV3-400CA
IV3-400MA
IV3-500CA
IV3-500MA
IV3-600CA
IV3-600MA

Ethernet cable
OP-88664 (2m)
OP-88665 (5m)
OP-88666 (10m)

For the method to supply power to the sensor, refer to  “Cables” (page 2-15).

The IV2 Series and IV Series can be connected on a network.
	y For details on connecting with the sensor of the IV2 Series, refer to  “IV2 Series User’s Manual (PC Software)”.
	y For details on connecting with the sensor of the IV-HG/IV-H Series, refer to  “IV-HG/IV-H Series User’s Manual (PC 
Software)”.
	y For details on connecting with the sensor of the IV-G/IV Series, refer to  “IV-G/IV Series User’s Manual (PC 
Software)”.
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System Configuration

Configuration of the IV3 Series network function
The following functions can be used by configuring a network with the IV3 Series.

	yBy using the data transfer function, images and status results can be transfered to SD cards and FTP/SFTP servers.
	yTrigger input, judgment result acquisition, program number switch (changeover) by connection with PLC on the field 
Network

PLC

IV3 Series
Ultra-compact model
Sensor amplifier

FTP/SFTP server

Communication network
	y EtherNet/IP™
	y TCP/IP non-procedural 
communications

IV3 Series
Ultra-compact 
model
Sensor head

IV3 Series
Built-in amplifier type

Sensor

PC Software for IV3 Series  IV3-Navigator
IV3-H1

Ethernet

	z When using a field network (DL unit) (ultra-compact model only)

PLC

IV3 Series
Ultra-compact model
Sensor amplifier

	yRS-232C
	y EtherCAT
	yCC-Link
	yDeviceNet

IV3 Series
Ultra-compact model
Sensor head

PC Software for IV3 Series  IV3-Navigator
IV3-H1

Ethernet
Communication Unit
DL Series
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IV3 Series Overview

IV3 Series Overview

IV3 Series
The IV3 Series is a “Vision Sensor”.
This sensor can be attached easily so complicated detection operations such as detecting the shapes of parts with a 
photoelectric switch can be achieved easily.
Operation condition settings require the use of the control panel (IV3-CP50) or the PC software IV3‑Navigator (IV3-H1) for 
the IV3 Series.
The sensor with control panel or the sensor with PC are connected via Ethernet so connection with multiple sensors can 
be performed.

Using with control panel

Ethernet switch

Function of the control panel
	y Setting the sensor
	yMonitoring the operation 
screen
	yMonitoring the operation 
information
	yReading the image history

Functions of sensor
	yCamera
	y Light
	y Image detection
	y I/O
	y Saving the image 
history

PLC  
(Communication network)
FTP/SFTP server

For the method to supply power to the sensor, refer to  “Cables” (page 2-15).

For details of operations using the control panel (IV3-CP50), refer to “IV3 Series User’s Manual (Control Panel)”. 
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IV3 Series Overview

Using with PC software “IV3-Navigator”
The PC software “IV3-Navigator” has the same functions as the control panel for the IV3 Series.

Ethernet switch

Functions of IV3-Navigator
	y Setting the sensor
	yMonitoring the operation 
screen
	yMonitoring the operation 
information
	yReading the image history

Functions of sensor
	yCamera
	y Light
	y Image detection
	y I/O
	y Saving the image 
history

PLC  
(Communication network)
FTP/SFTP server

For the method to supply power to the sensor, refer to  “Cables” (page 2-15).
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IV3 Series Overview

Judgment processing flow
This section describes the basic judgment processing flow of this device.

Trigger input

BUSY output
Total status output
Part discrimination 
result output

Trigger input
Inputs the imaging startup signal by synchronizing to the target position from a photoelectric 
switch or PLC.
Also, the trigger can be input at a regular interval with the internal trigger function.

Imaging Use the built-in light to obtain an image of the target with the CMOS image sensor. BUSY output 
turns ON.

Status output
Outputs the status result.
Standard mode: 	� When the total status result is OK, the total status OK output is ON.  

When the total status result is NG, the total status NG output is ON.
Sorting mode: 	 The output where the matching type is assigned is ON.

Save images Saves the image (up to 100 images) to the image history memory in the sensor.
Conditions for saving the image can be selected from “NG only”, “NG/near threshold OK”, or “All”.

Tool processing

Standard mode:	� According to the settings of a detection tool, the image of the target is scanned 
to detect whether a target is high or low quality. In addition, misaligned 
positions of the target can be corrected by using the position adjustment tool. 
Up to 65 tools can be set.

Sorting mode:	� Registers multiple varieties and judges which part type the target matches. Up 
to 8 part types can be registered. Up to 8 detection tools can be set. Misaligned 
positions of the target can be corrected by using the position adjustment tool.

After the detection process is completed, the BUSY output function turns OFF.

By using the data transfer function, images and status results can be transfered to SD cards and FTP/SFTP servers.
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Checking the package contents

The IV3 Series consists of the models below. Check that all of the bundled items below are included with each model 
before use. Remove, this revision is included with the previous correction.

Ultra-compact model sensor head

	y IV3-G500CA
	y IV3-G600CA

	y IV3-G500MA
	y IV3-G600MA

Sensor head x 1
 “Name and Function of Each Part” (page 1-13)
 “Mounting the Sensor” (page 2-2)
 �“Cables” (page 2-15)

Ultra-compact model sensor amplifier
	y IV3-G120

Sensor amplifier x 1

Instruction Manual x 1

LAN port cap x 1  
(mounted in the amplifier)

Power terminal block  
(mounted in the amplifier)

I/O terminal block (mounted in the 
amplifier)

 “Name and Function of Each Part” (page 1-13)
 “Mounting the Sensor” (page 2-2)
 “Cables” (page 2-15)

Options for the ultra-compact model

AI Lighting unit
	y IV3-LG5C
	y IV3-LG5M 

	y IV3-LG6C
	y IV3-LG6M

AI Lighting unit x 1

Sensor head mounting bracket 
x 1

Mounting screw 
(Slim head screw M4 x L6) x 2
(Double sems screw M4 x L6) x 2

Instruction Manual x 1
	� “Mounting the AI Lighting unit” (page 2-6)

Polarizing filter

	� Polarizing filter (sensor head)
	yOP-88642 (color)
	yOP-88643 
(monochrome)

Mounting screw
M3 x L5 (double-washer sems) x 1

Instruction Manual x 1

	� “Using the polarizing filter” (page 2-10)

	� Polarizing filter for the AI Lighting unit
	yOP-88646 (color)
	yOP-88647 
(monochrome) Instruction Manual x 1

	� “Using the polarizing filter” (page 2-10)

Mounting the dome attachment
	y IV2-GD05

Dome attachment for ultra-
compact model (Small)

Mounting screw (M4 x L8) x 2
Mounting screw (M4 x L10) x 2
* Double-washer sems screw
Instruction Manual x 1 

	y IV2-GD10

Dome attachment for ultra-
compact model (Large)

Mounting screw (M4 x L8) x 2
Mounting screw (M4 x L10) x 2
* Double-washer sems screw
Instruction Manual x 1 

	� “Mounting the dome attachment for ultra-compact model” 
(page 2-12)

Checking the package contents
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Checking the package contents

Sensor head/amplifier cable
	yOP-88648 (2m)
	yOP-88649 (5m)
	yOP-88650 (10m)

Sensor head/amplifier cable x 1

 �“Cables” (page 2-15)

Mounting bracket (When not using the AI 
Lighting unit)

	� Vertical mounting bracket
	yOP-87908

Mounting bracket x 1

Mounting screw (M4 x L8) x 2
* Double-washer sems screw

	� Transverse mounting bracket
	yOP-87909

Mounting bracket x 1

Mounting screw (M4 x L8) x 2
* Double-washer sems screw

	� Adjustable bracket
	yOP-87910

Mounting 
bracket x 1

Mounting screw
(M4 x L8) x 2
* Double-washer 
sems screw

Bracket x 1

Mounting bracket (When using the AI 
Lighting unit)

	� Common mounting bracket (common to 
built-in amplifier type)

	yOP-88634

Common mounting 
bracket x 1

Mounting screw (M3 x L7) x 4

	� Biaxial adjustable mounting bracket for the 
AI Lighting unit

	yOP-88638

Biaxial adjustable 
mounting bracket x 1

Mounting screw (M3 x L7) x 4

	� Adjustable bracket for the AI Lighting unit
	yOP-88639

Adjustable  
bracket x 1

Mounting screw (M3 x L7) x 4

SD card
	yCA-SD16G (16 GB)
	yKV-M4G (4GB)

SD card × 1
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Checking the package contents

Built-in amplifier type sensor

	y IV3-400CA
	y IV3-500CA
	y IV3-600CA

	y IV3-400MA
	y IV3-500MA
	y IV3-600MA

Sensor x 1

Water proof cap for  
the Power I/O cable connector x 
1
(Attached to the unit)

Water proof cap for  
the Ethernet cable connector x 1
(Attached to the unit)

 “Name and Function of Each Part” (page 1-13)
 “Mounting the Sensor” (page 2-2)
 �“Cables” (page 2-15)

Options for the built-in amplifier type

AI Lighting unit
	y IV3-L4C
	y IV3-L4M

	y IV3-L5C
	y IV3-L5M

	y IV3-L6C
	y IV3-L6M

AI Lighting unit x 1

Instruction Manual x 1

	� “Mounting the AI Lighting unit” (page 2-6)

Polarizing filter

	� Polarizing filter (sensor main unit)
	yOP-88640 (color)
	yOP-88641 
(monochrome)

Mounting screw
M2.5 x L5 (double-washer sems) x 2

Instruction Manual x 1

	� “Using the polarizing filter” (page 2-10)

	� Polarizing filter for the AI Lighting unit
	yOP-88644 (color)
	y OP-88645 (monochrome)

Instruction Manual x 1

	� “Using the polarizing filter” (page 2-10)

Mounting the dome attachment
	y IV3-D10

Dome attachment for IV3 
built-in amplifier type sensor

Mounting screw (M2.5 x L8) x 2
* Double-washer sems screw
Instruction Manual x 1 

	� “Mounting the dome attachment for built-in amplifier type” 
(page 2-14)

Power I/O cable (M12 A12 pin - strand wire)
	yOP-88654 (2m)
	yOP-88655 (5m)
	yOP-88656 (10m)

Power I/O cable x 1

 �“Cables” (page 2-15)

Ethernet cable

	� Ethernet cable (M12 X8pin - RJ-45)
	yOP-88664 (2m)
	yOP-88665 (5m)
	yOP-88666 (10m)

Ethernet cable x 1

 �“Cables” (page 2-15)

	�M12-M12 Ethernet cable 
(M12 D4pin-M12 X8pin)

	yOP-88651 (2m)
	yOP-88652 (5m)
	yOP-88653 (10m)

M12-M12 Ethernet cable x1
 �“Cables” (page 2-15)
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Checking the package contents

Mounting bracket (common when using the 
AI Lighting unit)

	� Common mounting bracket (common to all 
ultra-compact models)

	yOP-88634

Common mounting 
bracket x 1

Mounting screw (M3 x L7) x 4

	� Biaxial adjustable mounting bracket
	yOP-88635

Biaxial adjustable 
mounting bracket x 1

Mounting screw (M3 x L7) x 4

	� Adjustable bracket
	yOP-88636

Adjustable bracket x 1

Mounting screw  
(M3 x L7) x 4

SD card
	y IV3-MSD8G (8 GB: micro SD)

SD Card x 1
Conversion adapter x 1

* Stored in the dedicated case

Conversion connector

	� Conversion connector for power I/O cable
	yOP-88631 (M12 A12pin-A4pin Male) x1

	yOP-88632 (M12 A12pin-L5pin Male) x1

	� Conversion connector for Ethernet cable
	yOP-88633 (M12 X8pin-D4pin Female) x1

When using the Conversion connector for 
Ethernet cable (OP-88633), the Ethernet 
standard is fixed at 100BASE-TX. 

Communication cable

LAN cable (RJ-45 - RJ-45)
	yOP-87950 (1m) 	yOP-87951 (3m)
	yOP-87952 (5m) 	yOP-87953 (10m)

LAN cable (RJ-45 - RJ-45) x 1

PC software for IV3/IV2/IV series
	y IV3-H1

DVD x 1

Instruction Manual x 1
Starting Guide x 1

 “Installing IV3-Navigator (IV3-H1)” 
(page 2-22)

1

G
etting Started



1-13IV3 Series User’s Manual (PC Software)

Name and Function of Each Part

Name and Function of Each Part

Ultra-compact model sensor head

	y IV3-G500CA 	y IV3-G500MA
	y IV3-G600CA 	y IV3-G600MA

Name and function of each part of the ultra-
compact model sensor head

1 2 2 3 4 5

1	 Status indicator light
Indicates the operating status of the sensor.

 “Operation of the status indicator light: Ultra-compact 
model sensor head” (page 1-14)

2	 Mounting part
Used for mounting the sensor head.

 “Mounting the ultra-compact model sensor head” 
(page 2-3)

3	� Connector for Sensor head/amplifier cable
The connector can rotate.

Example of rotating
4	 Camera and built-in light
5	 Mounting part for the polarizing filter

Ultra-compact model sensor amplifier

	y IV3-G120

Name and function of each part: Ultra-
compact model sensor amplifier

1

2
5

3
4

7

6

8
9

1	 Indicator light
Indicates the operating status of the sensor amplifier.

 “Operation of the indicator light: Ultra-compact 
model sensor amplifier” (page 1-14)

2	 Connector for the sensor head/amplifier cable
 “Cables” (page 2-15)

3	 Power terminal block
Supplies power to this unit.

4	 I/O terminal block
Connects to the input and output cables.

5	 Connector on the communications unit
Used for connecting the communication unit (DL 
Series).
The protection cover is attached during shipment.

6	 SD card indicator light
Indicates the operating status of the SD card.

Green 
(ON)

The SD card is recognized. When the 
cover is open, the access stops.

Green 
(Blink) The SD card is accessed.

(OFF) The SD card is not mounted, or not 
recognized.

7	 Ethernet connector
Used for connecting to the control panel (IV3-CP50), 
PC, or field network.
When this is not used, attach the included LAN port 
cap.

8	 IP reset switch
Used for resetting the IP address assigned to this 
sensor amplifier.

9	 SD card slot
Mount the SD card.
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Name and Function of Each Part

Operation of the status indicator light: Ultra-
compact model sensor head

Status 
indicator light

Green 
(ON) The total status result is “OK”.

Green 
(Blink)

Under startup or setting in progress. 
Operation stopped. Blinks once a second.

Red (ON) The total status result is “NG”.

Red (Blink) An error has occurred.

(OFF)

	y Standby status until the first judgment 
finishes after starting the operation or 
after switching the program number.
	y The versions of the sensor head and 
sensor amplifier do not match.
	y An incompatible sensor head is 
connected.

Green and 
red are 
blinking 
alternately.

“LED Blinking” is requested.

Operation of the indicator light: Ultra-
compact model sensor amplifier

1

2

3

4

5

1	 PWR/ERR

Green 
(ON) Operation is in progress.

Green 
(Blink)

Setting in progress. Operation stopped. 
Blinks once a second.

Red (ON) Unrecoverable error has occurred.

Red (Blink) Recoverable error has occurred.

Orange 
(Blink)

	y “LED Blinking” is requested.  
Blinks four times a second.
	y Settings are being restored from the SD 
card.  
Blinks once a second.

(OFF)
	y Settings are being restored from the SD 
card.  
Blinks once a second.

2	 OUT
Indicates the comprehensive result.

Green 
(ON) The total status result is “OK”.

Green 
(Blink)

Startup is in progress. Alternatively, a 
program is not set.

Red (ON) The total status result is “NG”.

Orange 
(Blink)

	y “LED Blinking” is requested.  
Blinks four times a second.
	y Settings are being restored from the SD 
card.  
Blinks once a second.

(OFF)

Setting in progress.
Standby status until the first judgment 
finishes after starting the operation or after 
switching the program number.

3	 TRIG

Green 
(ON)

Green light lights up (one-shot) according 
to input of the internal or external trigger.

Orange 
(Blink)

“LED Blinking” is requested. Blinks four 
times a second.

4	 STATUS
Indicates the Ethernet connection status.

Green 
(ON) Connected normally to the sensor.

Green 
(Blink)

IP address has been retrieved but the 
sensor is not correctly connected.

Red (ON) The IP address coincides with other device 
or a network loop is detected.

Red (Blink) Communication timeout has occurred with 
the Ethernet/IP scanner.

(OFF) IP address is not assigned.
No correct connection with the PC.

5	 LINK/ACT
Indicates the link status to the Ethernet.

Green 
(ON) Normally linked.

Green 
(Blink)

Normally linked, and the data is sending/
receiving.

(OFF) Sensor is not normally linked.

For the state of the indicator light when the Field 
Network function is used, see “IV3 Series User’s 
Manual (Field Network).”
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Name and Function of Each Part

Built-in amplifier type sensor

	y IV3-400CA 	y IV3-400MA
	y IV3-500CA 	y IV3-500MA
	y IV3-600CA 	y IV3-600MA

Built-in amplifier type: Name and function of 
each part of the sensor

1

2
3

4

5

5

6

7

8
10

11

9

1	 Indicator light
Indicates the operating status of the sensor.
 �“Built-in amplifier type: Operation of the indicator 
light of the sensor” (page 1-15)

2	 Built-in light
LED light that illuminates the target.

3	� Connector cover
Remove when mounting the AI Lighting unit.

4	� Camera
Image the target.

5	 Mounting part
Used for mounting the sensor.

6	 Rotating connector
The direction the cable is pulled out can be changed.

7	 Connector for Ethernet cable
Connector for connecting the Ethernet cable. Use this 
for connecting the control panel, PC, or Ethernet switch.

 “Cables” (page 2-15)
8	 Connector for power I/O cable

Connector for connecting the power I/O cable.
Use this for supplying the power to the sensor and for 
connecting with external devices.

 “Cables” (page 2-15)
9	 SD card cover

Open when inserting/removing the micro SD or using 
the IP reset switch.

	yTightening torque: 0.15 to 0.20 N·m
10	 SD card slot

The slot the microSD card is inserted into.
There is an SD access indicator in the slot part.
 �“Built-in amplifier type: Operation of the indicator 
light of the sensor” (page 1-15)

11	 IP reset switch (inside the SD card cover)
Used for resetting the IP address assigned to this 
sensor amplifier.

When the cable is not connected to the 
connector for the power I/O cable or the 
connector for the Ethernet cable, attach the 
waterproof cap for included with the connector 
to maintain the enclosure rating.
Tightening torque: 0.45 to 0.55 N·m

Built-in amplifier type: Operation of the 
indicator light of the sensor

5 64321 1

1	 Status indicator light
Green 
(ON) The total status result is “OK”.

Green 
(Blink)

Under startup or setting in progress. 
Operation stopped. Blinks once a second.

Red (ON) The total status result is “NG”.
Red (Blink) An error has occurred.

(OFF)
Standby status until the first judgment 
finishes after starting the operation or after 
switching the program number.

Green and 
red are 
blinking 
alternately.

“LED Blinking” is requested.

2	 OUT
Indicates the comprehensive result.

Green The total status result is “OK”.
Green 
(Blink)

Startup is in progress. Alternatively, a 
program is not set.

Orange 
(Blink)

	y “LED Blinking” is requested.  
Blinks four times a second.
	y Settings are being restored from the SD 
card.  
Blinks once a second.

Red The total status result is “NG”.

(OFF)

Setting in progress.
Standby status until the first judgment 
finishes after starting the operation or after 
switching the program number.

3	 TRIG
Green (ON) Green light lights up (one-shot) according 

to input of the internal or external trigger.
Orange 
(Blink)

“LED Blinking” is requested.
Blinks four times a second.

4	 STATUS
Indicates the Ethernet connection status.

Green 
(ON) Connected normally to the sensor.

Green 
(Blink)

IP address has been retrieved but the 
sensor is not correctly connected.

Red (ON) The IP address coincides with other device 
or a network loop is detected.

Red (Blink) Communication timeout has occurred with 
the Ethernet/IP scanner.

(OFF) IP address is not assigned. No correct 
connection with the PC.

1
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Name and Function of Each Part

5	 SD
Indicates the operating status of the SD card.

Green (ON) The SD card is recognized.
Green 
(Blink) The SD card is accessed.

(OFF) The SD card is not mounted or not 
recognized.

The operation of the SD access indicator in the 
slot part is as follows;

Green 
(ON) The SD card is recognized.

(OFF) The SD card is not mounted or 
not recognized.

6	 LINK/ACT
Indicates the link status to the Ethernet.

Green (ON) Normally linked.
Green 
(Blink)

Normally linked, and the data is sending/
receiving.

(OFF) Sensor is not normally linked.

1
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2 

Installation and 

This chapter explains how to mount the sensor, how to set up 
the PC, and how to connect the cables.

Mounting the Sensor............................................................2-2
Cables..................................................................................2-15
Setting up the PC................................................................2-22

Connection

Chapter 
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Mounting the Sensor

Mounting the Sensor

About sensor

	z Ultra-compact model

	y IV3-G500CA 	y IV3-G500MA
	y IV3-G600CA 	y IV3-G600MA

	z Built-in amplifier type

	y IV3-400CA 	y IV3-400MA
	y IV3-500CA 	y IV3-500MA
	y IV3-600CA 	y IV3-600MA

Mounting the sensor head/sensor

Do not place the sensor head/sensor in an 
environment that exceeds the limit of its 
environmental resistance, or an environment 
that propagates vibration directly to the 
sensor head/sensor. Those may cause a 
damage or malfunction.

	y Field of view and optical axis have individual 
differences. Adjust the sensor position by 
checking the actual image at the time of 
installation.
	y Place the sensor in a location where ambient 
light will not affect the image. Ambient light 
includes solar light, lights of other devices, 
and photoelectric sensors. Also, be careful 
when the light intensity of the ambient light 
changes. Use a shield to protect when the 
location cannot be changed.
	y Place the sensor where no object can block 
out the internal light or the field of view of the 
sensor.
	yDetection may become unstable if multiple 
sensors are placed nearby each other, due to 
the lighting of each sensor. To prevent this, 
take the measures described below:

	yDelay the timing of external trigger inputs.
	yUse a shield to avoid interference.

Checking the field of view and installed 
distance
For the IV3 Series, the installed distance and the field of 
view of the camera is different depending on the type of 
sensor head/sensor used. Check the type of the sensor 
head/sensor to be used and its field of view and place it at 
the proper distance.

	z Ultra-compact model

Field of view H

Field of view V

Installed distance WD

Indicator light

Field of View V = Field of View H x 0.75 (H:V = 4:3)

Model
Installed 

distance WD 
Field of 
View H 

Field of 
View V 

	y IV3-G500CA
	y IV3-G500MA

50 22 16

100 42 31

200 81 61

300 121 90

400 160 120

500 199 149

600 238 179

800 317 238

1000 396 297

1200 474 356

1400 553 415

1600 631 474

1800 710 533

2000 789 592

2500 987 740

3000 1,184 888

	y IV3-G600CA
	y IV3-G600MA

50 51 38

100 96 72

200 187 140

300 278 208

400 369 276

500 460 344

600 550 412

800 732 548

1000 914 684

1200 1,095 820

1400 1,277 956

1600 1,458 1,092

1800 1,640 1,228

2000 1,822 1,364

2500 2,276 1,704

3000 2,730 2,044

(mm)
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Mounting the Sensor

	z Built-in amplifier type

Field of view H

Field of view V

Installed distance WD

Field of View V = Field of View H x 0.75
(H:V = 4:3)

Model
Installed 

distance WD 
Field of 
View H 

Field of 
View V 

	y IV3-400CA
	y IV3-400MA

400 58 44
500 74 56
600 90 67
800 121 91
1000 152 114
1200 183 137
1400 214 161
1600 246 184
1800 277 208
2000 308 231
2500 386 290
3000 464 348

	y IV3-500CA
	y IV3-500MA

50 22 16
100 42 31
200 81 61
300 121 90
400 160 120
500 199 149
600 238 179
800 317 238
1000 396 297
1200 474 356
1400 553 415
1600 631 474
1800 710 533
2000 789 592
2500 987 740
3000 1,184 888

	y IV3-600CA
	y IV3-600MA

50 51 38
100 96 72
200 187 140
300 278 208
400 369 276
500 460 344
600 550 412
800 732 548
1000 914 684
1200 1,095 820
1400 1,277 956
1600 1,458 1,092
1800 1,640 1,228
2000 1,822 1,364
2500 2,276 1,704
3000 2,730 2,044

(mm)

Mounting the ultra-compact model sensor 
head

	y IV3-G500CA 	y IV3-G500MA
	y IV3-G600CA 	y IV3-G600MA

Mounting the ultra-compact model sensor 
head

	�When screws are secured from the sensor 
head

	yScrew: M3 x 2
	yTightening torque: 0.3 to 0.6 N·m

	�When screws are secured from the wall
	yScrew: M4 x 2
	yTightening torque: 0.7 to 1.5 N·m
	y Screw hole on the sensor head: M4 (screw depth : 3.5 mm)

Attaching the optional mounting bracket

	� Vertical mounting bracket (OP-87908)
Attach the bracket using the screws attached to OP-
87908.

	yTightening torque: 0.7 to 1.5 N·m
Mounting 
examples

	� Transverse mounting bracket (OP-87909)
Attach the bracket using the screws attached to OP-
87909.

	yTightening torque: 0.7 to 1.5 N·m
Mounting 
examples
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Mounting the Sensor

	� Adjustable bracket (OP-87910)

1	Attach the bracket using the screws attached to 
OP-87910.

	yTightening torque: 0.7 to 1.5 N·m
Mounting 
examples

Connect the convex parts to the sensor head.

Convex part

2	Mount the bracket on the support side to fix.
	yTightening torque: 5 N·m

Mounting 
examples

Mounting the ultra-compact model sensor 
amplifier

Mount the sensor amplifier as follows for heat 
release.

	y For the mounting direction, place the indicator 
light toward the front.
	y Secure the surrounding space with 30 mm or 
more.
	y Set it on DIN rail mounted on sheet metal.

AA

A

A

A: 30 mm or more
DIN rail

1	Fit the stopper on the back of the sensor 
amplifier (center side) to the DIN rail (1), and then 
push the sensor amplifier in on the arrow mark 
direction (2) until you hear the clicking sound.

(1)

(2)

Stopper

When dismounting, push down the upper part of the 
front of the amplifier, while pushing the sensor amplifier 
on the reverse direction of the (1) arrow mark (upper 
side).

2
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Mounting the Sensor

Mounting the built-in amplifier type 
sensor

	y IV3-400CA 	y IV3-400MA
	y IV3-500CA 	y IV3-500MA
	y IV3-600CA 	y IV3-600MA

Mounting the sensor

For heat dissipation, attach the sensor to metal.

	�Mounting onto the mounting hole
	yMounting hole size: M3 depth 3.3 mm
	y Tightening torque: 0.5 to 0.7 N·m

In addition to the back M3 mounting hole, the 
sensor can be mounted on the back M2.5 (depth 
3.4 mm, tightening torque: 0.2 to 0.3 N·m) and the 
front M4 (depth 4.1 mm, tightening torque: 0.8 to 1.2 
N·m) hole.

Attaching the optional mounting bracket

	�Mounting bracket for general use (OP-88634)
Attach the bracket using the screws attached to the 
mounting bracket for general use (OP-88634).

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples

	� Biaxial adjustable bracket (OP-88635)

1	Attach the bracket using the screws included 
with the biaxial adjustment bracket (OP-88635).

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples

2	Loosen the screws on the left and right side of 
the mounting bracket, and adjust the angle and 
distance.

	yTightening torque: 0.7 to 1.5 N·m

Loosen the screws and adjust 
the angle and distance

	� Adjustable bracket (OP-88636)

1	Attach the bracket using the screws included 
with the adjustable bracket (OP-88636).

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples

2	Attach the bracket on the brace side, adjust the 
angle, and then fix the bracket with a bolt.

	yTightening torque: 7 to 9 N·m
Mounting 
examples

Prop (f12 +0.04
-0.06 )

Adjust the angle

Fix on the brace
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Mounting the Sensor

Mounting the AI Lighting unit

When mounting or detaching the attachment, 
turn off the power of the IV3 Series. Mounting or 
detaching the attachment while the power is on 
may cause a malfunction.

Mounting the AI Lighting unit onto the ultra-
compact model sensor head

	y IV3‑LG5C 	y IV3‑LG5M
	y IV3‑LG6C 	y IV3‑LG6M

	�Mounting the AI Lighting unit (for the ultra-
compact model)

1	Mount the sensor head onto the head mounting 
bracket.

	yTightening torque: 0.6 to 0.8 N·m
Face the concave 
surface outwards 
and fix with slim 

head screws.

2	Rotate the head cable connector in the direction 
the cable will be extracted.

3	Mount the sensor head from the light side of 
the AI Lighting unit and then fix to the mounting 
holes with screws.

	yTightening torque: 0.5 to 0.7 N·m

4	Connect the AI Lighting unit cable to the sensor 
head.

	yTightening torque: 0.6 to 0.8 N·m

Sensor head

Align the pins and pin connection
Rotating connector on 
the attachment

5	Connect the sensor head/amplifier cable to the 
rotating connector on the AI Lighting unit.

	yTightening torque: 0.6 to 0.8 N·m
Align the pins and pin connection

	y To tighten the screw by hand, turn it until the 
connector of the cable touches the sensor 
head firmly. Then turn it more about by 5° 
using a tool such as pliers.
	yDo not rotate the rotating connector with the 
cable connected. Doing so may interfere with 
the base of the cable causing damage. To 
rotate the rotating connector, make sure to 
disconnect the cable first.

	�Removing the AI Lighting unit (for the ultra-
compact model)

Perform removal in the reverse order.
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Mounting the Sensor

Mounting the AI Lighting unit (for the ultra-
compact model)

For heat dissipation, attach the sensor to metal.

	�Mounting onto the mounting hole
	yMounting hole size: M3 depth 4.4 mm
	y Tightening torque: 0.5 to 0.7 N·m

	� Attaching the optional mounting bracket

	z Mounting bracket for general use (OP-88634)
Attach the bracket using the screws attached to the 
mounting bracket for general use (OP-88634).

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples

Set the concave part on the 
bracket on the connector

	z Biaxial adjustable bracket for the AI Lighting 
unit (OP-88638)

1	Attach the bracket using the screws included 
with the biaxial adjustment bracket (OP-88638).

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples Set the concave part on the 

bracket on the connector

2	Loosen the screws on the left and right side of 
the mounting bracket, and adjust the angle and 
distance.

	yTightening torque: 0.7 to 1.5 N·m

Loosen the screws and adjust 
the angle and distance

	z Adjustable bracket for the AI Lighting unit  
(OP-88639)

1	Attach the bracket using the screws attached to 
OP-88639.

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples

Set the concave part on the 
bracket on the connector

2	Attach the bracket on the brace side, adjust the 
angle, and then fix the bracket with a bolt.

	yTightening torque: 7 to 9 N·m
Mounting 
examples

Prop (f12 +0.04
-0.06 )

Adjust the angle

Fix on the brace
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Mounting the Sensor

Mounting the AI Lighting unit onto the built-
in amplifier type sensor

	y IV3‑L4C 	y IV3‑L4M
	y IV3‑L5C 	y IV3‑L5M
	y IV3‑L6C 	y IV3‑L6M

	�Mounting the AI Lighting unit 
(for the built-in amplifier type)

1	Remove the connector cover on the front of the 
sensor.

Fall prevention screw

Fall prevention 
screw

2	Hook the groove on the sensor onto the hook of 
the AI Lighting unit, and push it in until it makes 
a clicking sound.

Hook the groove on the 
sensor onto the hook of the AI 
Lighting unit

Push until you hear 
the clicking sound.

3	Fix the sensor with two fall prevention screws.
	yTightening torque: 0.15 to 0.20 N·m

Fall prevention screw

	� Removing the AI Lighting unit 
(for the built-in amplifier type)

Perform removal following the procedure below.

1	Loosen the fall prevention screws.

Fall prevention screw

2	Remove the AI Lighting unit while pressing the 
hook at the bottom of the attachment.

Hook

3	Attach the connector cover on the front of the 
sensor.

	yTightening torque: 0.15 to 0.20 N·m

Mounting the AI Lighting unit 
(for the built-in amplifier type)

For heat dissipation, attach the sensor to metal.

	�Mounting onto the mounting hole
	yMounting hole size: M3 depth 3.3 mm
	y Tightening torque: 0.5 to 0.7 N·m

In addition to the back M3 mounting hole, the 
sensor can be mounted on the back M2.5 (depth 
3.4 mm, tightening torque: 0.2 to 0.3 N·m) and the 
front M4 (depth 4.1 mm, tightening torque: 0.8 to 1.2 
N·m) hole.
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Mounting the Sensor

	� Attaching the optional mounting bracket

	z Common mounting bracket (OP-88634)

1	Attach the bracket using the screws included 
with the common mounting bracket (OP-88634).

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples

2	After fixing the common mounting bracket to the 
mounting position, mount the AI Lighting unit onto 
the sensor.
Mounting 
examples

	z Biaxial adjustable bracket (OP-88635)

1	Attach the bracket using the screws included 
with the biaxial adjustment bracket (OP-88635).

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples

2	Loosen the screws on the left and right side of 
the mounting bracket, and adjust the angle and 
distance.

	yTightening torque: 0.7 to 1.5 N·m

Loosen the screws and adjust 
the angle and distance

	z Adjustable bracket (OP-88636)

1	Attach the bracket using the screws attached to 
OP-88636.

	yTightening torque: 0.5 to 0.7 N·m
Mounting 
examples

2	Attach the bracket on the brace side, adjust the 
angle, and then fix the bracket with a bolt.

	yTightening torque: 7 to 9 N·m
Mounting 
examples

Adjust the angle

Fix on the brace

Prop (f12 +0.04
-0.06 )
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Mounting the Sensor

Using the polarizing filter

When using the polarizing filter, adjust 
brightness with the polarization filter attached.

 “Brightness Adjustment” (page 4-12)

	�Mounting the polarizing filter for the ultra-
compact model (OP-88642/OP-88643)

1	Hook the groove on the sensor head onto the 
hook of the polarizing filter, and push it in until 
you hear the clicking sound.

Hook the groove on 
the sensor head onto 
the hook

Push until you hear 
the clicking sound.

2	Secure the polarizing filter with the attached screw.
	yTightening torque: 0.3 to 0.6 N•m

	� Removing the polarizing filter for the ultra-
compact model (OP-88642/OP-88643)

1	Remove the screw and then remove the 
polarizing filter while pulling the hook forward.

Hook

	�Mounting the polarizing filter for the AI 
Lighting unit (OP-88646/OP-88647): Ultra-
compact model

1	Hook the groove on the sensor head onto the 
hook of the polarizing filter, and push it in until 
you hear the clicking sound.

Hook the groove on the 
sensor head onto the 
hook

Push until you hear 
the clicking sound.

2	Fix the polarizing filter.
	yTightening torque: 0.15 to 0.20N•m

Fall prevention 
screw

	� Removing the polarizing filter for the AI 
Lighting unit (OP-88646/OP-88647): Ultra-
compact model

1	Loosen the screw and then remove the polarizing 
filter while pulling the hook forward.

Hook

Fall 
prevention 

screw
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Mounting the Sensor

	�Mounting the polarizing filter for the built-in 
amplifier type (OP-88640/OP-88641)

1	Mount the polarizing filter by aligning the 
mounting hole on the polarizing filter with the 
mounting hole on the front of the sensor.

Align with hole position

2	Secure the polarizing filter with the attached screw.
	yTightening torque: 0.15 to 0.2 N•m

	� Removing the polarizing filter for the built-in 
amplifier type (OP-88640/OP-88641)

1	Remove the screw and then remove the polarizing 
filter.

	�Mounting the polarizing filter for the AI 
Lighting unit for the built-in amplifier type 
(OP-88644/OP-88645)

1	Hook the groove on the sensor onto the hook of 
the polarizing filter, and push it in until you hear 
the clicking sound.

Hook the groove on the 
sensor onto the hook

Push until you hear 
the clicking sound.

2	Fix the polarizing filter.
	yTightening torque: 0.15 to 0.20N•m

Fall prevention screw

	� Removing the polarizing filter for the AI 
Lighting unit for the built-in amplifier type 
(OP-88644/OP-88645)

1	Loosen the screw on the polarizing filter.

Fall prevention screw

2	Remove the polarizing filter while pulling the 
hook forward.

Hook
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Mounting the Sensor

Mounting the dome attachment

Mounting the dome attachment for ultra-
compact model (IV2-GD05/IV2-GD10)

The dome attachment for ultra-compact model 
can be used with IV3 series (ultra-compact 
model), IV2 series, IV-HG series, or IV-G series. 

	yUse the dome attachment at a proper 
installation distance. Failure to do so may 
mitigate the effect.
	yWhen using the dome attachment, adjust 
the brightness with the dome attachment 
mounted.

 “Brightness Adjustment” (page 4-12)
	y For the color type, adjust the white balance 
with the dome attachment mounted.

 “White Balance (for Color Type Only)” 
(page 7-24)

	�Mounting the dome attachment for ultra-
compact model

1	Hook the groove on the sensor head onto the 
hook of the dome attachment for the IV3 series, 
and push it in until you hear the clicking sound.

Hook the groove 
on the sensor head 
onto the hook of the 
attachment.

Push until you hear 
the clicking sound.

	yAttach the sensor head so that the light-
receiving part of the sensor head fits into 
the hole of the dome attachment for the 
IV3 series.
	y If the engagement between the sensor 
head and the dome attachment is too 
tight, please spread the hook of the dome 
attachment by hand. 

2	Fix the dome attachment for the IV3 series with 
attached mounting screws.

	yTightening torque : 0.5N·m

Mounting screw (M4×L8)
(short)

Make sure to fix the dome attachment for the 
IV3 series with the mounting screws (M4 x L8) 
to prevent it from falling down.

	y If the attached mounting screws (M4 x L10) or 
screws with no double-washer sems are used, 
the sensor head may be damaged.
	y The attached mounting screws (M4 x L10) are 
used for securing the mounting bracket.
	y If the included mounting screws are not to be 
used, use double-washer sems screws (M4 x 
L8).

	y Tighten the mounting screws on the one side 
of the sensor head. If they are to be used on 
the opposite side, tighten them on the same 
side.
	y The mounting method for the IV2-GD10 is 
described here. The IV-2GD05 can also be 
mounted in the same way.

The vertical mounting bracket for the IV3 series 
(OP-87908), transverse mounting bracket for the 
IV3 series (OP-87909), or adjustable bracket for 
the IV3 series (OP-87910) can be used with the 
dome attachment for the IV3 series mounted on 
the sensor head. 
To use the bracket, attach it on the other side of 
the sensor head on which the mounting screws 
(M4 x L8) were tightened in step 2.
To attach the bracket, use the two attached 
mounting screws (M4 x L10).
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Mounting the Sensor

	�Mounting examples of the dome attachment

Vertical mounting bracket for 
the IV3 series (OP-87909)

Mounting screw (M4 x L10)
(long)

Screws for securing 
the sensor head are 
tightened on this 
side.

To attach the adjustable bracket for the IV3 series (OP-
87910), connect the convex part to the dome attachment 
for the IV3 series.

Convex part

If a sensor head with the dome attachment for 
the IV3 series attached is to be directly mounted 
to sheet metal, pay attention to the following 
items:

	y If they are to be secured from the sheet metal 
side with screws, be sure to use M4 screws 
(whose length of screw engagement should 
be 2.5 to 3.5 mm), and the tightening torque 
should be 0.7 to 1.5 N·m. 
	y If the screws are to be secured from the 
sensor head side, be sure to use the M3 
screws “double-washer sems screws” or else 
“screws with spring washer and flat washer”  
should be used, and the tightening torque 
should be 0.5 N·m. If screws larger than M4 
are used, the sensor head will be damaged. 

If the dome attachment for the IV3 series is used 
with the IV3-G300CA/IV3-G600MA, the field of 
view will be as shown below. 

	� Unmounting the dome attachment

1	Dismount the screw.

Mounting screw 
(M4×L8)

2	Dismount by lifting the front part of the sensor 
head, while pulling out the hook of the dome 
attachment for the IV3 series.

Hook
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Mounting the Sensor

Mounting the dome attachment for built-in 
amplifier type (IV3-D10)

	yUse the dome attachment at a proper 
installation distance. Failure to do so may 
mitigate the effect.
	yWhen using the dome attachment, adjust 
the brightness with the dome attachment 
mounted.

 “Brightness Adjustment” (page 4-12)
	y For the color type, adjust the white balance 
with the dome attachment mounted.

 “White Balance (for Color Type Only)” 
(page 7-24)

	�Mounting the dome attachment for built-in 
amplifier type

1	Align the mounting screw holes on the sensor 
with the mounting screw holes on the dome 
attachment, push the sensor all the way into the 
attachment.

Mounting screw 
holes

If the fit is tight, push the sensor in while 
spreading the hook.

2	Fix the dome attachment with attached mounting 
screws.

	yTightening torque : 0.15 to 0.20 N·m

Mounting screw (M2.5×L8)
Double-washer sems screw

Make sure to fix the dome attachment with the 
mounting screws (M2.5 x L8) to prevent it from 
falling down.

	y If screws with no double-washer sems are 
used, the sensor head may be damaged.
	y If the included mounting screws are not to be 
used, use double-washer sems screws (M2.5 x 
L8).

	� Removing the dome attachment

1	Remove the mounting screws and lift the sensor 
to remove it while pushing out the hooks of the 
dome attachment.

Hook
2
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Cables

Wiring the ultra-compact model

Connecting the sensor head/amplifier cable 
and sensor head

1	Connect the cable to the sensor head as shown 
below.

Adjust the pins and the pin 
connection

2	Tighten the connector by turning the screw-on 
connector in the clockwise direction.

	yTightening torque: 0.6 to 0.8 N·m

To tighten the screw by hand, turn it until the 
connector of the cable touches the sensor head 
firmly. Then turn it more about by 5° using a 
tool such as pliers.

Connecting the sensor head/amplifier cable 
and sensor amplifier

Align the connectors and insert the cable until a clicking 
sound is made.

Align the 
connectors.

To disconnect the cable, push in the tabs on both sides of 
the connector and pull out the connector.

Connecting the cable to the sensor amplifier

	� Connecting the Ethernet cable or LAN cable
Connect the cable to the sensor amplifier as shown 
below.

To disconnect the cable, pull the cable while pushing in 
the tab on the Ethernet cable.

	�Wiring the I/O terminal block
Insert the wire to B by pushing A in with a screwdriver.
Pull the wire out slightly to confirm that it is secured.

B

A

Use a wire with 60°C or higher temperature 
rating as the electrical wire.

Follow the instructions mentioned below to 
avoid damage caused by bad connections.

	y The nominal cross-sectional area of the wire 
for connecting the push type terminal block 
should be 0.2 mm2 to 1.5 mm2 (AWG16 to 26).
	y The stripped part of the wire should not be 
soldered (pre-soldered).
	y Length of the insulation removed from the 
wire should be around 10 mm.
	y Insert the wires to the power terminal block 
completely.
	yWire the power cables directly or using bar 
terminals into the terminal block.

Cables
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Cables

	z Connector pin configuration figure

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18

Terminal  
No.

Name
Assigning 

default 
value

Description

1 IN1 Ext. Trigger ↑
Set external trigger.
Rising timing (↑) or falling 
timing (↓) can be set.

2 IN2 OFF

Input assignable function
	y Program bit0 to bit6
	yClear Error
	y Ext. Master Save
	y Stop saving the SD card
	yOFF (not used)

3 IN3 OFF
4 IN4 OFF

5 IN5 OFF

6 IN6 OFF

7 IN7 OFF

8 IN8 OFF

9 Unused Unused Unused

10 OUT1 Total Status 
OK (N.O.)

Output assignable function
	y Total Status OK
	y Total Status NG
	yRUN
	y BUSY
	y Error
	y SD card error
	y Position adjustment
	y Status result of each tool  
(Tool 1 to 64)
	y Logical operation result of 
each tool (Logic 1 to 4)
	y Part discrimination result  
(Part0 to Part7)
	yMaster status result 
(Master 00 to Master 07)
	yOFF (not used)

11 OUT2 BUSY 
(N.O.)

12 OUT3 Error 
(N.C.)

13 OUT4 OFF
14 OUT5 OFF
15 OUT6 OFF
16 OUT7 OFF

17 OUT8 OFF

18 OUT 
COM

OUT 
COM Output Common

Compatible cable specification: AWG16 to 26

The output assignment, N.O./N.C., and input line 
assignment can be changed.

For input cables of this sensor, connect with 
non-contact output (transistor output/SSR 
output). For contact output (relay output), 
incorrect input may occur due to contact 
bouncing.

	� Supplying Power to the Sensor Amplifier
The power terminal block is mounted on the front of the 
sensor amplifier.

Use wire whose temperature rating is 60ºC or 
higher for the power supply.

Follow the instructions shown below to avoid 
damage caused
by bad connections.

	y The nominal cross-sectional area of the wire 
for connecting the power should be 0.8 mm2 to 
1.3 mm2 (AWG16 to 18).
	y Length of the insulation removed from the 
wire should be around 9 mm.
	y The stripped part of the wire should not be 
soldered (pre-soldered).
	y Insert the wires to the power terminal block 
completely.
	yWire the power cables directly or using bar 
terminals into the terminal block.

1	Insert the wire to B by pushing A in with a 
screwdriver.
Pull the wire out slightly to confirm that it is secured.

B

A

0V

24V 24V Wire to 24 V DC of the power 
supply.

0V Wire to 0 V of the power supply.
Ground.
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Cables

	� Connection diagram

	z Selecting NPN output
When NPN is selected as the Polarity

OUT

OUT COM

24 V power supply (24 V 
DC)

IN

0 V of power

FG

24 V DC

(NPN)

Load

Sensor External device

OUT COM is a common terminal for OUT. Be 
sure to connect it to 0V of the power supply.

Electrical specifications
Input circuit:	 non-voltage input

	yON voltage:	 2 V or lower
	yOFF current:	 0.1 mA or lower
	yON current:	 2 mA (short circuit)

Output circuit
	yMaximum rating:	 26.4 V, 50 mA
	yRemaining voltage:	 1.5 V or lower

Make sure to keep a total of each output 
with 160 mA or less.

0 V (power supply) and FG are insulated.

	z Selecting PNP output
When PNP is selected as the Polarity

OUT COM

24 V power supply (24 V 
DC)

IN

0 V of power

FG

OUT

(PNP)

24 V DC

Load

Sensor External device

OUT COM is a common terminal for OUT. Be 
sure to connect it to 24V of the power supply.

Electrical specifications
Input circuit:	 voltage input

	yMaximum input rating:	26.4 V
	yON voltage:	 18 V or higher
	yOFF current\:	 0.15 mA or lower
	yON current:	 2 mA (at 24 V)

Output circuit
	yMaximum rating:	 26.4 V, 50 mA
	yRemaining voltage:	 1.5 V or lower

Make sure to keep a total of each output 
with 160 mA or less.

	y 0 V (power supply) and FG are insulated.
	yUse OUTCOM and 0 V of power with a 
potential difference of 26.4 V or low.
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Cables

Wiring the built-in amplifier type

M12-M12 Ethernet cable
	yOP-88651 (2m)
	yOP-88652 (5m)
	yOP-88653 (10m)

Ethernet cable*1

	yOP-88664 (2m)
	yOP-88665 (5m)
	yOP-88666 (10m)

Power I/O cable
	yOP-88654 (2m)
	yOP-88655 (5m)
	yOP-88656 (10m)

*1  Supports PoE (Power over Ethernet)
 “When supplying power with the PoE (Power 

over Ethernet)” (page 2-20)

Changing the direction of the cable

1	Rotate the rotating connector to determine the 
direction the cable is to be pulled out.

Connecting the cable
When supplying the power with PoE, do not 
connect the power I/O cable.

	�When supplying power with the Power I/O 
cable

1	Align the pins of the connector for the power I/O 
cable with the protrusion connection of the cable 
connector, and connect the cable to the sensor. 
And then, tighten the connector by turning 
the screw on the connector in the clockwise 
direction.

	yTightening torque: 0.6 to 0.8 N·m

Adjust the pins and 
the pin connection

When connecting the connector, insert it 
without tipping and tighten it well.
If the tightening is weak, vibration can loosen 
the connector and cause bad connections.
Also, the enclosure rating may not be 
maintained with loose connection.
*	� After tightening the connector screw by 

hand, retighten it approximately 90° to 120° 
with pliers or similar tool.

Connect the Ethernet cable in the same way as needed.

2	Wire each cable according to its intended 
purpose.

	z Wiring color

Wiring 
color

Pin 
No.

Name
Assigning 

default 
value

Description

Brown 1 DC24 - + side of power
Blue 2 0V - - side of power

Pink 6 IN1 Ext. 
Trigger ↑

Set external trigger.
Rising timing (↑) or falling 
timing (↓) can be set.

Yellow 4 IN2 OFF
Input assignable function

	y Program bit0 to bit6
	yClear Error
	y Ext. Master Save
	y Stop saving the SD 
card
	yOFF (not used)

Output assignable 
function

	y Total Status OK
	y Total Status NG
	yRUN
	y BUSY
	y Error
	y SD card error
	y Position adjustment
	y Status result of each tool  
(Tool 1 to 64)
	y Logical operation result 
of each tool (Logic 1 to 4)
	y Part discrimination 
result  
(Part0 to Part7)
	yMaster status result 
(Master 00 to Master 07)
	yOFF (not used)

Light 
blue 5 IN3 OFF

Black 9 OUT1 Total 
Status OK

White 10 OUT2 BUSY

Gray 11 OUT3 Error

Purple 3 I/O1* OFF

Green 7 I/O2* OFF

Red 8 I/O3* OFF

Orange 12 OUTCOM - Output Common
* �The I/O1 to I/O3 can be used by individually selecting IN/

OUT.
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Cables

	z Cable specification
	yBrown / Blue : AWG22
	yBlack / White / Gray / Orange : AWG25
	yPeach / Yellow / Light blue / Purple / Green / Red: 
AWG28 
(without shield)

	z Connector pin layout 

1

2
4

3

5

6
7 8

9
10

11
12

The output assignment, N.O./N.C., and input/
output cable assignment can be changed.

Use it by assigning the optional function to IN1 to IN3, 
OUT1 to OUT3, and I/O1 to I/O3.
For the input-output switching method of I/O1 to I/
O3, refer to  “I/O Mapping (Built-In Amplifier Type)” 
(page 7-18).

	y Individually insulate the unused input-
output cables.
	y For input cables of this sensor, connect 
with non-contact output (transistor output/
SSR output). For contact output (relay 
output), incorrect input may occur due to 
contact bouncing.

	� Connection diagram

	z Selecting NPN output
When NPN is selected as the Polarity

OUT

OUT COM

24 V power supply (24 V 
DC)

IN

0 V of power

24 V DC

(NPN)

Load

Sensor External device

OUT COM is a common terminal for OUT. Be 
sure to connect it to 0V of the power supply.

Electrical specifications
Input circuit:	 non-voltage input

	yON voltage:	 2 V or lower
	yOFF current:	 0.1 mA or lower
	yON current:	 2 mA (short circuit)

Output circuit
	yMaximum rating:	 30 V, 50 mA
	yRemaining voltage:	 1.5 V or lower

Make sure to keep a total of each output 
with 120 mA or less.

0 V (power supply) and FG are insulated.

	z Selecting PNP output
When PNP is selected as the Polarity

OUT COM

24 V power supply (24 V 
DC)

IN

0 V of power

OUT

(PNP)

24 V DC

Load

Sensor External device

OUT COM is a common terminal for OUT. Be 
sure to connect it to 24V of the power supply.

Electrical specifications
Input circuit:	 voltage input

	yMaximum input rating:	30 V
	yON voltage:	 18 V or higher
	yOFF current:	 0.15 mA or lower
	yON current:	 2 mA (at 24 V)

Output circuit
	yMaximum rating:	 30 V, 50 mA
	yRemaining voltage:	 1.5 V or lower

Make sure to keep a total of each output 
with 120 mA or less.

	yUse OUTCOM and 0 V of power with a 
potential difference of 30 V or low.
	y For the wiring color when using the power I/O 
cable,  
refer to   “Wiring color” (page 2-18) .
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Cables

	� Connect the conversion connector

OP-88631
OP-88632

OP-88633

Align the recessed part of the conversion connector with 
the protruding part of the connector on the sensor side, 
and connect the conversion connector to the sensor. Then, 
tighten the connector by turning the screw on the connector 
in the clockwise direction.

	yTightening torque : 0.6 to 0.8 N·m
When connecting the connector, insert it 
without tipping and tighten it well.
If the tightening is weak, vibration can loosen 
the connector and cause bad connections.
Also, the enclosure rating may not be 
maintained with loose connection.
*	� After tightening the connector screw by hand, 

retighten it approximately 90° to 120° with 
pliers or similar tool.

	z Connection diagram when using the 
conversion connector for power I/O cable

Connector 
pin layout 

Pin No.

1 2 3 4 5
OP-88631

2

4

13 DC24V IN1 0V OUT1 -

OP-88632

1

2
3

4

5 DC24V unused 0V unused unused

	yUse a cable with a conductor resistance that 
complies with the length of the cable.

	y 10 m or less: 50 Ω/km or less
	y 20 m or less: 25 Ω/km or less
	y 30 m or less: 16 Ω/km or less

	yWhen using the conversion connector for 
power I/O cable (OP-88631), change the cable 
specification to 4pin by using the IV3-CP50 or 
IV3-Navigator.  
For details on how to change the setting, refer 
to  “Polarity” (page 7-17) .

	�When supplying power with the PoE (Power 
over Ethernet)

PoE compatible Ethernet switch

	z Specifications of the PoE power supply device

Applicable standard IEEE802.3af/at/bt
When not using the 

AI Lighting unit
Power class 4 or higher 
(class 6 or higher recommended) 

When using  
the AI Lighting unit

Power class 3 or higher 
(class 4 or higher recommended) 

	y Power should be supplied from either the 
power I/O cable (24V DC) or PoE.
	yWhen using the PoE, do not connect the 
power I/O cable. It may be damaged.
	yWhen using the PoE, operation may be 
restricted due to power limitation.
	yUse OP-88664/OP-88665/OP-88666 or CAT 5e 
or higher for the Ethernet cable.
	yWhen connecting or disconnecting the Ethernet 
cable, turn off the power of the PoE power 
supply device connected to the IV3 Series.

1	Align the pins of the connector for the Ethernet 
cable with the protrusion connection of the cable 
connector, and connect the cable to the sensor. 
And then, tighten the connector by turning 
the screw on the connector in the clockwise 
direction.

	yTightening torque: 0.6 to 0.8 N·m

Adjust the pins and 
the pin connection

When connecting the connector, insert it 
without tipping and tighten it well.
If the tightening is weak, vibration can loosen 
the connector and cause bad connections.
Also, the enclosure rating may not be 
maintained with loose connection.
*	� After tightening the connector screw by 

hand, retighten it approximately 90° to 120° 
with pliers or similar tool.

*	� For the connector for the power I/O cable, 
attach the waterproof cap for the attached 
connector to maintain the enclosure rating.
Tightening torque: 0.45 to 0.55 N·m
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Cables

Connecting the sensor and PC
Connect the PC with the sensor amplifiers using an Ethernet switch.

Ethernet switch
(Example) NE-Q05

Sensor head 
/amplifier cable
OP-88648 (2 m)
OP-88649 (5 m)
OP-88650 (10 m)

Ultra-compact model
Sensor head
IV3-G500CA
IV3-G500MA
IV3-G600CA
IV3-G600MA

Built-in amplifier type
Sensor
IV3-400CA
IV3-400MA
IV3-500CA
IV3-500MA
IV3-600CA
IV3-600MA

Ultra-compact model  
sensor amplifier

IV3-G120

LAN cable
OP-87950 (1m)
OP-87951 (3m)
OP-87952 (5m)
OP-87953 (10m)

Ethernet cable
OP-88664 (2m)
OP-88665 (5m)
OP-88666 (10m)

LAN cable
OP-87950 (1m)
OP-87951 (3m)
OP-87952 (5m)
OP-87953 (10m)

PLC  
(Communication network)
FTP/SFTP server

For the method to supply power to the sensor, refer to  “Cables” (page 2-15).

The IV2 Series and IV Series can be connected on a network.
	y For details on connecting with the sensor of the IV2 Series, refer to “IV2 Series User’s Manual (PC Software)”.
	y For details on connecting with the sensor of the IV-HG/IV-H Series, refer to “IV-HG/IV-H Series User’s Manual (PC 
Software)”.
	y For details on connecting with the sensor of the IV-G/IV Series, refer to “IV-G/IV Series User’s Manual (PC 
Software)”.
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Setting up the PC

This section explains how to install/uninstall the PC 
Software for the IV3 Series IV3-Navigator (IV3-H1) and 
how to set up the PC.

Required environment for the PC to be 
connected

To connect the sensor and PC, the environment which 
satisfies the following conditions is required.
Confirm that the PC to be used satisfies the following 
conditions.

	z OS
One of the following OS’s must be pre-installed.
(Supported for 32bit/64bit version)

	yWindows 11..........................Home/Pro/Enterprise
	yWindows 10.........................Home/Pro/Enterprise
	yWindows 7 (SP1 or higher)....�Home Premium/

Professional/Ultimate

	z Hardware

	� Interface
Must be equipped with Ethernet (1000BASE-T).

	�Processor
Needs to be compliant with system requirements for 
OS.

	�Memory capacity
4 GB or more

	�Monitor
	yResolution: 1024 × 768 pixel or higher
	yDisplay color: High Color (16bit) or higher

	�HDD free space required for installation
4 GB or more

	z Operating conditions
	y .NET Framework 4.5.2 or above needs to be installed.
	yMicrosoft Visual C++ 2017 Distribution Package 
Update or above needs to be installed.

*	� If not installed, it will be installed automatically when 
IV3-H1 is installed.

Installing IV3-Navigator (IV3-H1)
This section describes the procedure for installing the PC 
Software for the IV3 Series IV3-Navigator (IV3-H1) on the 
PC.

	y This section describes the installation using 
Windows 10 as an example.
	y Exit or finish all other running software before 
the installation.
	y Log on with a user who has administrative 
privileges.
	y If the user account control screen appears 
during the installation, press [Yes].
	y If the current user is a user account that does 
not have administrative privileges, input a 
user account with administrative privileges 
and the password.

1	Turn ON the power of the PC and start Windows.

2	Insert the “IV3-H1” disc into the media drive.
The installation program activates using the auto run 
function of the PC, and the install program selection 
screen opens. If the selection window does not display, 
open the media drive from My Computer and double-
click “IV3 Launcher.exe”.

3	Press [IV3-Navigator].

The InstallShield wizard screen opens.

4	Follow the instructions in the window.

5	After completion window for InstallShield Wizard 
is displayed, press [Finish].

	yAfter installation is finished, close the selection 
screen.
	y Install IV2-Navigator and IV-Navigator if you are using 
a combination of IV3, IV2, and IV Series devices. On 
the selection screen, press [IV2-Navigator] or [IV-
Navigator]. Follow the instructions in the window.

6	Remove the installation DVD.

Setting up the PC
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Setting up the PC

Installation destination of the software 
(reference)

Installation destination of the application software (default 
settings) are as follows.
Windows 10/7  32 bit version:

C:¥Program Files¥KEYENCE¥IV3-Navigator
Windows 11/10/7  64 bit version:

C:¥Program Files (x86)¥KEYENCE¥IV3-Navigator
Application

IV3-Navigator.exe: IV3-Navigator
Data saving destination

Document for the logon user \IV3-Navigator

Deleting the software (uninstall)
This section describes the procedure for uninstalling the PC 
Software for the IV3 Series IV3-Navigator (IV3-H1).

	y This section describes the installation using 
Windows 10 as an example.
	y If the user account control screen appears 
during the installation in the Windows 10 
environment, press [Yes].
	y Log on with a user who has administrative 
privileges.

1	Turn ON the power of the PC and start Windows.

2	Press [Settings] from the start menu.

3	Press [Apps].

4	Select [IV3-Navigator] and press [Uninstall].

5	After the confirmation dialog is displayed, press 
[Uninstall].
When the IV3-Navigator is removed from the Programs 
and Features screen, uninstallation is completed.
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Setting up the PC

Changing the PC Settings 
(IP Address Setting)

	y Log on with a user who has administrative 
privileges.
	yAuto acquisition of IP address (DHCP server) 
cannot be used due to the inability to connect 
with the sensor.

For Windows 10

1	Press [Settings] from the start menu.

2	Press [Network and Internet].

3	Press [Change the Adapter Option].

4	Right-click the [Ethernet] icon and select 
[Properties] from the displayed menu.

5	Select [Internet Protocol Version 4 (TCP/IPv4)] 
and press [Properties].

6	Select [Use the following IP address] and input 
the IP address and Subnet mask.

	y IP address:	 192.168.10.1
	ySubnet mask:	 255.255.255.0

Set a user-defined IP address (The above is an 
example). To connect with the existing network, 
input the IP address that was assigned by the 
network administrator.

7	After setting is completed, press [OK] and close 
all the windows.

For Windows 7

1	Open the Control Panel.

2	Press ([Network and Internet]) - [Network and 
Sharing Center].

3	Press [Change adapter settings] on the upper left 
on the screen.

4	Right-click the [Local Area Connection] icon and 
select [Properties] from the displayed menu.

5	Select [Internet Protocol Version 4 (TCP/IPv4)] 
and press [Properties].

6	Select [Use the following IP address] and input 
the IP address and Subnet mask.

	y IP address:	 192.168.10.1
	ySubnet mask:	 255.255.255.0

Set a user-defined IP address (The above is an 
example). To connect with the existing network, 
input the IP address that was assigned by the 
network administrator.

7	After setting is completed, press [OK] and close 
all the windows.
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3 

Basic Operation

This chapter explains the overview of the IV3-Navigator screen 
and operation, basic operation flow, and the operation when 
turning on the power for the first time.
This chapter also explains how to switch the connected sensor 
and the procedure to return the sensor to the factory default.

Overview of screen and operation......................................3-2
Basic operation flow............................................................3-4
Operation when the Power is Turned on............................3-5
Switching and Terminating the Sensor to be 
Connected...........................................................................3-10
Setting to the factory default.............................................3-12
Basic operation for tools...................................................3-13

Chapter 
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Overview of screen and operation

Overview of screen and operation

This section explains the screen displayed on the PC and operation overview.
For details of what can be set on each screen and its operations, refer to the applicable section.

Main screen in [Run]
Images and judges based on the judgment conditions.

 �“Overview of the Screen in [Run] / [Program]” (page 5-3)

Main screen in [Program]
Configures the program settings, sensor settings, and 
reference of the image history.

 �“Overview of the Screen in [Run] / [Program]” (page 5-3)

Program Details
Checks or initializes the program.

	 “Operations that can be performed with the program 
functions” (page 7-2)

Activation Menu screen
Selects the connection with the sensor or the Simulator. 
You can also change the display language.

	 “Operation when the Power is Turned on” (page 3-5)

A

B

E
D

C A AC

A

Multiple Sensors Monitoring
Displays the running status of multiple sensors that are 
connectable.

 �“Multiple Sensors Monitoring” (page 3-16)
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Overview of screen and operation

Settings Navigator (Sensor Setup)
Sets the program settings to be used for judgment.

	� “Chapter 4 Settings Navigator” (page 4-1)
Additional Learning (Learning Tool Only)
Perform additional learning of images.

 �“Auto Adjustment by the Additional Learning 
(Learning Tool Only)” (page 6-2)

Limit Adjustment
Adjusts the judgment threshold.

	 �“Adjusting Thresholds for Judgment” (page 6-15)

Image History
Opens the running image and 
learned image history (learning tool 
only) of the sensor.

	 �“Confirming the Images Whose 
Judgment are NG (Running 
Image History)” (page 5-17)

I/O Settings
Sets the input/output-related settings for 
the sensor.

	 “Setting the Input and Output 
Information of the Sensor” (page 7-13)

Sensor Advanced
Configures the advanced settings for the sensor.

	� “Setting the Advanced Information of the 
Sensor” (page 7-19)

B

Simulator
The settings of a program saved in a batch backup file (*.iv3a) 
or an individual program backup (*.iv3a) can be confirmed or 
changed and the image history can be confirmed.

 �“Chapter 10 Simulator” (page 10-1)

D

E
C

Change Connected Sensor
Switches the connected sensor. Or, terminates the sensor 
connection.

 �“Switching the Sensor to be Connected” (page 3-10)
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Basic operation flow

Installing, connecting, and wiring the sensor
Mount the sensor, and then connect and wire the cable.
Also, install the IV3-Navigator.

 “Chapter 2 Installation and Connection” (page 2-1)

Turning on the power
Turn on the power of the sensor, and then perform the initial start-up operation.

 “Operation when the Power is Turned on” (page 3-5)

Settings Navigator
Create the program to be used for operation in [Settings Navigator] (Sensor Setup).

STEP 1: Setting of image optimization
Set the image optimization settings for clearly imaging a target. Adjust the image for defining differences 
in an “OK” and “NG” image or Part image.
Set the trigger options, adjust the brightness and camera focal distance.

 “1. Image Optimization (Clearly Image a Target)” (page 4-8)

STEP 2: Registration of a master image
Capture an image and register the master image to serve as the reference of judgment.

 “2. Master Image Registration (Registering an Image as a Reference)” (page 4-20)

STEP 3: Tool settings/Part Registration settings
Sets the conditions to judge a target.

	yTool Settings
Set the tools onto the master image and set the threshold for judgment.
Up to 65 detection tools and position adjustment tools in one program can be set.
 “3. Tool Settings (Setting the Judgment Method of the Target of Standard Mode)” (page 4-28)

	yPart Registration Settings
Set the tool on the master image and register a part type to be judged.
The target part type will be judged based on the results judged by the detection tool.
Up to 8 detection tools and 1 position adjustment tool in one program can be set.

 “3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)” (page 4-121)

STEP 4: Output assignment
Assign the function to output to each output line.
 “4. Output Assignment (Setting Details of Outputting to Output Line)” (page 4-147)

Starting the operation/adjustment
Switch the settings screen to the run screen, and start the operation.

 “Chapter 5 Running” (page 5-1)
If the settings are not appropriate, perform the additional learning or limit adjustment.

 “Chapter 6 Adjusting” (page 6-1)

Basic operation flow
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Operation when the Power is Turned on

Operation flow when the power is turned 
on

Connection with the sensor

Turn on the power of the sensor

IV3-Navigator startup

(1)

Initial start-up  
of the sensor

Sensor Setup

(2)

(3)

RUN

(4)

Connection failed
(Error message)

(5)

(1) ‌�In order to communicate with the sensor, set a static IP 
Address on the PC. 

	� “Operation for Initial Startup of the IV3-Navigator” 
(page 3-6)

(2) ‌�When the sensor is turned on for the first time, perform 
the Initial Sensor Setup.

 “Operation for Initial Startup of the Sensor” (page 
3-8)

(3) ‌�The [Sensor Setup Menu] screen opens. Create 
a program with the Settings Navigator. After being 
created, operation begins.

 “Chapter 4 Settings Navigator” (page 4-1)
(4) ‌�If the software and the sensor setup have already been 

performed, move to operation automatically by turning 
on the power.

 “Chapter 5 Running” (page 5-1)
(5) ‌�When the connection process fails, the software will 

remain in the connecting screen.
 “Remedy when the Software cannot be Connected 

with the Sensor” (page A-15)

The sensor can be independently operated.

Operation when the Power is Turned on
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Operation when the Power is Turned on

Operation for Initial Startup of the IV3-
Navigator

Only engineers who are knowledgeable about 
networks should attempt connection when 
connecting the IV3 Series to a network.

Starting the IV3-Navigator

1	Turn on the power of the sensor.

Turn on the power of the sensor before 
[Connect] is pressed in step 3.

2	Double-click the [IV3-Navigator] icon on the 
desktop.

The Activation Menu screen opens.

3	Press [Connect].

If [Language] is pressed, the Select language 
screen opens. The display language can be 
changed to the desired language.

The Network Connection screen opens.

There are two ways to set the sensor to be connected.

	z When searching for a sensor on a network
	� “Searching for a Sensor to be Connected” (page 
3-6)

	z When specifying the sensor by IP address
	� “Specifying Sensor to be Connected by IP Address” 
(page 3-7)

Searching for a Sensor to be Connected
Automatically searches for a sensor on the network and 
connects with it.

	y The approximate time to search is 15 seconds or 
less if the “Search all network adapters” setting is 
“No”, and 105 seconds or less if it is “Yes”.
	yUp to 64 sensors can be searched.

1	Turn on the power of the sensor.

2	Press [Search Sensor].

If multiple network adapters are installed on the 
PC, perform the following:

	y Select a network adapter from the drop-down 
menu.
	y Press the search settings button ( ) to open 
the [Search Settings] dialog box, and set the 
search conditions for the network adapter and 
sensor.

Searching the sensor begins.

When the searching is finished, the searched result will 
be displayed.

If no sensor is found, refer to  “When 
the connection cannot be established by 
specifying the sensor” (page A-16).
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Operation when the Power is Turned on

3	Select the sensor to be connected.

	z When connecting to the sensor without an IP 
address
Press [Connect].

The following screen opens.
Press [OK].

The confirmation screen opens.

Press [Yes] to automatically configure the sensor 
network settings to connect to the PC. 
The Network Settings screen opens.
Input the IP Address, Subnet Mask, Default Gateway, 
and PORT, and then press [Connect].

	z When connecting to the sensor with set IP 
address
Press [Connect].

	yWhen the PC is connected with the sensor for the first 
time, perform the “Initial Sensor Setup” and set the 
polarity of the sensor and date/time.

 “Operation for Initial Startup of the Sensor” (page 3-8)
	yAfter the second time connecting with the sensor, the 
main screen in [Run] or [Program] opens.

Specifying Sensor to be Connected by IP 
Address

Used when the IP address of the sensor to be connected is 
defined beforehand.

1	Input the IP address of the sensor to be 
connected.

If multiple network adapters are installed on the 
PC, perform the following:

	y Select a network adapter from the drop-down 
menu.
	y Press the search settings button ( ) to open 
the [Search Settings] dialog box, and set the 
search conditions for the network adapter and 
sensor.

2	Press [Connect].

	yWhen the PC is connected with the sensor for the first 
time, perform the “Initial Sensor Setup” and set the 
polarity of the sensor and date/time.

 “Operation for Initial Startup of the Sensor” (page 3-8)
	yAfter the second time connecting with the sensor, the 
main screen in [Run] or [Program] opens.

When the connection with the sensor is 
unavailable, refer to  “When the connection 
cannot be established by specifying the sensor” 
(page A-16).
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Operation when the Power is Turned on

Operation for Initial Startup of the Sensor
When the sensor in the default setting is to be connected, 
perform the [Initial Sensor Setup] and select the polarity of 
the sensor (NPN or PNP) and date settings.
After the polarity is selected, set up the sensor in Settings 
Navigator.
For details on polarity, refer to  “Cables” (page 2-15).

1	Press [Initialize Sensor].

Initialization begins. After initialization is completed, the 
initialization completion screen opens.

2	Press [OK].

3	Select the polarity of the sensor, and press [OK].

Set the I/O port only when using Built-in amplifier type 
sensor.

	y IN
The corresponding I/O port can be used as an input 
(IN) port.
	yOUT
The corresponding I/O port can be used as an output 
(OUT) port.

4	Set the current date and time, and press [OK].

When pressing [Copy PC Date/Time], the PC 
date and time can be copied.

The main screen in [Program] opens.

5	Press [Sensor Setup], and set up the program.

For details, refer to  “Chapter 4 Settings Navigator” 
(page 4-1).
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Operation when the Power is Turned on

Operation when changing the sensor 
head (ultra-compact model only)
If the sensor head connected to a sensor amplifier is 
changed, initialization of the sensor amplifier is required.
Initialize the sensor amplifier following the instructions on 
the displayed screen.

The setting information of the sensor is saved 
in the sensor amplifier. Before initializing the 
sensor amplifier, it is recommended to perform 
[Batch Backup].
For details, refer to  “Backing up in a Batch” 
(page 8-3).

1	Press [Initialize Sensor].

The process to initialize the sensor begins. After 
initialization is completed, the initialization completion 
screen opens.

2	Press [OK].

The main screen in [Program] opens.

3	Press [Sensor Setup], and set up the program.

For details, refer to  “Chapter 4 Settings Navigator” 
(page 4-1).
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Switching and Terminating the Sensor to be Connected

Switching the Sensor to be Connected
When multiple sensors are connected to a PC, the sensor 
displayed can be changed.

IV3-Navigator
IV3-H1 Ethernet switch

1	Connect the PC with the sensor.
	� “Operation for Initial Startup of the IV3-Navigator” 
(page 3-6)

2	Press [Change Connected Sensor].

The process to search for the sensor begins. 

The list of sensors connected to the PC will be 
displayed.

3	Select the sensor to be displayed on the software 
and press [Connect].

The screen for the selected sensor opens.

	y If the settings for the selected sensor have 
not been made, the [Sensor Setup Menu] 
screen will be displayed. For details, refer 
to  “Chapter 4 Settings Navigator” (page 
4-1).
	yThe sensor to be connected can be 
switched in the main screen of [Program].

Switching and Terminating the Sensor to be 
Connected
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Switching and Terminating the Sensor to be Connected

Terminating connection with the sensor

1	Press [Disconnect].

The confirmation screen opens.

2	Press [Yes].

The Activation Menu screen opens.

Monitoring Connection
Monitors the running status of each sensor that is 
connected and connectable. Up to 16 units can be 
connected simultaneously.

 “Multiple Sensors Monitoring” (page 3-16)

Connection with a Sensor Currently 
Connected to Another Device

If the selected sensor is already connected with another 
control panel or a PC, pressing [Connection Start] will 
open a screen to confirm whether to disconnect the 
existing connection. Pressing [Yes] will disconnect the 
existing connection and connect the sensor with the PC in 
operation.

Cannot be connected to the following types of 
sensors:

	y A sensor that is not in operation
	y A sensor with version R1.00

When this action is performed, an error screen will open on 
the control panel or PC that has been disconnected, and 
pressing [OK] will restart the control panel or IV3-Navigator.
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Setting to the factory default

Setting to the factory default

Initializing the Sensor
Initializes the information set in the sensor and sets it to the 
factory default.

	y The following settings will not be initialized.
	y Polarity (Switching NPN/PNP) (Page 7-17)
	yCable specification (switching between 12 pin/4 
pin) (Page 7-17) (built-in amplifier models only)
	y SD card settings backup (switching between 
enabled/disabled) (Page 8-20)
	y Network Settings (IP Address / Subnet Mask / 
Default Gateway / Port number (TCP)) (Page 7-21)

	y To initialize the registered programs individually, 
refer to  “Initializing a Program” (page 7-10).

If the SD card settings backup (Page 8-20) 
setting is [Enable], the backup files on the SD 
card will also be initialized. To use an SD card 
that has not yet been initialized to restore 
different sensor settings, remove the SD card 
before initialization.

1	Switch the IV3-Navigator to the main screen in 
[Program] and press [Advanced Settings].

The [Sensor Advanced] screen opens.

2	Select the [Initialize/Update] tab and press 
[Initialize Sensor].

The confirmation screen opens.

3	Press [OK].

The confirmation screen opens.

4	Press [OK].

Initialization begins. After initialization is completed, the 
initialization completion screen opens.

5	Press [OK].

The system returns to the sensor advanced screen.
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Basic operation for tools

Operation of the Image Tool Bar
This section explains the operation method for the image 
tool bar displayed at the upper part of the image display 
screen for the IV3-Navigator by using the example of the 
main screen in [Run].

(1) (2) (1) (3) (4) (5) (6) (7)

Image display 
screen

(1)	 [Zoom In] / [Zoom Out] button
The displayed image is reduced/enlarged for each time 
the button is pressed.
Displayable zooming rates are as follows.
25%/50%/60%/75%/100%/150%/250%

If an entire image cannot be displayed, the 
amount of the image currently displayed will be 
displayed at the lower left of the screen.

Entire image

Enlarged area currently 
displayed

(2)	 Display Magnification
Displays the display magnification of the displayed 
image on the image display screen.

(3)	 [Fit Window] button
Makes the display size of the displayed image fit to the 
window size.

(4)	 Button to switch the display method for tools
Switches the display method for the tools.

 “Selecting the Display Method of the Tool Window” 
(page 5-7)

(5)	 [Manual Trigger] / [Trigger ON] button
Displayed if [External] is selected for [Trigger Options] 
or [Internal Trigger Control with IN1 Input] is set to [Yes].
This button is used when the external trigger cannot be 
input.
This button is not displayed on the simulator screen.

	y [Manual Trigger] button 
Displayed while in [Run] mode. Outputs the trigger 
once for each press of the button.

	y [Trigger ON] button 
Displayed while in [Program] mode. Switches the 
continuous trigger to ON/OFF for each press of the 
button.

(6)	 [Image File Location] button
	yBy pressing the button and selecting [Show Saved 
Image File Location], the folder where the image is 
saved when pressing [Save] opens.
	yBy pressing the button and selecting [Change Saved 
Image File Location], the save destination of an image 
can be changed.

(7)	 [Save] button
Individually saves the image displayed on the IV3-
Navigator into the PC. The iv3p format file that can 
be used for a master image registration, additional 
learning, and operation simulation will also be saved at 
the same time.
A screen capture of the IV3-Navigator screen will also 
be saved at the same time.

 “Saving Images and Screens Displayed on the IV3-
Navigator Individually” (page 8-5)

Basic operation for tools
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Basic operation for tools

Editing the Window
The window displayed when the tool (standard mode) or 
the part registration (sorting mode) is set can be edited to 
any size or direction.
This section explains an example of how to edit the window 
when adding the learning tool to a standard mode program 
and pressing [Add Learning Tool].

1	Press [Add Learning Tool] in [Tool Settings] of 
the Settings Navigator.
A window appears in the screen.

Window

2	Set the window.

	z Selecting the shape of the window
[Window Shape] ([□ Rect] or [○ Circle]) can be selected.

□ Rect Circle

	z Moving the window
By pressing inside the window,  will be displayed. 
Move the window by pressing and dragging it.

	z Changing the size of the window
By pressing either side of the window,  or  will be 
displayed. The height or width of the window can be 
changed by pressing and dragging it.

By pressing one of the corners of the window except 
the upper right corner,  will be displayed. The size of 
the window can be changed by pressing and dragging 
it.

When [○ Circle] is selected in the window shape 
settings, the size of the circle can be changed by 
pressing and dragging the outline of the circle.

	z Changing the direction (angle) of the window
By pressing and dragging the arrow mark on the upper 
right of the window, the direction (angle) of the window 
can be changed.
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Basic operation for tools

Editing Numbers
The numbers such as the trigger interval value and the 
threshold of each tool can be edited by multiple methods.

Setting by the Slider
Press the slider, and then slide it to the right or left to 
set the number. When canceling the change, press 
[Undo].

Slider

Adjust settings using the value input box
Using the value input box, inputs values for the selected 
option. Or, specify them by pressing the scroll button. When 
canceling the change, press [Undo].

Value input box

If there a range for the displayed option, the 
value input cannot exceed the range.
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Basic operation for tools

Multiple Sensors Monitoring

Displaying the operation monitoring screen
The operation monitoring screen can be displayed from the 
Activation Menu screen or the screen during the operation.

	� Displaying the operation monitoring screen 
from the Activation Menu screen

1	Press [Multiple Sensors Monitoring] from the 
Activation Menu screen.

The operation monitoring screen opens.

	� Displaying the operation monitoring screen 
from the screen during the operation

1	Press [Monitoring Connection] from the screen 
during the operation.

The operation monitoring screen opens.

Operation on the operation monitoring 
screen

The operation monitoring screen displays the running 
status of multiple sensors that are connected.

(2)
(3)

(4)

(5)

(1)

(2)
(3)

(4)

(5)

(1) (3)

(1) Number and 
device name

Names of the connected sensors and 
their IP addresses are displayed.
When one of them is selected, the 
sensor name and the area around 
the image turns orange.

(2) Menu

The following operations can be made.
	y File

	yClosing the operation monitoring
	yClosing IV3-Navigator

	y View
	y Sensor List

	y Image
	yControlling whether to display or 
hide the tool

	y Setting
	yNetwork Adapter
	yClear the sensor that is the target 
of the monitoring
	y Perform operation monitoring on 
startup 
Disable/enable switch

(3)
Sensor 

judgment 
condition

The judgment condition of the sensor 
is displayed.

	yOK: Status OK in standard mode
	yNG: Status NG in standard mode, or  
No type matching in sorting mode
	yM0 to M7: type matching in sorting 
mode
	y --: The condition is not yet judged, 
unable to judged, error, or in setting

(4) Taken image
The sensor image is displayed during 
the operation.
[Program] is displayed during the 
setup.

(5) Tool display
The tool window set to the sensor is 
displayed. Whether to display or hide 
can be controlled in the menu.
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Basic operation for tools

	� Displaying the screen during the operation/
setup of the selected sensor

By double-clicking the selected sensor, the operation 
screen will be displayed if the sensor has been operated, or 
the settings screen will be displayed if the sensor has been 
set.

	� Switching the network adapter

1	Press the [Settings] menu → [Network Adapter].

2	Select a network adapter, and press [Close].

You can press the search settings button ( ) to 
open the [Search Settings] dialog box, and set 
the search conditions for the network adapter 
and sensor.

 �“Searching for a Sensor to be Connected” 
(page 3-6)

	� Displaying the sensor list

1	On the operation monitoring screen or screen 
during the operation, turn on [Sensor List] from 
the [View] menu.
A list of connected sensors, connectable sensors, and 
other sensors is displayed.

Monitoring connection Normal connection

Sensor List

Icons indicating the detected sensor 
status, device name, and IP address 
are displayed. 
Double-click on any sensor to connect 
to that sensor. 

 : Connecting
 : Running
 : Setting
 : �Not connectable (the IP address 
is not set, network is different, 
etc.) 

 : �Others (sensor update in 
progress, etc.) 

[Connect] Connects with the selected sensor.

[Search Again] Searches sensors again, and updates 
the sensor list display.

[Monitoring 
Settings]

Specify the sensor to be monitoring 
target.

 “Monitoring Settings” (page 3-18).

[LED Blinking] Blinks the LED of the selected sensor.

2	Turn off [Sensor List] from the [View] menu.
The sensor list becomes hidden.
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Basic operation for tools

	�Monitoring Settings
Specify the sensor to be monitoring target.

1	Press [Monitoring Settings] on the Sensor List 
screen.
Monitored Sensor List screen opens and the information 
of each sensor is displayed. 

Press [LED Blinking] to blink the LED of the 
selected sensor.

2	Press  in the [Number] column to specify the 
sensor to be monitoring target. 

	yThe sensor to be monitoring target
Select a number from 1 to 16. On the Operation 
Monitoring screen, the sensor will appear at the 
location matching to the number.
	yThe sensor not to be monitoring target
Select OFF. The sensor being OFF will not appear on 
the Operation Monitoring screen. 

Each of the selected numbers matches the 
specified location on the Operation Monitoring 
screen. Even if the number is omitted, it is not 
padded.
For example, if “2”, “3”, and “4” are selected 
without selecting “1”, on the Operation 
Monitoring screen, No. 1 (upper left of the 
4-split screen) is not displayed, and the selected 
sensors are displayed in No. 2 (upper right of 
the 4-split screen), No. 3 (lower left of the 4-split 
screen) and No. 4 (lower right of the 4-split 
screen). 
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4 

Settings Navigator

This chapter explains the functions and operation methods of 
the Settings Navigator.

Settings Navigator................................................................4-2
Basic operation of the Settings Navigator.........................4-4
1. Image Optimization (Clearly Image a Target).................4-8
2. Master Image Registration (Registering an Image 
as a Reference)...................................................................4-20
3. Tool Settings (Setting the Judgment Method of the 
Target of Standard Mode)..................................................4-28
3. Part Registration Settings (Setting the Judgment 
Method of the Target of Sorting Mode)...........................4-121
4. Output Assignment (Setting Details of Outputting 
to Output Line)..................................................................4-147

(Setting the Status Conditions)

Chapter 
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Settings Navigator

In the Settings Navigator, the settings of the program required for judging the target with the sensor are set in each step.
Select sensor setup mode ([Standard Mode] or [Sorting Mode]) while sequentially following the steps with the navigation 
buttons, and adjust the settings using the menu.

Navigation button

Navigation button

Menus

	y In the case of [Standard Mode], step 3 becomes [Tool Settings].
	y In the case of [Sorting Mode], step 3 becomes [Part Registration].

Flow of the Settings Navigator: Standard Mode

Step 1: Image optimization settings
Set the image optimization settings for clearly imaging a target. Adjust the image settings 
to clearly define the differences between an “OK” and “NG” image.
Set the trigger options, adjust the brightness and camera focal distance.

 “1. Image Optimization (Clearly Image a Target)” (page 4-8)

Step 2: Registration of a master image
Capture an “OK” image and register the master image to serve as the reference of 
judgment.

 “2. Master Image Registration (Registering an Image as a Reference)” (page 4-20)

Step 3: Tool settings
Set tools to judge a target.
Set the tools onto the master image and set the threshold for judgment. Up to 65 detection 
tools and position adjustment tools in one program can be set.

 �“3. Tool Settings (Setting the Judgment Method of the Target of Standard Mode)” (page 4-28)

Step 4: Output assignment
Assign the content to output to each output line.

 “4. Output Assignment (Setting Details of Outputting to Output Line)” (page 4-147)

Settings Navigator
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Settings Navigator

Flow of the Settings Navigator: Sorting Mode

Step 1: Image optimization settings
Set the image optimization settings for clearly imaging a target. Adjust the 
image settings to clearly define the differences between the target types. 
Set the trigger options, adjust the brightness and camera focal distance.

 “1. Image Optimization (Clearly Image a Target)” (page 4-8)

Step 2: Registration of a master image
Capture an image and register the master image to serve as the basis to identify 
part types.

 “2. Master Image Registration (Registering an Image as a Reference)” 
(page 4-20)

Step 3: Part Registration Settings
Set the tool to identify a part type. Also register the image for the part type to be 
identified.
Up to 8 detection tools and 1 position adjustment tool in one program can be 
set.

 �“3. Part Registration Settings (Setting the Judgment Method of the Target of 
Sorting Mode)” (page 4-121)

Step 4: Output assignment
Assign the content to output to each output line.

 “4. Output Assignment (Setting Details of Outputting to Output Line)” 
(page 4-147)

4

Settings N
avigator



4-4 IV3 Series User’s Manual (PC Software)

Basic operation of the Settings Navigator

Starting the Settings Navigator

1	Turn on the power of the sensor.

2	Start the IV3-Navigator.
	� “Operation for Initial Startup of the IV3-Navigator” 
(page 3-6)

When the sensor is in one of the following 
conditions, the main screen in [Program] 
opens. Proceed to step 5.

	yWhen the power is turned on for the first 
time
	y If a program has not been set
	y If the initial setup is being performed on 
the sensor
	yWhen the sensor head is changed

3	Press [Program].

The confirmation screen opens.

4	Press [OK].
IV3-Navigator switches to [Program].

5	Select the program to be set.

 �“Changeover for a Target (Program Functions)” 
(page 7-2)

6	Press [Sensor Setup].

	z When a program which has not been set is 
selected
The [Select Mode] screen is displayed.
Select the mode (Standard Mode/Sorting Mode) to be 
used for judgment and press [OK].

Start setting [1. Image Optimization].

Setting the image 
optimization

 �“1. Image Optimization (Clearly Image a Target)” 
(page 4-8)

Basic operation of the Settings Navigator
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Basic operation of the Settings Navigator

	z When the program which has been set is 
selected
Press the navigation button for each step to start setting 
the program.

Navigation button

	� “1. Image Optimization (Clearly Image a Target)” 
(page 4-8)

	� “2. Master Image Registration (Registering an Image 
as a Reference)” (page 4-20)
	 �“3. Tool Settings (Setting the Judgment Method of 
the Target of Standard Mode)” (page 4-28)(Standard 
Mode)
	 �“3. Part Registration Settings (Setting the Judgment 
Method of the Target of Sorting Mode)” (page 4-121)
(Sorting Mode)

	� “4. Output Assignment (Setting Details of Outputting 
to Output Line)” (page 4-147)

When changing the set program from 
Standard mode to Sorting mode, or from the 
Sorting mode to the Standard mode, initialize 
the program once.

 �“Initializing a Program” (page 7-10)

Image Types of the Settings Navigator
The image types displayed in the Settings Navigator screen 
are as follows.

Image Type

Type Description

The current taken image.

The image registered as the master.
When multiple master image settings 
are disabled, “Master” will be displayed; 
when the multiple master image settings 
are enabled or in sorting mode, “Master00 
to 07” will be displayed; and when the 
master name is changed, the master 
name will be displayed.

Test operation screen.
Displays the taken image.

The image viewed from files or image 
history.
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Basic operation of the Settings Navigator

Settings Navigator Screen and Operation Flow
This section explains the screen to be displayed in the Settings Navigator and the operation flow.
For details of the contents which can set on each setting screen and its operations, refer to the applicable sections.

3. Part Registration 
 “3. Part Registration 

Settings (Setting the 
Judgment Method of 
the Target of Sorting 
Mode)” (page 4-121)

If programs are not being set

Select Mode

When a [Sorting Mode] 
program is selected

When a [Standard Mode] 
program is selected

3. Tool Settings
 “3. Tool Settings 

(Setting the Judgment 
Method of the Target 
of Standard Mode)” 
(page 4-28)

2. Master Registration
 “2. Master Image Registration 

(Registering an Image as a Reference)” 
(page 4-20)

1. Image Optimization
 “1. Image Optimization (Clearly Image a 

Target)” (page 4-8)

4. Output Assignment
 “4. Output Assignment (Setting 

Details of Outputting to Output Line)” 
(page 4-147)
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Basic operation of the Settings Navigator

Finishing the Settings Navigator

Finishing by completing all steps

1	Set all steps in the Settings Navigator.

2	Press [Complete].

The confirmation dialog to save appears.

3	Press [Yes].
The settings in the Settings Navigator will be saved into 
the program, and the system returns to the main screen 
in [Program].

	y By pressing [No], the confirmation dialog to 
cancel the settings opens. By pressing [Yes], 
the Settings Navigator closes without saving 
the settings.
	y By pressing [Cancel], the system returns to 
the Settings Navigator screen.

Finishing without completing all steps.

1	Press [Quit] at the lower right of the screen.

	z When the required settings are completed
The confirmation dialog to save appears.

	z When the required settings are not completed
The confirmation dialog to finish appears.

	yBy pressing [OK], the confirmation dialog to save 
appears.
	yBy pressing [Cancel], the system returns to the 
Settings Navigator screen.

The required settings have not completed 
yet. Even if [OK] is pressed and the setting 
contents are saved in the program, proper 
operation cannot be performed.

2	Press [Yes].
The settings in the Settings Navigator will be saved into 
the program, and the system returns to the main screen 
in [Program].

	y By pressing [No], the confirmation dialog to 
cancel the settings opens. By pressing [Yes], 
the Settings Navigator closes without saving 
the settings.
	y By pressing [Cancel], the system returns to 
the Settings Navigator screen.
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1. Image Optimization (Clearly Image a Target)

1. Image Optimization (Clearly Image a Target)

In this section, adjust the image optimization for defining 
differences in an “OK” and “NG” image or part image.

Setting the image optimization

	z Smart Image Optimization
By specifying an area on the target, the AI will 
automatically generate recommended optimized 
images. One of multiple recommended optimized 
images can be selected.

 “Settings of Smart Image Optimization” (page 4-9)

	z Trigger Options
A trigger in this manual indicates the timing to start 
imaging with the built-in camera of the sensor. In the 
Trigger Options, set the timing to image a target within 
the field of view of this device. This device can image a 
target at any timing and can image continuously.

 “Setting the Trigger Options” (page 4-10)
 “Checking the field of view and installed distance” 

(page 2-2)

	z Brightness Adjustment
The sensor images a target by receiving the reflected 
light of the built-in light exposed to a target using the 
CMOS image sensor.
In the Auto Brightness Adjustment, a target can be 
imaged with an appropriate brightness by automatically 
adjusting the light intensity and shutter speed according 
to the shape and surface condition (color, shininess, 
material).

 “Brightness Adjustment” (page 4-12)

	z Focus Adjustment
Adjusts the focus of lens. Adjusts for clearly imaging the 
shape of a target. Auto focus can adjust the focusing 
position automatically.

 “Focus Adjustment” (page 4-12)

When the master image is registered and image 
optimization settings other than Trigger Options 
are changed, the confirmation message that 
recommends you re-register the master image 
opens. Press [OK] and re-register the master 
image.

	� “2. Master Image Registration (Registering an 
Image as a Reference)” (page 4-20)

Main Screen for Image Optimization
This section explains the main screen for Image 
Optimization.

(7) (8)

(1)

(2)

(3)

(4)

(5)

(6)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 [Image Type] display
 “Image Types of the Settings Navigator” (page 4-5)

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Image taken by the sensor
Displays an image taken by the sensor. The image 
type to be displayed differs depending on the settings 
screen.

(5)	 Settings button
Displays the settings to be set for Image Optimization.

 “Settings of Smart Image Optimization” (page 4-9)
 “Setting the Trigger Options” (page 4-10)
 “Brightness Adjustment” (page 4-12)
 “Focus Adjustment” (page 4-8)
 “Advanced settings for image optimization” (page 

4-16)
(6)	 Edit settings screen

Displays the settings to be edited of the selected item 
using the settings button in the tab format.

(7)	 [Next to STEP2] button
Proceeds to “2. Master Registration”.

	� “2. Master Image Registration (Registering an Image 
as a Reference)” (page 4-20)

(8)	 [Quit] button
Finishes the Settings Navigator.
 “Finishing the Settings Navigator” (page 4-7)
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1. Image Optimization (Clearly Image a Target)

Settings of Smart Image Optimization
By specifying an area on the target, the AI will automatically generate recommended optimized images. One of multiple 
recommended optimized images can be selected.

Setting items for Smart Image Optimization

Items Description

Specify Target Area To determine the optimized images, specify the area to be optimized by the AI on the Live image.

AI-Generated Image 
Patterns

One of the appropriate optimized images can be selected from a number of recommended 
optimized images generated by AI.

Readjust Returns to Specify Target Area screen. Used when adjusting settings to generate optimized 
images using AI again. 

Set Smart Image Optimization

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for Image Optimization.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Smart Image Optimization].

4	Specify the target area.
To determine the optimized image, specify the target to 
be optimized by the AI on the Live image.

5	Press [OK].
The image obtained by Smart Image Optimization will 
be displayed.

By pressing [Readjust], the system returns to the 
procedure to specify the target area. The AI will be able 
to generate optimized images again based on settings 
changes.

Stop the target during Smart Image 
Optimization.

6	Select one Optimized Image and press [OK].
The system returns to the main screen for Image 
Optimization.
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1. Image Optimization (Clearly Image a Target)

Setting the Trigger Options
A trigger in this manual indicates the timing to start imaging with the built-in camera of the sensor. In the Trigger Options, 
set the timing to image a target within the field of view of this device. This device can image a target at any timing and can 
image continuously.

	z Internal trigger

(1)

(2)

(3)

Internal trigger

Imaging/internal 
processing

Status output

Trigger Interval Trigger Interval

(1)	 The trigger interval is determined according to the trigger interval settings.
(2)	 Perform internal processing after the imaging.
(3)	 Output the status result.

	� If [Internal Trigger Control with IN1 Input] is set to [Enable]

(1)

(2)

(3)

Internal trigger

IN1

Imaging/internal 
processing

Status output

Trigger Interval Trigger Interval

(1)	� The trigger will be input within the period of “Internal trigger interval + 1 ms” after IN1 is input (the trigger is input 
while IN1 is input). Thereafter the trigger will be input according to the trigger interval settings.

(2)	 Perform internal processing after the imaging.
(3)	 Output the status result.
 “Internal Trigger Control with IN1 Input” (page 7-15)

	z External trigger

(1)

(2)

(3)

External trigger

Imaging/internal 
processing

Status output

Trigger delay

(1)	 Start imaging by inputting the trigger signal from another device.
	 When the trigger delay interval is set, the imaging start time will be delayed by the specified period.
(2)	 Perform internal processing after the imaging.
(3)	 Output the status result.
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1. Image Optimization (Clearly Image a Target)

Settings for the Trigger Options

Items Description

Trigger Type Select the type of timing used to take an image.

Trigger Interval Set when [Internal Trigger] is selected in the trigger type setting.
Set an interval (cycle) at which the sensor automatically images.

Trigger Delay

Set when [External Trigger] is selected in the trigger type setting.
Used when the output timing of the sensor used as an external trigger and the imaging timing of this 
device cannot be synchronized. This device starts imaging after the set trigger delay time of the timing 
input passes.

Setting the Trigger Options

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for Image Optimization.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Trigger Options].

4	Select the trigger type.
Select [Internal Trigger] or [External Trigger].

Internal 
Trigger  
(default)

Starts imaging continuously within the 
interval specified in the trigger interval 
setting.
If [Internal Trigger Control with IN1 Input] 
is set to [Enable], an external input can 
control the internal trigger.

External 
Trigger

Starts imaging when receiving an external 
trigger from a photoelectric sensor or 
a PLC. The external trigger can be 
synchronized with a target’s motion.
The time (trigger delay) between inputting 
the trigger and when imaging starts can 
be set.

5	Set [Trigger Interval] or [Trigger Delay].
 “Editing Numbers” (page 3-15)
	z When [Internal Trigger] is selected in step 4
Set the trigger interval within the range of 1 to 10000 
ms (default: 50 ms).

	y If the internal trigger is input while BUSY is 
ON, a trigger error occurs.
	yWhen the lighting mode is set to 
continuous lighting, the trigger interval can 
be selected from 1 ms, 25 ms, 50 ms, or 
100 ms. For 100 ms or more, values can be 
selected in 100 ms intervals. The maximum 
value is 10000 ms.
 “Internal trigger” (page 11-3)
 “Error Messages” (page A-9)

	z When [External Trigger] is selected in step 4
Set the trigger delay within the range of 0 to 10000 ms 
(default: 0 ms).
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1. Image Optimization (Clearly Image a Target)

Brightness/Focus Adjustment
When modifying optimized image selected by Smart Image Optimization, or when performing fine adjustment for the 
brightness/focus position, the brightness adjustment, focus adjustment, and lighting conditions can be set.
When using Brightness Adjustment, the target can be imaged with an appropriate brightness by adjusting the light intensity 
and the imaging mode according to the shape and surface condition (color, shininess, material).
When using Focus Adjustment, adjust the focusing position for clearly imaging the shape of a target.
When adjusting the lighting conditions, select the internal light ON/OFF, lighting unit ON/OFF, and multiple imaging ON/
OFF.

Brightness/Focus adjustment settings

Items Description

Brightness 
Adjustment

Automatic Brightness Adjustment The brightness is automatically adjusted so that the brightness of 
the entire image becomes optimal.

Auto Adjustment by Specifying a 
Position on the Image

Automatically adjusts the brightness so that the brightness of the 
specified area and the area surrounding it becomes optimal. 

Manual Brightness 
Adjustment

Imaging Mode Selects imaging mode for sensor.

Brightness Adjust brightness of an image manually.

Focus Adjustment
Automatic Focus Adjustment Adjusts the focusing position automatically.

Manual Focus Adjustment Adjust the focus position by the slider.

Lighting

Internal Lighting Selects ON/OFF for the internal light.

Ext. Light Unit Selects ON/OFF for the AI Lighting unit (only when connecting 
the unit).

Multi-Capture Selects the multiple imaging ON/OFF.
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1. Image Optimization (Clearly Image a Target)

Adjusting Brightness

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for Image Optimization.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Brightness/Focus Adjustment].

4	Press the [Brightness Adj.] tab.

5	Adjust the brightness.

Do not move the target during auto 
brightness adjustment. The brightness may 
not be adjusted correctly.

	z Adjusting brightness automatically
By pressing [Automatic Brightness Adjustment], 
the brightness is automatically adjusted so that the 
brightness of the entire image becomes optimal.

	z Adjust automatically by specifying a position 
on the Image
By specifying a position on the image, the brightness 
is adjusted automatically so that the brightness of the 
specified surrounding area becomes optimal.
Used when the adjustment results of the [Automatic 
Brightness Adjustment] button are too bright or dark due 
to the influence of brightness other than the target.

	z Adjusting brightness manually
Manually adjust the brightness as needed by changing 
the brightness and the imaging mode.

 “Editing Numbers” (page 3-15)

Imaging 
Mode 

	yNormal (default)
This mode is the basic imaging mode. 
The target can be imaged with less 
noise.
	yHDR
Select to image a target such as 
metal that reflects light and has high 
contrast.
	yHigh Gain
Select to shorten the exposure time or 
when the imaging environment is in a 
dark place. Lowers image quality due 
to high gain.

Brightness Default value: 20

	y The auto adjustment optimally adjusts the imaging 
mode and brightness.
	y The exposure time will be calculated automatically.
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1. Image Optimization (Clearly Image a Target)

Adjusting focus

	y Place the target at the appropriate position.
 “Mounting the Sensor” (page 2-2)

	yDo not move the target during focus 
adjustment. The focus may not be adjusted 
correctly.

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for Image Optimization.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Brightness/Focus Adjustment].

4	Press the [Focus Adj.] tab.

When the [Auto Focus Adj Pos] (Page 7-26) is 
set to [Common], the following dialog opens.

5	Adjust the focusing position.

Auto 
adjustment

Manual 
adjustment

	z Adjusting the focusing position automatically
When [Automatic Focus Adjustment] is pressed, the 
focusing position is adjusted automatically.

	z Adjusting the focusing position manually
Adjust the focus position by the slider.

 “Editing Numbers” (page 3-15)

	z When multiple focusing positions exist
When there are multiple positions that were identified 
as the optimal position, the following screen opens.

By pressing [OK], the focus is adjusted to the closest 
position to the sensor, and the options of the positions 
that can be focused are indicated by ( ).
To change the focusing position to a different position, 
press the markers ( ) for the focusing positions.

	yDuring the automatic adjustment, the sensor 
automatically images a target by inputting the 
internal trigger regardless of the Trigger Options 
(Page 4-10) settings. Also, when continuous 
lighting (Page 4-18) is set, imaging will be 
performed with the flash lighting.
	y Auto adjustment searches the positions that can 
be focused over the entire area.
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Setting the lighting conditions

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for Image Optimization.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Brightness/Focus Adjustment].

4	Press the [Lighting] tab.

5	Set the lighting conditions.

	z Selecting ON/OFF for the internal light

Internal 
Lighting

	yON (default)
Turns on the built-in light of the 
sensor.
	yOFF
Turns off the built-in light of the 
sensor.

	z Selecting ON/OFF for the lighting unit

Ext. Light Unit 
(only when 
connected)

	yON (default)
Turns on the AI Lighting unit.
	yOFF
Turn off the AI Lighting unit.

	z Selecting multi-capture ON/OFF
By turning on only a part of the light of the main unit and 
the AI Lighting unit, and combining images with different 
emitting directions, a more ideal image can be obtained.

Multi-Capture

	yON
Multi-capture is performed.
	yOFF (default)
Multi-Capture is not performed.

When using multi-capture stop the target for 
the exposure time starting from the trigger 
input. Since an image is combined from 
images resulting from the multi-capture if the 
target moves during its capturing, the image 
will not be combined correctly.

	z Selecting the pattern when turning ON Multi-
Capture

Pattern 
1 to 4

Selects a pattern based on the 
brightness of the images obtained from 
multi-capture.
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Advanced settings for image optimization
Adjusts the image optimization settings using the advanced settings menu.

Advanced settings items for image optimization

Items Description Ref.

Digital Zoom
Magnification Set the magnification of digital zoom.

4-17
Zoom Area Specify an area in the sensor’s field of view as the zooming area.

Filter/Correction

Distortion Correction 
(Wide Field of View 
Sensor Model Only)

Correct image distortion.

4-18
Color Filters  

(Color Type Only)

If it is difficult to extract the edge (outline) of targets of different 
colors, select a filter for a color or a complementary color to be 
detected.

Lighting Mode Select lighting mode for the light. 4-19

When the master image is registered and the advanced settings for image optimization are changed, the 
confirmation message that recommends you to re-register the master image opens. Press [OK] and re-register 
the master image.

 “2. Master Image Registration (Registering an Image as a Reference)” (page 4-20)
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Setting the digital zoom

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for Image Optimization.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Extended Functions].

4	Select the [Zoom] tab and set the [Magnification].

5	Set [Zoom Area] as needed.

	z Zoom Area
The zoom area for digital zoom is specified.
Press the zoom area to set the area on which to be 
zoomed.

Zoom Area

To move the zoom area to the center of the screen, 
press [To image center].

If the zoom area is moved, the imaging area 
and tool window are moved together. It is 
recommended to re-register the master 
image and re-set the tools when moving the 
zoom area.

6	Press [OK].
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Setting distortion correction (wide field of 
view sensor model only)/color filters (color 
type only)

Color filters are not applied to the following:
	y Learning tool
	yColor Area tool
	yColor average tool
	yColor Prohibition/Brightness Prohibition tool
	yBlob Count tool

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for Image Optimization.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Extended Functions].

4	Select the [Filter/Correction] tab.
The image changes to monochrome. In this example, 
the outline in red and blue will be undefined.

5	Select ON/OFF for the distortion correction.
Correct the image distortion automatically. Use this 
when you are concerned about the distortion.

Distortion 
Correction

	yON (default)
Distortion correction is performed.
	yOFF
Distortion correction is not performed.

When distortion correction is ON, the 
processing time may slow down.
For the standard model, it cannot be turned 
ON.

6	Select the color to apply the color filter.
Select the filter of the color or complementary color to 
be detected (select red here).
By applying the color filter of the selected color, the red 
color becomes brighter and the outline with the blue 
color will be clarified.

Clarified outline
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Setting the lighting mode for the light

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for Image Optimization.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Extended Functions].

4	Press the [Lighting Mode] tab.

5	Set [Lighting Mode].

Lighting Mode

	y Flash (default)
The built-in light lights within the 
exposure time when imaging.
	yContinuous (color type only)
The built-in light lights regardless of 
specified exposure time when imaging 
a target.

	y If the lighting mode is changed, re-register 
the master image and re-set the tool. 
Otherwise correct judgment may not be 
possible.
	y [Continuous] cannot be selected when 
using a monochrome type.
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2. Master Image Registration 
(Registering an Image as a Reference)

Main screen for Master Image 
Registration

This section explains the main screen for the master image 
registration.

(7)(6) (8)

(1)

(2)

(3)

(4)

(5)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 [Image Type] display
 “Image Types of the Settings Navigator” (page 4-5)

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Image taken by the sensor
Displays an image taken by the sensor. The image 
type to be displayed differs depending on the settings 
screen.

(5)	 Settings button
Displays the settings for master registration.

	� “Register Live Image as Master” (page 4-20)
	� “Register From a Running Image History” (page 
4-21)

	� “Registering from the File Saved in the PC” (page 
4-22)

	� “Advanced Settings for the Master Registration” 
(page 4-24)

(6)	 [Back] button
Returns to the settings screen for Image Optimization.

	� “1. Image Optimization (Clearly Image a Target)” 
(page 4-8)

(7)	 [Next to STEP3] button
Proceeds to “3. Tool Settings” (Standard Mode) or 
“3. Part Registration” (Sorting Mode).
	 �“3. Tool Settings (Setting the Judgment Method of 
the Target of Standard Mode)” (page 4-28)
	 �“3. Part Registration Settings (Setting the Judgment 
Method of the Target of Sorting Mode)” (page 4-121)

(8)	 [Quit] button
Finishes the Settings Navigator.
 “Finishing the Settings Navigator” (page 4-7)

Register Live Image as Master

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for the Master 
Registration.

 “Settings Navigator Screen and Operation Flow” 
(page 4-6)

3	Place the target that will be used as the reference 
for judgment in the imaging position.

4	Press [Register Live Image as Master].

Switches to the [Live] screen.

5	Image the target.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

6	Check the displayed taken image and press 
[Register the image].

The confirmation dialog for the Master Registration 
opens.
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2. Master Image Registration (Registering an Image as a Reference)

7	Press [OK].
The master image will be registered and the sensor 
returns to the main screen for the master image 
registration.

The settings for the disabled outlines (Page 
4-50, Page 4-68) will be initialized. Set 
the outlines that will be disabled again as 
needed.

Register From a Running Image History
Registers an image from the image history saved in the 
memory within the sensor as a master image.

To register the master image from the image 
history, the image to be registered as a 
master image in the [Running Image History] 
must be saved.

 �“Confirming the Images Whose Judgment 
are NG (Running Image History)” (page 5-17)

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for the Master 
Registration.

 “Settings Navigator Screen and Operation Flow” 
(page 4-6)

3	Press [Register Image from Image History].

4	Select the image to be registered as the master 
image and press [OK].

Select the 
image

The selected image will be displayed.
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2. Master Image Registration (Registering an Image as a Reference)

5	Check the displayed image and press [OK].

The confirmation screen opens.

6	Press [OK].
The master image will be registered and the sensor 
returns to the main screen for the master image 
registration.

Registering from the File Saved in the PC
Registers an image from the PC as the master image.

	y Save the image to be registered as the master 
image into the PC in advance.
	y The files which can be registered as a master 
image are batch backup files (*.iv3a), individual 
program backup file (*.iv3a) or image capture 
files (*.iv3p).

 “Folder Composition and File Naming 
Rules” (page 8-8)

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for the Master 
Registration.

 “Settings Navigator Screen and Operation Flow” 
(page 4-6)

3	Press [Register From an Image File].4
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2. Master Image Registration (Registering an Image as a Reference)

4	Select the file to be registered as the master 
image.

	z When using a batch backup file (*.iv3a) or 
individual program backup file (*.iv3a)
Select the file to be registered as the master image and 
press [Open].

Select the file

Select the type of the image to be imported from the 
following. Select the target program when the Learned 
Image History is selected.

	yRunning Image History
	yMaster Image
	y Learned Image History

The list of images saved as the selected file image type 
will be displayed.
Select the image to be registered as the master image 
and press [OK].

Select the 
image

	z When using an image capture file (*.iv3p)
Select the file to be registered as the master image and 
press [Open].

Select the file

5	Check the displayed image and press [OK].

The confirmation screen opens.

6	Press [OK].
The master image will be registered and the sensor 
returns to the main screen for the master image 
registration.
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Advanced Settings for the Master Registration
Adjusts the master image registration using the advanced settings menu.

Advanced settings items for the master registration
Items Description Ref.

Brightness Correction The impact from changes in lighting can be reduced by setting the brightness level for the 
master image. 4-24

Master image settings Up to eight master images can be registered. (Standard mode only) 4-25
Master name The name of each master image can be edited. 4-27

Brightness Correction
	y For a monochrome type, the learning tool cannot 
be used when enabling brightness correction. 
Moreover, brightness correction cannot be 
enabled when the learning tool is set.
	yBrightness correction can be set only when a 
master image is registered.
	y The brightness correction can be performed 
only for the master image 0 when master 
image settings are [Multiple].
	yBrightness correction is not applied to the 
following tools.

	y Learning tool (color type)
	yColor Area tool, Color Average tool, Color 
Prohibition tool (color type),  
and Blob Count tool (color type)

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for the Master 
Registration.

 “Settings Navigator Screen and Operation Flow” 
(page 4-6)

3	Select the [Extended Functions] tab and press 
[Brightness Correction].
Switches to the master image 0 when master image 
settings are enabled.

4	Press [Enable].

	z For color type

	z For monochrome type
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5	Set the tool window to be a reference for the 
brightness correction.

 “Editing the Window” (page 3-14)

Region to be the 
brightness correction 
standard

For the region to be a reference of brightness 
correction, specify the following.

	yA region with average medium brightness. 
A region with strong shininess and 
reflection or a region which is too dark may 
not be corrected properly.
	yA region with a constant imaging status 
which does not change, such as device 
parts other than the target’s.

6	Press [Test run].

*
Screen for the color type

Insert a shield or something similar and if the brightness 
in the specified standard region changes, check that the 
brightness for the entire image is corrected.

7	Press [Before Corr]/[After Corr] to check the 
operation status before and after brightness 
correction.

8	Press [OK].
The system returns to the brightness correction settings 
screen.

	yWhen brightness correction is not to be used, 
press [Disable] on the screen from step 4.
	y Brightness correction corrects the brightness 
of the entire image so that the average 
brightness of the window that is used as 
the brightness standard is the same as the 
brightness of the master image.

Master Image Settings

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for the Master 
Registration.

 “Settings Navigator Screen and Operation Flow” 
(page 4-6)

3	Select the [Extended Functions] tab and press 
[Master Image Settings].

The master image settings screen open.

4	Press [Multiple].

By pressing [Single], master images other than the 
master image 0 are deleted.
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2. Master Image Registration (Registering an Image as a Reference)

5	Press [OK].
The master image list (an area displaying all master 
images) appears in the master registration screen.

By pressing the “Switch to Display All Master Images 
<-> Single Master Image” button below the master 
image, whether the master image list is displayed or 
hidden can be changed.

6	Press the [Master Registration] tab.

7	Select one master image (0 to 7) to be registered 
from the master image list.

The master image 0 must be registered.

8	Register the master image.
 “Register Live Image as Master” (page 4-20)
 “Register From a Running Image History” (page 4-21)
 �“Registering from the File Saved in the PC” (page 4-22)

When the registration ends, a confirmation screen to 
switch to the next master image appears.

9	By pressing [OK], the next master image is 
selected.

By pressing [Cancel], the registered master image 
remains selected.

10	Repeat steps 7 to 9 to register all the master 
images you want to register (up to 8).

The selected master image can be deleted 
by pressing “Delete master image” button. 
However, master image 0 cannot be deleted. 
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Master name
If the master image settings are [Enable], master names 
can be set for master images.

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the main screen for the master 
registration.

 “Settings Navigator Screen and Operation Flow” 
(page 4-6)

3	Select the [Extended Functions] tab.

4	If the master image settings are [Enable], select 
the master image to edit the master name.

If the master image is not registered, the master name 
cannot be edited. Register the master image first.

5	Press [Master IMG Name].

6	Edit the master name.
Up to 16 characters in alphanumeric can be set.

7	Press [OK].
The changed master name appears in the image type 
display on the top left of the screen.
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3. Tool Settings 
(Setting the Judgment Method of the Target of Standard Mode)

This section explains the setting methods for “Step 3. Tool 
Settings” of standard mode.
For "Step 3: Part Registration" of Sorting mode, refer to  
 “3. Part Registration Settings (Setting the Judgment 

Method of the Target of Sorting Mode)” (page 4-121)

In standard mode, set tools in the master image to judge 
whether a target is OK or No Good.
The aspects of the target registered as the master image 
are set as an “OK” image. During operation, the sensor 
judges whether it is an “OK” image or “NG” image by 
judging the differences in the registered master image and 
the target to be examined.

The number of tools that can be set in one program are as 
follows:

	yUp to 65 tools can be set.
	y If the position adjustment tool or outline tool are included:

	yThere is a limit to the total number of tools for the 
position adjustment tool and outline tool.
	yThe number of tools that can be set vary depending 
on the tool settings. Generally, this is about 40 tools.
	yGenerally about 20 tools if the search algorithm for 
the position adjustment tool is set to high accuracy.

Types of tools

Basic tools

	� Learning tool
A tool which can automatically recognize the difference 
between targets by registering “OK” and “NG” images used 
for learning.

 �“Auto Adjustment by the Additional Learning (Learning 
Tool Only)” (page 6-2)

In the learning tool, learning will be executed after setting 
the tool windows used to identify OK/NG parts (images 
where the differences are clear) and registering an “OK” 
image and an “NG” image.

OK NG

OK NG

Status that cannot 
be judged

Unregistered Unregistered

Status that can be 
judged

Start settings (not learned)

Learning Settings

Settings completed (OK/NG Target Learning completed)

Registered as OK

Execute OK/NG Target Learning

Registered as NG

Add Learning Tool (Page 4-44)

OK/NG Target Learning (Page 4-44)
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	�Outline tool
A detection tool to calculate the matching rate for the 
target based on the outline information of a registered 
“OK” image.
Judges whether a target is OK or NG by setting the 
threshold for the matching rate.

 “Outline tool” (page 4-48)

Tool settings

Master Image
Outline extraction 

processing

Processing and judgment during an operation
Internal processing <Judge is OK>

Searches the region for a target which has the outline of the 
same shapes as the outline of the “OK” image.
Outline can be detected even if a target is rotated.

Example when the result was NG
No same shapes exist

(Detection of existence)
Different shape

(Shape detection)

Different direction
(Detection of direction)

The matching rate is indicated in 0 to 100.
100 indicates that an outline is completely 
matched. The matching rate decreases with 
more non-matching parts.

	� Color Area/Area tool
A tool to calculate the matching rate of the area (number 
of pixels) of a target in comparison to the area (number 
of pixels) of a registered “OK” image (100%). Judges 
whether a target is OK or NG by setting the threshold 
for the matching rate.
If the sensor is a color type, the tool will be Color Area 
tool. The system judges the area for presence of pixels 
of a user-specified color.
If the sensor is a monochrome type, the tool will be the 
Area tool. The system judges bthe area for presence of 
pixels of a user-specified brightness.

 “Color Area/Area tool” (page 4-52)

Tool settings

Master Image

Color extraction process
(Color type)
Brightness extraction process
(Monochrome type)

Processing and judgment during an operation
Internal processing <Judge is OK>

Compares the area of a target as defining an 
area of an “OK” image to 100 %.

Example when the result was NG
Area is narrow Area is wide

	y The matching rate is indicated in 0 to 100 
(default).
100 indicates that an area is completely 
matched. The matching rate decreases as the 
area of a target narrows.
	y The setting for the display range and threshold 
for the matching rate can be changed to 0 to 
200 or 0 to 999. Also, a target can be judged 
by setting an upper limit for the threshold.

 “Upper Limit” (page 4-56)
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	� Color/Brightness Average Tool
A tool to calculate the matching rate in the color/
brightness of a target to be examined in comparison 
to the color/brightness of a registered master image 
(100%). Judges whether a target is OK or NG by setting 
the threshold for the matching rate.
If the sensor is color type, the tool will be the Color 
Average tool. The system judges using a user-defined 
color.
If the sensor is monochrome type, the tool will be the 
Brightness Average tool. The system judges using a 
user-defined brightness.
This tool is different from the Color Area/Area tool, as 
only the color/brightness is considered, and not the 
amount of pixels in the target area.

 “Color/Brightness Average Tool” (page 4-59)
Tool settings

Master Image

Color average extraction process
(Color type)
Brightness average extraction 
process (Monochrome type)

Tool window

Processing and judgment during an operation
Internal processing <Judge is OK>

Compares the average color (color type) or brightness 
(monochrome type) inside a tool window with the color/
brightness defined in the master image.

Example when the result was NG
Color is different

(Color type)
Brightness is different
(Monochrome type)

	y The matching rate is indicated in 0 to 100.
100 indicates that the color and brightness 
is completely matched. The matching rate 
decreases as the color or brightness of the 
target differs.
	y The average color/brightness value is 
extracted from inside the tool window. If there 
are multiple color/brightness values mixed 
inside the tool window, the average value is 
calculated according to the area. For example, 
if red and white are mixed, the color average 
will be pink.

Color average process

Tool window
	yUsing in combination with the external master 
image registration function enables target 
changeover of the type of product to be 
performed easily.

 “Input Settings” (page 7-13)
 “Registering the Master Image” (page 11-11)

	� Position Adjustment tool
A tool to correct the differences in position of a target by 
searching for the outline information of a registered “OK” 
image. The position adjustment is used in conjunction 
with other detection tools.

 “Position Adjustment Tool” (page 4-66)
Tool settings

Tool window
Position adjustment 

window

Master Image

Processing during an operation

Tool window

Position adjustment window

Search range of the 
tool window

Position adjustment process

	yWhen the Position Adjustment tool is being 
used, the processing time will be longer.
	yWhen using an Outline tool with a Position 
Adjustment tool, the search range position 
of the Outline tool will be adjusted. The 
outline of the target is searched in the 
adjusted search range and the searched 
outline will be judged.
	y If position adjustment fails, the result of 
position adjustment is NG. In addition, 
all other detection tools will not perform 
their judgment process. Failure of position 
adjustment can be checked with the 
position adjustment status output. When 
position adjustment fails, review the 
position adjustment settings and position 
determining accuracy for a target.

 ‌�“4. Output Assignment (Setting Details of 
Outputting to Output Line)” (page 4-147)

	yWhen the Position Adjustment tool is added, 
the following settings for the detection tools 
that have been set will be changed.

Outline tool

When the search range is 
set as the entire range, field 
of view the search range will 
be initialized to the default 
value in which the position 
adjustment is enabled.

Color Area/ 
Area tool

When the window shape 
is set to the entire range, 
the window shape will be 
initialized to the default 
value in which the position 
adjustment is enabled.

EdgePixels 
tool

When the window shape 
is set to the entire range, 
the window shape will be 
initialized to the default 
value in which the position 
adjustment is enabled.

	y In standard mode, multiple position 
adjustment tools can be set in each 
program. If multiple position adjustment 
tools are set, you can set which position 
adjustment tool will be applied to each 
detection tool.
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Advanced tools 1

	�Width tool
A tool to calculate the matching rate of the width of a 
target in comparison to the width of a registered “OK” 
image (100%). Judges whether a target is OK or NG by 
setting the threshold for the matching rate.
 “Width Tool” (page 4-70)

Tool settings

Master Image
Width (height) 

extraction processing

Processing and judgment during an operation
Internal processing <Judge is OK>

Find the width of a target from both directions.
Compares the width of a target by defining the width of 
an “OK” image as 100%.

Example when the result was NG
Width (height) is 

short Width (height) is long

	y The matching rate is indicated in 0 to 200 
(default).
100 indicates that the width is completely 
matched to the master image.
The matching rate decreases as the width of a 
target shortens.
	y The setting for the display range and threshold 
for the matching rate can be changed to 0 to 
100 or 0 to 999. If it changes to 0 to 100, set 
the threshold only for the lower limit.

 “Upper Limit” (page 4-73)

	� Diameter tool
A tool to calculate the matching rate of the diameter of a 
target in comparison to the diameter of a registered “OK” 
image (100%). Judges whether a target is OK or NG by 
setting the threshold for the matching rate.
 “Diameter Tool” (page 4-76)

Tool settings

Master Image
Diameter extraction 

processing

Processing and judgment during an operation
Internal processing <Judge is OK>

Compares the diameter of a target by defining 
the diameter of an “OK” image as 100%.

Example when the result was NG
Diameter is small Diameter is big

	y The matching rate is indicated in 0 to 200 
(default).
100 indicates that the diameter is completely 
matched to the master image.
The matching rate decreases as the diameter 
of a target decreases.
	y The setting for the display range and threshold 
for the matching rate can be changed to 0 to 
100 or 0 to 999. If it changes to 0 to 100, set 
the threshold only for the lower limit.

 “Upper Limit” (page 4-78)
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	� Edge tool
A tool to count and judge the number of edges for a 
registered “OK” image (Bright/Dark changes). The 
target is judged within the set region. The Edge tool 
judges whether a target is OK or NG by setting the 
threshold for the number of edges.

 “Edge Tool” (page 4-82)

Tool settings
Master Image

Tool window

Processing and judgment during an operation
Internal processing <Judge is OK>

Search the target edge from one direction.
Rotate the tool window to set the direction to be 
examined.

Example when the result was NG

No edge
Number of edges is 

high

	yMaximum value of the matching rate is 
adjusted automatically.
The matching rate is indicated in the number 
of edges. 0 indicates that there is no edge in 
the window.
	yUp to 320 edges can be counted. Targets with 
321 or more edges cannot be counted.
	y The setting for the display range and threshold 
for the matching rate can be changed to 0 to 
5, 0 to 10, 0 to 20, 0 to 50, 0 to 128, 0 to 256, 
or 0 to 320. Also, a target can be judged by 
setting an upper limit for the threshold.

 “Upper Limit” (page 4-85)

	� Pitch tool
A tool to calculate the matching rate for the distance 
between pitches of a target in comparison to the 
average value of the distance between pitches of a 
registered “OK” image (100%). Judges whether a target 
is OK or NG by setting the threshold for the matching 
rate.

 “Pitch tool” (page 4-86)

Tool settings

Master Image
Extract distance 
between pitches

Processing and judgment during an operation
Internal processing <Judge is OK>

Compares the distance between pitches of a target by 
defining the average value of the distance between 
pitches of an “OK” image as 100%.

Example when the result was NG
Number of pitches is 

different
Distance between 
pitches is different

	y The matching rate is indicated in 0 to 200 
(default).
The average value of all the distances 
between pitches is 100.
Among all of the distances between pitches, 
the one which deviates the most from the 
average value is displayed to show the 
matching rate.
	y Both maximum and minimum values of 
the distances between all the pitches are 
displayed in status gauge.
	yWhen the number of pitches is different from 
the number for master image, the matching 
rate is 0.
	y The maximum number of detectable pitches 
is 159 when the measurement mode is [Pin 
Pitch], and 160 when the measurement 
mode is [Pin Width]. More pitches cannot be 
detected.
	y The display range of matching rate and the 
setting range of threshold can be changed to 0 
to 999.
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	� Hi-Sp.Adj tool
A tool to correct for differences in position of a target by 
searching the edge feature of a registered “OK” image.
The Hi-Sp.Adj tool is used with other detection tools. 
Compared with the normal position adjustment tool, 
the Hi-Sp.Adj tool allows for a high speed adjustment 
process.
Select either 1-Axis Adjustment which corrects X axis 
position or Y axis position, or 2-Axis Adjustment which 
corrects both directions of X axis and Y axis.

 “High-Speed Position Adjustment Tool” (page 4-92)

Tool settings

Position adjustment window
Tool window

Master Image

Processing during an operation

Position adjustment window
Tool window

Position adjustment 
process

	yBy using Hi‑Sp.Adj tool, processing time 
increase is smaller than that of the Position 
Adjustment tool.
	yWhen using the Hi-Sp.Adj tool with an 
Outline tool, the high speed adjustment 
tool will adjust the search range. The 
outline of the target is searched in the 
adjusted search range and the searched 
outline will be judged.
	y If the Hi‑Sp.Adj fails, the result of the 
Position Adjustment tool is NG. In addition, 
all other detection tools will not perform 
their judgment process. Failure of Hi-Sp.
Adj can be checked with the Hi-Sp.Adj 
output. Review the Hi-Sp.Adj settings and 
the position determining accuracy for a 
target.

 ‌�“4. Output Assignment (Setting Details 
of Outputting to Output Line)” (page 
4-147)

	yWhen the Hi-Sp.Adj tool is added, the 
following settings for the detection tools 
which have been set will be changed.

Outline tool

When the search range 
is set as the entire 
range, the search range 
will be initialized to the 
default value in which 
the Hi‑Sp.Adj is enabled.

Color Area/ 
Area tool

When the window shape 
is set as the entire 
range, the window 
shape will be initialized 
to the default value in 
which the Hi‑Sp.Adj is 
enabled.

EdgePixels 
tool

When the window shape 
is set as the entire 
range, the window 
shape will be initialized 
to the default value in 
which the Hi‑Sp.Adj is 
enabled.

	y In standard mode, multiple high-speed 
position adjustment tools can be set in 
each program. If multiple high-speed 
position adjustment tools are set, you can 
set which high-speed position adjustment 
tool will be applied to each detection tool.
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Advanced tools 2

	�OCR Tool
A tool used to determine whether the text and date of 
the object match the registered “OK” image text and 
date.
 “OCR Tool” (page 4-97)

Master Image

Tool settings Master text extraction  
(character reading)

Master date extraction  
(date reading)

EXP. date
0 1 . 1 0 . 2 0 x x

EXP. date
0 1 . 1 0 . 2 0 x x

2 000 x x. .11

Processing and judgment during an operation
Internal processing <Judge is OK>

EXP. date
0 1 . 1 0 . 2 0 x x

EXP. date
0 1 . 1 0 . 2 0 x x

2 000 x x. .11

The text and date on the object are read and compared 
to the text and date on an “OK” image.

Example when the result was NG
Character/date is 

wrong
Character/date is 

incomplete

EXP. date
0 2 . 1 0 . 2 0 x x

EXP. date
0   . 1 0 . 2 0 x x

	y The matching rate is indicated as 0 or 100.
If all the text or date match, 100 is displayed. If  
the text or date does not match, or the number 
of letters does not match, 0 is displayed.
	y If the shade contrast function is enabled, the 
matching rate may vary depending on the 
color shading, even if the text and date match. 
The lighter the printing is for the text and date, 
the lower the matching rate will be.

	� EdgePixels tool
A tool to calculate the matching rate of the number of 
edge pixels of a target in comparison to the number of 
edge pixels of a registered “OK” image (100%). Judges 
whether a target is OK or NG by setting the threshold 
for the matching rate.
The EdgePixels tool differs from the Outline tool as the 
target shape is not considered.

 “EdgePixels tool” (page 4-105)

Tool settings
Master Image Edge pixels extract

Processing and judgment during an operation
Internal processing <Judge is OK>

Compares the edge pixels of a target by defining edge 
pixels of an “OK” image as 100%.

Example when the result was NG
Number of edge pixels  

is high
Number of edge pixels  

is low

	y The matching rate is indicated in 0 to 100 
(default).
100 indicates that edge pixels are completely 
matched.
The matching rate decreases as the edge 
pixels of a target drop off.
	y The setting for the display range and threshold 
for the matching rate can be changed to 0 to 
200 or 0 to 999. Also, a target can be judged 
by setting an upper limit for the threshold.

 “Upper Limit” (page 4-107)
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	� Color Prohibition/Brightness Prohibition 
tool
A tool that judges protrusions and misalignment of 
a target into the prohibition range. If protrusion or 
misalignment occurs into the range registered as the 
standard (100%) (protrusion/misalignment prohibited 
area), the matching rate decreases. Judges whether 
a target is OK or NG by setting the threshold for the 
matching rate.
The system judges protrusions and misalignments 
by the area the target is protruding into the specified 
tool window. If the sensor is a color type, the system 
judges by the color area specified by the user. If it is a 
monochrome type, the system judges by the brightness 
area specified by the user.

 “Color Prohibition/Brightness Prohibition tool” (page 
4-109)
Tool settings

Master Image

Color extraction process
(Color type)
Brightness extraction process
(Monochrome type)

Tool window
(Protrusion/misalignment prohibited area)

Correct position

Processing and judgment during an operation
Internal processing <Judge is OK>

Defined as 100% if there are no protrusions or 
misalignments inside the target tool window.

Example when the result was NG
Misalignment Protrusion

Tool window
Tool window

Mask

The matching rate is indicated in 0 to 100. 100 
indicates that there are no misalignments or 
protrusions. The matching rate decreases the 
more the protruded and misaligned area (the 
area the target enters the protrusion prohibited 
area) increases.

	� Blob Count tool
A tool to count the number of blobs of the extracted 
color (brightness) in a set area. Judges whether a target 
is OK or NG by setting the threshold to the number of 
blobs.

 “Blob Count Tool” (page 4-115)
Tool settings

Master Image

Count: 3

Blob extraction with specified color
(Color type)
Blob extraction with specified 
brightness
(Monochrome type)

Detection area

Processing and judgment during an operation
Internal processing <Judge is OK>

Count the blobs within the set area 
range.

Example when the result was NG
The number is few The blob is small

Count: 2 Count: 2

	y The area range is set in Advanced Settings > 
Size Settings.
	y The upper limit of the number of counts is 200 
per tool.
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Main Screen for the Tool Settings
This section explains the main screen for the Tool settings.
When multiple masters is disabled

(10)(9) (11)

(1)

(2)

(3)

(4)

(6)

(7)

When multiple masters is enabled

(10)(9)(8) (11)

(1)

(2)
(3)

(4)
(5)

(6)

(7)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 [Image Type] display
 “Image Types of the Settings Navigator” (page 4-5)

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Master Image
Displays the master image and tool window. If a search 
range is set, a tool window which indicates the range 
(light blue) will be displayed.

(5)	 Master image list (only when multiple masters is 
enabled)
Displays the list of all master images.

(6)	 Tool settings button
Adds, edits, copies, or deletes the tool.

 “Adding/Editing/Copying/Deleting a Tool” (page 4-36)
(7)	 Tool list

Displays a list of tools set in the program and a 
threshold for each tool.
When multiple masters is enabled, the master number 
(  etc.) will be displayed for each tool, and the tools 
for unselected master images will be displayed in gray.

(8)	 All master images display <-> Single master image 
display switching button (only when multiple 
masters is enabled)
Controls whether to display or hide the master image list.

(9)	 [Back] button
Returns to the master registration screen.

	� “2. Master Image Registration (Registering an Image 
as a Reference)” (page 4-20)

(10)	[Next to STEP4] button
Proceeds to the Output Assignment settings.

	� “4. Output Assignment (Setting Details of Outputting 
to Output Line)” (page 4-147)

(11)	[Quit] button
Finishes the Settings Navigator.
 “Finishing the Settings Navigator” (page 4-7)

Adding/Editing/Copying/Deleting a Tool

Adding a Tool
1	Press [Add Tool].

2	Select the tool to be added and press [OK].

3	Adjust setting items for each tool.

	z Basic Tools
 “Learning tool” (page 4-41)
 “Outline tool” (page 4-48)
 “Color Area/Area tool” (page 4-52)
 “Color/Brightness Average Tool” (page 4-59)
 “Position Adjustment Tool” (page 4-66)

	z Extra1
 “Width Tool” (page 4-70)
 “Diameter Tool” (page 4-76)
 “Edge Tool” (page 4-82)
 “Pitch tool” (page 4-86)
 “High-Speed Position Adjustment Tool” (page 4-92)

	z Extra2
 “OCR Tool” (page 4-97)
 “EdgePixels tool” (page 4-105)
 “Color Prohibition/Brightness Prohibition tool” 

(page 4-109)
 “Blob Count Tool” (page 4-115)

4

Settings N
avigator



4-37IV3 Series User’s Manual (PC Software)

3. Tool Settings (Setting the Judgment Method of the Target of Standard Mode)

Editing a tool

1	Select a tool to edit the settings.

Selected tool

2	Press [Edit].

3	Edit setting items for each tool.

	z Basic Tools
 “Learning tool” (page 4-41)
 “Outline tool” (page 4-48)
 “Color Area/Area tool” (page 4-52)
 “Color/Brightness Average Tool” (page 4-59)
 “Position Adjustment Tool” (page 4-66)

	z Extra1
 “Width Tool” (page 4-70)
 “Diameter Tool” (page 4-76)
 “Edge Tool” (page 4-82)
 “Pitch tool” (page 4-86)
 “High-Speed Position Adjustment Tool” (page 4-92)

	z Extra2
 “OCR Tool” (page 4-97)
 “EdgePixels tool” (page 4-105)
 “Color Prohibition/Brightness Prohibition tool” 

(page 4-109)
 “Blob Count Tool” (page 4-115)

Copying a Tool

	yCopies a tool which has been set, and pastes 
it to the same position. The Pos. Adj. tool and 
Hi‑Sp.Adj tool cannot be copied.
	y If 64 tools are set, tools cannot be copied.

1	Select a tool to be copied.

Selected tool

2	Press [Copy].

3	Press [OK].

The copied tool window with the will be selected and 
displayed in the copy source tool window.

Button of the copied tool

Copied tool

The next available tool number which has not 
been set will be automatically assigned as the 
copied tool number.
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4	Press [Edit] and adjust the settings of the copied 
tool.

	z Basic Tools
 “Learning tool” (page 4-41)
 “Outline tool” (page 4-48)
 “Color Area/Area tool” (page 4-52)
 “Color/Brightness Average Tool” (page 4-59)
 “Position Adjustment Tool” (page 4-66)

	z Extra1
 “Width Tool” (page 4-70)
 “Diameter Tool” (page 4-76)
 “Edge Tool” (page 4-82)
 “Pitch tool” (page 4-86)
 “High-Speed Position Adjustment Tool” (page 4-92)

	z Extra2
 “OCR Tool” (page 4-97)
 “EdgePixels tool” (page 4-105)
 “Color Prohibition/Brightness Prohibition tool” 

(page 4-109)
 “Blob Count Tool” (page 4-115)

Deleting a tool

1	Select a tool to be deleted.

Selected tool

2	Press [Delete].

The confirmation screen opens.

3	Press [OK].
The selected tool will be deleted and the sensor returns 
to the main screen for the Tool settings.

Common Setting Items for the Tool 
Settings

Mask settings
Adds a rectangular/circular mask region in the window frame.

	y□ Rect (default): Specifies a rectangular mask region or a 
mask cutting region.
	y○ Circle: Specifies the area to mask the target or remove 
from the mask with a circular window.

1	Press [Mask].

2	Press [Add Mask].
Area inside the mask region is excluded from a 
detection target.

3	Select the mask shape, position, size, and angle 
according to the target.

 “Editing the Window” (page 3-14)

Set the mask shape

4	Press [OK].
The system returns to the screen to set the mask 
region.
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5	Press [Cut Mask] to cut a mask region.
Inside the region removed from the mask, the mask is 
disabled and detection is enabled.

6	Select the shape, position, size, and angle of the 
area to remove from the mask according to the 
target.

 “Editing the Window” (page 3-14)

Set cut shape

7	Press [OK].
The system returns to the screen to set the mask region.

8	Repeat steps 2 to 7 as needed to set the mask 
region.
Adding a mask or removing sections of the mask can be 
performed up to 20 times.

9	Press [OK].

Area not to be 
masked

Area to be masked

Position Adjustment Setting
If multiple position adjustment tools or high-speed position 
adjustment tools are set, you can select a position 
adjustment /high-speed position adjustment tool to be 
applied by each detection tool.

1	Press the [Extended Functions] tab → [Position 
Adjustment Setting] tab of the detection tool.

2	Select the number of the Position Adjustment/
High-Speed Position Adjustment tool to be 
applied from [Pos. Adj. No.].

When master image settings are disabled
	yThe default value when setting the Position 
Adjustment/High-Speed Position Adjustment tool is 
[00:  Pos. Adj.].
	yThe default value when not setting the Position 
Adjustment/High-Speed Position Adjustment tool is 
[00: (Not Set)].
	y If [None] is selected, the Position Adjustment/High-
Speed Position Adjustment tool will not be applied 
(Position adjustment will not be done).

When master image settings are enabled
	yOnly the Position Adjustment/High-Speed Position 
Adjustment tool on the same master image can be 
selected.
	yThe default is [None].
	y If [Do Not Set] is selected, the Position Adjustment/
High-Speed Position Adjustment tool will not be 
applied (Position adjustment will not be done).
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3	Press [OK].
A “+” will appear on the position adjustment/high-speed 
position adjustment window applied to the currently 
selected detection tool.

Tool Name Setting

If the display language (Page 7-30) is changed, 
characters may become unreadable.

A user-defined name such as a name of target can be set to 
tools (up to 16 characters).
This section explains it using an example of the [Outline] 
tool.

1	Input any name into the text box.
Up to 16 characters in alphanumeric can be set.

The tool name can be confirmed in the main screen in 
[Run].

 “Chapter 5 Running” (page 5-1)

Switch Master Image (only when multiple 
masters are enabled)

When multiple masters are enabled, the master image to 
which to add a tool can be switched.
This section explains it using an example of the [Outline] 
tool.

1	Press [Switch Master Image].

2	Select a master image on the master image 
switching screen, and press [OK].

The master image to which to add the tool will be 
switched.
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Learning tool

	z Setting items for the Learning tool settings

Items Description

Add 
Learning  

Tool

Window Shape Select the window shape to specify the area of the target to detect.

Mask

Adds a rectangular/circular mask region in the window frame. Areas inside 
the mask region are excluded from learning on the target to be detected. 
In addition, a mask cutting region can be added in the mask region. Inside 
the mask cutting region, the mask is disabled and it becomes the target of 
learning. Adding a mask or removing sections of the mask can be performed 
up to 20 times.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. 
Tool names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

Learning 
OK/NG 
targets

Add OK
Registers LIVE images as the OK target/NG target.

Add NG

From File Imports images to be registered as the OK target/NG target from files saved 
in the PC.

From History Imports images to be registered as the OK target/NG target from the image 
history.

Start Learning Learns the OK images/NG images.

	z Setting items for the Learning tool settings (advanced settings)

Items Description Ref.

Add 
Learning  

Tool
Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to 

be applied to the learning tool can be selected. 4-39

Learning 
OK/NG 
targets

Variable Brightness
Sets whether to register multiple images of different brightness 
when registering the OK target/NG target.
To use variable brightness, the target must not be moving.

4-46
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Learning tool settings screen

(8)(7) (9)

(5)
(6)

(1)

(2)

(3)

(4)

(1)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(2)	 Master Image
Displays the master image, tool window for the learning 
tool, and position adjustment window for the position 
adjustment tool.

(3)	 Tool operation button
Adds, edits, or deletes the learning tool and position 
adjustment tool.

(4)	 Tool selection button
Selects the tool to confirm/edit/delete the setting 
contents.

(5)	 Condition Display
Displays the condition of the learning settings.

Display Status

Learning Tool 
Not Set

The tool window for the learning tool 
is not set.

Not learned OK work/NG work learning has not 
been completed.

Learned OK target/NG target learning has 
been learned.

Relearning 
required

Relearning is needed because of a 
setting change.

(6)	 [Learning OK/NG targets] button
Performs the imaging and learning of OK/NG work.

 “OK/NG Target Learning for the Learning Tool” 
(page 4-44)

(7)	 [Back] button
Returns to the master registration screen.

	� “2. Master Image Registration (Registering an Image 
as a Reference)” (page 4-20)

(8)	 [Next to STEP4] button
Proceeds to the Output Assignment settings.

	� “4. Output Assignment (Setting Details of Outputting 
to Output Line)” (page 4-147)

(9)	 [Quit] button
Finishes the Settings Navigator.
 “Finishing the Settings Navigator” (page 4-7)
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OK/NG Target Learning Screen

(11)(10)

(6)

(6)

(4)
(5)

(5)

(3)

(7)

(7)

(8)

(8)

(1)

(2)

(1)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(2)	 Image taken by the sensor
Displays an image taken by the sensor.

(3)	 [From File] button
Registers an image saved in the PC as OK target or NG 
target.

 “Registration of Image Saved in PC” (page 4-47)
(4)	 [From History] button

Registers an image of the running image history as OK 
target or NG target.

 “Registration of Image from the Image History” 
(page 4-46)

(5)	 Registered image
Displays the last registered image.

(6)	 Operation buttons

Deletes all registered images.

Deletes the last registered image so that it can be 
redone.

The registered image can be expanded and 
checked.
When registering multiple images, they can be 
confirmed with the move buttons.

(7)	 Number of images registered
Displays the number of images registered.

If the learning brightness change is [ON], by 
registering the first image, nine images are 
registered including the brightness change 
images (eight images).

(8)	 [Add OK]/[Add NG] button
Press [Add OK] when registering a capture image as an 
OK target. Press [Add NG] when registering a capture 
image as an NG target.
Registers at least one image each.
Repeat the operation so that multiple images can be 
registered as well.

(9)	 Condition Display
Ready to Learn....�OK target and NG target image 

registration have been completed, and 
the sensor is ready to start learning.

(10)	[Start Learning] button
Starts the learning.

(11)	[Cancel] button
Returns to the main screen of the learning settings.
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Add Learning Tool

1	Start the Settings Navigator.
 “Starting the Settings Navigator” (page 4-4)

2	Display the learning tool settings screen.
 “Settings Navigator Screen and Operation Flow” 

(page 4-6)

3	Press [Add Learning Tool].
The tool window settings screen for the learning tool will 
be displayed.

The tool window will be displayed on the master image. 
Select the window shape, position, size, and angle 
according to the target.

 “Editing the Window” (page 3-14)

Set the position, size, and 
angle

	y The tool window size should be set 
according to the size of the image where 
the difference between an “OK” and “NG” 
target is clear.

 �“Optimizing the Size of the Tool 
Window” (page 6-19)

	y If misalignment of the tool window occurs 
because of target position misalignment 
when optimizing the window, set the 
position adjustment tool.

 �“Position Adjustment Tool” (page 4-66)

4	Add or Adjust the [Mask] as needed.
 “Mask settings” (page 4-38)

5	Perform the position adjustment setting as 
needed.

 “Position Adjustment Setting” (page 4-39)

6	Perform the settings for the tool name as needed.
 “Tool Name Setting” (page 4-40)

7	Press [OK].
The system returns to the learning tool settings screen.

OK/NG Target Learning for the Learning Tool

1	Press [Learning OK/NG targets].
 “Learning tool settings screen” (page 4-42)

2	Register [OK Target].

	z Registration of Taken Image
 “Registration of Taken Image” (page 4-46)

	z Registration of Image from the Image 
History

 “Registration of Image from the Image History” 
(page 4-46)

	z Registration of image saved in a file
 �“Registration of Image Saved in PC” (page 4-47)

The registered image will be displayed.

If multiple learning tools are set, capture 
a target where all learning tool judgments 
are OK. Learning cannot be performed 
correctly on a target with mixed OK and NG 
judgments.
In this case, perform additional learning.

 �“Learning Multiple Images for Stability” 
(page 6-20)
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3	Register [NG Target].
The registration method is the same as step 2.

	yWhen setting multiple learning tools, a 
screen for selecting OK or NG will appear 
for each learning tool at registering an NG 
target. Select OK or NG.

	yBe sure to register a target or background 
to be judged as an NG in one of the 
multiple learning tools.

The registered image will be displayed.

4	Repeat step 2 or step 3 when registering multiple 
images.

By capturing multiple images of different 
judgment criteria, the judgment stability will 
be improved automatically.

 “Learning Multiple Images for Stability” 
(page 6-20)

5	Press [Start Learning].

6	Check the registered image and press [OK].

The system returns to the learning tool settings screen.

When the learning settings are completed, 
[Learned] will be displayed.
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	� Registration of Taken Image

1	When changing the [Variable Brightness] setting, 
select the [Extended Functions] tab.

Variable brightness can be ON in the following 
cases.

	yDuring internal trigger
	yWhen pressing [T] with external trigger set to 
image by using the internal trigger.

2	Image a target to be registered.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If an external trigger cannot be input, press [T] to take 
an image of the target by temporarily using the internal 
trigger.

3	Press [Add OK] or [Add NG].

The captured image will be displayed.

	� Registration of Image from the Image 
History

1	Press [From History].

2	Select the image to be registered, and press [OK].

Select the 
image

3	Press [Registered as OK] or [Registered as NG].

The registered image will be displayed.
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	� Registration of Image Saved in PC

1	Press [From File].

2	Select the file to be imported, and press [Open].

Select the file

3	If a batch backup file (*.iv3a) or individual program 
backup file (*.iv3a) is selected, select the image 
type to be imported from the following.

	yRunning Image History
	yMaster Image
	y Learned Image History

Select the target program when the Learned Image 
History is selected.

The list of images saved as the selected file image type 
will be displayed.

4	Select the image to be registered, and press [OK].

Select the 
image

The registered image will be displayed.

5	Press [Registered as OK] or [Registered as NG].

The registered image will be displayed.
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Outline tool

	z Setting items for the Outline tool

Items Description

Edit Window
Window Shape Select the window shape used to specify the area of the target to be detected.

Search Range Specifies an area in which to search for the outline of a target. By specifying a 
narrower area as the search range, the processing time will be shortened.

Fine Tune 
Outline

Remove Outline Judges by disabling an unnecessary outline which interrupts the stabilized 
detection. The disabled outlines can be specified by tracing the extracted outline.

Sensitivity The outline extraction sensitivity can be selected according to the target quality.

Limit Adjustment
Adjusts the threshold (matching rate) used in the OK/NG judgment. During threshold 
adjustment, the system switches to Test mode so that the threshold can be adjusted 
to an applicable value for operation.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool 
names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	z Setting items for the Outline tool (advanced settings)

Items Description Ref.

Rotation Range

Sets the range of rotation to search for the outline of the target.
The system judges NG if an angle of the target exceeds its rotation range 
even if the target is the same shape.

	y If the rotation range is set wide, the acceptable range of variation in the 
angles at which a target can be placed is wider.
	y If the rotation range is set narrow, the processing time can be 
shortened.
	y The direction of the target can be judged by limiting the rotation range.

4-51

Search Algorithm The detection mode of the Outline tool can be changed depending on the 
inspection requirements. 4-51

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be 
applied to the Outline tool can be selected. 4-39
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Setting the Outline Tool

1	Add the [Outline] tool.
 “Adding a Tool” (page 4-36)

The main screen for [Outline] opens.

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

Rect Circle

Set the position, size, and angle

The window angle can be reset using the [Angle 
Reset] button.

3	Set the search range as needed.
 “Search Range Settings” (page 4-50)

4	Adjust the outline as needed.
 “Settings for Disabling Outlines” (page 4-50)
 “Setting a Sensitivity” (page 4-50)

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.	 ] to 
take an image of the target by temporarily using the 
internal trigger.

7	Adjust the threshold for anomaly detection by 
checking the matching rate.
<Setting example>
If the matching rate of an “OK” image is higher than 
90 and if the matching rate of a “NG” image is lower 
than 40, set the threshold to 65, the value intermediate 
between 40 and 90.

Limit Match

	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	y A matching rate of 100 indicates that an 
outline is completely matched. The matching 
rate decreases with differences between the 
outline of the target and the master image.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

	� “Matching Rate of the Outline Tool and 
Position Adjustment Tool” (page A-6)

8	Press [OK].
The system returns to the main screen of [Outline].

9	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

10	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� Search Range Settings

1	Press [Partial].

2	Set the tool window to indicate the search range.
 “Editing the Window” (page 3-14)

Search Range

The search range cannot be rotated.

	� Setting a Sensitivity

1	Select the extraction sensitivity of the outline.

The outline which cannot 
be extracted

2	Confirm the condition of the outline extraction, 
which changes according to the selected 
[Sensitivity].

Extracted outline

	� Settings for Disabling Outlines

1	Press [Remove Outline].

2	Specify the unnecessary outline by dragging 
with the mouse.
The specified outline changes from green to yellow.

The outline that the outline 
extraction has disabled 
(yellow)

	y The size of the mouse cursor when specifying 
the unnecessary outlines can be changed in 
[Size].
	y The [Undo] button is applicable up to 20 times.

3	When setting is completed, press [OK].
The system returns to the main screen of [Outline].
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Advanced settings for the Outline Tool

	� Rotation Range

1	Select the [Extended Functions] tab and set the 
rotation range.

2	Press the [Settings] tab.
The system returns to the main screen of [Outline].

	� Search Algorithm

1	Select the [Extended Functions] tab and select 
the search algorithm type (High Accuracy/Mid 
Sens./High Speed).

	y Select [High Accuracy] when detection is 
not stable because of a small difference 
in the matching rate of an “OK” and “NG” 
image.
	y Select [Mid Sens.] when detection is not 
stable because of the influence of an 
unnecessary outline other than the target 
such as the background.
	y Select [High Speed] to shorten the 
processing time.

2	Press the [Settings] tab.
The system returns to the main screen of [Outline].
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Color Area/Area tool

	z Setting items for the color area/area tool

Items Description

Edit Window

Window Shape Selects the window shape to specify an area of the target to be extracted.

Mask

Adds a rectangular/circular mask region in the window frame. The area inside 
the mask region is excluded from the area extraction target. In addition, 
a mask cutting region can be added in the mask region. Inside the region 
removed from the mask, the mask is disabled and the area extraction is 
enabled. Adding a mask or removing sections of the mask can be performed 
up to 20 times.

Color 
Extraction

(For color type)

Extract Color from Image Press the area on the master image to extract the color and set the extraction 
range. 

Extraction Area Adjustment Expands or reduces automatically the extraction area of the color extracted.

LIVE image
The color range to be extracted can be set using the Live image of the target.
In addition, the range of color to be extracted can be based on the image in 
the image history or from an image on a saved file.

Brightness 
Extraction

(For monochrome 
type)

Extract Brightness from 
Image

Press the area on the master image to extract the brightness and set the 
extraction range. 

LIVE image A brightness range to be extracted can be set using the Live image of the 
target.

Limit Adjustment
Adjusts the threshold (matching rate) used in the OK/NG judgment. During 
threshold adjustment, the system switches to Test mode so that the threshold 
can be adjusted to an applicable value for operation.

Upper 
Limit

Upper Limit
Enables an upper limit on the threshold.
Enable when OK/NG judgment is desired for a situation when the target area 
is larger than the area extracted from the master image.

Scale When the upper limit of the threshold is ON, select the threshold scale 
according to the range of the matching rate required for judgment.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool 
names can be checked on the run screen.

	� “Chapter 5 Running” (page 5-1)

	z Setting items for the color area/area tool (advanced settings)

Items Description Ref.

Advanced Color Extraction
(For color type)

Advanced Brightness 
Extraction

(For monochrome type)

	yColor type
Specifies a color to be extracted using HSV (H: Hue, S: Saturation, V: 
Brightness).

4-57	yMonochrome type
Specifies the brightness value to be extracted.

LIVE image The color/brightness range to be extracted can be set using the Live image of the 
target.

Fixed Reference Area Select the condition for which the matching rate of the Color Area/Area is 100%. 4-58

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be applied to the 
Color Area/Area tool can be selected. 4-39
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Setting the Color Area/Area Tool

1	Add the [ColorArea] tool (color type) or [Area] 
tool (monochrome type).
In the screen that appears by selecting [Color Tools], 
select [ColorArea] or [Area] and press [OK].

 “Adding a Tool” (page 4-36)

The main screen for [ColorArea]/[Area].

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

Rect Circle

Set the position, size, and angle

When [Entire] is selected, the tool window will be 
hidden.

The window angle can be reset using the [Angle 
Reset] button.

3	Apply the mask as needed.
 “Mask settings” (page 4-38)

4	Set the area to extract from the target.

	z For color type
Press [Settings] of the color extraction.

The screen to select a color to be extracted opens.
Press the color to be the reference of judgment for the 
area.

Press

The pressed color will be extracted.
	y If the areas of color that have not been extracted 
are pressed repeatedly, the extraction range can be 
increased.
	yPress [Exclude] to specify the color to exclude from 
the extracted color.
	yPress the [+]/[-] of the extraction area adjustment, and 
the range of color to be extracted can be expanded/
reduced.
	yPress [Undo] to cancel the previous operation 
(UNDO).
	yTo re-extract the color, press [Clear] and then press 
the color to be the reference of judgment again.
	yBy pressing [LIVE image], the range of color to be 
extracted can be set based on the file image saved 
in the Live image/Running image history/PC of the 
target.

 “Adjusting in the Live Image” (page 4-55)

When setting is completed, press [OK].
The system returns to the main screen for [ColorArea].
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	z For monochrome type
Press [Settings] of the brightness extraction.

The screen to select brightness to be extracted opens.
Press the brightness to be the reference of judgment for 
the area.

Press

The pressed brightness will be extracted.
	y If the areas of brightness that have not been extracted 
are pressed repeatedly, the extraction range can be 
expanded.
	yAdjust the slider, and the range of the brightness to be 
extracted can be expanded/reduced.

 “Editing Numbers” (page 3-15)
Pressing [+]/[-] can set the upper and the lower limit 
of brightness in a range within 0 to 255 with the 
extracted brightness as a reference.
	yPress [Undo] to cancel the previous operation 
(UNDO).
	yTo re-extract the brightness, press [Clear] and then 
press the color to be the reference of judgment again.
	yBy pressing [LIVE image], the range of brightness to 
be extracted can be set based on the Live Image of 
the target.

When setting is completed, press [OK].
The system returns to the main screen for [Area].

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

7	Adjust the threshold for anomaly detection by 
checking the matching rate.
<Setting example>
If the matching rate of an “OK” image is higher than 
90 and if the matching rate of a “NG” image is lower 
than 40, set the threshold to 65, the value intermediate 
between 40 and 90.

Limit Match

	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	y The matching rate is 100 when an area 
matches perfectly. This becomes smaller with 
a narrower area and larger with a wider area. 
If the matching rate exceeds the upper limit 
of the threshold range, the matching rate will 
display as the upper limit of the threshold 
range.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	� “Shortening the Processing Time” (page 6-26)

8	Set the upper limit as needed.
 “Upper Limit” (page 4-56)

9	When setting is completed, press [OK].
The system returns to the main screen for [ColorArea]/
[Area].

10	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

11	Press [OK].

The system returns to the main screen for the tool 
settings.

4

Settings N
avigator



4-55IV3 Series User’s Manual (PC Software)

3. Tool Settings (Setting the Judgment Method of the Target of Standard Mode)

	� Adjusting in the Live Image

1	Press [LIVE image].

The Master image (top) and Live image (bottom) are 
displayed.
When adjusting with the LIVE image, go to step 3.

2	When adjusting with other than the Live image, 
press the drop-down menu to import the image.

	z When importing from a file saved in the PC
Select [File].

Select the file to be imported, and press [Open].

Select the file

When selecting a batch backup file (*.iv3a) or individual 
program backup file (*.iv3a), select the image type from 
the following, and press [OK].

	yRunning Image History
	yMaster Image
	y Learned Image History

Select the target program when the Learned Image 
History is selected.

The list of images saved as the selected file image type 
will be displayed.
Select the image to be imported, and press [OK].

Select the 
image

Check the image and press [OK].

The imported image will be displayed on the bottom 
side of the screen.

	z When importing from the running image 
history
Select [Image History].

Select the image to be imported, and press [OK].

Select the 
image

Check the image and press [OK].

The imported image will be displayed on the bottom 
side of the screen.
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3	Adjust the color extraction area by checking the 
matching rate.

Match

By selecting the [Extract] or [Exclude] button and 
pressing on an image (Master/Live/Log), the color 
extraction area can be adjusted.

	yPress [Extract], and if the areas of color that have not 
been extracted are pressed repeatedly, the extraction 
range can be expanded. 
	yPress [Exclude] to specify the color to exclude from 
the extracted color.
	yPress [+]/[-], and the range of color to be extracted 
can be expanded/reduced.
	yTo re-extract the color, press [Clear] and then press 
the color to be the reference of judgment again.

4	After setting is completed, press [Return to 
Master Image].

	� Upper Limit

1	Switch the check box to ON for [Upper Limit].

The sliders to set the upper limit and the lower limit of 
the threshold will be displayed.
Select the Settings scale from [0-200] or [0-999] 
according to the range of the matching rate necessary 
for judgment.

OFF (default)
Sets the upper and the lower limit of 
the threshold in a range within 0 to 
100.

ON

0-200
(default 
value)

Sets the upper and the lower limit of 
the threshold in a range within 0 to 
200.

0-999

Sets the upper and the lower limit of 
the threshold in a range within 0 to 
999.
The slider movement unit is 5.

2	Adjust the threshold for anomaly detection by 
checking the matching rate.

MatchThreshold (lower limit)

Threshold (upper limit)

	y A target is detected as OK if the matching rate 
is between the lower limit and the upper limit, 
and detected as NG if the matching rate is 
greater than the upper limit or smaller than the 
lower limit. 
	y The matching rate is 100 when an area 
matches perfectly. This becomes smaller with 
a narrower area and larger with a wider area. 
If the matching rate exceeds the upper limit 
of the threshold range, the matching rate will 
display as the upper limit of the threshold 
range.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

3	When setting is completed, press [OK].
The system returns to the main screen for [ColorArea]/
[Area].
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Advanced settings of the ColorArea/Area 
Tool

	� Advanced Color Extraction/Advanced 
Brightness Extraction

1	Select the [Extended Functions] tab and press 
[Settings] of [Advanced Color Extraction].
For a monochrome type, press [Settings] of [Advanced 
Brightness Extraction].

2	Specify a color or brightness of the extraction 
target.

	z For color type

	y You can adjust the value by slider while 
confirming the color histogram. The values 
within the range specified by the sliders will be 
used as the brightness.
	y The vertical axis indicates the extracted pixel.
	y Among the pixels of each color to be extracted, 
the maximum one becomes the maximum 
value of the vertical axis.
	y The range and extraction rules in the color 
extraction detailed settings are shown as 
follows.

H

Set the upper limit and lower limit for 
the range of 0 to 359.

	y Lower limit ≤ Upper limit
The extraction range of a color is from 
the lower limit to the upper limit.
	y Lower limit > Upper limit
The extraction range of a color is 
from 0 to the upper limit, and from the 
lower limit to 359.

S Set the upper limit and lower limit for 
the range of 0 to 255.
The extraction range of a color is from 
the lower limit to the upper limit.V

	y By pressing [LIVE image], the range of the 
extracted color can be set based on the Live 
Image of the target.
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	z For monochrome type

	y Adjust the value by slider while confirming the 
monochrome histogram.
The values within the range specified by the 
sliders will be used as the brightness.
	y The vertical axis indicates the extracted pixel.
Among the extracted pixels of each brightness, 
the one that has the most pixels becomes the 
maximum value of vertical axis.
	y The range and extraction rules in the extraction 
detailed settings are shown as follows.

V

Set the upper limit and lower limit for 
the range of 0 to 255.
The extraction range of the brightness 
is from the lower limit to the upper limit.

	y By pressing [LIVE image], the range of 
brightness to be extracted can be set based 
on the Live Image of the target.

3	Press [OK].
The system returns to the main screen for [ColorArea]/
[Area].

	� Fixed Reference Area
	y Select [Enable] if the master image does not 
contain the color/brightness to be used for 
judgment.
	y “Color Prohibition/Brightness Prohibition 
tool” (page 4-109) is helpful for judging target 
protrusions and misalignments.

1	Select the [Extended Functions] tab and press 
[Settings] for [Fixed Reference Area].

2	Adjust the fixed reference area settings.

3	Press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen for [ColorArea]/
[Area].
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Color/Brightness Average Tool

	z Setting Items for the Color/Brightness Average tool

Items Description

Master Color Settings
(For color type)

Master Bright. Settings
(For monochrome type)

Window Shape Select the window shape to specify an area of the target to be 
extracted.

Angle Reset When the window shape is set to [□Rect], resets the angle of the window.

Mask

Adds a rectangular/circular mask region in the window frame. The 
area inside the mask area is excluded from the color and brightness 
average. In addition, adds a rectangular/circular cutting region in the 
mask region. The mask is disabled inside the mask cutting region and it 
becomes the target of color and brightness average. Adding a mask or 
removing sections of the mask can be performed up to 20 times.

Limit Adjustment
Adjusts the threshold (matching rate) used in the OK/NG judgment. 
During threshold adjustment, the system switches to Test mode so that 
the threshold can be adjusted to an applicable value for operation.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. 
Tool names can be checked on the run screen.

	� “Chapter 5 Running” (page 5-1)

	z Setting Items for the Color/Brightness Average tool (advanced settings)

Items Description Ref.

Color Range Settings
(For color type)

Brightness Range Settings
(For monochrome type)

	yColor type
Specifies the judgment sensitivity for the color extracted from the master 
image.

	yMonochrome type
Specifies the judgment sensitivity for the brightness extracted from the master 
image. 4-61

LIVE image The color range to be extracted can be set using the Live image of the target.

From a Hist. Imports images to be used for the judgment sensitivity from the running image 
history.

From File Imports an image used for the judgment sensitivity from a file saved on your 
computer.

Spec. Method Selects how to specify the master color/brightness. 4-65

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be applied to 
the Color/Brightness Average tool can be selected. 4-39
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Setting the Color/Brightness Average Tool

1	Add the [ColorAverage] tool (color type) or 
[Bright. Avg.] tool (monochrome type).
In the screen that appears by selecting [Color Tool], 
select [ColorAverage]/[Bright. Avg.] and press [OK].

 “Adding a Tool” (page 4-36)

The main screen for [ColorAvg.]/[Bright. Avg.] opens.

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

 “Editing the Window” (page 3-14)

Rect Circle

Set the position, size, and angle

When [Entire] is selected, the tool window will be 
hidden.

The window angle can be reset using the [Angle 
Reset] button.

	y The average color or average brightness 
value is automatically extracted from inside 
the window.
	yOnly set the window size to the color or 
brightness area that you want to judge. If 
the background is included, the average 
color or brightness average that includes 
the background color will be registered. 
Therefore, the matching rate difference 
between an “OK” image and a “NG” image 
that you want to judge will decrease.

Good example Bad example

3	Apply the mask as needed.
The area inside the mask area is excluded from 
average color or average brightness extraction.

 “Mask settings” (page 4-38)

4	Press [Live Adjustment].

The sensor changes to the test operation.

5	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.
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6	Adjust the threshold for anomaly detection by 
checking the matching rate.
<Setting example>
If the matching rate of an “OK” image is higher than 
90 and if the matching rate of a “NG” image is lower 
than 40, set the threshold to 65, the value intermediate 
between 40 and 90.

Limit Match

Average color/brightness of the master 
image
Average color/brightness of the Live 
image

	y 100 indicates that the color and brightness 
is completely matched. The matching rate 
decreases as the color or brightness of the 
target differs. For the color average tool, the 
smallest matching rate for H/S/V calculated 
individually will be the matching rate for the 
tool.
	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

7	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

Advanced settings of the Color/Brightness 
Average tool

	� Color Range Settings /Brightness Range 
Settings

1	Select the [Extended Functions] tab and press 
[Settings] of [Color Range Settings].
For a monochrome type, press [Settings] of [Brightness 
Range Settings].

2	Select an image for which you want to adjust the 
color/brightness area.
If you want to use the master image, go to step 3.

	z To use the Live image
Press [LIVE image].
The color area can be set based on the Live image of 
the target.

	z When importing from the image history
Press [From a Hist.] to select the image that is desired 
to be used.

For details of how to perform this operation, refer 
to  “When importing from the running image 
history” (page 4-55).

	z When importing from a file saved in the PC
Press the [From File] button to select the file that is 
desired to be imported.

For details of how to perform this operation, 
refer to  “When importing from a file saved in 
the PC” (page 4-55).

When selecting a batch backup file (*.iv3a) or individual 
program backup file (*.iv3a), select the image type from 
the following.

	yRunning Image History
	yMaster Image
	y Learned Image History

Select the target program when the Learned Image 
History is selected.
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3	Select the color/brightness judgment sensitivity.

	z For color type

	y Selecting [High Sensitivity]/[Normal 
Sensitivity]/[Low Sensitivity] automatically 
sets the judgment area. (The average color 
(HSV) value is the center of the master 
image window.)
	y To narrow the OK area, select [High 
Sensitivity]. This enables small color 
differences to be differentiated.
	y To widen the OK area, select [Low 
Sensitivity]. This setting makes judgment 
resistant to individual OK color differences 
and light interference.
	y [Manual] enables the desired area to be set 
as needed.
	yRe-registering the master image or 
registering an external master image 
automatically updates the area in 
conjunction with the average color for 
the updated master image. If [Manual] is 
selected, it is automatically updated while 
retaining the specified area.

	�Selecting sensitivity on the master image

(2)

(4)
(3)

(1)

No. Description

(1)
Selects the color judgment sensitivity ([High 
Sensitivity]/[Normal Sensitivity] (default)/[Low 
Sensitivity]/[Manual]).

(2)

The following items are displayed on the bar graph 
(H/S/V).

	y (Average color value of the master image)
	y Solid line (color judgment sensitivity area)
	yDotted line (threshold area of the color average 
tool)

Bar graph scale
H	 :	� Automatically adjusts the average 

color value of the master image to 
be centered on the bar.

S/V	 :	Left end is 0 and right end is 255.

(3) Displays the average HSV value of the master 
image.

(4) Displays the average color of the master image.

	�Selecting sensitivity on an image other than the 
master image

(2)

(4)
(5)

(3)

(6)

(7)

(1)

No. Description

(1)
Selects the color judgment sensitivity ([High 
Sensitivity]/[Normal Sensitivity] (default)/[Low 
Sensitivity]/[Manual]).

(2)

	y The following items are displayed on the bar 
graph (H/S/V).

	y (Average color value of the master image)
	y (Average color value of the Live image)
	y  �(Average color value of the image file or 

history image)
	y Solid line (color judgment sensitivity area)
	yDotted line (threshold area of the color average 
tool)

	yDisplays the total status result for each sensitivity 
on the right side of the bar graph (H/S/V). When 
all status results are OK, the total status result for 
the tool will be OK.

Status result
(Green: OK; red: NG)

Bar graph scale
H	 :	� Automatically adjusts the average 

color value of the master image to 
be centered on the bar.

S/V	 :	Left end is 0 and right end is 255.

(3) Displays the average HSV value of the master 
image.

(4) Displays the average color of the master image.

(5) Displays the average HSV value of the imported 
image.

(6) Displays the average color of the imported image.

(7) Presses this when setting is completed.

4

Settings N
avigator



4-63IV3 Series User’s Manual (PC Software)

3. Tool Settings (Setting the Judgment Method of the Target of Standard Mode)

Relationship between the color judgment 
sensitivity and matching rate

	yWhen the average color of the target matches 
the average color of the master image, the 
matching rate is 100. The matching rate 
decreases as the difference between the 
average color of the target and master image 
increases. The sensitivity area is automatically 
adjusted so that the matching rate becomes 
70.

100

70

HSV sensitivity 
range
Matching rate 
threshold range

Match

H/S/V

Color average

Limit

	y The color average tool individually calculates 
the matching rate of H (hue)/S (saturation)/V 
(brightness) for the target.
	y The smallest matching rate for H/S/V 
calculated individually will be the matching rate 
for the color average tool.

	�When [Manual] is selected
The OK range can be adjusted as needed. 

Adjust the 
range with the 
slider

For an image other than the master image, the average 
color value of the imported image is displayed.

	z For monochrome type

	y Selecting [High Sensitivity]/[Normal 
Sensitivity]/[Low Sensitivity] automatically 
sets the judgment area. (The average 
brightness value is the center of the master 
image window.)
	y To narrow the range of OK brightness, 
select [High Sensitivity]. This enables small 
brightness differences to be differentiated.
	y To widen the range of OK brightness, 
select [Low Sensitivity]. This setting makes 
judgment resistant to individual brightness 
differences and light interference.
	y [Manual] enables the desired area to be set 
as needed.
	yRe-registering the master image or 
registering an external master image 
automatically updates the area in 
conjunction with the average brightness 
for the updated master image. If [Manual] is 
selected, it is automatically updated while 
retaining the specified area.

	�Selecting sensitivity on the master image

(4)
(3)

(1)

(2)

No. Description

(1)
Selects the brightness judgment sensitivity 
([High Sensitivity] / [Normal Sensitivity] (default) / 
[Low Sensitivity]/[Manual]).

(2)

The following items are displayed on the bar graph.
	y (Average brightness value of the master 
image)
	y Solid line (brightness judgment sensitivity area)
	yDotted line (threshold area of the brightness 
average tool)

The bar graph scale is from 0 on the left 
to 255 on the right.

(3) Displays the average brightness value of the 
master image.

(4) Displays the average brightness of the master 
image.

4

Settings N
avigator



4-64 IV3 Series User’s Manual (PC Software)

3. Tool Settings (Setting the Judgment Method of the Target of Standard Mode)

	�Selecting sensitivity on an image other than the 
master image

(2)

(4)
(5)

(3)

(6)

(7)

(1)

No. Description

(1)
Selects the brightness judgment sensitivity 
([High Sensitivity] / [Normal Sensitivity] (default) / 
[Low Sensitivity]/[Manual]).

(2)

	y The following items are displayed on the bar 
graph.

	y 	� (Average brightness value of the master 
image)

	y 	� (Average brightness value of the Live 
image)

	y ( 	�Average brightness value of the image file 
or history image)

	y Solid line (brightness judgment sensitivity area)
	yDotted line (threshold area of the brightness 
average tool)

	y The tool status result is displayed on the right side of 
the bar graph.

Status result
(Green: OK; red: NG)

The bar graph scale is from 0 on the left 
to 255 on the right.

(3) Displays the average brightness value of the 
master image.

(4) Displays the average brightness of the master 
image.

(5) Displays the average brightness value of the 
imported image.

(6) Displays the average brightness of the imported 
image.

(7) Presses this when setting is completed.

Relationship between the brightness judgment 
sensitivity and matching rate

	yWhen the average brightness of the target 
matches the average color of the master 
image, the matching rate is 100. The matching 
rate decreases as the difference between the 
average brightness of the target and master 
image increases. The sensitivity area is 
automatically adjusted so that the matching 
rate becomes 70.

100

70

Sensitivity range

Matching rate 
threshold range

Match

Brightness

Brightness 
average

Limit

	�When [Manual] is selected
The OK range can be adjusted arbitrarily.

Adjust the 
range with the 
slider

For an image other than the master image, the average 
brightness value of the imported image is displayed.

4	When setting is completed, press [OK].
The system returns to the main screen for the extended 
functions settings.

5	Press the [Settings] tab.
The system returns to the main screen for [ColorAvg.]/
[Bright. Avg.].
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	� Specify Method

1	Select the [Extended Functions] tab and press 
[Settings] of [Spec. Method].
For a monochrome type, press [Settings] of [Spec. 
Method].

2	Select how to specify the master color/
brightness.

When updating the master color/brightness 
registered for the master image, select [From 
Mst.Img.].

	z From Mst.Img. (default)
The average color/brightness value in the window 
specified with the master image is set as the master 
color/brightness.
If the master image is updated, the master color is 
automatically updated.

	z Direct Input
Input the HSV value/brightness to specify the master 
color/brightness.
Even if the master image is updated, the master color is 
not automatically updated.

3	Press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen for [ColorAvg.]/
[Bright. Avg.].
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Position Adjustment Tool

	z Setting items for the Position Adjustment tool

Items Description

Edit Window

Window Shape Select the shape of the window to specify the area of the target used as the 
position adjustment reference.

Search Range
Specifies an area in which to serve as the reference of position adjustment for a 
target. By specifying a narrower area as the search range, the processing time will 
be shortened.

Fine Tune 
Outline

Remove Outline Judges by disabling an unnecessary outline which interrupts the stabilized 
detection. The disabled outlines can be specified by tracing the extracted outline.

Sensitivity The outline extraction sensitivity can be selected according to the target quality.

Limit Adjustment

Adjusts the threshold (matching rate) which judges whether the position 
adjustment succeeds or fails. During threshold adjustment, the system switches 
to Test mode so that the threshold can be adjusted to an applicable value for 
operation.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool 
names can be checked on the run screen.

	� “Chapter 5 Running” (page 5-1)

	z Setting items for the Position Adjustment tool (Advanced Settings)

Items Description Ref.

Rotation Range

Sets the range of rotation to adjust the position for the target.
The status result of the position adjustment is NG and position is not adjusted if the angle 
of rotation of the target exceeds its rotation range.

	y If the rotation range is set wide, the acceptable range of variation in the angles at which 
a target can be placed is wider.
	y If the rotation range is set narrow, the processing time can be shortened.

4-69

Search Algorithm The algorithm used to search for the Position Adjustment tool can be adjusted depending 
on the inspection requirements. 4-69
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Setting of the Position Adjustment Tool

1	Adds the [Pos. Adj.] tool.
 “Adding a Tool” (page 4-36)

The main screen for [Pos. Adj.] opens.

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

 “Editing the Window” (page 3-14)

Set the position, size, and 
angle

Rect Circle

Set the position and size of the position 
adjustment tool to capture as much of a 
part that is common amongst all targets as 
possible.

 “Stabilizing the Position Adjustment” 
(page 6-21)

The window angle can be reset using the [Angle 
Reset] button.

3	Set the search range as needed.
 “Search Range Settings” (page 4-68)

4	Adjust the outline as needed.
 “Settings for Disabling Outlines” (page 4-68)
 “Setting a Sensitivity” (page 4-68)

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Image the target.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

7	Adjust the threshold to judge whether or not the 
position adjustment succeeds by checking the 
matching rate.

Limit Match

	y If there are many variations of the target shape 
that the position adjustment tool has been set 
to, set the threshold to a lower matching rate.
	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

8	When setting is completed, press [OK].
The system returns to the main screen for [Pos. Adj.].

9	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

10	Press [OK].

The system returns to the main screen for the tool 
settings.

4

Settings N
avigator



4-68 IV3 Series User’s Manual (PC Software)

3. Tool Settings (Setting the Judgment Method of the Target of Standard Mode)

	� Search Range Settings

1	Press [Partial].

2	Set the tool window to indicate the search range.
 “Editing the Window” (page 3-14)

Search Range

The search range cannot be rotated.

	� Setting a Sensitivity

1	Select the extraction sensitivity of the outline.

The outline which cannot 
be extracted

2	Confirm the condition of the outline extraction, 
which changes according to the selected 
[Sensitivity].

Extracted outline

	� Settings for Disabling Outlines

1	Press [Remove Outline].

2	Specify the unnecessary outline by dragging 
with the mouse.
The specified outline changes from green to yellow.

The outline that the outline 
extraction has disabled 
(yellow)

	y The size of the mouse cursor when specifying 
the unnecessary outlines can be changed in 
[Size].
	y The [Undo] button is applicable up to 20 times.

3	Press [OK].
The system returns to the main screen for [Pos. Adj.].
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Advanced settings of the Position 
Adjustment tool

	� Rotation Range

1	Select the [Extended Functions] tab and set the 
rotation range.

2	After setting is completed, press the [Settings] 
tab.
The system returns to the main screen for [Pos. Adj.].

	� Search Algorithm

1	Select the [Extended Functions] tab and select 
a search algorithm type (High Accuracy/High 
Speed) for the position adjustment window.

	y Select [High Accuracy] when detection is 
not stable because of a small difference 
in the matching rate of an “OK” and “NG” 
image.
	y Select [High Accuracy] when detection is 
not stable because of the influence of an 
unnecessary outline other than the target, 
such as the background.
	y Select [High Speed] to shorten the 
processing time.

2	After setting is completed, press the [Settings] 
tab.
The system returns to the main screen for [Pos. Adj.].
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Width Tool

	z Setting items for the Width tool

Items Description

Edit Window Specifies the area of the target to be detected using a tool window.

Mask Adds a rectangular mask region in the tool window frame.
The area inside the mask region is excluded from the width detection target.

Automatic Edge Sensitivity 
Adjustment

Automatically adjust the sensitivity that detects the edge that will become the 
standard of reference for width extraction.

(Manual adjustment) Manually adjust the sensitivity that detects the edge that will become the standard of 
reference for width extraction.

LIVE image The edge sensitivity can be adjusted using the Live image from the target.

Limit Adjustment
Adjusts the threshold (matching rate) used in the OK/NG judgment. During threshold 
adjustment, the system switches to Test mode so that the threshold can be adjusted 
to an applicable value for operation.

Upper Limit
Enables an upper limit on the threshold.
Enable when OK/NG judgment is desired for a situation when the target width is 
longer than the width extracted from the master image.

Scale When the upper limit of the threshold is ON, select the threshold scale according to 
the range of the matching rate required for judgment.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool names 
can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	z Setting items for the Width tool (advanced settings)

Items Description Ref.

Width Extraction 
Method Width Mode Select the method used to extract the target width. 4-73

Scaling Setting

Scaling Setting
Sets scaling.
Set when length is being used for anomaly detection instead of the 
matching rate.

4-80
Display Value

When scaling is enabled, inputs the display value in relation to matching 
rate 100. A matching rate of 100 indicates that the width is completely 
matched. The matching rate becomes smaller with a narrower width and 
larger with a wider width.

Copy Setting When scaling is enabled, copy the scaling settings from another tool.

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be 
applied to the Width tool can be selected. 4-39
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Setting the Width Tool

1	Select the [Extra1] tab, and add the [Width] tool.
 “Adding a Tool” (page 4-36)

The [Width] direction selection screen opens.

2	Press [Horizontal Dir.]/[Vertical Dir.].

The main screen for [Width] opens.

3	Set the position, size, and angle of the tool 
window according to the target.

 “Editing the Window” (page 3-14)

Set the position, size, and 
angle

The window angle can be reset using the [Angle 
Reset] button.

4	Apply the mask as needed.
The area inside the mask region is excluded from the 
width detection target.

 “Mask settings” (page 4-38)

5	Adjust the edge sensitivity setting as needed.
 “Edge Sensitivity Settings” (page 4-72)

6	Press [Live Adjustment].

The sensor changes to the test operation.

7	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

8	Adjust the threshold for anomaly detection by 
checking the matching rate.

Match
Threshold (upper limit)

Threshold (lower limit)

	y The target is judged OK when the matching 
rate is within a threshold range, and NG when 
it is outside the range.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

9	Set [Upper Limit] as needed.
 “Upper Limit” (page 4-73)

10	When setting is completed, press [OK].
The system returns to the main screen of [Width].

11	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

12	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� Edge Sensitivity Settings

1	Press [Settings] for [Edge Sensitivity Settings].

2	Adjust the edge sensitivity.

	z When the edge sensitivity is adjusted 
automatically
Press [Automatic Edge Sensitivity Adjustment].

The edge sensitivity will be adjusted automatically 
according to the target.

	z When the edge sensitivity is adjusted manually
Switch the [show edge graph] check box to ON.

Edge graph

LimitON

Adjust the threshold value for edge sensitivity by 
checking the edge graph being displayed.

	y The edge sensitivity limit can be adjusted by 
pressing the red line.
	y Press [LIVE image] to adjust threshold value 
for edge intensity using the target Live image.

The edge intensity threshold indicates the ratio 
of edge recognition taking the edge intensity 
maximum value (where the contrasting density 
is greatest) as 100%.

Edge detection 
direction

Threshold for edge 
sensitivity (%)

(Illustration for edge 
intensity wave)

Threshold for edge sensitivity 50%  
(2 edges to be detected)

Threshold for edge sensitivity 30%  
(4 edges to be detected)

100% in-between

+255

0

100%

30%

50%

0%

Projection 
wave

Edge intensity 
wave

+255

0

3	Press [OK].
The system returns to the main screen of [Width].
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	� Upper Limit

1	Set the upper limit settings.

	z When changing the setting scale
Select [0-999] from the [Scale] drop-down menu.
Adjust the threshold for anomaly detection by checking 
the matching rate.

	y The target is judged OK when the matching 
rate is within a threshold range, and NG when 
it is outside the range.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

	z When the upper limit is disabled
Switch the check box to [OFF] for the upper limit.
Adjust the threshold for anomaly detection by checking 
the matching rate.
<Setting example>
If the matching rate of an “OK” image is higher than 
90 and if the matching rate of a “NG” image is lower 
than 40, set the threshold to 65, the value intermediate 
between 40 and 90.

Match
Limit

OFF

	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

Extended functions for the width tool

	�Width Extraction Method

1	Select the [Extended Functions] tab and press 
[Settings] in [Width Extraction Method].

2	Select [Width Extraction Method].

	yWhen extracting the width which is similar 
to the one registered in the master image, 
select [Mas. Wid.].

Master Image
Performance during 

an operation

Width to be measured
	yWhen extracting the outer-most width of 
the tool window, select [Outside].

Width to be measured
	yWhen extracting the inner-most width of 
the tool window, select [Inside].

Width to be measured
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3	Press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen of [Width].

	� Scaling Setting

1	Select the [Extended Functions] tab and press 
[Settings] in [Scaling Setting].

2	Select [Enable] and perform the Scaling Setting.

	y If scaling is [Enable], the display range 
and the setting scale (x2 or x10) of the 
threshold adjustment will be automatically 
adjusted.
	y If scaling is [Enable], the threshold can be 
adjusted by 0.1 mm.

	z When changing the scaling settings
Enter a user-defined value in [Display Value].
The setting range is 0.05 to 9999 (maximum input 
digits: 4), and the default value is 100.0.
The value of matching rate 100 is scaled by the display 
value.

The scaling display value can be adjusted by 
0.05 mm.
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	z When copying scaling settings
Select the source tool for the Scaling Setting from the 
[Copy Setting] drop-down menu, and press [Copy].

The confirmation screen opens.
Press [OK].

The display of [Display Range] is updated to the 
value after scaling.

If the scaling value of the source tool is 
changed, copy the scaling settings again.

3	Press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen of [Width].
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Diameter Tool

	z Setting items for the Diameter tool

Items Description

Edit Window Specifies the area of the target to be detected using a tool window.

Mask Adds a circular mask region in the tool window frame.
The area inside the mask region is excluded from the diameter detection target.

Diameter 
Extraction 

Extraction 
Sensitivity Selects the sensitivity for diameter extraction according to the target.

Change Specified 
Circle

The diameter used for inspection can be changed when there are multiple circles of the 
extracted diameter.

Limit Adjustment
Adjusts the threshold (matching rate) used in the OK/NG judgment. During threshold 
adjustment, the system switches to Test mode so that the threshold can be adjusted to an 
applicable value for operation.

Upper Limit
Enables an upper limit on the threshold.
Set if the OK/NG judgment is desired when a target diameter is longer than the OK 
diameter.

Scale When the upper limit of the threshold is ON, select the threshold scale according to the 
range of the matching rate required for judgment.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool names can 
be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	z Advanced settings of the Diameter tool

Items Description Ref.

Diameter 
Extraction

Diameter 
Mode Select the method used to extract the target diameter. 4-79

Bright/Dark Direction Selects the direction for which the tool detects the target edge. 4-80

Scaling 
Setting

Scaling 
Setting

Sets scaling.
Set when length is being used for anomaly detection instead of the matching 
rate.

4-80
Display Value When scaling is enabled, inputs the display value in relation to matching rate 

100.

Copy Setting When scaling is enabled, copy the scaling settings from another tool.

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be applied to 
the Diameter tool can be selected. 4-39
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Setting the Diameter tool

1	Select the [Extra1] tab, and add the [Diameter] 
tool.

 “Adding a Tool” (page 4-36)
The main screen for [Diameter] opens.

2	Set the position and size of the tool window 
according to a target.
Place the center of the tool window inside the target.

Set the tool window

Center of tool window

 “Editing the Window” (page 3-14)

The sensor detects circles from the center of 
tool window towards outside.

3	Apply the mask as needed.
The area inside the mask region is excluded from the 
diameter detection target.

 “Mask settings” (page 4-38)

4	Perform diameter extraction as needed.
 “Diameter Extraction Settings” (page 4-78)

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

7	Adjust the threshold for anomaly detection by 
checking the matching rate.

Match
Threshold (upper limit)

Threshold (lower limit)

	y The target is judged OK when the matching 
rate is within a threshold range, and NG when 
it is outside the range.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

8	Set [Upper Limit] as needed.
 “Upper Limit” (page 4-78)

9	When setting is completed, press [OK].
The system returns to the main screen of [Diameter].

10	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

11	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� Diameter Extraction Settings

1	Press [Settings] of the [Diameter Extraction].

2	Select [Extraction Sensitivity] of a diameter.

3	Press [◄ Inside]/[Outside ►] of “Change 
Specified Circle”, and select the circle with the 
diameter to be used for inspection.

The circle used for diameter extraction is 
displayed in green color.
You can also press the yellow candidate circle to 
select the circle for diameter extraction.

4	Press [OK].
The system returns to the main screen of [Diameter].

	� Upper Limit

1	Set the upper limit settings.

	z When changing the setting scale
Select [0-999] from the [Scale] drop-down menu.
Adjust the threshold for anomaly detection by checking 
the matching rate.

	y The target is judged OK when the matching 
rate is within a threshold range, and NG when 
it is outside the range.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

	z When the upper limit is disabled
Switch the check box to [OFF] for the upper limit.
Adjust the threshold for anomaly detection by checking 
the matching rate.
<Setting example>
If the matching rate of an “OK” image is higher than 
90 and if the matching rate of a “NG” image is lower 
than 40, set the threshold to 65, the value intermediate 
between 40 and 90.

Match
Limit

OFF

	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)
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Advanced settings for the Diameter tool

	� Diameter Mode

1	Select the [Extended Functions] tab and press 
[Settings] in [Diameter Extraction].

2	Select the diameter mode.

	y If the circle desired is the one whose 
diameter is similar to the circle specified 
inside the tool window, select [Set Φ].

Diameter to be detected

Performance during 
an operationMaster Image

	yWhen extracting the largest circle inside 
the tool window, select [Max].

Diameter to be detected

Performance during 
an operationMaster Image

	yWhen extracting the smallest circle inside 
the tool window, select [Min].

Diameter to be detected

Performance during 
an operationMaster Image

3	Press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen of [Diameter].
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	� Bright/Dark Direction

1	Select the [Extended Functions] tab and select 
[Bright/Dark Direction].

	yWhen detecting edges in the same bright/
dark direction as the master image, select 
[Master Dir.].
	yWhen detecting both bright->dark and 
dark->bright edges, select [Both].
	yWhen detecting edges that change from 
bright to dark, select [Bright -> Dark].
	yWhen detecting edges that change from 
dark to bright, select [Dark -> Bright].

Dark->BrightBright->Dark

Tool window Tool window

The sensor detects circles from the center of 
tool window towards outside.

2	Press the [Settings] tab.
The system returns to the main screen of [Diameter].

	� Scaling

1	Select the [Extended Functions] tab and press 
[Settings] in [Scaling Setting].

2	Select [Enable] and perform the Scaling Setting.

	y If scaling is enabled, the display range 
and the setting scale (x2 or x10) of the 
threshold adjustment will be automatically 
adjusted.
	y If scaling is enabled, the threshold can be 
adjusted by 0.1 mm.
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	z When changing the scaling settings
Enter a user-defined value in [Display Value].
The value of matching rate 100 is scaled by the display 
value.

The scaling display value can be adjusted by 
0.05 mm.

	z When copying scaling settings
Select the source tool for the Scaling Setting from the 
[Copy Setting] drop-down menu, and press [Copy].

The confirmation screen opens.
Press [OK].

The display of [Display Range] is updated to the 
value after scaling.

If the scaling value of the source tool is 
changed, copy the scaling settings again.

3	Press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen of [Diameter].
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Edge Tool

	z Setting items for the Edge tool

Items Description

Edit Window Specifies the area of the target to be detected using a tool window.

Mask Adds a rectangular mask region in the tool window frame.
The area inside the mask region is excluded from the edge detection target.Add Mask

Automatic Edge Sensitivity 
Adjustment Automatically adjusts the sensitivity which detects the edge.

Manual adjustment Manually adjusts the sensitivity which detects the edge.

LIVE image The edge sensitivity can be adjusted using the Live image from the target.

Limit Adjustment
Adjusts the threshold (Match *1) used in the OK/NG judgment. During threshold 
adjustment, the system switches to Test mode so that the threshold can be adjusted to 
an applicable value for operation.

Upper Limit
Enables an upper limit on the threshold.
Set if OK/NG judgment is desired for a target that has a number of target edges larger 
than the number of edges of the master image.

Scale

When the upper limit of the threshold is ON, select the threshold scale according to the 
range of the matching rate required for judgment.
The default value is automatically adjusted according to the number of edges of 
the registered master image.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool names 
can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

*1	The matching rate is the number of edges.

	z Setting items for the Edge tool (advanced settings)

Items Description Ref.

Edge Detection Selects the bright/dark direction which detects a target edge. 4-85

Fine Edge Mode Set this when the space between edges is narrow. 4-85

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be 
applied to the Edge tool can be selected. 4-39
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Setting the Edge tool

1	Select the [Extra1] tab, and add the [Edge] tool.
 “Adding a Tool” (page 4-36)

Displays the Edge tool direction selection screen.

2	Press [Horizontal Dir.]/[Vertical Dir.].

For [Horizontal Dir.], the edges are detected 
from the left to the right side of the tool window; 
for [Vertical Dir.], the edges are detected from 
the top to the bottom.

The main screen for [Edge] opens.

3	Set the position, size, and angle of the tool 
window according to the target.

Set the position, size, and 
angle

 “Editing the Window” (page 3-14)

The window angle can be reset using the [Angle 
Reset] button.

4	Apply the mask as needed.
Inside the mask region is excluded from an edge 
detection target.

 “Mask settings” (page 4-38)

5	Adjust the edge sensitivity setting as needed.
 “Edge Sensitivity Settings” (page 4-84)

6	Press [Live Adjustment].

The sensor changes to the test operation.

7	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

8	Adjust the threshold for anomaly detection by 
checking the number of edges.
<Setting example>
If the number of an “OK” image edges is 8, and if the 
number of a “NG” image edges is other than 8, set it to 8.

Match
Threshold (upper limit)

Threshold (lower limit)

A target is judged OK when the number of edges 
is within a threshold range, and NG when it is 
outside the range.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

9	Set [Upper Limit] as needed.
 “Upper Limit” (page 4-85)

10	When setting is completed, press [OK].
The system returns to the main screen for [Edge].

11	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

12	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� Edge Sensitivity Settings

1	Press [Settings] for [Edge Sensitivity Settings].

2	Adjust the edge sensitivity.

	z When the edge sensitivity is adjusted 
automatically
Press [Automatic Edge Sensitivity Adjustment].

The edge sensitivity will be adjusted automatically 
according to the target.

	z When the edge sensitivity is adjusted manually
Switch the [show edge graph] check box to ON.

Edge graph

LimitON

Adjust the threshold value for edge sensitivity by 
checking the edge graph being displayed.

	y The edge sensitivity limit can be adjusted by 
pressing the red line.
	y Press [LIVE image] to adjust threshold value 
for edge intensity using the target Live image.

The edge intensity threshold indicates the ratio 
of edge recognition taking the edge intensity 
maximum value (where the contrasting density 
is greatest) as 100%.

Edge detection 
direction

Threshold for edge 
sensitivity (%)

(Illustration for edge 
intensity wave)

Threshold for edge sensitivity 50%  
(2 edges to be detected)

Threshold for edge sensitivity 30%  
(4 edges to be detected)

100% in-between

+255

0

100%

30%

50%

0%

Projection 
wave

Edge intensity 
wave

+255

0

3	Press [OK].
The system returns to the main screen for [Edge].
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	� Upper Limit

1	Set the upper limit settings.

	z When changing the setting scale
Select [0-999] from the [Scale] drop-down menu.
Adjust the threshold for anomaly detection by checking 
the matching rate.

	y The target is judged OK when the matching 
rate is within a threshold range, and NG when 
it is outside the range.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

	z When the upper limit is disabled
Switch the check box to [OFF] for the upper limit.
Adjust the threshold for anomaly detection by checking 
the matching rate.
<Setting example>
If the number of an “OK” image edges is 8, and if the 
number of a “NG” image edges is other than 8, set it to 8.

Match
Limit

OFF

	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

Advanced settings of the Edge tool

	� Edge Detection

1	Select the [Extended Functions] tab and select 
the [Edge Detection].

	z Bright/Dark Direction
	yWhen detecting both bright->dark and dark->bright 
edges, select [Both].
	yWhen detecting edges that change from bright to 
dark, select [Bright -> Dark].
	yWhen detecting edges that change from dark to 
bright, select [Dark -> Bright].

Dark->BrightBright->Dark

Tool window Tool window

For [Horizontal Dir.], the edges are detected 
from the left to the right side of the tool window; 
for [Vertical Dir.], the edges are detected from 
the top to the bottom.

	z Fine Edge Mode
Press [Settings] and select [ON] when edges cannot be 
differentiated ones because the space between edges 
is narrow.

2	Press the [Settings] tab.
The system returns to the main screen for [Edge].
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Pitch tool

	z Setting items for the Pitch tool

Items Description

Edit Window Specifies the area of the target to be detected using a tool window.

Mask Adds a rectangular mask region in the tool window frame.
Area inside the mask region is excluded from a pitch detection target.

Automatic Edge Sensitivity 
Adjustment

Automatically adjust the sensitivity that detects the edge that will become the 
standard of reference for pitch extraction.

Manual adjustment Manually adjust the sensitivity that detects the edge that will become the standard of 
reference for pitch extraction.

LIVE image The edge sensitivity can be adjusted using the Live image from the target.

Limit Adjustment

Adjusts the threshold (matching rate) used in the OK/NG judgment. During threshold 
adjustment, the system switches to Test mode so that the threshold can be adjusted 
to an applicable value for operation.
A matching rate of 100 indicates that the average value of all pitches is completely 
matched to the master image. The value which deviates the most from the average 
value among all pitches becomes the matching rate. When the number of pitches is 
different from the number for the master image, the matching rate is 0.

Scale Select the scale for the threshold according to the range of matching rates requires 
for judgment.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool names 
can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	z Setting items for the Pitch tool (advanced settings)

Items Description Ref.

Pitch Extraction 
Method

Bright/Dark 
Mode Select the method to extract the target pitch.

4-89Meas. Mode Select the measuring method for the pitch extracted from a target.

Narrow Pitch 
Mode Set when pitch width is narrow.

Scaling Setting

Scaling Setting
Sets scaling.
Set when length is being used for anomaly detection instead of the 
matching rate.

4-90
Display Value

When the scaling is enabled, input the display value in relation to 
matching rate (*) 100.
A matching rate of 100 indicates that the average value of all pitches is 
completely matched to the master image. The value which deviates the 
most from the average value among all pitches becomes the matching 
rate. When the number of pitches is different from the number for the 
master image, the matching rate is 0.

Copy Setting When scaling is enabled, copy the scaling settings from another tool.

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be 
applied to the Pitch tool can be selected. 4-39
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Setting the Pitch tool

1	Select the [Extra1] tab, and add the [Pitch] tool.
 “Adding a Tool” (page 4-36)

Displays the Pitch tool direction selection screen.

2	Press [Horizontal Dir.]/[Vertical Dir.].

The main screen for [Pitch] opens.

3	Set the position, size, and angle of the tool 
window according to the target.

 “Editing the Window” (page 3-14)

Set the position, 
size, and angle

The window angle can be reset using the [Angle 
Reset] button.

4	Apply the mask as needed.
Area inside the mask region is excluded from a pitch 
detection target.

 “Mask settings” (page 4-38)

5	Adjust the edge sensitivity setting as needed.
 “Edge Sensitivity Settings” (page 4-88)

6	Press [Live Adjustment].

The sensor changes to the test operation.

7	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

8	Adjust the threshold for anomaly detection by 
checking the matching rate.

Current number of pitches/ 
number of registered pitches in master image

Match

Status gauge
  MAX matching rate (Upper)
  MIN matching rate (Lower)

Threshold (lower limit)
Threshold (upper limit)

	yWhen changing the scale, select [0-999] from 
the [Scale] drop-down menu.
	y The target is judged OK when the matching 
rate is within a threshold range, and NG when 
it is outside the range.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

9	When setting is completed, press [OK].
The system returns to the main screen for [Pitch].

10	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

11	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� Edge Sensitivity Settings

1	Press [Settings] for [Edge Sensitivity Settings].

2	Adjust the edge sensitivity.

	z When the edge sensitivity is adjusted 
automatically
Press [Automatic Edge Sensitivity Adjustment].

The edge sensitivity will be adjusted automatically 
according to the target.

	z When the edge sensitivity is adjusted manually
Switch the [show edge graph] check box to ON.

Edge graph

LimitON

Adjust the threshold value for edge sensitivity by 
checking the edge graph being displayed.

	y The edge sensitivity limit can be adjusted by 
pressing the red line.
	y Press [LIVE image] to adjust threshold value 
for edge intensity using the target Live image.

The edge intensity threshold indicates the ratio 
of edge recognition taking the edge intensity 
maximum value (where the contrasting density 
is greatest) as 100%.

Edge detection 
direction

Threshold for edge 
sensitivity (%)

(Illustration for edge 
intensity wave)

Threshold for edge sensitivity 50%  
(2 edges to be detected)

Threshold for edge sensitivity 30%  
(4 edges to be detected)

100% in-between

+255

0

100%

30%

50%

0%

Projection 
wave

Edge intensity 
wave

+255

0

3	Press [OK].
The system returns to the main screen for [Pitch].
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Advanced settings of the Pitch tool

	� Bright/Dark Mode

1	Select the [Extended Functions] tab and select 
[Bright/Dark Mode].

	yWhen extracting pitches between bright 
regions, select [Bright].

Number of pitches 1

	yWhen extracting pitches between dark 
regions, select [Dark].

Number of pitches 2

2	Press the [Settings] tab.
The system returns to the main screen for [Pitch].

	�Measurement Mode

1	Select the [Extended Functions] tab and select 
[Meas. Mode].

	y Example of [Pin Pitch]

Number of pitches 2

	y Example of [Pin Width]

Number of pitches 3

2	Press the [Settings] tab.
The system returns to the main screen for [Pitch].
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	� Narrow Pitch Mode

1	Select the [Extended Functions] tab and press 
[Settings] of [Narrow Pitch Mode].

2	Enable/Disable Narrow Pitch Mode.

If [Enable] is selected, pitches can be extracted 
even when the pitch width is narrow.

3	Press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen for [Pitch].

	� Scaling

1	Select the [Extended Functions] tab and press 
[Settings] in [Scaling Setting].

2	Select [Enable] and perform the Scaling Setting.

	y If scaling is enabled, the display range 
and the setting scale (x2 or x10) of the 
threshold adjustment will be automatically 
adjusted.
	y If scaling is enabled, the threshold can be 
adjusted by 0.1 mm.
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	z When changing the scaling settings
Enter a user-defined value in [Display Value].
The value of matching rate 100 is scaled by the display 
value.

The scaling display value can be adjusted by 
0.05 mm.

	z When copying scaling settings
Select the source tool for the Scaling Setting from the 
[Copy Setting] drop-down menu, and press [Copy].

The confirmation screen opens.
Press [OK].

The display of [Display Range] is updated to the 
value after scaling.

If the scaling value of the source tool is 
changed, copy the scaling settings again.

3	Press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen for [Pitch].
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High-Speed Position Adjustment Tool

	z Setting items for the High-Speed Position Adjustment tool

	�1-Ax. Adjustment

Items Description

Edit Window Specifies the area of the target to be detected using a tool window.

Scan Direction Selects the direction for which the tool detects the target edge.

Automatic Edge Sensitivity 
Adjustment Automatically adjusts the sensitivity which detects the edge.

Manual adjustment Manually adjusts the sensitivity which detects the edge. 1 to 100 (default: 50)

LIVE image The edge sensitivity can be adjusted using the Live image from the target.

Test run Changes to Test mode, used to check that the position adjustment has been 
performed correctly.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool names 
can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	�2-Ax. Adjustment

Items Description

X-Axis

Edit Window Specifies the area of the target to be detected using a tool window.

Scan Direction Selects the direction for which the tool detects the target edge.

Automatic Edge Sensitivity 
Adjustment Automatically adjusts the sensitivity which detects the edge.

Manual adjustment Manually adjusts the sensitivity which detects the edge. 1 to 100 (default: 50)

LIVE image The edge sensitivity can be adjusted using the Live image from the target.

Y-Axis

Edit Window Specifies the area of the target to be detected using a tool window.

Scan Direction Selects the direction for which the tool detects the target edge.

Automatic Edge Sensitivity 
Adjustment Automatically adjusts the sensitivity which detects the edge.

Manual adjustment Manually adjusts the sensitivity which detects the edge. 1 to 100 (default: 50)

LIVE image The edge sensitivity can be adjusted using the Live image from the target.

Common Test run Changes to Test mode, used to check that the position adjustment has been 
performed correctly.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool names 
can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	z Setting items for the High-Speed Position Adjustment tool (Advanced Settings)
The contents of the extended functions that can be set in [1-Ax. Adjustment], [2-Ax. Adjustment (X-Axis)], and [2-Ax. 
Adjustment (Y-Axis)] are the same.

Items Description Ref.

Edge Detection Selects the bright/dark direction which detects a target edge. 4-96
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Setting the High-Speed Position Adjustment Tool

	� 1-Axis Adjustment

1	Select the [Extra1] tab, and add the [High-Speed 
Position Adjustment] tool.

 “Adding a Tool” (page 4-36)

2	Select the [1-Ax. Adjustment] button. Press [Horizontal 
Dir.] or [Vertical Dir.], and press [OK].

The main screen for [1-Ax. Adj] opens.

3	Select the detection direction, and set the position 
and size of the tool window according to a target.

Set the position, size, and 
angle

	yDetection direction: From Left (default)
Detects edges from the left side of window to the right side.

Tool window

	yScan Direction: From Right
Detects edges from the right side of window to the left side.

Tool window

	yScan Direction: From Top
Detects edges from the top of window to the bottom.

Tool window

	yScan Direction: From Bottom
Detects edges from the bottom of window to the top.

Tool window

4	Adjust the edge sensitivity setting as needed.
 “Edge Sensitivity Settings” (page 4-95)

5	Press [Common], and then press [Test run].

The sensor changes to the test operation.

6	Position correction is performed and the edge 
detection process can be confirmed.

7	Press [OK].
The system returns to the main screen for [1-Ax. Adj].

8	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

9	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� 2-Axis Adjustment

1	Select the [Extra1] tab, and add the [High-Speed 
Position Adjustment] tool.

 “Adding a Tool” (page 4-36)

2	Select the [2-Ax. Adjustment] button, and press 
[OK].

The main screen for [2-Ax. Adj] opens.

3	Press [X-Axis].

4	Select the detection direction, and set the 
position and size of the tool window according to 
a target.

Set the position, size, and 
angle

5	Press [Y-Axis], and perform steps 3 and 4 for the 
Y axis.

6	Adjust the edge sensitivity setting as needed.
 “Edge Sensitivity Settings” (page 4-95)

7	Press [Common], and then press [Test run].

The sensor changes to the test operation.

8	Position correction is performed and the edge 
detection process can be confirmed.

9	Press [OK].
The system returns to the main screen for [2-Ax. Adj].

10	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

11	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� Edge Sensitivity Settings

1	For [2-Ax. Adjustment], select an axis to set.

2	Press [Settings] for [Edge Sensitivity Settings].

3	Adjust the edge sensitivity.

	z When the edge sensitivity is adjusted 
automatically
Press [Automatic Edge Sensitivity Adjustment].

The edge sensitivity will be adjusted automatically 
according to the target.

	z When the edge sensitivity is adjusted manually
Switch the [show edge graph] check box to ON.

Edge graph

LimitON

Adjust the threshold value for edge sensitivity by 
checking the edge graph being displayed.

	y The edge sensitivity limit can be adjusted by 
pressing the red line.
	y Press [LIVE image] to adjust threshold value 
for edge intensity using the target Live image.

The edge intensity threshold indicates the ratio 
of edge recognition taking the edge intensity 
maximum value (where the contrasting density 
is greatest) as 100%.

Edge detection 
direction

Threshold for edge 
sensitivity (%)

(Illustration for edge 
intensity wave)

Threshold for edge sensitivity 50%  
(2 edges to be detected)

Threshold for edge sensitivity 30%  
(4 edges to be detected)

100% in-between

+255

0

100%

30%

50%

0%

Projection 
wave

Edge intensity 
wave

+255

0

4	Press [OK].
The system returns to the main screen for [1-Ax. Adj] or 
[2-Ax. Adj].

5	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)
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Advanced settings for the High-Speed 
Position Adjustment tool

The contents of the extended functions that can be set in 
[1-Ax. Adjustment], [2-Ax. Adjustment (X-Axis)], and [2-Ax. 
Adjustment (Y-Axis)] are the same.

	� Edge Detection

1	For [2-Ax. Adj], select an axis to set.

2	Select the [Extended Functions] tab and select 
[Edge Detection].

	yWhen detecting edges in the same bright/
dark direction as the master image, select 
[Master Dir.].
	yWhen detecting both bright->dark and 
dark->bright edges, select [Both].
	yWhen detecting edges that change from 
bright to dark, select [Bright -> Dark].
	yWhen detecting edges that change from 
dark to bright, select [Dark -> Bright].

Dark->BrightBright->Dark

Tool window Tool window

3	Press [OK].
The system returns to the main screen for [High-Speed 
Position Adjustment].
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OCR Tool

	z Setting items for the OCR tool

The characters that can be recognized by the OCR tool are as follows.

Numbers 0123456789

Letters ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Symbols  . / ++ - : ( ) # * (9 symbols)

Items Description

Edit 
Window Mask 

Add Mask Adds a rectangular/circular mask region in the tool window frame. Area 
inside the mask region is excluded from an OCR examination target.

Cut Mask
Removes a rectangular/circular region from the mask region.
Inside the region removed from the mask, the mask is disabled and 
OCR extraction is enabled.

Reading 
Settings

Character Reads the printed text.

Character 
Settings

Letter reading Select whether to read letters.
Number 
reading Select whether to read numbers.

Symbol reading Select whether to read symbols.
Date Reads the printed text, and extracts the part that was read as the date.

Date 
Settings Date format Selects the date format for the text to be read.

Status conditions
(When the reading 
target is set to 
[Character].)

Master text Edits the master text.

Judge number of char(s) only Judges whether the number of letters on the object matches the 
number of letters in the master text.

Status conditions
(When the reading 
target is set to 
[Date].)

Master date Edits the master date.
Calendar sync Sets the master date to the current date and time on the sensor.

Sync 
Settings

Offset from 
current (day)

Sets the number of days for the master date to be offset in relation to 
the current date and time on the sensor.

Date Change: 
Time

Set this when delaying the time that the master date changes. The 
master date will change at “00:00” by default.

Acceptable 
error (min)

Set the time error in minutes for dates to be judged as OK both before 
and after the date change is to occur.

0 in 10s pos of 
mm/dd

Sets to include a leading zero when the month and/or day in the 
master date is a single digit.

Test run

Switches to Test Run mode to check of the OK/NG judgment status. 
Used to adjust the threshold (Match) used in OK/NG judgment.

Adjusts the threshold (Match) used in OK/NG judgment when the 
shade contrast function for character recognition is set to [Enable].

Tool Name
A user-defined name, such as the name of a target, can be set for 
tools. Tool names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	z Setting items for the OCR tool (advanced settings)

Items Description Ref.

Shade Contrast Evaluate the contrast of the target text or date.
If the ink of the text or date is lighter than the master text, the matching rate will decrease. 4-102

OCR Algorithm The detection mode of the OCR tool can be selected. 4-103

Dot Matrix Print Select this when reading dot characters such as those made by IJP (ink jet printers) that 
are not stable.

4-104
Print Type Set this when [Dot Matrix Print] is [Enable]. Selects the print type of the dot matrix to be 

read.

Position Adjustment 
Setting

The Position Adjustment/High-Speed Position Adjustment tool to be applied to the OCR 
tool can be selected. 4-39
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Setting the OCR tool

The maximum number of characters that can be 
read by one tool is 16.

1	Select the [Extra2] tab, and add the [OCR] tool.
 “Adding a Tool” (page 4-36)

The main screen for [OCR] opens.

2	Set the position, size, and angle of the tool 
window according to the target text.
Select the target text with the tool window.

Set the position, 
size, and angle

 “Editing the Window” (page 3-14)

3	Apply the mask as needed.
The area inside of the mask region is excluded from 
character recognition.

 “Mask settings” (page 4-38)

4	Configure the reading settings.
 “Reading Settings” (page 4-99)

5	Press [Go] of the Execute reading.

The text or date to be set as the master are read.

6	Adjust the status conditions as necessary.
 “Setting the Status Conditions” (page 4-100)

7	Press [Test run].

The sensor changes to the test operation.

A character string is judged as OK if the string 
matches the master text and NG if the string 
does not match the master text.

8	Press [OK].
The system returns to the main screen for [OCR].

9	Input a tool name as needed.
 “Tool Name Setting” (page 4-40)

10	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� Reading Settings

	z To read text

1	Press [Settings].

2	Select [Character] as the reading target and set 
whether to use letters, numbers, or symbols as 
the reading target.

Letter reading Disable, upper case letters, and upper 
case/lower case letters can be selected.

Number reading Enable or disable can be selected.

Symbol reading Enable or disable can be selected.

3	When setting is completed, press [OK].
The character string that was selected to be the master 
is read and the system returns to the main screen for 
[OCR].

	z To read the date

1	Press [Settings].

2	Select [Date] as the reading target, and set [Date 
Format].

Set the date format to match that of the 
reading target.
Dates that differ from the set date format will 
not be read.

3	Press [OK] and read the date that you want to set 
as the master text.

The date that was selected to be the master is read and 
the system returns to the main screen for [OCR].
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	� Setting the Status Conditions

	z To read text

1	Press [Status conditions].

2	Edit [Master text] if necessary.

Configure this setting if you want to judge 
text other than the text read with [Master 
Registration].
You can set arbitrary characters (all letters, 
numbers, and symbols) not included in the 
specified letters, numbers, and symbols.
?	 :	� Judges all letters, numbers, and 

symbols as OK.
$	 :	� Judges all letters as OK.
%	 :	� Judges all numbers as OK.
@	:	� Judges all symbols as OK.

[Arbitrary characters] usage example
	yMaster text: AB$DE
ABCDE	 :	 OK
ABFDE	 :	 OK
AB5DE	 :	 NG
	yMaster text: AB?DE
ABCDE	 :	 OK
ABFDE	 :	 OK
AB5DE	 :	 OK

3	Set [Judge number of char(s) only] if necessary.
If it necessary to only judge if the number of characters 
matches the master text, set the [Judge number of 
char(s) only] check box to ON and enter the number of 
characters.

ON

Specify the minimum and maximum number 
of characters to judge as OK.

Example: 4 to 8 characters
If the number of characters in a string of text 
is between four and eight characters, it is 
judged as OK.

4	When setting is completed, press [OK].
The system returns to the main screen for [OCR].
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	z To read the date

1	Press [Status conditions].

2	Edit the Master Date if necessary.

Configure this setting if changing the master 
date used for the master image.
Even if the date is changed, the Master Date 
is updated without having to read the target 
text again.
Make sure that the format of the edited 
Master Date is the same as [Date Format] set 
in [Reading Settings].
If the Master Date format order for the 
[Reading Settings] date format could not 
be interpreted, the display format will be 
unknown and the Master Date will not be set 
correctly.

3	Set [Calendar sync] as necessary.

The master date will synchronize with the sensor 
date and time.
Set this item to link the reading target date to the 
current date and time.

Switch the check box to ON for [Calendar sync].

ON

	z Offset from current
Offsets the master date by the desired number of days 
away from the current date on the sensor.

	z Date Change: Time
Delays the time that the master date changes to a user-
specified time. The default time that the master date 
change is “00:00”.

When the Date Change Time is set to “06:00”, 
operation will continue as the master date of the 
previous day between “00:00” to “06:00”.
The master text of the tool will advance to the 
next day at “06:00”.
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	z Acceptable error (min)
Sets the time error (allowable error) in minutes for dates 
to be judged as OK both before and after the date 
changes.

Current master date set using 
calendar sync
Range judged as OK

Acceptable error (min)

Day before 
Master Date

Day after 
Master Date

Master date

If the current master date is set within the [Acceptable 
error (min)] range by calendar synchronization, the set 
time before or after the master date can be included in 
the range to be judged as OK.
Set this item if the date may change after the date is 
printed or before it is checked.

Example with the allowable error set to 5 
minutes

Allowable error (5 minutes)

December 14
23:55 0:05 23:55 0:05

December 16December 15

A

A

C

C

B

(A)	 If the current master date is between 0:00 
and 0:05 using calendar synchronization, 
the day before and the day set as the 
master date will be judged as OK.

(B)	 If the current master date is between 0:06 
and 23:54 using calendar synchronization, 
only the day set as the master date will be 
judged as OK.

(C)	 If the current master date is between 23:55 
and 24:00 using calendar synchronization, 
the day set as the master date and the next 
day will be judged as OK.

	z 0 in 10s pos of mm/dd
Sets whether to add a leading [0] when the month and/
or day in the target date is a single digit.
Select this setting according to the date format of the 
target date.

4	When setting is completed, press [OK].
The system returns to the main screen for [OCR].

Advanced settings for the OCR tool

	� Shade Contrast

1	Select the [Extended Functions] tab and set 
[Shade Contrast].

If shade contrast is enabled, the threshold 
for anomaly detection (Matching Rate) can 
be adjusted on the test run screen.

 “Test run (when Shade Contrast is set to 
[Enable])” (page 4-102)

2	Press the [Settings] tab.
The system returns to the main screen for [OCR].

	z Test run (when Shade Contrast is set to 
[Enable])

1	Press the [Settings] tab, then [Test run].

The sensor changes to the test operation.

2	Capture an “OK” text or date that is clearly 
printed and a “NG” text or date that is not printed 
clearly.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.
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3	Adjust the threshold for anomaly detection by 
checking the matching rate.
<Setup example>
If the matching rate of an “OK” image is higher than 
90 and if the matching rate of a “NG” image is lower 
than 40, set the threshold to 65, the value intermediate 
between 40 and 90.

MatchLimit

Master text/Text read

The target is judged OK when the matching rate 
is within a threshold range, and NG when it is 
outside the range.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

	�OCR Algorithm

1	Select the [Extended Functions] tab and select 
the [OCR Algorithm] type (High Speed/High 
Accuracy).

	y If the reading target text or date cannot 
be correctly recognized, select [High 
Accuracy].
	y Select [High Speed] to shorten the 
processing time.

2	When setting is completed, press [OK].
The system returns to the main screen for [OCR].
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	� Dot Matrix Print

1	Select the [Extended Functions] tab and select 
[Enable] for [Dot Matrix Print].

2	Select the Print Type.

Select [Enable] when dot characters such as 
those from IJP (ink jet printer) cannot be read 
accurately.

	y Select [Black Dot Printing] when the 
printing is darker than the background, or 
[White Dot Printing] when it is brighter than 
the background.
	y Select the dot roughness from [Normal] or 
[Coarse]. Select [Coarse] when detection is 
not stable in [Normal].

3	When setting is completed, press [OK].
The system returns to the main screen for [OCR].
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EdgePixels tool

	z Setting items for the EdgePixels tool

Items Description

Edit Window

Window Shape Selects the window shape to specify the area of the target to detect.

Mask

Adds a rectangular/circular mask region in the window frame. The area 
inside the mask region is excluded from the edge pixels extraction target. 
In addition, a mask cutting region can be added in the mask region. Inside 
the region removed from the mask, the mask is disabled and edge pixels 
extraction is enabled. Adding a mask or removing sections of the mask can 
be performed up to 20 times.

Sensitivity Adjustment Sets the extraction sensitivity for the edge pixels tool according to the target.

LIVE image The extraction sensitivity of the edge pixels tool can be adjusted on the Live 
image from the target.

Limit Adjustment
Adjusts the threshold (matching rate) used in the OK/NG judgment. During 
threshold adjustment, the system switches to Test mode so that the 
threshold can be adjusted to an applicable value for operation.

Upper Limit 
Upper Limit

Enables an upper limit on the threshold. Enable when OK/NG judgment is 
desired for a situation when the target edge pixels are larger than the edge 
pixels extracted from the master image.

Scale When the upper limit of the threshold is ON, select the threshold scale 
according to the range of the matching rate required for judgment.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. 
Tool names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	z Setting items for the EdgePixels tool (advanced settings)

Items Description Ref.

Fixed 
Reference 

Area
Select a condition which the matching rate of the EdgePixels tool is 100%. 4-108

Position 
Adjustment 

Setting

The Position Adjustment/High-Speed Position Adjustment tool to be applied to the EdgePixels 
tool can be selected. 4-39
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Setting the EdgePixels Tool

1	Add the [EdgePixels] tool.
 “Adding a Tool” (page 4-36)

The main screen for [EdgePixels] opens.

2	Select the tool window shape, position, size, and 
angle according to the target.

 “Editing the Window” (page 3-14)

Set the position, size, and 
angle

Rect Circle

When [Entire] is selected, the tool window will be 
hidden.

The window angle can be reset using the [Angle 
Reset] button.

3	Apply the mask as needed.
The area inside the mask region is excluded from an edge 
pixels extraction target.

 “Mask settings” (page 4-38)

4	Perform the sensitivity setting as needed.
 “Sensitivity Adjustment” (page 4-107)

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

7	Adjust the threshold for anomaly detection by 
checking the matching rate.
<Setting example>
If the matching rate of an “OK” image is higher than 
90 and if the matching rate of a “NG” image is lower 
than 40, set the threshold to 65, the value intermediate 
between 40 and 90.

MatchLimit

A target is detected as OK if the matching rate is 
greater than the threshold, and detected as NG 
if the matching rate is lower than the threshold.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

8	Set the Upper Limit as needed.
 “Upper Limit” (page 4-107)

9	When setting is completed, press [OK].
The system returns to the main screen for [EdgePixels].

10	Set the tool name as needed.
 “Tool Name Setting” (page 4-40)

11	Press [OK].

The system returns to the main screen for the tool 
settings.
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	� Sensitivity Adjustment

1	Press [Settings].

2	Select the extraction sensitivity of the edge 
pixels.

When [LIVE image] is pressed, the extraction 
sensitivity of the edge pixels can be adjusted 
from the target Live image.

3	When setting is completed, press [OK].
The system returns to the main screen for [EdgePixels].

	� Upper Limit

1	Switch the check box to ON for [Upper Limit].

The sliders to set the upper limit and the lower limit of 
the threshold will be displayed.
Select the Settings scale from [0-200] or [0-999] 
according to the range of the matching rate necessary 
for judgment.

2	Adjust the threshold for anomaly detection by 
checking the matching rate.

MatchThreshold (lower limit)
Threshold (upper limit)

A target is detected as OK if the matching rate is 
between the thresholds, and detected as NG if 
the matching rate is outside of the thresholds.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

3	When setting is completed, press [OK].
The system returns to the main screen for [EdgePixels].
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Advanced settings for the Edge Pixels tool

	� Fixed Reference Area
Select [Enable] if the master image does not contain 
the edge pixels to be judged.

1	Select the [Extended Functions] tab and press 
[Settings] for [Fixed Reference Area].

2	Adjust the fixed reference area settings.

	yWhen the number of edge pixels extracted 
from the master image is to be used as the 
reference for judgment, select [Disable].
	yWhen 1/20th of number of pixels in the 
sensor’s FOV range is to be used as the 
reference for judgment, select [Enable].

View size

Number of edge pixels 
for 1/20 of sensor FOV  
= Matching rate 100

3	When setting is completed, press [OK].
The system returns to the main screen for the extended 
functions settings.

4	Press the [Settings] tab.
The system returns to the main screen for [EdgePixels].
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Color Prohibition/Brightness Prohibition tool

	z Setting items for the Color Prohibition/Brightness Prohibition Tool

Items Description

Edit Window

Window Shape Selects the window shape to specify the area of the target to prohibit.
Angle Reset When the window shape is set to [□Rect], resets the angle of the window.

Mask

Add Mask Adds a rectangular/circular mask region in the tool window frame. The 
area inside the mask region is excluded from the area extraction target.

Cut Mask
Adds a rectangular/circular cutting region in the mask region. Inside 
the region removed from the mask, the mask is disabled and the area 
extraction is enabled.

Undo The previous operation can be cancelled.
Up to 20 operations can be undone. (UNDO)

Clear Deletes a mask region which has been set.
Color Extraction
(For color type)

Sets an extraction range by pressing the color to be detected as a 
protrusion on the master image or Live image.

Extraction Area Adjustment Expands or reduces automatically the extraction area of the color 
extracted.

Undo The previous operation can be canceled. (UNDO)
Clear Cancels the selection of the extracted color.

LIVE image The color range to be extracted can be set using the Live image of the 
target.

Brightness Extraction
(For monochrome type)

Sets an extraction range by pressing the brightness to be detected as a 
protrusion on the master image or Live image.

Undo The previous operation can be canceled. (UNDO)
Clear Removes the extracted brightness from the tool.

LIVE image The brightness range can be extracted from the Live image of the 
target.

Threshold/
Sensitivity Adj.

Match Adjusts the threshold (matching rate) used in the OK/NG judgment.

Sensitivity Settings Selects the sensitivity for which the matching rate of protrusion detection 
is 0%.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. 
Tool names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)

	z �Setting items for the Color Prohibition/Brightness Prohibition tool (advanced settings)

Items Description Ref.

Advanced Color Extraction
(For color type) Specifies a color to be extracted using HSV (H: Hue, S: Saturation, V: Brightness).

4-113
Advanced Brightness 

Extraction
(For monochrome type)

Specifies the brightness value to be extracted.

LIVE image A color or brightness range to detect protrusions can be set using the Live image 
of the target.

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be applied to the 
Color Prohibition/Brightness Prohibition tool can be selected. 4-39
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Setting the Color Prohibition/Brightness 
Prohibition Tool

1	Select the [Extra2] tab and add the [Color 
Prohibit/Bright. Prohibit] tool.

 “Adding a Tool” (page 4-36)
The main screen for [Color Prohibit/Bright. Prohibit] 
opens.

2	Select the tool window shape, position, size, and 
angle according to the target.

 “Editing the Window” (page 3-14)

Set the position, size, and 
angle

Rect Circle

When [Entire] is selected, the tool window will be 
hidden.

The window angle can be reset using the [Angle 
Reset] button.

3	Apply the mask as needed.
The area inside the mask region is excluded from being 
a color/brightness Prohibition detection target.

 “Mask settings” (page 4-38)

Using the tool in conjunction with mask 
settings enables misalignments and 
protrusions in various directions to be 
detected.

Horizontal Vertical

Target
Mask

Tool window
Cross direction

Target
Mask

Tool window

4	Set the area to extract from the target.

	z For color type
Press [Settings] of the Color Extraction.

The screen to select a color to be extracted opens.
Press the color to be the judgment reference for 
detection.

Press

The pressed color will be extracted.
	y If the areas of color that have not been extracted 
are pressed repeatedly, the extraction range can be 
expanded.
	yPress the [Exclude] button to specify the color to 
exclude from the extracted color.
	yPress the [+]/[-] of the extraction area adjustment, and 
the range of color to be extracted can be expanded/
reduced.
	yTo re-extract the color, press [Clear] and then tap the 
color to be the reference of judgment again.
	yBy pressing [LIVE image], the range of the extracted 
color can be set using the Live Image of the target.

When setting is completed, press [OK].
The system returns to the main screen for [Color 
Prohibit/Bright. Prohibit].

4

Settings N
avigator



4-111IV3 Series User’s Manual (PC Software)

3. Tool Settings (Setting the Judgment Method of the Target of Standard Mode)

	z For monochrome type
Press [Settings] of the Brightness Extraction.

The screen to select brightness to be extracted opens.
Press the brightness to be the judgment reference for 
detection.

Press

The pressed brightness will be extracted.
	y If the areas of brightness that have not been extracted 
are pressed repeatedly, the extraction range can be 
expanded.
	yAdjust the slider, and the range of the brightness to be 
extracted can be expanded/reduced.

 “Editing Numbers” (page 3-15)
	yTo re-extract the brightness, press [Clear] and then 
press the brightness to be the reference of judgment 
again.
	yBy pressing [LIVE image], the range of brightness to 
be extracted can be set using the Live Image of the 
target.

When setting is completed, press [OK].
The system returns to the main screen for [Color 
Prohibit/Bright. Prohibit].

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

7	Select a sensitivity for the matching rate.

Sensitivity

Match

	z High Sens. (default)
If [1/600th of the total sensor view] area in the tool 
window protrudes, the matching rate is 0%. The 
sensitivity to detect the protrusion increases.
Select this setting when you do not want to allow 
protrusions or deviations.

	z Low Sens.
If [1/10th of the total sensor view] area in the tool 
window protrudes, the matching rate is 0%.
This setting enables protrusions and deviations to 
be judged when they are allowed. Additionally, this 
setting makes judgment resistant to individual target 
differences and ambient light interference.
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8	Adjust the threshold for anomaly detection by 
checking the matching rate.
<Setting example>
Set the detection threshold for the matching rate of the 
protrusion and misalignment that should be detected as 
a NG target.

Limit Match

A target is detected as OK if the matching rate is 
greater than the threshold, and detected as NG 
if the matching rate is lower than the threshold.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

9	When setting is completed, press [OK].
The system returns to the main screen for [Color 
Prohibit/Bright. Prohibit].

10	Input a tool name as needed.
 “Tool Name Setting” (page 4-40)

11	Press [OK].

The system returns to the main screen for the tool 
settings.
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Advanced settings for the Color Prohibition/
Brightness Prohibition tool
	� Advanced Color Extraction/Advanced 
Brightness Extraction

1	Select the [Extended Functions] tab and press 
[Settings] of [Advanced Color Extraction].
For a monochrome type, press [Settings] of [Advanced 
Brightness Extraction].

2	Specify a color or brightness of the extraction 
target.

	z For color type

	y You can adjust the value by slider while 
confirming the color histogram. The values 
within the range specified by the sliders will be 
used as the brightness.
	y The vertical axis indicates the extracted pixel.
	y Among the pixels of each color to be extracted, 
the maximum one becomes the maximum 
value of the vertical axis.
	y The range and extraction rules in the color 
extraction detailed settings are shown as 
follows.

H

Set the upper limit and lower limit for 
the range of 0 to 359.

	y Lower limit ≤ Upper limit
The extraction range of a color is from 
the lower limit to the upper limit.
	y Lower limit > Upper limit
The extraction range of a color is 
from 0 to the upper limit, and from the 
lower limit to 359.

S Set the upper limit and lower limit for 
the range of 0 to 255.
The extraction range of a color is from 
the lower limit to the upper limit.V

	y By pressing [LIVE image], the range of the 
extracted color can be set based on the Live 
Image of the target.
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	z For monochrome type

	y Adjust the value by slider while confirming the 
monochrome histogram.
The values within the range specified by the 
sliders will be used as the brightness.
	y The vertical axis indicates the extracted pixel.
Among the extracted pixels of each brightness, 
the one that has the most pixels becomes the 
maximum value of vertical axis.
	y The range and extraction rules in the extraction 
detailed settings are shown as follows.

V

Set the upper limit and lower limit for 
the range of 0 to 255.
The extraction range of the brightness 
is from the lower limit to the upper limit.

	y By pressing [LIVE image], the range of 
brightness to be extracted can be set based 
on the Live Image of the target.

3	Press [OK].
The system returns to the main screen for [Color 
Prohibit/Bright. Prohibit].
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Blob Count Tool

	z Setting items for the Blob Count tool

Items Description

Edit Window

Window Shape Selects the window shape to specify an area of the target to be extracted.

Mask

Adds a rectangular/circular mask region in the window frame. The area inside 
the mask region is excluded from the area extraction target. In addition, 
a mask cutting region can be added in the mask region. Inside the region 
removed from the mask, the mask is disabled and the extraction is enabled. 
The mask region can be adjusted up to 20 times (UNDO).

Color 
Extraction
(For color 

type)

Extract Color from Image Presses the color to be extracted from the master image and set the 
extraction range.

Extraction Area Adjustment Expands or reduces automatically the extraction area of the color extracted.

LIVE image
The color range to be extracted can be set using the Live image of the target.
In addition, the range of color to be extracted can be based on the image in 
the image history or from an image on a saved file.

Brightness 
Extraction

(For monochrome 
type)

Extract Brightness from 
Image

Presses the brightness to be extracted from the master image and set the 
extraction range.

LIVE image A brightness range to be extracted can be set using the Live image of the 
target.

Limit Adjustment
Adjusts the threshold (count) used in the OK/NG judgment. During threshold 
adjustment, the system switches to Test mode so that the threshold can be 
adjusted to an applicable value for operation.

Scale Select the scale for the threshold according to the range of matching rates 
requires for judgment.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool 
names can be checked on the run screen.

	� “Chapter 5 Running” (page 5-1)

	z Setting items for the Blob Count tool (advanced settings)

Items Description Ref.

Advanced Color Extraction
(For color type)

Advanced Brightness 
Extraction

(For monochrome type)

	yColor type
Specifies a color to be extracted using HSV (H: Hue, S: Saturation, V: 
Brightness).
	yMonochrome type
Specifies the brightness value to be extracted.

4-118

LIVE image The color/brightness range to be extracted can be set using the Live image of the 
target.

Size Limit Setting Sets the range of a blob size (area) to be counted.
As a scale for size settings, 1 to 200 or 1 to 999 can be selected. 4-119

LIVE image The range of a blob size to be counted in the Live image of the target can be set.

Boundary Exclusion Sets whether to count or exclude a target that protrudes from the window. 4-120

Position Adjustment Setting The Position Adjustment/High-Speed Position Adjustment tool to be applied to the 
Blob Count tool can be selected. 4-39
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Setting the Blob Count tool

1	Select the [Extra2] tab, and add the [Blob Count] 
tool.

 “Adding a Tool” (page 4-36)
The main screen for [Blob Count] opens.

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

Rect Circle

Set the position, size, and angle

The window angle can be reset using the [Angle 
Reset] button.

 “Adding a Tool” (page 4-36)

3	Apply the mask as needed.
The area inside the mask region is excluded from the 
blob count.

 “Mask settings” (page 4-38)

4	Set the area to extract from the target.

	z For color type
Press [Settings] of the Color Extraction.

The screen to select a color to be extracted opens.
Press the color of the target to be counted.

Press

The pressed color will be extracted.
	y If the areas of color that have not been extracted 
are pressed repeatedly, the extraction range can be 
expanded.
	yPress the [Exclude] button to specify the color to 
exclude from the extracted color.
	yPress the [+]/[-] of the extraction area adjustment, and 
the range of color to be extracted can be expanded/
reduced.
	yPress [Undo] to cancel the previous operation 
(UNDO).
	yTo re-extract the color, press [Clear] and then tap the 
color to be the reference of judgment again.
	yBy pressing [LIVE image], the range of the extracted 
color can be set using the Live Image of the target.

When setting is completed, press [OK].
The system returns to the main screen for [Blob Count].
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	z For monochrome type
Press [Settings] of the the Brightness Extraction.

The screen to select brightness to be extracted opens.
Press the brightness of the target to be counted.

Press

The pressed brightness will be extracted.
	y If the areas of brightness that have not been extracted 
are pressed repeatedly, the extraction range can be 
expanded.
	yAdjust the slider, and the range of the brightness to be 
extracted can be expanded/reduced.

 “Outline tool” (page 4-48)
	yPress [Undo] to cancel the previous operation 
(UNDO).
	yTo re-extract the brightness, press [Clear] and then 
press the brightness to be the reference of judgment 
again.
	yBy pressing [LIVE image], the range of brightness to 
be extracted can be set using the Live Image of the 
target.

When setting is completed, press [OK].
The system returns to the main screen for [Blob Count].

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Take an “OK” image and a “NG” image.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.

7	Adjust the threshold for anomaly detection by 
checking the count.

Limit Match

The target is judged OK when the count is within 
a threshold range, and NG when it is outside the 
range.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Outline tool” (page 4-48)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

8	When setting is completed, press [OK].
The system returns to the main screen for [Blob Count].

9	Input a tool name as needed.
 “Tool Name Setting” (page 4-40)

10	Press [OK].
The system returns to the main screen for the tool 
settings.
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Advanced settings for the Blob tool

	� Advanced Color Extraction/Advanced 
Brightness Extraction

1	Select the [Extended Functions] tab and press 
[Setup] of [Advanced Color Extraction].
For a monochrome type, press [Setup] of [Advanced 
Brightness Extraction].

2	Specify a color or brightness of the extraction 
target.

	z For color type

	y You can adjust the value by slider while 
confirming the color histogram. The values 
within the range specified by the sliders will be 
used as the brightness.
	y The vertical axis indicates the extracted pixel.
	y Among the pixels of each color to be extracted, 
the maximum one becomes the maximum 
value of the vertical axis.
	y The range and extraction rules in the color 
extraction detailed settings are shown as 
follows.

H

Set the upper limit and lower limit for 
the range of 0 to 359.

	y Lower limit ≤ Upper limit
The extraction range of a color is from 
the lower limit to the upper limit.
	y Lower limit > Upper limit
The extraction range of a color is 
from 0 to the upper limit, and from the 
lower limit to 359.

S Set the upper limit and lower limit for 
the range of 0 to 255.
The extraction range of a color is from 
the lower limit to the upper limit.V

	y By pressing [LIVE image], the range of the 
extracted color can be set based on the Live 
Image of the target.
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	z For monochrome type

	y Adjust the value by slider while confirming the 
monochrome histogram.
The values within the range specified by the 
sliders will be used as the brightness.
	y The vertical axis indicates the extracted pixel.
Among the extracted pixels of each brightness, 
the one that has the most pixels becomes the 
maximum value of vertical axis.
	y The range and extraction rules in the extraction 
detailed settings are shown as follows.

V

Set the upper limit and lower limit for 
the range of 0 to 255.
The extraction range of the brightness 
is from the lower limit to the upper limit.

	y By pressing [LIVE image], the range of 
brightness to be extracted can be set based 
on the Live Image of the target.

3	Press [OK].
The system returns to the advanced settings for [Blob 
Count].

	� Size Limit Setting

1	Select the [Extended Functions] tab and press 
[Settings] of [Size Limit Setting].

2	Press [LIVE image] as needed, and take an “OK” 
image and an “NG” image.

	yThe image which the sensor is currently imaging will 
be displayed.
	y If [Trigger Options] is set to [External Trigger] or 
[Internal Trigger Control with IN1 Input] is set to 
[Enable], input the external trigger.
	y If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.
	yWhen pressing [Return to Master Image], the system 
returns to the master image display.

3	Adjust the threshold for the size by checking the 
matching rate.

MatchLimit

	yAdjust the slider, and the range of the threshold for 
the size can be expanded/reduced.
	yPress [+]/[-], and the range of the threshold for the 
size can be expanded/reduced.
	yThe Settings scale can be selected from [1-200] or 
[1-999] according to the range of the matching rate 
necessary for judgment.

The maximum size (area) extracted as a blob in 
the master image is set as the matching rate of 
100. The target is counted when the matching 
rate is within a threshold range, and "Size NG" 
when it is outside the range.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Outline tool” (page 4-48)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

4	When the Live image is displayed, pressing 
[Return to Master Image] returns to the master 
image display.

5	Press [OK].
The system returns to the advanced screen for [Blob 
Count].
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	� Boundary Exclusion

1	Select the [Extended Functions] tab and press 
[Settings] of [Boundary Exclusion].

2	Press [LIVE image] as needed, and take an “OK” 
image and an “NG” image.

	yThe image which the sensor is currently imaging will 
be displayed.
	y If [Trigger Options] is set to [External Trigger] or 
[Internal Trigger Control with IN1 Input] is set to 
[Enable], input the external trigger.
	y If the external trigger cannot be input, press [Trig.] to 
take an image of the target by temporarily using the 
internal trigger.
	yWhen pressing [Return to Master Image], it returns to 
the master image display.

3	Select enable or disable according to if the target 
can be protruding from the field of view. 

Enable The target that protrudes from the window is 
not counted.

Disable The target is counted when its size within the 
window is within the size range.

4	When the Live image is displayed, pressing 
[Return to Master Image] returns to the master 
image display.

5	Press [OK].
The system returns to the advanced screen for [Blob 
Count].

When "Enable" the Boundary Exclusion, the 
target that protrudes beyond the window is not 
counted.

Enable

Count: 3

The target that protrudes 
from the window is not 
counted.

Disable

Count: 4

The target is counted when 
its size within the window 
is within the size setting 
range.
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3. Part Registration Settings 
(Setting the Judgment Method of the Target of Sorting Mode)

This section explains the setting methods for “Step 3. Part 
Registration” of Sorting mode.
For "Step 3: Tool Settings" of Standard Mode, refer to  “3. 
Tool Settings (Setting the Judgment Method of the Target of 
Standard Mode)” (page 4-28).

Sorting mode enables multiple varieties (up to eight) to be 
registered and which part type the target matches to be 
judged.

An example usage of sorting mode:
	y Judge multiple part types
	yRank the same part type
	yBasic object phase discrimination

Up to 9 detection tools and position adjustment tools can 
be set in one program at the same time for judgment (up to 
8 detection tools can be set).

Workflow for Setting and Running Sorting 
Mode

In Sorting mode, the image registered with master 
registration is Part 0. The detection tool is set on the master 
image (Part 0). Register images for Part 1 to Part 7 in “Part 
Image Registration.”
Detection tools are automatically registered with the optimal 
parameters on multiple part type images. For instance, 
in the case of the learning tool, it learns the differences 
between part type images to identify the part type. For the 
color/brightness average tool, the color and brightness 
for each part type is registered to identify the part type. 
Multiple detection tools can also be used in combination to 
identify part types.
While the device is running, it judges whether a captured 
image of the object matches any of the part types and 
identifies the part type.

2. Master Registration

3. Part Registration

4. Output Settings

Tool Settings (Page 4-126)

OUT1: Part 0: (Master 00)
OUT2: Part 1: (Master 01)
OUT3: Part 2: (Master 02)
OUT4: Part 3: (Master 03)

Part Image Registration (Page 4-140)

Registered as Part 0 (Master 00)

Settings Navigator

RUN

Trigger input

BUSY output

Part 0 output

Part 1 output

Part 2 output

Part 3 outputPart 2

Part 1
(Master 01)

Part 2
(Master 02)

Part 3
(Master 03)
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Types of tools

Basic Tools

	� Learning Tool
A tool that can automatically recognize the difference 
between objects by registering and learning images that 
match the part type.
By performing additional learning, stability can be 
improved as well.

 �“Auto Adjustment by the Additional Learning 
(Learning Tool Only)” (page 6-2)

In the learning tool, learning will be executed after 
setting the tool windows used to identify part types 
(images where the differences are clear) and registering 
an image that matches the part type.

 “Learning tool” (page 4-41)
 “Learning Tool” (page 4-126)

	�Outline Tool
A detection tool to calculate the matching rate for the 
target based on the outline information of a registered 
part type.
Judges a part type by setting the threshold for the 
matching rate.

 “Outline tool” (page 4-48)
 “Outline Tool” (page 4-127)

	� Color/Brightness Average Tool
A tool to calculate the matching rate in the color and 
brightness of a target to be examined in comparison to 
the color and brightness of a registered part type-target 
(100%). Judges a part type by setting the threshold for 
the matching rate.
If the sensor is color type, the tool will be the Color 
Average tool. The system judges using a user-defined 
color.
If the sensor is monochrome type, the tool will be the 
Brightness Average tool. The system judges using a 
user-defined brightness.
This tool is different from the Color Area/Area tool, as 
only the color/brightness is considered, and not the 
amount of pixels in the target area.

 “Color/Brightness Average Tool” (page 4-59)
 “Color/Brightness Average Tool” (page 4-129)

	� Position Adjustment Tool
A tool to correct the differences in position of a target by 
searching for the outline information of a registered part 
type. The position adjustment is used in conjunction 
with other detection tools.

 “Position Adjustment Tool” (page 4-66)
 “Position Adjustment Tool” (page 4-132)

Advanced Tool 1

	�Width Tool
A detection tool to calculate the width of the target 
based on the width of a registered part type. Judges a 
part type by setting the threshold for the width.
 “Width Tool” (page 4-70)
 “Width Tool” (page 4-134)

	� Diameter Tool
A detection tool to calculate the diameter of the target 
based on the diameter of a registered part type. Judges 
a part type by setting the threshold for the diameter.
 “Diameter Tool” (page 4-76)
 “Diameter Tool” (page 4-136)

	� High Speed Adjustment Tool
A tool to correct for differences in position of a target by 
searching the edge feature of a registered part type.
The Hi-Sp.Adj tool is used with other detection tools. 
Compared with the normal position adjustment tool, 
the Hi-Sp.Adj tool allows for a high speed adjustment 
process.
Select either 1-Axis Adjustment which corrects X axis 
position or Y axis position, or 2-Axis Adjustment which 
corrects both directions of X axis and Y axis.

 “High-Speed Position Adjustment Tool” (page 4-92)
 “High-Speed Position Adjustment tool” (page 4-138)
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Main Screen for the Part Registration 
Settings

This section explains the main screen for the Part 
Registration settings.

(10)(9) (11)

(1)

(2)

(3)

(4)

(5)

(6)
(7)

(8)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(3)	 Master Image
Displays the master image, tool window for the learning 
tool, and position adjustment window for the position 
adjustment tool. If a search range is set, a window 
which indicates the range (light blue) will be displayed.

(4)	 Tool operation button
Adds, edits, or deletes the learning tool and position 
adjustment tool.

(5)	 Tool selection button
Selects the tool to confirm/edit/delete the setting 
contents.

(6)	 Condition Display
Displays the condition of the learning settings.

Display Status

None The learning tool is not set.

Not learned
The learning for the target to 
judge the part type has not 
been completed.

Learned The target to judge the part 
type has been learned.

Relearning required Relearning is needed because 
of a setting change.

(7)	 [Part Image Registration] button
Performs the imaging and learning for the target to 
judge the part type.

 “Part Image Registration” (page 4-140)
(8)	 [Limit/Outline Adjustment] button

This button adjusts the threshold for detection tools with 
the exception of the position adjustment and high speed 
adjustment tools and adjusts the outline for the outline 
tool.

 “Limit Adjustment” (page 4-145)
 “Adjusting the Outline” (page 4-146)

(9)	 [Back] button
Returns to the master registration screen.

	� “2. Master Image Registration (Registering an Image 
as a Reference)” (page 4-20)

(10)	 [Next to STEP4] button
Proceeds to the Output Assignment settings.

	� “4. Output Assignment (Setting Details of Outputting 
to Output Line)” (page 4-147)

(11)	[Quit] button
Finishes the Settings Navigator.
 “Finishing the Settings Navigator” (page 4-7)

Adding/Editing/Copying/Deleting a Tool

Adding a Tool

1	Press [Add Tool].

2	Select the tool to be added and press [OK].

3	Set setting items for each tool.

	z Basic Tools
 “Learning Tool” (page 4-126)
 “Outline Tool” (page 4-127)
 “Color/Brightness Average Tool” (page 4-129)
 “Position Adjustment Tool” (page 4-132)

	z Extra 1
 “Width Tool” (page 4-134)
 “Diameter Tool” (page 4-136)
 “High-Speed Position Adjustment tool” (page 4-138)
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Editing a tool

1	Select a tool to edit the settings.

Selected tool

2	Press [Edit].

3	Edit setting items for each tool.

	z Basic Tools
 “Learning Tool” (page 4-126)
 “Outline Tool” (page 4-127)
 “Color/Brightness Average Tool” (page 4-129)
 “Position Adjustment Tool” (page 4-132)

	z Extra 1
 “Width Tool” (page 4-134)
 “Diameter Tool” (page 4-136)
 “High-Speed Position Adjustment tool” (page 4-138)

Copying a tool

	yCopies a tool which has been set, and pastes 
it to the same position. The Pos. Adj. tool and 
Hi‑Sp.Adj tool cannot be copied.
	y If eight detection tools are set, tools cannot be 
copied.

1	Select a tool to be copied.

Selected tool

2	Press [Copy].

3	Press [OK].

The copied tool window with the will be selected and 
displayed in the copy source tool window.

Button of the copied tool

Copied tool

The next available tool number which has not 
been set will be automatically assigned as the 
copied tool number.

4	Press [Edit] and adjust the settings of the copied 
tool.

	z Basic Tools
 “Learning Tool” (page 4-126)
 “Outline Tool” (page 4-127)
 “Color/Brightness Average Tool” (page 4-129)
 “Position Adjustment Tool” (page 4-132)

	z Extra 1
 “Width Tool” (page 4-134)
 “Diameter Tool” (page 4-136)
 “High-Speed Position Adjustment tool” (page 4-138)
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Deleting a tool

1	Select a tool to be deleted.

Selected tool

2	Press [Delete].

The confirmation screen opens.

3	Press [OK].
The selected tool will be deleted and the sensor returns 
to the main screen for the Tool settings.

Common Setting Items for the Tool 
Settings

Mask
Adds a rectangular/circular mask region in the window frame.

	y□ Rect (default): Specifies a rectangular mask region or a 
mask cutting region.
	y○ Circle: Specifies the area to mask the target or remove 
from the mask with a circular window.
 “Mask settings” (page 4-38)

Tool Name Setting
The tool name can be edited. Up to 16 characters in 
alphanumeric can be set.

 “Tool Name Setting” (page 4-40)
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Learning Tool

	z Settings for the Learning Tool

Items Description Ref.

Window Shape Select the window shape to specify the area of the target to detect. -

Mask

Adds a rectangular/circular mask region in the window frame. The area inside the 
mask region is excluded from the learning target. In addition, a mask cutting region 
can be added in the mask region. Inside the region removed from the mask, the mask 
is disabled and learning is enabled. Adding a mask or removing sections of the mask 
can be performed up to 20 times.

4-38

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool names 
can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)
4-40

Adding Learning tool for the Part 
Registration settings

1	Add [Learning Tool].
 “Adding a Tool” (page 4-123)

The main screen for [Learning Tool] opens.

Only one learning tool can be set in Sorting 
mode. Multiple learning tools cannot be set.

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

 “Editing the Window” (page 3-14)

Set the position, size, and 
angle

	y The tool window size should be set 
according to the size of the image where 
the difference between an “OK” and “NG” 
target is clear.

 �“Optimizing the Size of the Tool 
Window” (page 6-19)

	y If misalignment of the tool window occurs 
because of target position misalignment 
when optimizing the window, set the 
position adjustment tool.

 �“Setting of the Position Adjustment 
Tool” (page 4-133)

3	Add or Adjust the [Mask] as needed.
 “Mask settings” (page 4-38)

4	Perform the settings for the tool name as needed.
 “Tool Name Setting” (page 4-40)

5	Press [OK].
The system returns to the main screen of the Part 
Registration settings.
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Outline Tool

	z Setting items for the Outline tool

Items Description Ref.

Edit Window

Window Shape Select the window shape used to specify the area of the target to be 
detected.

―
Search Range

Specifies an area in which to search for the outline of a target. By 
using a narrower area for the search range, the processing time will be 
shortened.

Fine Tune 
Outline

Remove Outline
Judges by disabling an unnecessary outline which interrupts the 
stabilized detection. The disabled outlines can be specified by tracing the 
extracted outline.

4-50

Sensitivity The outline extraction sensitivity can be selected according to the target 
quality. 4-50

Limit Adjustment
Adjusts the threshold (matching rate) used in the part type judgment. 
During threshold adjustment, the system turns to Test mode so that the 
thresholds can be adjusted to the applicable value for operation.

―

Tool Name
A user-defined name, such as the name of a target, can be set for tools. 
Tool names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)
4-40

	z Setting items for the Outline tool (advanced settings)

Items Description Ref.

Rotation Range

Sets the range of rotation to search for the outline of the target.
The system judges NG if an angle of the target exceeds its rotation range 
even if the target is the same shape.

	y If the rotation range is set wide, the acceptable range of variation in the 
angles at which a target can be placed is wider.
	y If the rotation range is set narrow, the processing time can be 
shortened.
	y The direction of the target can be judged by limiting the rotation range.

4-51

Search Algorithm The detection mode of the Outline tool can be changed depending on the 
inspection requirements. 4-51
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Setting the Outline Tool

1	Add the [Outline] tool.
 “Adding a Tool” (page 4-123)

The main screen for [Outline] opens.

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

Set the position, size, and angle

□ Rectangle ○ Circle

The window angle can be reset using the [Angle 
Reset] button.

3	Set the search range as needed.
 “Search Range Settings” (page 4-50)

4	Adjust the outline as needed.
 “Settings for Disabling Outlines” (page 4-50)
 “Setting a Sensitivity” (page 4-50)

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Capture the part type.
If [Trigger Options] is set to [External] or [Internal 
Trigger Control with IN1] is set to [Enable], input an 
external trigger.
If the external trigger cannot be input, press [Trigger 
ON] to take an image of the target by temporarily using 
the internal trigger.

7	Adjust the threshold for part type judgment by 
checking the matching rate.
<Setting example>
If the matching rate of the same part type is higher than 
90 and if the matching rate of a different part type is 
lower than 40, set the threshold to 65, which is a value 
in between 40 and 90.

Threshold Matching rate

	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	y A matching rate of 100 indicates that an 
outline is completely matched. The matching 
rate decreases with differences between the 
outline of the target and the master image.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

	� “Matching Rate of the Outline Tool and 
Position Adjustment Tool” (page A-6)

8	Press [OK].
The system returns to the main screen of [Outline].

9	Set a tool name as needed.
 “Tool Name Setting” (page 4-40)

10	Press [OK].
The system returns to the main screen for the tool 
settings.

[Fine Tune Outline] and [Limit Adjustment] are 
performed in this section for the image of the 
part type registered in “2. Master Registration”.
For details about [Fine Tune Outline] and [Limit 
Adjustment] for images registered of other part 
types, see “Limit/Outline Adjustment.”

 “Limit/Outline Adjustment” (page 4-145)
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Color/Brightness Average Tool

	z Setting Items for the Color/Brightness Average tool

Items Description Ref.

Master Color Settings
(For color type)

Master Bright. Settings
(For monochrome type)

Window Shape Selects the window shape to specify an area of the target 
to be extracted.

―
Angle Reset When the window shape is set to [□Rect], resets the angle 

of the window.

Mask

Adds a rectangular/circular mask region in the window 
frame. The area inside the mask area is excluded from 
the color and brightness average. In addition, adds a 
rectangular/circular cutting region in the mask region. 
The mask is disabled inside the mask cutting region and 
it becomes the target of color and brightness average. 
Adding a mask or removing sections of the mask can be 
performed up to 20 times.

4-38

Limit Adjustment

Adjusts the threshold (matching rate) used in the part 
type judgment. During threshold adjustment, the system 
switches to Test mode so that the threshold can be 
adjusted to an applicable value for operation.

―

Tool Name

A user-defined name, such as the name of a target, can 
be set for tools. Tool names can be checked on the run 
screen.

	� “Chapter 5 Running” (page 5-1)

4-40

	z Setting Items for the Color/Brightness Average tool (advanced settings)

Items Description Ref.

Color Range
(For color type)

Brightness Range
(For monochrome type)

	yColor type
Specifies the judgment sensitivity for the color extracted from the master 
image.

	yMonochrome type
Specifies the judgment sensitivity for the brightness extracted from the master 
image. 4-61

Live image The color range to be extracted can be set using the Live image of the target.

From a Hist. Imports images to be used for the judgment sensitivity from the running image 
history.

From File Imports an image used for the judgment sensitivity from a file saved on your 
computer.

Specify Mast.Color
(For color type)

Specify Mast.Bright
(For monochrome type)

Selects how to specify the master color/brightness.
In Sorting mode, only [From Mst.Img.] can be selected. 4-65
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Setting the color/brightness average tool

1	Add the [Color Avg.] tool (color type) or [Bright. 
Avg.] tool (monochrome type).

 “Adding a Tool” (page 4-123)
The main screen for [Color Avg.]/[Bright. Avg.] opens.

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

 “Editing the Window” (page 3-14)

Set a position, size, and angle

□ Rectangle ○ Circle

When [Entire] is selected, the tool window will be 
hidden.

The window angle can be reset using the [Angle 
Reset] button.

	y The average color or average brightness 
value is automatically extracted from inside 
the window.
	yOnly set the window size to the color or 
brightness area that you want to judge. If 
the background is included, the average 
color or brightness average that includes 
the background color will be registered. 
Therefore, the matching rate difference 
between the part type that you want to 
judge will decrease.

Good example Bad example

3	Apply the mask as needed.
The area inside the mask area is excluded from 
average color or average brightness extraction.

 “Mask settings” (page 4-38)

4	Press [Live Adjustment].

The sensor changes to the test operation.

5	Capture the part type.
If [Trigger Options] is set to [External] or [Internal 
Trigger Control with IN1] is set to [Enable], input an 
external trigger.
If the external trigger cannot be input, press [Trigger 
ON] to take an image of the target by temporarily using 
the internal trigger.
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6	Adjust the threshold for part type judgment by 
checking the matching rate.
<Setting example>
If the matching rate of the same part type is higher than 
90 and if the matching rate of a different part type is 
lower than 40, set the threshold to 65, which is a value 
in between 40 and 90.

Threshold Matching rate

Average color/brightness of the master 
image
Average color/brightness of the Live 
image

	y 100 indicates that the color and brightness 
is completely matched. The matching rate 
decreases as the color or brightness of the 
target differs. For the color average tool, the 
smallest matching rate for H/S/V calculated 
individually will be the matching rate for the 
tool.
	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

7	Set a tool name as needed.
 “Tool Name Setting” (page 4-40)

8	Press [OK].
The system returns to the main screen for the tool 
settings.

[Limit Adjustment] is performed in this section 
for the image of the part type registered in “2. 
Master Registration”.
For details about [Limit Adjustment] for images 
registered of other part types, see “Limit/Outline 
Adjustment.”

 “Limit/Outline Adjustment” (page 4-145)
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Position Adjustment Tool

	z Setting items for the Position Adjustment tool

Items Description Ref.

Edit Window

Window Shape Select the shape of the window to specify the area of the target used 
as the position adjustment reference.

―
Search Range

Specifies an area in which to serve as the reference of position 
adjustment for a target. By using a narrower area for the search 
range, the processing time will be shortened.

Fine Tune 
Outline

Remove Outline
Judges by disabling an unnecessary outline which interrupts the 
stabilized detection. The disabled outlines can be specified by tracing 
the extracted outline.

4-50

Sensitivity The outline extraction sensitivity can be selected according to the 
target quality. 4-50

Limit Adjustment

Adjusts the threshold (matching rate) which judges whether the 
position adjustment succeeds or fails. During threshold adjustment, 
the system turns to Test mode so that the thresholds can be adjusted 
to the applicable value for operation.

―

Tool Name
A user-defined name, such as the name of a target, can be set for 
tools. Tool names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)
4-40

	z Setting items for the Position Adjustment tool (Advanced Settings)

Items Description Ref.

Rotation Range

Sets the range of rotation to adjust the position for the target.
The status result of the position adjustment is NG and position is not adjusted if the angle 
of rotation of the target exceeds its rotation range.

	y If the rotation range is set wide, the acceptable range of variation in the angles at which 
a target can be placed is wider.
	y If the rotation range is set narrow, the processing time can be shortened.

4-69

Search Algorithm The algorithm used to search for the Position Adjustment tool can be adjusted depending 
on the inspection requirements. 4-69
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Setting of the Position Adjustment Tool

Only one position adjustment tool can be set in 
Sorting mode. Position adjustment tool cannot 
be set.

1	Adds the position adjustment tool.
 “Adding a Tool” (page 4-123)

The main screen for [Pos. Adj.] opens.

2	Perform [Edit Window].

Pressing the window directly will also allow for 
editing of the window.

Select the tool window shape, position, size, and angle 
according to the target.

 “Editing the Window” (page 3-14)

Set a position, size, and 
angle

□ Rectangle ○ Circle

Set the position and size of the position 
adjustment tool to capture as much of a 
part that is common amongst all targets as 
possible.

 “Stabilizing the Position Adjustment” 
(page 6-21)

The window angle can be reset using the [Angle 
Reset] button.

3	Set the search range as needed.
 “Search Range Settings” (page 4-68)

4	Adjust the outline as needed.
 “Settings for Disabling Outlines” (page 4-68)
 “Setting a Sensitivity” (page 4-68)

5	Press [Live Adjustment].

The sensor changes to the test operation.

6	Image the target.
If [Trigger Options] is set to [External] or [Internal 
Trigger Control with IN1] is set to [Enable], input an 
external trigger.
If the external trigger cannot be input, press [Trigger 
ON] to take an image of the target by temporarily using 
the internal trigger.

7	Adjust the threshold to judge whether or not the 
position adjustment succeeds by checking the 
matching rate.

Threshold Matching rate

	y If there are many variations of the target shape 
that the position adjustment tool has been set 
to, set the threshold to a lower matching rate.
	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.

	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

8	When setting is completed, press [OK].
The system returns to the main screen for [Pos. Adj.].

9	Set a tool name as needed.
 “Tool Name Setting” (page 4-40)

10	Press [OK].
The system returns to the main screen for the tool 
settings.
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Width Tool

	z Setting items for the Width tool

Items Description Ref.

Edit Window Specifies the area of the target to be detected using a tool window. ―

Mask
Adds a rectangular mask region in the tool window frame.
The area inside the mask region is excluded from the width detection 
target.

4-38

Edge Sensitivity Auto Adjustment Automatically adjust the sensitivity that detects the edge that will become 
the standard of reference for width extraction.

4-84(Manual adjustment) Manually adjust the sensitivity that detects the edge that will become the 
standard of reference for width extraction.

Live image The edge sensitivity can be adjusted from the Live image of the target.

Limit Adjustment
Adjusts the threshold (matching rate) used in the part type judgment. 
During threshold adjustment, the system turns to Test mode so that the 
thresholds can be adjusted to the applicable value for operation.

4-85Upper Limit

Enables an upper limit on the threshold.
Enable when part type judgment is desired for a situation when the target 
width is greater than the part type width.
In sorting mode, this setting can only be selected if [Enable] is set.

Scale When the upper limit of the threshold is ON, select the threshold scale 
according to the range of the matching rate required for judgment.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. 
Tool names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)
4-40

	z Setting items for the Width tool (advanced settings)

Items Description Ref.

Width Extraction 
Method Width Mode Select the method used to extract the target width. 4-73

Scaling

Scaling Setting

Sets scaling.
Set when length is being used for part type judgment instead of the 
matching rate.
Scaling is required in Sorting Mode.

4-80

Display Value

When scaling is enabled, inputs the display value in relation to matching 
rate 100. A matching rate of 100 indicates that the target width is 
completely matched to the master image. The matching rate becomes 
smaller with a narrower width and larger with a wider width.

Copy Setting When scaling is enabled, copy the scaling settings from another tool.
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Setting the Width Tool

1	Select the [Extra 1] tab, and add the [Width] tool.
 “Adding a Tool” (page 4-123)

The [Width] direction selection screen opens.

2	Press [Horizontal Dir.]/[Vertical Dir.].

The main screen for [Width] opens.

3	Set the position, size, and angle of the tool 
window according to the target.

 “Editing the Window” (page 3-14)

Set a position, size, and 
angle

The window angle can be reset using the [Angle 
Reset] button.

4	Apply the mask as needed.
The area inside the mask region is excluded from the 
width detection target.

 “Mask settings” (page 4-38)

5	Adjust the edge sensitivity setting as needed.
 “Edge Sensitivity Settings” (page 4-72)

6	Set scaling.
 “Scaling Setting” (page 4-74)

7	Press [Live Adjustment].

The sensor changes to the test operation.

8	Capture the part type.
If [Trigger Options] is set to [External] or [Internal 
Trigger Control with IN1] is set to [Enable], input an 
external trigger.
If the external trigger cannot be input, press [Trigger 
ON] to take an image of the target by temporarily using 
the internal trigger.

9	Adjust the threshold for part type judgment by 
checking the matching rate.
The setting range is 0 to 200 or 0 to 999, the lowest 
default value is 80, and highest default value is 120 
(These vary depending on the scaling setting).
Set the judgment range as the same part type.

Threshold (upper limit)
Matching rateThreshold  

(lower limit)

	y The target is judged OK when the matching 
rate is within a threshold range, and NG when 
it is outside the range.
	y A matching rate of 100 indicates that the target 
width is completely matched to the master 
image. The matching rate becomes smaller 
with a narrower width and larger with a wider 
width. If the matching rate exceeds the upper 
limit of the threshold range, the matching rate 
will display as the upper limit of the threshold 
range.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

10	When setting is completed, press [OK].
The system returns to the main screen of [Width].

11	Set a tool name as needed.
 “Tool Name Setting” (page 4-40)

12	Press [OK].
The system returns to the main screen for the tool 
settings.

[Limit Adjustment] is performed in this section 
for the image of the part type registered in “2. 
Master Registration”.
For details about [Limit Adjustment] for images 
registered of other part types, see “Limit/Outline 
Adjustment.”

 “Limit/Outline Adjustment” (page 4-145)

4

Settings N
avigator



4-136 IV3 Series User’s Manual (PC Software)

3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

Diameter Tool

	z Setting items for the Diameter tool

Items Description Ref.

Edit Window Specifies the area of the target to be detected using a tool window. ―

Mask
Adds a circular mask region in the tool window frame.
The area inside the mask region is excluded from the diameter detection 
target.

4-38

Diameter 
Extraction

Ext. Sens Selects the sensitivity for diameter extraction according to the target.
4-78Change Specified 

Circle
The diameter used for inspection can be changed when there are multiple 
circles of the extracted diameter.

Limit Adjustment
Adjusts the threshold (matching rate) used in the part type judgment. During 
threshold adjustment, the system turns to Test mode so that the thresholds 
can be adjusted to the applicable value for operation.

4-85Upper Limit

Enables an upper limit on the threshold.
Set if the part type judgment is desired when a target diameter is longer than 
the part type diameter.
In sorting mode, this setting can only be selected if [Enable] is set.

Scale When the upper limit of the threshold is ON, select the threshold scale 
according to the range of the matching rate required for judgment.

Tool Name
A user-defined name, such as the name of a target, can be set for tools. Tool 
names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)
4-40

	z Setting items for the Diameter tool (advanced settings)

Items Description Ref.

Diameter 
Extraction

Diameter 
Mode Select the method used to extract the target diameter. 4-79

Bright/Dark Direction Selects the direction for which the tool detects the target edge. 4-80

Scaling

Scaling 
Setting

Sets scaling.
Set when length is being used for part type judgment instead of the matching 
rate.
Scaling is required in Sorting Mode.

4-80

Display Value When scaling is enabled, inputs the display value in relation to matching rate 
100.

Copy Setting When scaling is enabled, copy the scaling settings from another tool.
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Setting the Diameter Tool

1	Select the [Extra 1] tab, and add the [Diameter] 
tool.

 “Adding a Tool” (page 4-123)
The main screen for [Diameter] opens.

2	Set the position and size of the tool window 
according to a target.
Place the center of the tool window inside the target.

Set the tool window

Center of tool window

 “Editing the Window” (page 3-14)

The sensor detects circles from the center of 
tool window towards outside.

3	Apply the mask as needed.
The area inside the mask region is excluded from the 
diameter detection target.

 “Mask settings” (page 4-38)

4	Perform diameter extraction as needed.
 “Diameter Extraction Settings” (page 4-78)

5	Set scaling.
 “Scaling Setting” (page 4-74)

6	Press [Live Adjustment].

The sensor changes to the test operation.

7	Capture the part type.
If [Trigger Options] is set to [External] or [Internal 
Trigger Control with IN1] is set to [Enable], input an 
external trigger.
If the external trigger cannot be input, press [Trigger 
ON] to take an image of the target by temporarily using 
the internal trigger.

8	Adjust the threshold for part type judgment by 
checking the matching rate.
Set the judgment range as the same part type.

Threshold (upper limit)
Matching rateThreshold 

(lower limit)

	y The target is judged OK when the matching 
rate is within a threshold range, and NG when 
it is outside the range.
	y The threshold can be changed using the slider 
or the [+]/[-] button.
	� “Selecting the Display Method of the Tool 
Window” (page 5-7)

	� “Editing Numbers” (page 3-15)
	 �“Adjusting Thresholds for Judgment” 
(page 6-15)

9	When setting is completed, press [OK].
The system returns to the main screen of [Diameter].

10	Set a tool name as needed.
 “Tool Name Setting” (page 4-40)

11	Press [OK].
The system returns to the main screen for the tool 
settings.

[Limit Adjustment] is performed in this section 
for the image of the part type registered in “2. 
Master Registration”.
For details about [Limit Adjustment] for images 
registered of other part types, see “Limit/Outline 
Adjustment.”

 “Limit/Outline Adjustment” (page 4-145)
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

High-Speed Position Adjustment tool

	z Setting items for the High-Speed Position Adjustment tool
The contents of the extended functions that can be set in [1-Ax. Adj], [2-Ax. Adj (Axis:X)], and [2-Ax. Adj (Axis:Y)] are 
the same.

Items Description Ref.

Axis

Axis:X

Axis:Y

Edit Window Specifies the area of the target to be detected using a tool window.
―

Scan Direction Selects the direction for which the tool detects the target edge.

Edge Sensitivity Settings Sets the sensitivity which detects the edge.

4-95

Edge Sensitivity Auto 
Adjustment Automatically adjusts the sensitivity which detects the edge.

Manual adjustment Manually adjusts the sensitivity that detects the edge. 1 to 100 (default: 
50)

Show edge graph Displays the edge graph on an image.

Live image The edge sensitivity can be adjusted from the Live image of the target.

Common Test Operation Changes to Test mode, used to check that the position adjustment has 
been performed correctly. 4-93

Tool Name
A user-defined name, such as the name of a target, can be set for 
tools. Tool names can be checked on the run screen.

 ‌�“Chapter 5 Running” (page 5-1)
4-40

	z Setting items for the High-Speed Position Adjustment tool (Advanced Settings)
The contents of the extended functions that can be set in [1-Ax. Adj], [2-Ax. Adj (Axis:X)], and [2-Ax. Adj (Axis:Y)] are 
the same.

Items Description Ref.

Edge Detection Selects the bright/dark direction that detects a target edge. 4-96
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

Setting the High-Speed Position Adjustment 
Tool

	� 1-Axis Adjustment

1	Select the [Extra 1] tab, and add the [Hi-Sp.Adj] 
tool.

 “Adding a Tool” (page 4-123)

2	Select the [1-Ax. Adjustment] button. Press 
[Horizontal Dir.] or [Vertical Dir.], and press [OK].

The main screen for [1-Ax. Adj] opens.

3	Select the detection direction, and set the 
position and size of the tool window according to 
a target.

Set a position, size, and 
angle

	yDetection direction: Left (default)
Detects edges from the left side of window to the right 
side.

Tool window

	yScan Direction: Right
Detects edges from the right side of window to the left 
side.

Tool window

	yScan Direction: Top
Detects edges from the top of window to the bottom.

Tool window

	yScan Direction: Bottom
Detects edges from the bottom of window to the top.

Tool window

4	Adjust the edge sensitivity setting as needed.
 “Edge Sensitivity Settings” (page 4-95)

5	Press [Common], and then press [Test run].

The sensor changes to the test operation.

6	Position correction is performed and the edge 
detection process can be confirmed.

7	Press [OK].
The system returns to the main screen for [1-Ax. Adj].

8	Set a tool name as needed.
 “Tool Name Setting” (page 4-40)

9	Press [OK].
The system returns to the main screen for the tool 
settings.
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

Part Image Registration

	z Setting items for the Part image registration

Items Description Ref.

Add Part Type Up to 8 part types can be added. 4-142

Part Name Part type names for each part type can be edited. 4-142

Add Image Registers Live images as the target to judge the part type. 4-143

Start Learning
(When the learning tool is set) Learns the target to judge the part type. 4-142

	z Setting items for the Part image registration (Advanced Settings)

Items Description Ref.

Variable Brightness
(When the learning tool is set)

Sets whether to register multiple images of different brightness when 
registering the target to judge the part type.
To use variable brightness, the target must not be moving.

4-142

From File Imports images to be registered as the target to judge the part type 
from the file saved in the PC. 4-144

From History Imports images to be registered as the target to judge the part type 
from the image history. 4-143
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

Part Image Registration Screen
When the learning tool is set

(12)(11)(10)

(6)
(5)

(9)

(4)

(7)

(8)

(2)

(3)

(1)

When the learning tool is not set

(12)(11)(10)

(5)

(9)

(4)

(7)

(8)

(2)

(3)

(1)

(1)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(2)	 Part list
Displays the added part type images.
Up to 8 part types can be displayed.

(3)	 Image taken by the sensor
Displays an image taken by the sensor.

(4)	 [Settings]/[Extended Functions] tab
Switches between the settings tab and advanced 
settings tab.

(5)	 [Part Name] button
Edits the master names of each part type.

(6)	 Number of images registered
Displays the number of images registered.

If Variable Brightness is [ON], by registering 
the first image, seven images are registered 
including the variable brightness images (six 
images).

(7)	 Operation buttons

Deletes all registered images.
The image registered at Part 0 cannot be deleted 
because it is linked to the master image.

Deletes the last registered image so that it can be 
redone.

The registered image can be expanded and 
checked.
When registering multiple images, they can be 
confirmed with the move buttons.

(8)	 [Add Image] button
Press [Add Image] when registering a capture image as 
a target to judge the part type. Registers at least one 
image each.
Repeat the operation so that multiple images can be 
registered as well.

(9)	 Registered image
Displays the last registered image.

(10)	Added part display or hide button
Controls whether to display or hide the added part type 
image.

(11)	[Start Learning] button
Starts the learning.

(12)	[Back] button
The system returns to the main screen of the Part 
Registration settings.
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

Procedure to Part Image Registration

1	Press [Part Image Registration].
 “Main Screen for the Part Registration Settings” 

(page 4-123)

2	Select Part1.
Selects Part1 from the Part list.

	y For Part0, a master image is automatically 
registered. When changing the image of 
Part0, perform master image registration 
again.
	y To start learning, at least two part types 
(including Part0) must be registered.

3	Register the image for the part type.
Registers an image as the target to judge the part type.

	z Registration of Taken Image
 “Registration of Taken Image” (page 4-143)

	z Registration of Image from the Image History
 “Registration of Image from the Image History” 

(page 4-143)

	z Registration of image saved in a file
 “Registration of image saved in a file” (page 4-144)

The registered image will be displayed.

4	When the learning tool is set, repeat step 3 when 
registering multiple images for the part type.

By capturing multiple images of different 
judgment criteria, the judgment stability will 
be improved automatically.

 “Learning Multiple Images for Stability” 
(page 6-20)

5	Add Part2 to 7 as needed.
Up to 7 part types can be added.

6	Register the images for each part type.
Registers an image as the target to judge the part type.
The registration method is the same as step 3 to 4.

7	Press [Start Learning] or [OK].

	z When the learning tool is set
Press [Start Learning].

When learning is completed, press [OK].

The system returns to the main screen of [Part 
Registration].

When the part registration settings are 
completed, [Learned] will be displayed.

	z When the learning tool is not set
Press [OK].

The system returns to the main screen of [Part 
Registration].
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

	� Registration of Taken Image

1	When changing the [Variable Brightness] setting, 
select the [Extended Functions] tab.

Variable brightness can be ON in the following 
cases.

	yDuring internal trigger
	yWhen pressing [T] with external trigger set to 
image by using the internal trigger.

2	Image a target to be registered.
If [Trigger Options] is set to [External Trigger] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
the external trigger.
If an external trigger cannot be input, press [T] to take 
an image of the target by temporarily using the internal 
trigger.

3	Press [Add Image].

The captured image will be displayed.

	� Registration of Image from the Image 
History

1	Select the [Extended Functions] tab and select 
[From History].

2	Select the image to be registered, and press [OK].

Select the 
image

3	Press [OK].

The registered image will be displayed.
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

	� Registration of image saved in a file

1	Store a batch backup file (*.iv3a), an individual 
program backup file (*.iv3a) or an image capture 
file (*.iv3p) beforehand in the PC folder.

 “Saving the Sensor Settings and Images” (page 8-3)

2	Press [From File].

3	Select the file to be imported, and press [Open].

Select the file

4	If a batch backup file (*.iv3a) or individual 
program backup file (*.iv3a) is selected, select 
the image type to be imported from the following.

	yRunning Image History
	yMaster Image
	y Learned Image History

Select the target program when the Learned Image 
History is selected.

The list of images saved as the selected file image type 
will be displayed.

5	Select the image to be registered, and press [OK].

Select the 
image

The registered image will be displayed.

6	Press [OK].

The registered image will be displayed.
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

Limit/Outline Adjustment
The threshold for each part type registered in the detection 
tool can be adjusted. Additionally, the outline for each part 
type registered in the outline tool can also be adjusted.
Note that the threshold for the position adjustment/high-
speed adjustment tool cannot be adjusted.

Limit Adjustment

1	Press [Limit/Outline Adjustment] on the part type 
settings screen.

2	Select the detection tool and then press [Limit 
Adjust].

The sensor changes to Test mode.
The Limit Adjustment screen appears.

3	Select the part type for which the threshold is to 
be adjusted.

M0 to M7 displayed on the screen represents Part 0 to 
Part 7.

4	Image the part type target to be the reference of 
judgment.
If [Trigger Options] is set to [External] or [Internal 
Trigger Control with IN1 Input] is set to [Enable], input 
an external trigger.
If the external trigger cannot be input, press [Trigger 
ON] to take an image of the target by temporarily using 
the internal trigger.

5	Adjust the threshold by checking the matching 
rate.
The optimal threshold can be set for each part type (M0 
to M7).

	z Outline Tool/Color/Brightness Average Tool
<Setting example>
If the matching rate of the same part type is higher than 
90 and if the matching rate of a different part type is 
lower than 40, set the threshold to 65, which is a value 
in between 40 and 90.

Threshold

Matching rate

	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	y A matching rate of 100 indicates that the target 
is completely matched to the master image. 
The matching rate decreases with differences 
between the outline of the target and the 
master image.
 �“Adjusting Thresholds for Judgment” 
(page 6-15)

	z Width tool/Diameter tool
	yThe width tool sets the range of the width to be judged 
as the same part type.

 “Setting the Width Tool” (page 4-135)
	yThe diameter tool sets the range of the diameter as 
the same part type.
 “Setting the Diameter Tool” (page 4-137)

	z Learning tool

For learning tool, threshold adjustment 
is not needed since the target match is 
automatically adjusted by learning.
Use threshold adjustment if additional 
learning cannot be made or when it is 
determined to be needed after additional 
learning.
Additional learning also enables “NG” 
images to be registered and learned.

 �“Auto Adjustment by the Additional 
Learning (Learning Tool Only)” (page 6-2)

The matching rate of either part type appears. The part 
type is not displayed. Adjust the threshold so that all 
part types are “OK” and part type images that are not 
registered are “NG”.

6	Press [OK] to return to the threshold/outline 
adjustment screen.
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3. Part Registration Settings (Setting the Judgment Method of the Target of Sorting Mode)

Adjusting the Outline

1	Press [Limit/Outline Adjustment] on the part type 
settings screen.

2	Select the outline tool and then press [Fine Tune 
Outline].

3	Select the part type image for which the outline 
is to be adjusted, and press [OK].

0 to 7 displayed on the screen represents Part 0 to Part 
7.

4	Adjust outline removal and sensitivity.

 “Settings for Disabling Outlines” (page 4-68)
 “Setting a Sensitivity” (page 4-68)

5	Press [OK] to return to the threshold/outline 
adjustment screen.
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4. Output Assignment (Setting Details of Outputting to Output Line)

Set the output items to be assigned to the output line.
	� “Cables” (page 2-15)
	 “Chapter 11 Controlling with the Input/Output Line” 

(page 11-1)

Main Screen for the Output Assignment

(8)(7) (9)

(1)

(2)

(3)

(4)

(6)

(5)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 [Image Type] display
 “Image Types of the Settings Navigator” (page 4-5)

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Master Image
Displays the master image and tool window.

(5)	 Output Assignment button
	y [Output Asgmt.] tab
Assigns the output item to each output line.

 “Setting the Output Assignment” (page 4-148)
	y [Extra1] tab, [Extra2] tab 
(can be set only in the standard mode)
Sets the total status conditions, logics, and program 
auto-switching.

 “Total Status Conditions” (page 4-150)
 “Logic Settings” (page 4-151)
 “Program Auto-Switching” (page 4-152)

(6)	 [Enable]/[Disable] setting for the Trigger Error output
Selects whether to enable/disable the output when a 
trigger error occurs.

 “Error Messages” (page A-9)
(7)	 [Back] button

Returns to the tool settings screen, or part registration 
settings screen.
	 �“3. Tool Settings (Setting the Judgment Method of 
the Target of Standard Mode)” (page 4-28)
	 �“3. Part Registration Settings (Setting the Judgment 
Method of the Target of Sorting Mode)” (page 4-121)

(8)	 [Complete] button
Finishes the Settings Navigator.
 “Finishing the Settings Navigator” (page 4-7)

(9)	 [Quit] button
Finishes the Settings Navigator.
 “Finishing the Settings Navigator” (page 4-7)

Setting Range of the Output Assignment

	z In the standard mode
Setting range Description

OFF Do not output.
Output will be constantly OFF.

Tot.StatusOK

When the total status result of the tools 
which have been set is OK, the output 
turns ON. The total status condition can 
be selected from the following:

	y All Tools OK
	y Any Tool OK
	y Logic 1
	y Logic 2
	y Logic 3
	y Logic 4

Tot.StatusNG When the total status result is NG, the 
output turns ON.

RUN
When the sensor is running and no 
system error has occurred, the output 
turns ON.

BUSY

The output turns ON in the following 
cases.

	y Judgment process in progress 
(capture process/image process)
	y Switching programs
	yRegistering the external master image
	yData transferring to an SD card (in the 
case of settings enabled)

Error

The output turns ON when the following 
errors occur.

	y System error
	y Startup memory readout error
	y Program switching error
	y External master registration error
	y SD card access error

The following errors are output when 
settings are [Enable].

	y Trigger error
	y FTP error
	y SD card transfer error

SD card error

The output turns ON when the following 
errors occur.

	y SD card access error
	y SD card transfer error (when settings 
are [Enable])

Tool 00:  
Pos. Adj.

When the status result of the position 
adjustment is OK, the output function 
turns ON.

Tool 01 to 64

When the status results of the detection 
tool and position adjustment tool are 
OK, the output function turns ON.
Status results can be output by each 
tool.

Master 00 to 07

	yWhen master image settings are 
enabled and the status results for all 
tools, except the position adjustment 
tool, are OK with the selected master 
image set, the output function turns 
ON.
	y If the status result for multiple master 
numbers is OK, the supported output 
functions turn ON.

Logic 1 to 4 When the status result of the specified 
logic is OK, the output turns ON.

4. Output Assignment (Setting Details of Outputting to Output Line)
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4. Output Assignment (Setting Details of Outputting to Output Line)

	z In sorting mode
Setting range Description

OFF Do not output.
Output will be constantly OFF.

Part0 to Part7

When the status result of the learning 
tool for a specified part type is OK, the 
output function turns ON.
Status results can be output by each part 
type.

Total Status 
NG

When the status result for all part types 
is NG, the output turns ON.

RUN
When the sensor is running and no 
system error has occurred, the output 
turns ON.

BUSY

The output turns ON in the following 
cases.

	y Judgment process in progress (capture 
process/image process)
	y Switching programs
	yData transferring to an SD card (in the 
case of settings enabled)

Error

The output turns ON when the following 
errors occur.

	y System error
	y Startup memory readout error
	y Program switching error
	y External master registration error
	y SD card access error

The following errors are output when 
settings are [Enable].

	y Trigger error
	y FTP error
	y SD card transfer error

SD card error

The output turns ON when the following 
errors occur.

	y SD card access error
	y SD card transfer error (when settings 
are [Enable])

	z Default value
Ultra-

compact  
model

Built-in 
amplifier 

type
Standard 

Mode
Sorting 
Mode

OUT1 Tot.StatusOK 
(N.O.)

MASTER00 
(N.O.)

OUT2 BUSY (N.O.)
OUT3 Error (N.C.)

OUT4 I/O1

OFF
OUT5 I/O2
OUT6 I/O3
OUT7 -
OUT8 -

Trigger error
DisableFTP error

SD card transfer error

	y The output settings which determine N.O./N.C. 
can be changed.

 “Output Settings” (page 7-15)
	y The input cable assignment can be changed.

 “Input Settings” (page 7-13)
	y The FTP error output can be changed.

 “FTP Error” (page 9-4)
	y The SD card transfer error output can be 
changed.

 “SD card transfer error” (page 8-14)

Setting the Output Assignment

1	Press the item name of an output line and select 
the output item.

2	Finishes the Settings Navigator.
 “Finishing the Settings Navigator” (page 4-7)
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4. Output Assignment (Setting Details of Outputting to Output Line)

Extended Functions for the Output Assignment

	z Setting Items of the Output Assignment (Extended Function 1)
Items Description Setting range Ref.

Total Status 
Conditions

Selects a condition for the total 
status result.
The total status result is determined 
according to the selected condition.

	yAll tools OK (default)
When the status results of all of the detection tools are OK, 
the total status output turns ON.
	yAny Tool OK
When the status results of any of the detection tools are 
OK, the total status output turns ON.
	y Logic 1 to 4
When the status result for the set logic is OK, the total 
status output turns ON.

4-150

Logic 
Settings

A logical operation can be performed 
using the status results of selected 
detection tools and can be applied to 
an output.
Up to 4 items, Logic 1 to 4, can be 
defined.

	yUnused (default)
The selected items are not used in a logical formula.
	yUsed
The status results of the selected items must be OK for the 
logic output to turn ON.
	yUsed (Inverse)
The status results of the selected items must be NG for the 
logic output to turn ON. 4-151

Logic Selects the operation method for the 
logic settings.

	yAND (default)
When the status results of all of the selected detection tools 
are OK, the Logic output turns ON.
	yOR
When the status results of any of the selected detection 
tools are OK, the logic output turns ON.

	z Setting Items of the Output Assignment (Extended Function 2)
Items Description Setting range Ref.

Program  
Auto-Switching

Switches the program 
automatically according to the 
total status result.

	y Enable
Enables the program auto-switching.
	yDisable (default)
Disables the program auto-switching.

4-152

Switching 
destination

If Total 
Status OK
(Standard 
Mode)

Selects the switching 
destination program when the 
total status is OK.

	yNone (default)
The program is not switched.
	y P000 to P127 (program number)
Switches to the program with a selected number.

During 
Part Type 
Judgment
(Sorting 
Mode)

Selects the switching 
destination program for each 
judged part type (00 to 07).

Total Status 
NG

Selects the switching destination 
program when the total status is 
NG.

Delay Sets the delay time when 
switching. 	y 0 to 10000 ms (default: 3000 ms)

NG Confirmation  
Timing

Selects the timing to judge as 
total status NG.

	y Every trigger (default)
Determines the target as the total status NG when 
NG occurs for every trigger.
	yAfter Judgment Waiting Time (at internal trigger 
only)
When the total status NG occurs after the judgment 
waiting time has passed, the program switching 
operation at the total status NG is executed. Even 
if the total status NG occurs during the judgment 
waiting time, the program switching operation at the 
total status NG is not executed.
	yAfter retry count (at external trigger only)
When the total status NG counts reach the retry 
count + 1, the program switching operation at the 
total status NG is executed. If the total status NG 
counts are within the retry count, the program 
switching operation at the total status NG is not 
executed.

Judgment waiting time
Sets the status waiting time 
when the NG confirmation timing 
is "After Judgment Waiting Time".

	y 0 to 999 s (default: 30 s)

Retry count
Sets the retry count when the 
NG confirmation timing is "After 
Retry Count".

	y 0 to 999 counts (default: 5)
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4. Output Assignment (Setting Details of Outputting to Output Line)

Total Status Conditions

1	Select the [Extra1] tab and select a total status 
condition.

The total status result is displayed according to the 
selected condition.

	z All Tools OK
When all of the detection tools are OK, the total status 
output turns ON.

Image of total status output when the total 
status condition is [All Tool OK]

OK
Tool A

Tool B

Total 
Status

OK

OK

NG

NG

NG

	z Any Tool OK
When any of the detection tools are OK, the total status 
output turns ON.

Image of total status output when the total 
status condition is [Any Tool OK]

OK
Tool A

Tool B

Total 
Status

OK

OK

NG

NG

NG

For [Any Tools OK], the status result of the 
position adjustment is not included in the 
total status conditions.

	z Logic 1 to 4
When the status result of the defined logic are OK, the 
total status output turns ON.

Image of total status output  
when the total status condition is [Logic 1 to 4]

Logic  
1 to 4

Total 
Status

OK

OK

NG

NG

	yWhen the position adjustment fails the 
status result of each tool is NG.
	y If the Learning/Area/Edge Pixel/Width/
Diameter/Edge/Pitch/OCR/Blob Count tool 
window protrudes from the imaging area 
when position adjustment succeeds, the 
tool cannot be judged and the status result 
is NG.

2	When setting is completed, press the [Output 
Asgmt.] tab.
The system returns to the main screen for [Output 
Assignment].
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4. Output Assignment (Setting Details of Outputting to Output Line)

Logic Settings

1	Select the [Extra1] tab and select the logic 
number to which the logical formula is to be 
defined.

When an undefined detection tool has been 
defined to a logic, [Undefined tool selected.] is 
displayed on the right side of the logic number. 

2	Select the operation method for the logic.

	yWhen [AND] has been selected, the logic 
output turns ON when the status results of all 
of the selected detection tools are OK.
	yWhen [OR] has been selected, the logic output 
turns ON when the status results of any of the 
selected detection tools are OK.

3	Select items to be integrated into the logic.

The status result of the logic is calculated from OK/NG 
of all of the items which [Used] or [Used (Inverse)] has 
been set.

	z Logic : AND

Image of logic output  
when the Logic is [AND]

Tool A

Logic 1 to 4Tool B
Tool C

(Inverse)

Tool A Tool B Tool C Logic

OK OK OK NG

NG OK OK NG

OK NG OK NG

NG NG OK NG

OK OK NG OK

NG OK NG NG

OK NG NG NG

NG NG NG NG
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4. Output Assignment (Setting Details of Outputting to Output Line)

	z Logic : OR

Image of logic output  
when the Logic is [OR]

Tool A

Logic 1 to 4Tool B
Tool C

(Inverse)

Tool A Tool B Tool C Logic

OK OK OK OK

NG OK OK OK

OK NG OK OK

NG NG OK NG

OK OK NG OK

NG OK NG OK

OK NG NG OK

NG NG NG OK

	y Select either [Unused]/[Used]/[Used (Inverse)] 
for each item (Pos. Adj./Tool 01 to Tool 64/
Master 00 to Master 07/Logic 1 to Logic 3).
	yWhen the status results of the [Used] items 
are OK, the status output for items in the logic 
turns ON.
	yWhen the status results of the [Used (Inverse)] 
items are NG, the status output for items in the 
logic turns ON.
	y To define a logic which has been already set 
to another logic, use the logic number which is 
greater than the logic number which has been 
set.
For example, use either of Logic 2 to Logic 4 
in case of defining Logic 1 to another logic.

When the program number has been 
changed or the sensor is put into [Run] from 
[Sensor Setup Menu] after the the power is 
turned ON, a judgment is not performed until 
a trigger has been input. Until the trigger 
is input, the judgment result of each tool is 
OFF.

4	When setting is completed, press [OK].
The system returns to the main screen for the extended 
functions settings.

5	Press [Output Asgmt.] tab.
The system returns to the main screen for [Output 
Assignment].

Program Auto-Switching
Set the switching conditions for the program auto-switching 
function.
 “Using Program Auto-Switching” (page 7-11)
 �“Importing the Status Output (When Program Auto-
Switching is “Enable”)” (page 11-8)

1	Select the [Extra2] tab and press [Enable] for 
program auto-switching.

2	Press [OK] in the confirmation screen.

Change the program switching method to [Panel/PC/
Network/Auto-Switching].
 “Program Switching Method” (page 7-14)

4

Settings N
avigator



4-153IV3 Series User’s Manual (PC Software)

4. Output Assignment (Setting Details of Outputting to Output Line)

3	Select the switching destination program.

	z In standard mode

Total Status OK
Selects the switching destination 
program when the total status is 
OK.

Total Status NG
Selects the switching destination 
program when the total status is 
NG.

Delay The delay time (default: 3000 ms) 
for switching can be set.

	z In sorting mode

Part Judgment Time

Press [Destination Setting] to 
select the switching destination 
program for each part type when 
the part type discrimination is OK 
on the destination setting screen 
that appears.

If Total Status NG
Selects the switching destination 
program when the total status is 
NG.

Delay The delay time (default: 3000 ms) 
for switching can be set.

4	Select the timing to determine NG.
Internal trigger

External trigger

NG confirmation 
timing

The following items can be 
selected:

	y Every trigger (default)
	y After Judgment Waiting Time  
(at internal trigger only)
	y After retry count  
(at external trigger only)

After Judgment 
Waiting Time  
(at internal trigger 
only)

Specifies the judgment waiting 
time (default: 30 s) when the 
NG confirmation timing is [After 
Judgment Waiting Time].

After retry count  
(at external trigger 
only)

Specifies the retry count (default: 
5) when the NG confirmation 
timing is [After Retry Count].
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4. Output Assignment (Setting Details of Outputting to Output Line)

	yWhen "None" is selected for the switching destination, the current operation screen and judgment conditions 
are retained. When the same program number is selected for the switching destination, switching to the 
same program is processed and the operation screen and status are reset. If resetting the status in the start 
point program, select the same program.
	y The life-span for the operation of the focusing function (program switch count) is 100,000 times. If the 
focusing position does not need to be changed in each program, set [Auto Focus Adj Pos] to [Common] to 
extend its duration.

 “Auto Focus Adj Pos” (page 7-19)

The methods to use "NG Confirmation Timing" properly are as follows:
	y Every trigger
Determines the status for each trigger. Automatically switches to the program set in the switching destination 
according to the status result.
This is mainly used for automatic machines and inline status without human intervention.
	yAfter Judgment Waiting Time (at internal trigger only)
Even if the judgment process results in the total status NG, the total status result is not determined during the time 
set in "Judgment Waiting Time". The program switching operation at the total status NG is not executed. When the 
total status is OK, the program switching operation at the total status OK is executed at that point.
This is mainly used to check the work of assembly processes that require human intervention etc. The amount of time 
to complete a task can be set, using "Judgment Waiting Time".
	yAfter retry count (at external trigger only)
Even if the judgment process results in the total status NG, the total status result is not determined up to the count 
set in "Retry Count". The program switching operation at the total status NG is not executed. When the total status is 
OK, the program switching operation at the total status OK is executed at that point.
This is mainly used to check the work of assembly processes that require human intervention etc. The number of 
times where the operator retries can be set, using "Retry Count".
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5 

Running

This chapter explains the procedures for starting operation 
and the names and functions of each section displayed on the 
operation screen.
The chapter also explains useful functions when confirming 
operation status.

Starting an Operation...........................................................5-2
Overview of the Screen in [Run] / [Program].....................5-3
Names and Functions of the Screen in [Run] / 
[Program]..............................................................................5-4
Confirming the NG Occurrence Status of the Sensor 
Connected (List of NG Sensor Occurrences)..................5-13
Holding the Image of the Sensor on which NG 
Occurred (NG Hold Function)............................................5-16
Confirming the Images Whose Judgment are NG 
(Running Image History)....................................................5-17

Chapter 
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Starting an Operation

Starts operation according to the program created with the Settings Navigator.

The sensor can be independently operated.

Turning on the power and starting 
operation

1	Turn on the power of the sensor and boot up IV3-
Navigator.

	� “Operation for Initial Startup of the IV3-Navigator” 
(page 3-6)

2	Confirm that the main screen in [Run] opens.

	z For a [Standard Mode] (including the learning 
tool) program

	z For a [Standard Mode] (not including the 
learning tool) program

	z For a [Sorting Mode] program

If the image or status result does not update, 
refer to  “Troubleshooting” (page A-7).

Exiting the sensor settings and starting 
operation

1	Exit any settings screens that are open on the 
sensor, such as the Settings Navigator.
 �“Finishing the Settings Navigator” (page 4-7)

2	Press [Run].

The run screen opens and the operation starts.

If the image or status result does not update, 
refer to  “Troubleshooting” (page A-7).

Starting an Operation
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Overview of the Screen in [Run] / [Program]

Overview of the Screen in [Run] / [Program]

Statistical information display
Displays statistical information of status 
results. (Page 5-9)

Additional Learning (Learning Tool Only)
Perform additional learning of images.

 “Auto Adjustment by the Additional 
Learning (Learning Tool Only)” (page 6-2)

Limit adjustment (standard mode only)
Adjusts the tool threshold.

 “Adjusting Thresholds for Judgment” (page 6-15)

Tool information display
Displays the threshold/judgment value by 
tools and the histogram for status result.
(Page 5-10)

Settings Navigator (Sensor Setup)
Sets the program to be used for judgment.

 “Starting the Settings Navigator” (page 4-4)
Main screen in [Program]
(Page 5-4)

Main screen in [Run]
(Page 5-4)

A B

A B
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Names and Functions of the Screen in [Run] / [Program]

Names and Functions of the Screen in [Run] / 
[Program]
Main Screen in [Run] / [Program]

	z Main screen in [Run]

(2)
(3)
(4)
(5)

(6)
(7)

(10)

(8)

(13)
(14)

(15)

(16)

(1)

(12)

	z Main screen in [Program]

(2)
(3)
(4)
(5)

(6)

(10)

(9)

(11)

(17)

(18)

(1)

(12)

(7)

(1)	 Menu bar
 “Operating from the Menu Bar” (page 7-27)

(2)	 Sensor operation menu

Menu Function Ref.

Change 
Connected 
Sensor

Detects the connected sensor 
and changes the currently 
connected sensor.

3-10

Disconnect Disconnects the connection to 
the sensor. 3-11

List of NG 
Sensor

When the function of [List of NG 
Sensor Occurrences] is used 
and the NG occurrence sensor is 
registered on the list, the button 
will be displayed. The number of 
NG occurrences on the sensor 
registered is displayed.

5-13

Clear NG 
Hold

If the screen is held after 
detecting an NG when the [NG 
Hold Function] is [Enable], this 
button releases the held screen.

5-16

Remove SD 
card

Displayed when inserting an SD 
card. Removes the SD card. 5-16

(3)	 Settings button

(a) (b) (c) (d) (e) (f)

No. button Function Ref.

(a)
[Run] /  
[Program]  
switch

Switches the main screen 
between [Run] and 
[Program].

	y By pressing [Program] on 
the main screen in [Run], 
operation stops and the 
sensor switches to the 
main screen in [Program].
	y By pressing [Run] on the 
main screen in [Program], 
setting finishes and the 
sensor switches to the 
main screen in [Run].

5-3

(b) Program  
information

Displays the program 
number and program name.
Programs can be switched 
from the drop-down menu.

7-2

(c) Details Displays the Program Details 
screen. 7-8

(d)

Running 
image 
history or 
running/
learned  
image 
history

Displays the running image 
history and learned image 
history (only when a learning 
tool is included).

5-17
6-8

(e) I/O Settings Displays the I/O Settings 
screen. 7-13

(f) Advanced 
Settings

Displays the sensor 
advanced settings screen. 7-19
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Names and Functions of the Screen in [Run] / [Program]

(4)	 Total status result/by image type

	�Main screen in [Run] (standard mode)
For standard mode, displays the total status result.
The condition of the total status can be selected from [All 
Tools OK] / [Any Tool OK] / [Logic 1] to [Logic 4].

Displayed when the total status result is OK.

Displayed when the total status result is NG.

Displayed when the total status result is NG 
while the NG hold function is set to [Enable].
Holds the image when judged as NG.

OK/NG can be changed to user-defined 
characters such as PASS/FAIL.

 “Judgment Notation Settings” (page 7-23)

	�Main screen in [Run] (Sorting mode)
For sorting mode, displays a part type (master)/part 
type (master) name that is the target to be judged.

When the master name has not been set:
When the results of position adjustment are 
OK, the part numbers (M0 to M7) for which 
the part type discrimination is OK will be 
displayed.

When the master name has been set:
When the results of position adjustment are 
OK, the part (master) number (00 to 07) 
for which the part type discrimination is OK 
(upper) and its part (master) name (lower) 
will be displayed.

Displayed when the position adjustment 
results or part type discrimination results are 
all NGs.

Displayed when the position adjustment 
result or part type discrimination result is NG 
while the NG hold function is set to [Enable].
Holds the image when judged as NG.

	�Main screen in [Program]
Displays the image type (Master).

(5)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(6)	 Tool window
Displays the selected tool window region with a green 
frame when the status result is OK, and displays with a 
red frame when the status result is NG.
The tool window selected can be changed by pressing 
a different tool region.

 “Selecting the Display Method of the Tool Window” 
(page 5-7)

(7)	 Brightness correction region
When the brightness correction is set, the brightness 
correction region will be displayed with a blue frame.

(8)	 Statistical information display
Displays the statistical information of the status results. 
(default value: hidden).

 “Statistical Information Display” (page 5-9)
(9)	 Search Range

If the search range of the selected tool is being set to 
[Partial], the search range will be displayed with a light 
blue frame. If the position adjustment is set, the search 
range after position adjustment will be displayed.

(10)	Sensor Information
Displays the sensor head model, device name (Page 
7-21), IP address (Page 7-21), and MAC address 
(Page 7-21).

“Lock Enabled” will be displayed in the 
lower right of the main screen in [Run] if the 
password lock is set.

Password is required when while switching 
to the [Program] main screen.

 “Security” (page 7-22)

(11)	Mode
Displays the program mode (Standard Mode/Sorting 
Mode).

5
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Names and Functions of the Screen in [Run] / [Program]

(12)	Program information
Displays the information set in the program.
(a)
(b)
(c) (d)

No. Description Ref.

(a)

Number of learned images (Learning 
tool only)
Displays the number of learned images 
and number of not reflected images.

6-8

(b)

Trigger type (trigger interval/trigger 
delay)

	y For the internal trigger: Displays the 
trigger interval in brackets.
	y For the external trigger: Displays the 
trigger delay time in brackets.

4-11

(c)

Processing time
Displays the time between receiving a 
trigger (external or internal) and when the 
status result is output.
If the output setting is [One-Shot] (Page 7-16), 
the ON-delay time is not included.

6-26

(d)

Remaining time/Retry count/Switching
Displays the remaining time for the 
judgment waiting time or remaining 
retry count when setting program auto-
switching. [Switching] appears during 
switching delay after the switching 
destination program is set.

4-152

(13)	[Additional Learning] button (learning tool only)
Performs the additional learning of images displayed on 
the screen.

 “Additional Learning by Taken Image” (page 6-5)
(14)	[Limit Adjustment] button

Manually adjusts the tool threshold.
 “Adjusting Thresholds for Judgment” (page 6-15)

(15)	Status gauge
Displays the status gauge per set tool.

 “Tool Information Display” (page 5-10)
(16)	Tool information

Displays the information for the selected tool.
 “Tool Information Display” (page 5-10)

(17)	[Sensor Setup] button
Displays the Settings Navigator screen.

 “Starting the Settings Navigator” (page 4-4)
(18)	Master image display

Displays the master image registered to the currently 
selected program. If no master image is registered, the 
[No Master Image] will be displayed.

Search area and tool window will be hidden 
when you select [OFF] for the display methods 
for the tools (Page 5-7).

Selecting the Tool Window
The method for selecting the tool window is as follows.

	yPress to select the status gauge of the tool window.
	yPress to select the tool window displayed on the image of 
the sensor.

1	Press the tool window displayed on the status 
gauge or image of the sensor.

Press either one
The selected tool window will be highlighted.5
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Names and Functions of the Screen in [Run] / [Program]

Selecting the Display Method of the Tool 
Window

The display method for the tool window can be selected 
using the button for the display method of the image tool 
bar.

1	By pressing the button for switching the display 
method, the suitable display method can be 
selected.

The display method of the tool window changes 
according to the selected menu.

 “Display Methods of Tools (Learning Tool)” (page 
5-7)

 “Display Methods of Tools (Other Than the Learning 
Tool)” (page 5-8)

Display Methods of Tools (Learning Tool)

	z OFF

All the tool windows and search ranges become hidden.

	z Window

	�Selected tool window
	yDisplays the frame of the tool window with a thick 
line. If a mask region is set, the region where the 
tool window and mask region are combined will be 
displayed.
	yDisplays the frame of the search range in light blue.

	�Non-selected tool window
	yDisplays the frame of the tool window with a thin line.
	yThe search range and the mask region will not be 
displayed.

	�Common
When the results of position adjustment or status results 
are OK, the tool will be displayed in green. If one of the 
status results is NG, the tool will be displayed in red.
Displays the brightness correction window in blue.

	z Process

Compared to when the [Window] is selected, the 
following conditions are different. Other details are the 
same.

	�Selected tool window
	yTool window: When the status result is OK
Displays the region with a high matching rate between 
the target and learned OK work (the region based on 
which the OK judgment was made) which is shown in 
green. The higher the matching rate of the region, the 
darker the green display becomes.
	yTool window: When the status result is NG
Displays the region with a high matching rate between 
the target and learned NG work (the region based on 
which the NG judgment was made) which is shown 
in red. The higher the matching rate of the region, the 
darker the red display becomes.

	y If a matching rate between the target and both 
learned OK work and learned NG work is low, 
the learned work may not be displayed.
	y The display range/density is rough indication. 
It should be treated as reference information.

	�Selected position adjustment window
Indicates the recognized outline with a series of points 
in green (OK) or red (NG).

	� If brightness correction has been set
The inside of the window is displayed with the corrected 
brightness when selected. (Only the window to be a 
target of brightness correction)
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Names and Functions of the Screen in [Run] / [Program]

Display Methods of Tools (Other Than the 
Learning Tool)

	z OFF

All the tool windows and search ranges become hidden.

	z Window

	�Selected tool
	yDisplays the frame of the tool window with a thick 
line. If a mask region is set, the region where the 
tool window and mask region are combined will be 
displayed.
	yDisplays the frame of the search range in light blue.

	�Non selected tools
	yDisplays the frame of the tool window with a thin line.
	yThe search range and the mask region will not be 
displayed.

	�Common
When the results of position adjustment or status results 
are OK, the tool will be displayed in green. If one of the 
status results is NG, the tool will be displayed in red.
Displays the brightness correction window in blue.

	z Process

Inside the tool 
window

Outside the tool 
window

Compared to when the [Window] is selected, the 
following conditions are different. Other details are the 
same.

	�Selected tool
	yOutline/edge pixels/width/diameter/edge/pitch tool/
position adjustment
The window indicates the recognized outline/edge 
with a series of points in green (OK) or red (NG).
Inside of the tool window is displayed in monochrome, 
and outside the tool window in color if the sensor is 
the color type.
	yColor area/area/color prohibition/brightness prohibition 
tool
Displays the extracted region as green (OK) or red 
(NG).
	yOCR tool
Displays the recognized text and date on a green (OK) 
or red (NG) window.
	yColor average tool
Displays the master color ( ) and target color ( ) on 
the top left of the screen.
	yBrightness average tool
Displays the master brightness ( ) and target 
brightness ( ) on the top left of the screen.
	yBlob count tool
On counted lumps, displays the green check mark ( ) 
when the number of counts is OK, and the red check 
mark ( ) when the number of counts is NG. Displays 
the red oblique line mark ( ) on size NG lumps.

	� If brightness correction has been set
The inside of the tool window is displayed with the 
corrected brightness when selected. (For tools subject 
to brightness correction only)
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Names and Functions of the Screen in [Run] / [Program]

Statistical Information Display
When the [Statistical Information] button in the [View] 
menu is selected, the statistical information of judgment is 
displayed.

Displaying the Statistical Information

1	Select [View] → [Statistical Information] on 
the menu bar to place a check mark next to 
[Statistical Information].

The statistical information will be displayed.

	z In standard mode

(4)(1) (2)

(5)(3)

	z In sorting mode

(4)(1)

(5)(2)

(3)

Contents of the statistical information are as follows.
(1)	 TIME

Displays information related to the processing time.

TIME Displays the processing time of the latest 
judgment process.

Max Displays the maximum value of the 
processing time.

Min Displays the minimum value of the 
processing time.

Ave Displays the average value of the 
processing time.

(2)	 Trigger No.
Displays information related to the number of triggers.

Trigger No.
Displays the total number of triggers 
issued. This number does not include the 
number of trigger errors.

OK Displays the number of triggers issued with 
the total status OK in the standard mode.

Part type Displays the number of triggers issued for 
each part type in sorting mode.

NG

	yDisplays the number of triggers issued with 
the total status NG in the standard mode.
	yDisplays the number of triggers issued 
where the part type discrimination is all 
NG in sorting mode.

TrERR Displays the number of triggers issued as 
error triggers.

(3)	 OUT
Displays the information related to the outputs assigned 
to an output line in [Output Assignment] of the [Sensor 
Setup]. (Page 4-147).

	y The ON/OFF state of the output is not tracked.
	y For the error output, during normal operation: 
OFF, at the error occurrence: ON
	y In standard mode, each tool state will be 
displayed.
Status OK: ON Status NG: OFF
	y In sorting mode, each part type matching state 
will be displayed.
Suitable (OK): ON Not Suitable (NG): OFF

(4)	 [Switch] button
Switches the statistical information display.

(5)	 [Reset] button
Resets the histogram, processing time, and number of 
triggers.

Pressing the [Reset] button does not reset [OUT].

The processing time, number of triggers, histogram, 
judgment record, matching information are reset 
under the following conditions.

	yWhen [Reset] is pressed.
	yWhen the power of the sensor is turned OFF.
	yWhen a tool is added/deleted/copied.
	yWhen the upper limit of the color area/area/edge 
pixel/width/diameter/edge/pitch tool is enabled/
disabled or when the setting scale is changed.
	yWhen changing the scaling settings for the width/
diameter/pitch tool.
	yWhen the program is switched.
	yWhen the sensor is initialized.
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Names and Functions of the Screen in [Run] / [Program]

Hiding the statistical information

1	Select [View] → [Statistical Information] on the 
menu bar to release the check mark.

The statistical information becomes hidden.

Tool Information Display
You can display or hide the selected tool information with 
the [View] menu.

The matching rate histograms are displayed by 
default.

Displaying the tool information

1	Select [View] → [Tool Information] on menu bar 
to place a check mark next to [Tool Information].

The tool information will be displayed.

	z In standard mode

(1) (2)

(3)

(4)

(5)

(6)

(7) (8) (9)
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Names and Functions of the Screen in [Run] / [Program]

	z In sorting mode

(1) (2)

(3)

(4)

(5)

(6)

(7) (8) (9)

Contents of the tool information are as follows.
(1)	 [Additional Learning ] button

 �“Auto Adjustment by the Additional Learning 
(Learning Tool Only)” (page 6-2)

(2)	 [Limit Adjustment] button (standard mode only)
 “Adjusting Thresholds for Judgment” (page 6-15)

(3)	 Status gauge
Displays the status results of the tool window set in the 
program.
In standard mode
Displays the tool name, status results (OK/NG), a line 
indicating the threshold, and a value of the matching 
rate.

	y Judge is OK

	y Judge is NG

Tool Name

Limit

Status result and  
matching rate

In sorting mode
The tool name, status results, and the matching rate 
value will be displayed except for position adjustment 
tools. As a status result, the name of the part 
type (master) will be displayed when the part type 
discrimination is OK, whereas NG will be displayed 
when the part type discrimination is NG.
For position adjustment tools, it is the same as that of 
standard mode.

	y Part type discrimination OK

	y Part type discrimination NG

Tool Name
Status result and  
matching rate

For details of the status result, refer to  “Displaying 
and outputting the status result” (page A-4).

	y Both maximum and minimum values of 
the distances between all the pitches are 
displayed in the status gauge of the Pitch 
tool. Among all of the distances between 
pitches, the one which deviates the most from 
the average value is displayed to show the 
matching rate.
	y Threshold is not displayed for the High-Speed 
Position Adjustment tool.
	y If the scaling function is used with the Width/
Diameter/Pitch tool, the scaling unit is 
displayed.

 “Displaying and outputting the status result” 
(page A-4)
	y Threshold is not displayed in the status gauge 
of OCR tool. When the characters/date is 
completely matching, the matching rate is 
indicated with 100. If either the text or date 
does not match, 0 is displayed.
	y If [Shade Contrast] of the OCR tool is set to 
[Enable], the threshold is displayed. The value 
of the matching rate is associated with the 
shade contrast of the character/date.

(4)	 Tool Name
Displays the name of the selected tool.
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Names and Functions of the Screen in [Run] / [Program]

(5)	 Histogram
Displays the histogram (frequency distribution) of the 
selected tool.
With the threshold being a border, the range for OK is 
displayed in green and for NG is displayed in red.

	yHorizontal axis....�Displays the distribution of the 
matching rate. The display of the 
range is fixed. It cannot be specified 
arbitrarily.

	yVertical axis.......�Adjusts automatically according to the 
maximum value of the frequency. It 
cannot be specified arbitrarily.

	y The upper limit of the histogram is 999999. 
The values display stops updating when the 
upper limit is reached.
	y Pitch tool displays the histogram (frequency 
distribution) of the selected pitches.

When in sorting mode, the histogram can 
only be displayed for the position adjustment 
and learning tools. When using the outline, 
color/brightness average, width, or diameter 
tools, the message, “Not available in Sorting 
Mode.” will appear.

(6)	 Matching rate of the latest judgment process
Displays the matching rate of the latest judgment 
process.

(7)	 Limit
Displays the threshold of the selected tool with a vertical 
line (orange).

Threshold is not displayed for the High-Speed 
Position Adjustment tool.

(8)	 Judgment Record
Displays the judgment process counts for OK or NG.

	y The upper limit of the judgment processing 
count display is 999999. The values display 
stops updating when the upper limit is 
reached.
	y If the judgment threshold is changed, the 
histogram will update according to the result 
judged based on the changed threshold.
However, the judgment record retains 
the counts judged based on the previous 
threshold. Therefore, the judgment conditions 
on the histogram may be different from the 
displayed judgment record counts.

(9)	 Matching rate information
Displays the information related to the matching rate.

Max Displays the maximum value of the 
matching rate.

Min Displays the minimum value of the 
matching rate.

Ave Displays the average value of the 
matching rate.

	y Both maximum (Max) and minimum (Min) 
values of all the pitches are displayed in the 
Pitch tool.
	y Ave is not displayed in Edge tool and High-
Speed Position Adjustment tool.

For the method to reset the histogram, judgment record, 
and matching rate information, refer to  “Statistical 
Information Display” (page 5-9).

Hiding the tool information

1	Select [View] → [Tool Information] on menu bar 
to release the check mark.

The tool information becomes hidden.
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Confirming the NG Occurrence Status of the 
Sensor Connected (List of NG Sensor Occurrences)

Overview of the List of NG Sensor 
Occurrences

When using the [List of NG Sensor Occurrences] function, 
the [List of NG Sensor Occurrences] button blinks (red) 
when NG occurs on a sensor connected to the PC while in 
RUN mode.

Press [List of NG Sensor] to display the list of the sensors 
connected and to confirm their NG statuses.

	yOnly the sensors which have been registered 
as targets for NG sensor monitoring are 
displayed in the list.
	y [List of NG Sensor Occurrences] can only be 
displayed while running.
	y The IV3 Series, IV2 Series and IV Series can be 
mixed and confirmed on the list.

(7)(6)(2) (3) (4) (5)

(1)

(10)(9)(8)

(1)	 Sensor list
Displays the sensors registered on the [List of NG 
Sensor Occurrences].

(2)	 State
Displays the status of the sensors registered on the [List 
of NG Sensor].

Green (ON) No NG occurred.

Red (ON) An NG has occurred at least once.

Red (Blink)
The number of NG occurrences has 
increased after displaying the latest [List 
of NG Sensor Occurrences].

Yellow 
(lighting)
Yellow 

(blinking)

The sensor is not connected due to a 
connection error. Check the connection 
with the sensor.
Blinks when confirming the [List of NG 
Sensor Occurrences] for the first time. 
Lights up when the status has been 
confirmed.

Gray
The sensor has not been registered, or 
the information of the sensor is being 
acquired.

(3)	 NG Count
Displays the status of the sensors registered on the [List 
of NG Sensor Occurrences].
The status of the sensor is displayed with characters.

NG: (counts)

The NG count is displayed as a value 
from 0 to 99999. The NG count is the 
accumulated value after turning the 
power on.
The maximum number of NGs that 
can be displayed is 99999. After 
99999 NGs have occurred, the 
number will not increase.

NOT SET The sensor for the corresponding 
number has not been registered.

SYS ERR (No.)

An error number will be displayed 
when an important or fatal error 
occurs with the sensor. If multiple 
errors occur, the lowest error number 
will be displayed.

CONNECTION 
ERROR ERROR The sensor is not connected.

UPDATING

The information from the sensor 
is being acquired. For example, 
UPDATED is displayed when the 
information from the sensor has not 
yet been acquired after startup.

To reset the NG count, perform one of the 
operations below.

	y Press [Clear].
	y Turn the power off.
	y Initialize the sensor.

(4)	 Device Name
Displays the device name assigned to the sensor.

(5)	 IP Address
Displays the IP address set for the sensor.
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(6)	 [Clear All NG Counts] button
Clears the NG occurrence status of all the sensors 
registered on the [List of NG Sensor Occurrences].

(7)	 [Clear NG Count] button
Clears the NG occurrence status of the selected sensor.

(8)	 [Display Switch] button
Switches the sensor list display. NG occurrence status 
of up to 64 sensors can be confirmed without scrolling.

(9)	 [Connect] button
Connects to the selected sensor and displays the 
sensor’s image on the IV3-Navigator.
If the sensor on which NG occurred is selected, it can 
change to that sensor.

(10)	[Close] button
Closes the [List of NG Sensor Occurrences] screen.

Setting [List of NG Sensor Occurrences]

1	Display the main screen in [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Select [Setting] → [List of NG Sensor 
Occurrences] from the menu bar.

3	Register the sensor.

	z When searching for a sensor and registering it
Press [Search Sensor].

The searched sensor will be registered.

	z When registering by specifying the IP Address 
of the sensor
Press [Add Sensor].

Enter the IP address of a sensor and press [OK].

The sensor of the specified IP address will be 
registered.

The number displayed on the [List of NG Sensor 
Occurrences] is automatically assigned.
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4	Select the number which is displayed on the List 
of NG Sensor Occurrences from the drop-down 
menu of [Number].

	yNumbers will be displayed on [List of NG 
Sensor Occurrences] in the selected order.
	y If the sensor was registered by specifying 
the IP address, the number is automatically 
assigned. Change the number as needed.

5	Repeat step 3 and step 4 and register the sensors 
for which the NG status will be monitored.

	yUp to 16 sensors can be registered on 
[List of NG Sensor Occurrences].
	yTo initialize [List of NG Sensor 
Occurrences], press [Clear].

6	Press [OK].
The system returns to the main screen in [Program].
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Holding the Image of the Sensor on which NG 
Occurred (NG Hold Function)

Overview of the NG Hold function
If the NG Hold function is used, the image of the sensor on 

which NG occurred during Run mode is held and  

is displayed on the screen.
The image when the NG occurred can be confirmed.

NG occurs during running.

“NG HOLD” is 
displayed as 
the total status 
result and the 
screen is held.

Press [Clear NG Hold] when releasing the image held.

	y If another NG occurs during holding of an NG 
image, the NG image will be updated.
	y The NG hold status will be released with one 
of the operations below.
-	�When the run screen is changed to the 

[Sensor Setup Menu] screen.
-	�When external master image registration 

is performed.
-	�When the status output is reset with an 

error clear external input.
-	�When [Clear NG Hold] is pressed.

	y The operation Information will be updated 
during NG hold.

Setting the NG Hold function

1	Select [Setting] → [NG Hold Function] → [Enable] 
from the menu bar.
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The sensor has built-in memory for saving images used 
for judgment. According to the save condition, the sensor 
automatically save the latest images. The saving conditions 
are as follows.

	z NG images only (default value)
Saves only the images where the total status result was 
NG.

	z NG / near threshold OK
Saves the following images.

	yThe images where the matching rates of the learning 
tool are close to the threshold, among the images 
where the judgment results are OK
	y Images whose status results are NG

If saving OK images where the matching rates 
are close to the threshold, the images that 
should be judged as NG which have been 
mistakenly judged as OK can be searched.

	z All images
Saves all images that were judged.

The saved images are loaded into the PC and can be used 
for confirming the causes or trends of NG results.
Up to 100 images can be saved.

Since the memory of the image history is 
volatile, all saved images are erased when the 
power is turned OFF.
To save the images, perform [Batch Backup].

Displaying the [Running Image History] 
Screen

This section explains how to display the [Running Image 
History] screen.

There are 2 methods for displaying the [Running 
Image History] screen.
[Logging Settings] can only be set and adjusted 
from the [Program].

Displaying from the Main Screen in [Run]

1	Display the main screen in [Run].
 “Starting an Operation” (page 5-2)

2	Perform the following.

	z When using the learning tool
Press [Run/Learned Img. History].

The confirmation screen opens.
Press [Running Image History].

	z When not using the learning tool
Press [Running Image History].

Confirming the Images Whose Judgment are NG 
(Running Image History)
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3	Select whether or not to stop logging while 
running (image-updating of the image history).

When operation is not paused
	y The added or overwritten history image will 
not be updated automatically. To update, 
close the history image display once and 
then display it again.
	yWhen an image in the history is erased 
by overwriting and the sensor is updated 
while displaying the image on the IV3-
Navigator, it may not be displayed again on 
the IV3-Navigator.

The [Running Image History] screen opens.

Displaying from the [Sensor Setup Menu] 
screen

1	Display the main screen in [Program].
 “Overview of the Screen in [Run] / [Program]” (page 

5-3)

2	Perform the following.

	z When using the learning tool
Press [Run/Learned Img. History].

Press [Running Image History].

	z When not using the learning tool
Press [Running Image History].

The [Running Image History] screen opens.
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Loading and Confirming Saved Images
Displays the running image history in the sensor.

1	Display the [Running Image History] screen.
 “Displaying the [Running Image History] Screen” 

(page 5-17)

	z In standard mode

(14)

(16)

(13)

(1) (2) (3) (4) (5)

(15)

(6)

(8)
(7)

(9)

(10)

(11)

	z In sorting mode

(14)

(16)

(13)

(12)

(1) (2) (3) (4) (5)

(15)

(6)

(8)
(7)

(9)

(10)

(11)

(1)	 [Specify Filter] button
The [Filter Settings] screen opens.

	z Display Image
Selects the type of images to be displayed on the 
[Running Image History] screen from the following. [Near 
threshold OK] is for the Learning tool.

	yAll
	yNG/near threshold OK
	yNG Only

	z Sort
Selects the order of images to be displayed on the 
[Running Image History] screen from the following.

	yMatch : From highest
	yMatch : From lowest
	yDate/Time: From newest
	yDate/Time: From oldest

	z Target tool (standard mode only)
Displays only the images containing the selected tools 
on the [Running Image History] screen.

	z Period
Specifies the images to be displayed on the [Running 
Image History] screen by time period.

	yAll periods
Displays all images.

	yPage
Specifies the time period for [Start] and [End], and 
displays images.

(2)	 [Save All Images] button
Saves the running image history to individual files (*.bmp 
and *.iv3p) or a batch backup file (*.iv3a).

 ‌�“Saving the Image History Individually” (page 5-20)
 ‌�“Backing up the Image History in a Batch” (page 5-21)

When backing up the images in a batch 
from the View screen, the files saved will be 
[Settings/Running Image History].

(3)	 [Refresh] button
Displayed if “No” is selected in the logging stop dialog 
when the image history to be displayed while RUN mode.
Clears the image history displayed on the IV3-
Navigator, and then acquires and displays the latest 
image history from the sensor.

(4)	 [Delete All] button
 “Clearing the Saved Images” (page 5-21)

(5)	 [Logging Settings] button
 “Changing the Logging Conditions of the Image 

History” (page 5-22)
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(6)	 Thumbnail images
Displays the total status result, trigger number, save 
time, and thumbnail images.

For details of the number of triggers, refer to  
“Statistical Information Display” (page 5-9).

(7)	 Trigger number
Displays the processing time and number of triggers of 
the magnified history image.

(8)	 Total status result
Displays the total status result of the magnified history 
image as OK or NG.

(9)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(10)	Magnified display screen
Magnifies the selected thumbnail image.

(11)	Program number
Displays the program number and name of the history 
image currently being displayed.

(12)	Part type selection button (sorting mode only)
Displays the matching rate and status result for images 
registered in the selected part type judged as masters 
for each tool.

(13)	[Recomm image to learn] button (learning tool only)
Displays the images recommended to be learned.

 “Additional Learning from the Running Image 
History” (page 6-6)

(14)	[Additional Learning] button (learning tool only)
Perform the additional learning with the selected image.

 “Additional Learning from the Running Image 
History” (page 6-6)

(15)	Tool list
Displays the tool list set in the program of the images.

(16)	[Close] button
The system returns to the main screen in [Run] or 
[Program].

An image displayed with red below requires 
processing with a setting different than the current 
program.

	y Program number
	y Program name
	y Trigger No.
	y Processing time

Saving the Image History Individually
Saves image histories saved in the sensor to individual files 
(*.bmp and *.iv3p).

1	Display the running image history screen.
 “Displaying the [Running Image History] Screen” (page 

5-17)

2	Press [Save All Images] and select the saving 
method from the following.

	ySave All Images Individually (*.bmp,*.iv3p)
	ySave Filtered images individually(*.bmp,*.iv3p)

The [Browse For Folder] screen opens.

3	Specify the desired save destination and press 
[OK].

The save completion message opens.

This process saves all files at the same time. To 
save a file individually, save it with the [Save] 
button of the image tool bar.

 “Operation of the Image Tool Bar” (page 3-13)

4	Press [OK].
Returns to the [Running Image History] screen.
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Backing up the Image History in a Batch
Saves all the images saved in the sensor to a batch backup 
file (*.iv3a).

The [Filter Settings] option is disabled.

1	Display the running image history screen.
 “Displaying the [Running Image History] Screen” (page 

5-17)

2	Press [Save All Images] and select [Batch 
Backup (*.iv3a)].

The [Batch Backup] screen opens.

3	Select [Filter] and press [Go].
The [Filter] can be selected from the following.

	yAll
	yNG Only

The save as screen opens.

4	Press [Save].

Change the save destination of the file and file 
name as needed.

The backup completion message opens.

5	Press [OK].
Returns to the [Running Image History] screen.

Clearing the Saved Images
Clears the history images saved in the sensor.

1	Display the running image history screen.
 “Displaying the [Running Image History] Screen” 

(page 5-17)

2	Press [Delete All].

The confirmation screen opens.

3	Press [Yes].
The image history will be cleared.

4	Press [Close].

The system returns to the main screen in [Run] or 
[Program].
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Changing the Logging Conditions of the 
Image History

Sets the logging condition (storage condition) for the image 
history.

1	Display the main screen in [Program].
 “Overview of the Screen in [Run] / [Program]” (page 

5-3)

2	Display the running image history screen.
 “Displaying the [Running Image History] Screen” 

(page 5-17)

3	Press [Logging Settings].

4	Select a logging condition.

	z All
Saves all the images to the image history regardless of 
the status result.

	z NG/near threshold OK
Saves the following images.

	yThe images where the matching rates of the learning 
tool are close to the threshold, among the images 
where the judgment results are OK
	y Images whose status results are NG

If saving OK images where the matching rates 
are close to the threshold, the images that 
should be judged as NG which have been 
mistakenly judged as OK can be searched.

	z NG Only (default value)
Only saves images where the status result is NG to the 
image history.

5	Press [OK].
Returns to the [Running Image History] screen.
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6 

Adjusting

This chapter explains the adjustment method to make full use 
of the judgment capacity of this unit.

Auto Adjustment by the Additional Learning 
(Learning Tool Only).............................................................6-2
Adjusting Thresholds for Judgment.................................6-15
Stabilizing the Judgment...................................................6-16
Shortening the Processing Time......................................6-26

Chapter 
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Auto Adjustment by the Additional Learning 
(Learning Tool Only)

Additional Learning
Additional learning function allows for a user to stabilize the 
judgment of the learning tool for standard mode and sorting 
mode.

	z When using the additional learning
Additional learning is used when there is a target whose 
judgment is not stable during operation or test operation 
after setting [3. Tool Settings] (Page 4-28) and [3. Part 
Registration Settings] (Page 4-121) during sensor setup.

A target whose judgment is not stable is the 
target where the capture status is different 
from the registration status of the learning 
settings.
Target misalignment (shape, surface 
condition, dirt, setting position) and the 
change of ambient light or background can 
influence the judgment status.

	z Advantage of the additional learning
By imaging a target where the detection is not stable or 
by using images from the history to learn, judgment can 
be adjusted automatically. By performing the additional 
learning of multiple images, the stability is improved 
automatically.

Method for the additional learning
Additional learning can be executed by the following methods.

	z Using the capture image while in operation
By using the OK/NG judgment image or Part Type 
discrimination image, adjust automatically the judgment 
of the learning tool.

	� “Additional Learning by Taken Image” (page 6-5)

	z Using the image history
Use images of the running image history to adjust 
automatically the judgment of the learning tool.

	� “Additional Learning from the Running Image 
History” (page 6-6)

	z Using the learned image history
By using the learned image history and changing the 
status results of the learning tool, the judgment of the 
learning tool is adjusted automatically.
In addition, delete images that are needed for learning 
mode.

	� “Additional Learning from the Learned Image 
History” (page 6-10)

	z Using an image saved in PC
Use a batch backup file (*.iv3a), individual program 
backup file (*.iv3a), or image capture file (*.iv3p) stored 
in the PC to adjust automatically the judgment of the 
learning tool.

	� “Additional Learning from Files Saved in the PC” 
(page 6-13)

If a batch backup file (*.iv3a) or individual 
program backup file (*.iv3a) is used, the image to 
be imported can be selected from the following.

	yRunning Image History
	yMaster Image
	y Learned Image History

Flow of Additional Learning Operation

	z In standard mode

NG (45)

NG (5)

OK (95)

OK (60)

NG (5)

OK (90)

OK NG

OK NG

NG (5)

NG (5)

OK (95)

OK (90)

NG (5)

OK (90)

Status that can be 
judged

Settings completed
(OK/NG target learning completed)

Operation (test operation)

Additional 
Learning

RUN

Optimizing the 
judgment using 
multiple images

(multiple images)

All target judgments are 
stabilized

Wants to judge as OK, 
but low matching rate

Wants to judge as NG, 
but high matching rate

Additional 
learning as OK

Additional 
learning as NG
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	z In sorting mode

Part2 (55)

Part2 (90)

Part1 (95)

Part1 (55)

Part2 (95)

Part1 (90)

Part1 Part2

Part1 Part2

Part2 (95)

Part2 (90)

Part1(95)

Part1(95)

Part2 (95)

Part1 (90)

Status that can be 
judged

Settings completed
(part type image learned)

Operation (test operation)

Additional 
Learning

RUN

Optimizing the 
judgment using 
multiple images

(multiple images)

All Part discriminations 
are stabilized

Wants to judge as Part1, 
but low matching rate

Wants to judge as Part2, 
but low matching rate

Additional 
learning as 

Part1

Additional 
learning as 

Part2
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What should be done in the following case

Condition Remedy Ref.

When additional learning is performed but the 
wrong status result (OK/NG, or Part Type) is 
applied.

Modify the learned image to the correct status result in the 
[Learned image history] screen, and additional learning. 6-10

When you want to confirm the learned image. Confirm the image in the [Learned image history] screen. 6-7

When you want to delete the learned image. Delete the image in the [Learned image history] screen. 6-7

When you want to look automatically for an 
image whose detection is not stable.

Perform additional learning of the “Recomm image to learn” in 
the [Running Image History] screen. 6-6

When two copies of the same image are 
captured mistakenly and additional learning is 
performed so that one of them is OK and the 
other is NG, or both are different part types 
each.

Delete the unneeded image in the [Learned image history] 
screen. 6-7

When an inspection is not stable even though 
additional learning has been repeatedly 
performed.

	y Take large images of the part where the difference in an OK/
NG image or part type image is clear.
	y Set the tool window only for the part where the difference in an 
OK/NG or part type is clear. For images where the difference 
in an OK/NG or part type image is small in the tool window, the 
detection may not be stable.
	yWhen a positional deviation of the target occurs, adjust the 
settings of the position adjustment. In addition, set the search 
algorithm to the high accuracy.
	y Perform the additional learning using multiple images where 
the judgments are not stable.
	yCheck if there are any images with non-reflection.

6-16
6-21

When changing the settings of the program, 
such as modifying/adding/deleting tool windows 
in “3. Tool Settings" or "3. Part Registration 
Settings" of the Settings Navigator, or re-doing 
the learning operation by changing the settings 
for OK/NG target learning or part type image 
registration.

The additional learning will be cleared. Perform additional 
learning as needed.
The registered image remains in [Learned image history], 
however, it will be in the state that is not reflected in the learning 
process (not reflected).

6-10

When you want to perform additional learning 
by using an image acquired by another sensor. Use additional learning from an outside media source. 6-13

When the sensor recognizes the background 
(no target) as OK, but the status should be NG.

Perform additional learning of an image where the background is 
captured.
Register the status result as NG (standard mode only).

6-5
6-6

6-13

When the sensor should judge the background 
(no target) as OK.

Perform additional learning of an image where the background is 
captured.
Register the status result as OK (standard mode only).

There are multiple “targets the sensor should 
judge as OK” and “targets the sensor should 
judge as NG”.

Perform additional learning for all of the targets.
Register the status results as OK or NG per tool window (standard 
mode only).
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Additional Learning by Taken Image

1	Display the main screen in [Run].
	� “Starting an Operation” (page 5-2)

2	Capture an image where the target is the object 
desired for additional learning.

3	Press [Additional Learning].

4	Press [OK].

The operation will stop.

When the number of images used for 
additional learning has exceeded the upper 
limit, the [Check Registered Images] screen 
appears after operation stops.

	� “Operation When the Registered Number 
Reaches the Upper Limit” (page 6-14)

5	Confirm the selection state of the status result. 
Change the status result as needed, then press 
[Start Learning].

	z In standard mode

When multiple tool windows are set, 
confirm/change all status results for the tool 
windows.

The confirmation screen opens.

	z In sorting mode

The confirmation screen opens.

6	Press [OK].
Learning will be performed.

7	After learning has been completed, press [OK].

	yWhen pressing [Cancel] while learning, 
learning can be canceled.
	yWhen a similar learned image is found, the 
[Check Registered Images] screen opens.

	�“Confirming the Similar Images and 
Additional Learning” (page 6-14)

	y You can edit/delete images where 
additional learning of the wrong status 
result is performed in the [Learned image 
history] screen.

	�“Additional Learning from the Learned 
Image History” (page 6-10)

Returns to the Test screen.
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Additional Learning from the Running 
Image History

1	Display the [Running Image History] screen.
	� “Displaying the [Running Image History] Screen” 
(page 5-17)

2	Select an image for the additional learning.
 “Loading and Confirming Saved Images” (page 5-19)

When the number of images used for 
additional learning has exceeded the upper 
limit, the [Check Registered Images] screen 
appears after operation stops.

	� “Operation When the Registered Number 
Reaches the Upper Limit” (page 6-14)

	z When using the recommended image to be learned
Press [Recomm image to learn].

Images which have high impact on the learning effects 
are displayed automatically.

	yWhen an image to be learned is not found, 
finish the additional learning process, or perform 
additional learning with another method.
	y Images which have no running image history 
remained may be displayed.

Check the image and press [OK].

The confirmation screen for stopping operation 
during Run mode will be displayed. Press [OK], 
and stop operation.

The [Additional Learning] screen opens.

	z When specifying an image for additional learning
Select the image to perform additional learning, and 
press [Additional Learning].

Select the image

The confirmation screen for stopping operation 
during Run mode will be displayed. Press [OK], 
and stop operation.

The [Additional Learning] screen opens.

3	Confirm the selection state of the status result. 
Change the status result as needed, then press 
[Start Learning].

	z In standard mode

When multiple tool windows are set, 
confirm/change all status results for the tool 
windows.

The confirmation screen opens.

	z In sorting mode

The confirmation screen opens.

4	Press [OK].
Learning will be performed.

5	After learning has been completed, press [OK].

	yWhen pressing [Cancel] while learning, 
learning can be canceled.
	yWhen a similar learned image is found, the 
[Check Registered Images] screen opens.

	�“Confirming the Similar Images and 
Additional Learning” (page 6-14)

	y You can edit/delete images where 
additional learning of the wrong status 
result is performed in the [Learned image 
history] screen.

	�“Additional Learning from the Learned 
Image History” (page 6-10)

Returns to the [Running Image History] screen.
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Displaying the [Learned image history] 
screen

The [Learned image history] screen is the screen that 
can confirm/edit images registered in the OK/NG target 
learning, part image registration, or additional learning.

	� “OK/NG Target Learning for the Learning Tool” (page 4-44)
	� “Part Image Registration” (page 4-140)
	� “Auto Adjustment by the Additional Learning (Learning 
Tool Only)” (page 6-2)

This section explains how to display the [Learned image 
history] screen.

	y The [Learned image history] screen can 
be displayed when using a program in the 
learning tool.
	y There are two methods for displaying the 
[Learned image history] screen.

Displaying from the Main Screen in [Run]

1	Display the main screen in [Run].
 “Starting an Operation” (page 5-2)

2	Press [Run/Learned Img. History].

3	Press [Learned Image History].

The confirmation dialog for the operation stop appears.

4	Press [OK] in the confirmation screen.
The [Learned image history] screen opens.

Displaying from the main screen in 
[Program]

1	Press [RUN/Learned Img. History] on the [Sensor 
Setting Menu] screen.

2	Press [Learned Image History].

The [Learned image history] screen opens.

When an image where an error occurs is 
included in the learned image history, a 
confirmation dialog opens.

 �“(1) Thumbnail images” (page 6-9)
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Confirming Learned Image History
Confirm the learned image history in the program.

1	Display the [Learned image history] screen.
 “Displaying the [Learned image history] screen” 

(page 6-7)

	z In standard mode

(12)(11)(10)

(8)

(6)
(5)

(7)

(1)

(3)
(2)

(4) (9)

	z In sorting mode

(12)(11)(10)

(8)

(6)
(5)

(7)

(1)

(3)
(2)

(4) (9)

(1)	 Thumbnail images
Displays the image status, image number, and 
thumbnail image.

Image status Image number

Thumbnail 
images

Type Description

The original image acquired when 
registering OK/NG target or a part type.

The image acquired when [Variable 
Brightness] is [ON].
Images where the brightness is different 
are saved.

	y Standard Mode:	� OK 8 images, NG 8 
images

	y Sorting Mode:	� 6 images per part type 
will be saved.

Images with high learning effect.
Since the influence on judgment is large, 
the judgment capacity of the sensor 
may change when editing or deleting to 
perform additional learning.

Images which no longer apply to the 
learning algorithm because the settings 
were changed.
Since changing the settings of the 
learning tool or position adjustment tool 
after image registration remove these 
images from learning, these images adopt 
the status of [Learning Not Reflected].
No error occurred. Delete or perform 
additional learning as needed.

An image on which an error has occurred.
	y “OK/NG not selected” Error
Images where the tool window was 
added after registration by additional 
learning. There is no judgment 
information (OK/NG) for the added tool 
window. Select the status result for 
additional learning.
	y Position Adjustment Error
There is a tool window protruded out 
of the view range as the result of the 
position adjustment. Additional learning 
cannot be performed for this image.

(2)	 Explanation of the image status
The explanation of the image status icon displayed 
on a thumbnail image. The icon of the original image is 
described as "OK/NG Target Images" in standard mode, 
and as "Main Image of Part" in sorting mode.
In standard mode

In sorting mode
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(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 History image
Displays the image saved in the sensor.

(5)	 [Save All Images] button
Saves all the images saved in the program to individual 
files (*.bmp and *.iv3p) or a batch backup file (*.iv3a).

 ‌�“Saving the Image History Individually” (page 5-20)
 ‌�“Backing up the Image History in a Batch” (page 5-21)

When backing up the images in a batch 
from the View screen, the files saved will be 
[Settings/Running Image History].

(6)	 [Delete Image] button
	� “Deleting the Learned Images” (page 6-12)

(7)	 Image number
Displays the image number for the selected thumbnail 
image.

(8)	 [Edit] button
Selects this when editing the status result (OK/NG, or 
Part) of the selected image to redo learning.

	� “Editing the Status Result to be Learned” (page 6-10)

(9)	 Tool list
Displays the tool list and the registered status results 
(OK/NG or Part Type) for the selected thumbnail image.

(10)	[Display OK/NG target image] button (standard 
mode only)
Displays the “OK/NG Target Images” registered in the 
program.

	� “OK/NG Target Learning for the Learning Tool” 
(page 4-44)

(11)	Learned
Display the number of learned images and number of 
not reflected images.

The total number of registered images is up to 
100 (including the brightness change function 
images).

(12)	[Close] button
The system returns to the main screen in [Run] or 
[Program].

Edit Screen of the Learned Image History

(12)(11)(10)(9)

(6)

(4)
(5)

(8)

(1)

(2)

(3) (7)

(1)	 Thumbnail images
The following is different from the [Learned image 
history] screen. Other details are the same.

Change Waiting 
Display

[Add Leaning] display
	�Change Waiting Display
The status result of the learning tool has been changed. 
The image is waiting for the changed contents to be 
learned.

	�[Add Leaning] display
A check mark appears when the [Add Leaning] button is 
ON.

(2)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(3)	 History image
Displays the image and tool windows.
The selected tool window is highlighted.

(4)	 Image number
Displays the image number for the selected thumbnail 
image.

(5)	 [Clear] button
Returns status result (OK/NG, or Part Type) edited in 
the tool window list to the state before editing.

(6)	 [Add Learning] button
Displayed when the image is not reflected in the 
learning process.
Pressing the button adds the images in display to the 
learning process.

(7)	 Tool list
Displays the list of the tools. The status result (OK/NG, 
or Part Type) can be edited.

(8)	 Edited display
Displayed when the status result (OK/NG, or Part Type) 
has been edited.
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(9)	 [Display OK/NG target image] button (standard 
mode only)
Displays the “OK/NG Work Image” registered in the 
program.

	� “OK/NG Target Learning for the Learning Tool” 
(page 4-44)

(10)	Learned
Display the number of learned images and number of 
not reflected images.

The total number of registered images is up to 
100 (including the brightness change function 
images).

(11)	[Learn Selected Image] button
Perform additional learning with the selected image.

(12)	[Close] button
The system returns to the main screen in [Run] or 
[Program].

Additional Learning from the Learned 
Image History

Editing the Status Result to be Learned

The status result of the images registered 
as the OK/NG target learning or part image 
registration cannot be edited.

1	Display the [Learned image history] screen.
 “Displaying the [Learned image history] screen” 

(page 6-7)

2	Select an image on which to edit the status result 
and press [Edit].

Select the image
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3	Confirm the selection state of the status result of 
the tool. Change the status result as needed.

	z Image reflected in the learning

Confirm the selection state of the status result of the 
learning tool. Change the status result as needed.
In the standard mode

Change status 
result (OK/NG, 
or Part Type)

The part type discrimination results are 
shown in sorting mode.

	z Image not reflected to the learning (no error)

The setting of the learning tool has been changed since 
this image was registered. Confirm the selection state of 
the setting contents or status result of the learning tool. 
When the target judgment can be performed normally 
using the image, select the desired status result and 
press [Add Learning].
If there is a possibility that the image may judge the 
target mistakenly, such as in the case that the settings 
of the learning tool are not appropriate, do not add the 
image to the learning.

Change status 
result (OK/NG, 
or Part Type)

The part type discrimination results are 
shown in sorting mode.

	z Image not reflected to the learning (with 
errors)

	�“OK/NG not selected” Error

There is a learning tool whose status result is not 
selected.
When the target judgment can be performed normally 
using the image, select the desired status result and 
press [Add Learning]. If there is a possibility for the 
image to judge the target mistakenly, do not add to 
learning.

Change status 
result (OK/NG, 
or Part Type)

For a changed learning tool, the change waiting 
display (Page 6-9) opens.

	�Position Adjustment Error

There is a tool window protruded out of the view range 
as the result of the position adjustment. Additional 
learning cannot be performed for this image. Check the 
position adjustment, or delete the image in the [Learned 
image history] screen.
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4	When learning multiple images in a batch, 
change the selected image with the operation 
buttons, and repeat step 3.

Select the 
image to 
change status 
result (OK/NG, 
or Part Type)

5	Press [Learn Selected Image].

The confirmation screen opens.

6	Press [OK].
Learning will be performed.

7	After learning has been completed, press [OK].
Returns to the [Learned image history] screen.

	yWhen pressing [Cancel] while learning, 
learning can be canceled.
	y You can edit/delete images where 
additional learning of the wrong status 
result is performed in the [Learned image 
history] screen.

	�“Additional Learning from the Learned 
Image History” (page 6-10)

Deleting the Learned Images

When deleting images from the learned image 
history, learning will be executed automatically 
to adjust the judgment process.

1	Display the [Learned image history] screen.
 “Displaying the [Learned image history] screen” 

(page 6-7)

2	Select an image to be deleted, and press [Delete 
Image].

Select the image

The confirmation screen opens.

3	Press [OK].
The image is deleted, and learning is executed using 
the remaining images.

Deleting images cannot be undone.

4	After learning has been completed, press [OK].

5	Press [Close].

The system returns to the main screen in [Run] or 
[Program].
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Additional Learning from Files Saved in 
the PC

1	Display the main screen in [Program] or [Run].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Select [File] → [Additional Learning from File] 
from the menu bar.

3	Select the batch backup file (*.iv3a), individual 
program backup file (*.iv3a) or image capture file 
(*.iv3p), and press [Open].

Select the file

4	If a batch backup file (*.iv3a) or individual 
program backup file (*.iv3a) is selected, select 
the image type to be imported from the following.

	yRunning Image History
	yMaster Image
	y Learned Image History

Select the target program when the Learned Image 
History is selected.

The list of images saved as the selected file image type 
is displayed.

5	Select the image to be used for additional 
learning, and press [OK].

Select the 
image

The confirmation screen for stopping operation during 
Run mode will be displayed. Press [OK], and stop 
operation.

When the number of images used for 
additional learning has exceeded the upper 
limit, the [Check Registered Images] screen 
appears after operation stops.

	� “Operation When the Registered Number 
Reaches the Upper Limit” (page 6-14)

The [Additional Learning] screen opens.

6	Confirm the selection state of the status result 
(OK/NG, or Part Type). Change the status result 
as needed, then press [Start Learning].

	yWhen multiple learning tools are set, 
confirm/change all status results for the 
learning tools.
	y The part type discrimination results are 
shown in sorting mode.

The confirmation screen opens.

7	Press [OK].
Learning will be performed.

8	After learning has been completed, press [OK].

	yWhen pressing [Cancel] while learning, 
learning can be canceled.
	yWhen a similar learned image is found, the 
[Check Registered Images] screen opens.

	�“Confirming the Similar Images and 
Additional Learning” (page 6-14)

	y You can edit/delete images where 
additional learning of the wrong status 
result is performed in the [Learned image 
history] screen.

	�“Additional Learning from the Learned 
Image History” (page 6-10)

The system returns to the main screen in [Program].
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Operation When the Registered Number 
Reaches the Upper Limit

The number of images that can be registered to the learned 
image history is up to 100.

	yStandard Mode
Total number of registration images of OK/NG target 
learning (including variable brightness image) + registered 
images of the additional learning
	ySorting Mode
Total number of registration images of part type image 
registration (including variable brightness image) + 
registered images of the additional learning

When the variable brightness is OFF, the number of 
learned image histories that can be displayed will be 
less than 100.

If additional learning is performed once the upper limit of 
images has been reached, the [Check Registered Images] 
screen opens.
Confirm the images recommended to be deleted, and 
delete them.

The total number of master images and learned 
images that can be memorized in the main 
unit is about 1000 images for programs 0 to 31 
together.
If exceeding this limit, delete unnecessary 
learned images, etc.

1	The [Check Registered Images] screen opens.

2	When deleting the displayed images, press [OK]. 
When not deleting them, press [Cancel].

	yWhen pressing [OK], the images will be deleted, and 
additional learning can be performed.
	yWhen pressing [Cancel], additional learning will finish.

When not deleting the images recommended 
to be deleted, select images from the learned 
image history to delete.

	� “Deleting the Learned Images” (page 6-12)

Confirming the Similar Images and 
Additional Learning

When images which have similar features to images for 
additional learning have been registered with different 
status results, the [Check Registered Images] screen 
opens.
Confirm the status result for each image.

1	The [Check Registered Images] screen opens.

2	Select the registration method.

	z In standard mode
	yContinue Learning with Both OK
Performs the additional learning regarding both status 
results of [Registered Image] and [Last Registered 
Image] as OK.
	yContinue Learning with Both NG
Performs the additional learning regarding both status 
results of [Registered Image] and [Last Registered 
Image] as NG.
	yContinue Learning
Performs the additional learning without changing 
the status results of [Registered Image] and [Last 
Registered Image].

	z In sorting mode
	yContinue Learning with both	 M - (Part Number)
Performs the additional learning regarding both status 
results of [Registered Image] and [Last Registered 
Image] as a specified part number.
	yContinue Learning
Performs the additional learning without changing 
the status results of [Registered Image] and [Last 
Registered Image].

3	Press [OK].
Learning will be performed.

When performing learning on a similar image 
with a different status result, stability of the 
judgment process can be decreased.
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Adjusting Thresholds for Judgment

Below is the method for manually adjusting the threshold 
while in operation.

	yNot available in sorting mode.
	y For the learning tool, threshold adjustment 
is not needed since the target match is 
automatically adjusted by learning. Use 
threshold adjustment if additional learning 
cannot be made or when it is determined to be 
needed after additional learning.
 �“Auto Adjustment by the Additional Learning 
(Learning Tool Only)” (page 6-2)

Threshold adjustment can be started using the 
[Limit Adjustment] button in the [Tool Settings] of the 
Settings Navigator as well.

1	Display the main screen in [Run].
 “Starting an Operation” (page 5-2)

2	If multiple tools are set in the program, select the 
tool to adjust the threshold.

3	Press [Limit Adjustment].

The confirmation screen opens.

4	Press [Yes].
The operation stops and turns to “Test run”.

Operation is not suspended. Changing the 
threshold reflects the value in the status 
output from the trigger immediately after the 
change.
To not reflect the value in the status output, 
adjust the threshold on the settings screen 
for each tool’s sensor settings.

5	Capture an “OK” or “NG” image to be the reference 
of judgment.

6	Adjust the threshold by checking the matching 
rate.
<Setting example>
If the matching rate of an “OK” image is higher than 
90 and if the matching rate of a “NG” image is lower 
than 40, set the threshold to 65, the value intermediate 
between 40 and 90.

Match

Limit

	yWhen the learning tool is set, the limit 
adjustment of the position adjustment 
cannot be performed from the run screen. 
Change it from the settings screen.
	y The threshold value after being adjusted 
cannot be backed up using the “SD card 
settings backup” function.

	y If multiple tools are set in the program, the tool 
for adjusting the threshold can be selected.
	y A target is detected as OK if the matching rate 
is greater than the threshold, and detected 
as NG if the matching rate is lower than the 
threshold.
	y The display color of the tool changes 
according to the status result of the tool.

	�“Selecting the Display Method of the Tool 
Window” (page 5-7)

	y The threshold can be changed by using the 
slider.

 �“Editing Numbers” (page 3-15)

7	After the adjustment is completed, press 
[Complete].
The system returns to the main screen in [Run].
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This section explains how to adjust the device when the 
judgment is not stable.
To stabilize judgment, it is necessary to take a clear image 
of the target and adjust the detection tool such that it 
functions in a stable manner.

	y “Stabilizing the Judgment Process by Taking a Clear 
Image of the Target” (page 6-16)
- Make the target large in the field of view
- Achieving adequate image brightness
- Achieve good focus
- Reduce the image blur
- Reduce the shininess of the glossy or metal surface
- Adjust the color tint (for color type only)
- Reduce the effect of lighting variation
	y “Stabilizing the Learning Tool” (page 6-19)
	y “Stabilizing by Correcting for Misaligned Target Position” 
(page 6-21)
	y “Stabilizing the Position Adjustment” (page 6-21)
	y “Stabilizing the High-Speed Position Adjustment” 
(page 6-22)
	y “Stabilizing the Outline Tool” (page 6-22)
	y “Stabilizing the Color Area/Area/Color Average/Brightness 
Average/Color Prohibition/Brightness Prohibition Tool” 
(page 6-23)
	y “Stabilizing the EdgePixels tool” (page 6-23)
	y “Stabilizing the Width/Edge/Pitch tool” (page 6-24)
	y “Stabilizing the Diameter Tool” (page 6-24)
	y “Stabilizing the OCR Tool” (page 6-25)
	y “Stabilizing the Blob Count tool” (page 6-25)

If judgment is adjusted to stabilize the 
inspection, the processing time may become 
longer, depending on the settings changed. 
Adjust the judgment process while balancing 
the required processing time.

Stabilizing the Judgment Process by 
Taking a Clear Image of the Target

Adjust the imaging conditions so that the sensor can take 
images with which the detection tools can clearly recognize 
differences between an “OK” and “NG” image.

Make the target large in the field of view
The judgment stabilizes by taking a large image of the 
target within the field of view.

	� Adjusting the installed distance (WD)
Install the sensor close to the target.
Install the sensor at the appropriate distance from the 
target upon checking the field of view and the installed 
distance of the sensor.
 ‌�“Checking the field of view and installed distance” 
(page 2-2)

¡: Adequate × : Inadequate

	� Using the digital zoom function
The target can be imaged larger using the digital zoom 
function.
	 �“Setting the digital zoom” (page 4-17)

Stabilizing the Judgment
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Achieving Adequate Image Brightness
If the image is too dark, the judgment process becomes 
unstable due to poor contrast. Also, if the image is too 
bright, the judgment process may become unstable. 
Perform Smart Image Optimization and select the best 
optimized image. When the best optimized image cannot 
be acquired for Smart Image Optimization, adjust the 
settings using brightness adjustment.

 “Settings of Smart Image Optimization” (page 4-9)
 “Adjusting Brightness” (page 4-13)

	�When Performing Fine Brightness 
Adjustment
Finer adjustment of the brightness can be made in 
Advanced Brightness Adjustment.

 “Adjusting Brightness” (page 4-13)

	z Adjusting automatically by pressing the target
If you press the image of the target, the brightness 
around the pressed position will be adjusted to be 
optimal automatically.
Used when the adjustment results of the [Automatic 
Brightness Adjustment] button are too bright or dark due 
to the influence of brightness other than the target.

	z Imaging Mode
When [High Gain] is selected, the brightness 
amplification factor increases and the screen becomes 
brighter.

	z Brightness
Setting a higher value gives a longer exposure time, 
resulting in a brighter screen.

	� If the brightness cannot be properly 
adjusted due to uneven brightness
Refer to  “Reducing the Shininess of a Glossy or 
Metal Surface” (page 6-18).

Achieving Good Focus
Adjusting the focus is required to clearly image of the 
target. Since focus can be adjusted automatically using 
Smart Image Optimization, individual adjustments are 
not needed. However, when performing fine adjustment 
etc., the finer adjustment can be made using "Focus 
Adjustment".

 “Adjusting focus” (page 4-14)

	�When Performing Fine Focus Adjustment
The focusing position may not be adjusted correctly 
if the image is too dark or too bright. Adjust to an 
applicable brightness with Brightness Adjustment (Page 
4-13) and then perform auto focus adjustment.
If the focus still cannot be properly adjusted, adjust the 
focus manually.

	� “Adjusting focus” (page 4-14)

Adjust the focus position by the slider.
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Reducing the Image Blur
If the image is blurred while imaging a moving target, the 
image blurring can be corrected and the exposure time 
(shutter time) can be shortened by using the AI Lighting 
unit and adjusting the imaging mode/brightness.

	� Using the AI Lighting Unit
Using the AI Lighting unit increases the light intensity so 
that the exposure time can be shortened and blurring 
can be reduced.

	� “Mounting the AI Lighting unit” (page 2-6)

	� Adjusting the Imaging Mode and Brightness
Adjust the imaging mode and brightness, and shorten 
the exposure time. Adjust the exposure time with the 
advanced brightness adjustment.

 “Adjusting Brightness” (page 4-13)

Exposure time

	z Imaging Mode
	yBy selecting [High Gain], the brightness gain becomes 
higher. The screen becomes brighter so that the 
exposure time can be shortened and the image 
blurring can be reduced. Image noise may increase.
	yThe exposure time may be shortened if [HDR] is 
selected.

	z Brightness
When the value is reduced, the exposure time becomes 
shorter, resulting in a less blurry image.

Unmounting a polarizing filter can increase 
the brightness of the image. By unmounting 
the filter, image blurring can be reduced as the 
exposure time can be shortened.

Reducing the Shininess of a Glossy or Metal 
Surface
Glossy and/or metal surfaces may reflect the built-in light 
back into the camera. Since mirror reflection has a highlight 
intensity, the amount of light received will be saturated and 
the surface will shine. This section explains how to reduce 
the glare.

	� Using Multiple Imaging
By performing multiple imaging for a target and 
combining the images of shine-free areas, a clean 
image with less shine can be created.
The multiple imaging can be performed with only the 
built-in light of the sensor. However, by using the AI 
Lighting unit, light can be emitted at a certain angle to 
the target, resulting in a cleaner image with less shine. 
Perform Smart Image Optimization and select the image 
optimization for the multiple imaging. The settings can 
be done manually from the lighting advanced settings.

 “Setting the lighting conditions” (page 4-15)
 “Adjusting Brightness” (page 4-13)
 “Mounting the AI Lighting unit” (page 2-6)

	� Using the Dome Attachment
Use the dome attachment.
By emitting the target with uniform diffuse light from the 
entire circumference, bright/dark difference is reduced 
and glare is prevented.
This is effective for any shapes of targets.

 “Mounting the dome attachment” (page 2-12)

Target

Diffused light

Dome attachment

	� Using the Polarizing Filter
Use the polarizing filter. The optical characteristics 
of the polarizing filter attachment cut off the mirror 
reflection and reduce the glare on the target’s surface.
	 �“Using the polarizing filter” (page 2-10)

	� Using HDR
By selecting HDR in the imaging mode, glare can be 
reduced.
The HDR (High Dynamic Range) function prevents light 
saturation in the area with glare by imaging the target 
with a wider dynamic range.

 “Adjusting Brightness” (page 4-13)
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	� Installing the sensor at an angle
The built-in lighting will not reflected back into the 
camera, so the glare on the target’s surface can be 
reduced.
This is effective for flat-surface targets.

When the sensor is  
installed in front of 
the target

When the sensor is  
installed at an angle 
from the target

The mirror reflection 
of the built-in light 
reflects into the 
camera and causes 
the surface to have 
glare.

The mirror reflection 
of the built-in light 
does not reflect into 
the camera so no 
surface glare occurs.

Adjusting the color tint (for color type only)
Adjust the white balance if the color tint of the color type 
image is different from that of the target.
	 �“White Balance (for Color Type Only)” (page 7-24)

Reducing the effect of illumination variation
If detection is not stable due to the ambient light from the 
surroundings where the sensor is installed, the effect of the 
illumination variation can be reduced using the following 
method.

	yUse the AI Lighting unit.
The lighting intensity of this device will be increased, 
making it less influenced from changes in surrounding 
lighting.
	yUse the brightness correction function.
	�“Mounting the AI Lighting unit” (page 2-6)
	� “Brightness Correction” (page 4-24)

If detection cannot be stabilized with the methods above, 
use shielding around the sensor to prevent influence from 
the ambient light.

	� “Brightness Correction” (page 4-24)

Stabilizing the Learning Tool

Optimizing the Size of the Tool Window
To enhance the learning effect, the tool window should be 
set according to the size of the image where the difference 
in an "OK" and "NG" or Part image is clear. When the 
difference between an “OK” and “NG” target in the tool 
window is small, judgment may not be stable since the 
differences cannot be recognized. When the misalignment 
of the position of the target is large, set a position 
adjustment tool.
The following is the explanation with an example of 
standard mode.

	� Setting according to the image target 
difference to be judged
Usage example: Detection of the presence of a part

	yBefore..... �Setting a tool window that is much larger 
than the target.

	yAfter........ �Setting a tool window that fits to the size of 
the target.

OK work

NG work

OK work

NG work

Before After

Tool window
(size of window dilutes 
the difference)

Tool window
(optimization for the 
target difference)

	� Setting by dividing into multiple tool windows
Usage example: Detection of the presence of four 
targets (less than 3 is NG).

	yBefore..... �Setting one tool window for the four targets 
in a batch.

	yAfter........ �Setting four tool windows, one for each target.

OK work

NG work

OK work

NG work

Before After

Tool window x 1
(size of window dilutes 
the difference)

Tool window x 4
(optimization for the 
target difference)
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	� Setting the position adjustment tool
Usage example: Detection of the presence of targets 
whose positions are misaligned.

	yBefore..... �Setting one large tool window
	yAfter........ �Setting the position adjustment tool and tool 

window optimized for the targets

OK work

NG work

OK work

NG work

Before After

Position adjustment 
window

Tool windowTool window

 “Stabilizing by Correcting for Misaligned Target Position” 
(page 6-21)

 “Stabilizing the Position Adjustment” (page 6-21)

Learning Multiple Images for Stability
Target misalignment (shape, surface condition, dirt, setting 
position) or changes of ambient light or background may 
influence the inspection. In these cases, registering to 
learn multiple images that are different in capture status will 
automatically improve judgment stability.
The methods of registering to learn multiple images are 
“OK/NG Target Learning” or “Part Image Registration”, and 
“Additional Learning”.

 “OK/NG Target Learning for the Learning Tool” (page 4-44)
 “Part Image Registration” (page 4-140)
 “Additional Learning” (Page 6-2)

The following indicates examples of images that are 
different in capture status. Perform learning to register 
multiple images as OK or NG.

	z Example 1: Registering multiple images with 
position misalignment
The capture status (what is seen) changes due to target 
misalignment. If it is the case, multiple images with 
different capture statuses are registered.

Tool window

	z Example 2: Registering multiple images for 
changes of the target

Dirt/flaw Deformation Color tint

Tool window

	z Example 3: Registering multiple images for 
changes of the background

Tool window

	z Example 4: Registering multiple images for 
changes of the ambient light

Tool window

Shininess/shadow/ambient light change

By turning ON [Variable Brightness] to perform 
the OK/NG target learning, the influence from the 
ambient light becomes small.

 “Registration of Taken Image” (page 4-46)
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Stabilizing by Correcting for Misaligned 
Target Position

If there is variation (misalignment) in the positioning of the 
target, the target to be judged may also be removed from 
the tool window and cannot be judged correctly.
Detection can be stabilized by using the position adjusting 
function.

 “Position Adjustment Tool” (page 4-66)

	z Tool settings

Tool window
Position adjustment window

Master Image

	z Processing during an operation

Tool window
Position adjustment window

Search range of the tool window

Position adjustment process

Stabilizing the Position Adjustment
This section explains how to adjust when the position 
adjustment is not stable.

 “Position Adjustment Tool” (page 4-66)

If the target tilts and the position adjustment 
becomes unstable

Search Range
Rotation Range

	z Rotation Range
	yBroaden the rotation range if the tilt of the target 
exceeds the rotation range (default value: ± 20°).

 “Rotation Range” (page 4-69)
	yTo stabilize the position adjustment, the tool window 
will search with the range ± a few degrees wider than 
the set value of the rotation range. (The tool window 
will search ± a few degrees even if the rotation range 
is set to 0°.)

	z Search Range
Broaden the search range if the variation in the position 
of the target exceeds the region to be searched.

 “Search Range Settings” (page 4-68)

If the position adjustment becomes unstable 
due to the effect of the unwanted outlines

	yThe outline disabling function can disable unwanted 
outlines.

 “Settings for Disabling Outlines” (page 4-68)
	ySet the extraction sensitivity to [Low Sens.].

 “Setting a Sensitivity” (page 4-68)

If the outline of the reference target cannot 
be detected

	y If the contrast of the target is low, the outline may not be 
extracted. Set the extraction sensitivity to [High Sens.].

 “Setting a Sensitivity” (page 4-68)
If the process remains unstable even after setting the 
extraction sensitivity to [High Sens.], it may be necessary 
to adjust the exposure condition for the target.
	�“Stabilizing the Judgment Process by Taking a 
Clear Image of the Target” (page 6-16)

	yFor the color type, the outline extraction may become 
stable by using the color filter.

	� “Setting distortion correction (wide field of view sensor 
model only)/color filters (color type only)” (page 4-18)

When the window position after the position 
adjustment is misaligned and not stable

Set the search algorithm to [High Accuracy] when the 
detection is not stable because the position of the tool 
window after the position adjustment does not match 
the target position.

 “Search Algorithm” (page 4-51)
 “Search Algorithm” (page 4-69)
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Stabilizing the High-Speed Position 
Adjustment

This section explains how to adjust when the High-Speed 
Position Adjustment is not stable.

 “High-Speed Position Adjustment Tool” (page 4-92)

If the detection becomes unstable due to 
the effect of unwanted edges other than the 
target

	yRaise the threshold for edge sensitivity so that 
unwanted edges are not extracted.

 “Edge Sensitivity Settings” (page 4-95)
	yChange to an image with no unwanted edges by 
making the target background plain, etc.

If the edge of a target cannot be detected
	ySet the window size as the same as the size of the 
target.
If the judgment direction is horizontal (X axis in case 
of 2-Axis Adjustment), set the height of the tool 
window the same as the height of the target.
	yDecrease the threshold for edge sensitivity.
If the edge cannot be detected even after decreasing 
the threshold for edge sensitivity, it may be necessary 
to adjust the exposure for the target. Adjust the 
exposure so that shade on the target does not appear.

 “Edge Sensitivity Settings” (page 4-95)

Stabilizing the Outline Tool
This section explains how to adjust the outline tool when 
the judgment for an “OK” and “NG” image is not stable.

 “Outline tool” (page 4-48)

If the outline cannot be detected when the 
target goes out of position

Adjust the search region. Broaden the search area if the 
variation in the position of the target exceeds the area 
to be searched.

 “Search Range Settings” (page 4-50)

If the detection becomes unstable due to the 
effect of unwanted outlines other than the 
target

	yThe outline disabling function can disable unwanted 
outlines.

 “Settings for Disabling Outlines” (page 4-50)
	ySet the extraction sensitivity to [Low Sens.].

 “Setting a Sensitivity” (page 4-50)
	ySet the search area so that non-target areas 
containing unwanted outlines are not searched.

 “Search Range Settings” (page 4-50)
	ySet the search algorithm to [High Accuracy].

 “Search Algorithm” (page 4-51)
	yMake an image with no unwanted outlines by making 
the target background plain, etc.

If the target tilts and the outline cannot be 
detected

Adjust the rotation range. Broaden the rotation range if 
the tilt of the target exceeds the rotation range (default 
value: ± 20°).

 “Rotation Range” (page 4-51)

If the matching rate difference between an 
“OK” and “NG” image is small

Adjust the search algorithm.
If there is no difference between the matching rate for 
an “OK” and “NG” image, select [Mid Sens] or [High 
Accuracy]. [High Accuracy] improves judgment accuracy 
more than [Mid Sens]. However, the processing time 
becomes longer.

 “Search Algorithm” (page 4-51)

If the outline of the target cannot be detected
	y If the contrast of the target is low, the outline may not be 
extracted. Set the extraction sensitivity to [High Sens.].

 “Setting a Sensitivity” (page 4-50)
If the process remains unstable even after setting the 
extraction sensitivity to [High Sens.], it may be necessary 
to adjust the exposure condition for the target.
	�“Stabilizing the Judgment Process by Taking a 
Clear Image of the Target” (page 6-16)

	yFor the color type, the outline extraction may become 
stable by using the color filter.
 �“Setting distortion correction (wide field of view 
sensor model only)/color filters (color type only)” 
(page 4-18)
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Stabilizing the Color Area/Area/Color 
Average/Brightness Average/Color 
Prohibition/Brightness Prohibition Tool

This section explains how to adjust the Color Area/Area/
Color Average/Brightness Average/Color Prohibition/
Brightness Prohibition tool when the judgment for an “OK” 
and “NG” image is not stable.

 “Color Area/Area tool” (page 4-52)
 “Color/Brightness Average Tool” (page 4-59)
 “Color Prohibition/Brightness Prohibition tool” (page 4-109)

If the color you wish to judge cannot be 
extracted

	yPress and extract the color or the brightness to be the 
reference for judgment.
	y If the areas of color or brightness that have not been 
extracted are pressed repeatedly, the extraction range 
can be added.
	yAdjust the extraction range with the extraction range 
zoom in/zoom out ([+]/[-] buttons). Press [+] to 
expand the color or brightness range currently being 
extracted. Press [-] to reduce the range.
	yFor the Color Area/Color Average/ Color Prohibition 
tool, isolate the desired color for inspection using 
the [Exclude], and then press the unnecessary color 
extracted to exclude it.

 ‌�“Setting the Color Area/Area Tool” (page 4-53)
 ‌�“Setting the Color/Brightness Average Tool” 
(page 4-60)
 ‌�“Setting the Color Prohibition/Brightness 
Prohibition Tool” (page 4-110)

	ySet the [Fixed Reference Area] to [Enable (Large/
Small)].

 ‌�“Fixed Reference Area” (page 4-58)
	y If color difference detection does not stabilize 
when using the color average tool, adjust [Color 
ID Sensitivity] and [Limit]. Use the Live image 
(capture the target) for adjustment. The sensitivity 
and threshold can be adjusted while comparing the 
difference between the master color and target color 
on the Live image.

 ‌�“Color Range Settings /Brightness Range Settings” 
(page 4-61)

If the area search becomes unstable due to 
unwanted colors being extracted

	yFor the Color Area/Color Average/Color Prohibition 
tool, select the [Exclude] button, and then press the 
color that was unnecessarily extracted to exclude it.

 ‌�“Setting the Color Area/Area Tool” (page 4-53)
 ‌�“Setting the Color/Brightness Average Tool” 
(page 4-60)
 ‌�“Setting the Color Prohibition/Brightness 
Prohibition Tool” (page 4-110)

	yAdjust with the mask function. The region in which 
unwanted colors are extracted can be disabled.

 “Mask settings” (page 4-38)
	yFor the color/brightness average tool, adjust the 
position and size of the window. Set so that the region 
with unwanted colors is not included in the window.

 ‌�“Setting the Color/Brightness Average Tool” 
(page 4-60)

Stabilizing the EdgePixels tool
This section explains how to adjust the EdgePixels tool 
when the judgment for an “OK” and “NG” image is not 
stable.

 “EdgePixels tool” (page 4-105)

If the target edge pixels cannot be extracted
	y If the contrast of the target is low, the edge pixels may 
not be extracted.
Set the edge extraction sensitivity to [High Sens.].
If the process remains unstable even after setting the 
edge extraction sensitivity to [High Sens.], it may be 
necessary to adjust the exposure for the target.
 “Sensitivity Adjustment” (page 4-107)

	yWhen the number of the target’s edge pixels is low, 
capture a bigger target and increase the pixels of the 
edge to be extracted.

If it becomes unstable due to unwanted edge 
pixels being extracted

Adjust with the mask function. Mask the region in which 
unwanted edge pixels have been extracted.

 “Mask settings” (page 4-38)
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Stabilizing the Width/Edge/Pitch tool
This section explains how to adjust the Width/Edge/Pitch 
tool when the judgment for an “OK” and “NG” image is not 
stable.
 “Width Tool” (page 4-70)
 “Edge Tool” (page 4-82)
 “Pitch tool” (page 4-86)

If the detection becomes unstable due to 
the effect of unwanted edges other than the 
target

	yAdjust with the mask function. Mask the region in 
which unwanted edges have been extracted.

 “Mask settings” (page 4-38)
	yRaise the threshold for edge sensitivity so that 
unwanted edges are not extracted.
 “Edge Sensitivity Settings” (page 4-72)
 “Edge Sensitivity Settings” (page 4-84)
 “Edge Sensitivity Settings” (page 4-88)

	yChange to an image with no unwanted edges by 
making the target background plain, etc.

If the edge of a target cannot be detected
	yAlign the rotation angle of tool window with the edge 
angle.
	yDo not protrude from the tool window the side of the 
target that is not in the judgment direction of the tool 
window.
If the judgment direction is horizontal, change the 
height of the tool window to be shorter than the height 
of the target.
	yDecrease the threshold for edge sensitivity.
If the edge cannot be detected even after decreasing 
the threshold for edge sensitivity, it may be necessary 
to adjust the exposure for the target. Adjust the 
exposure so that shade on the target does not appear.
 “Edge Sensitivity Settings” (page 4-72)
 “Edge Sensitivity Settings” (page 4-84)
 “Edge Sensitivity Settings” (page 4-88)

Stabilizing the Diameter Tool
This section explains how to adjust the diameter tool when 
the judgment for an “OK” and “NG” image is not stable.
 “Diameter Tool” (page 4-76)

If the detection becomes unstable due to 
the effect of unwanted circles other than the 
target

	yAdjust with the mask function.
 “Mask settings” (page 4-38)

	ySet the edge sensitivity to low so that the unwanted 
circles will not be detected.
 “Diameter Extraction Settings” (page 4-78)

	yChoose an image with no unwanted edges by making 
the target background plain, etc.

If the target circle cannot be detected
	ySet the detection direction for the diameter to detect 
both bright and dark directions.

 “Bright/Dark Direction” (page 4-80)
	ySet the edge sensitivity to [Hi Sens].
If the diameter can not be detected even after setting 
the edge sensitivity to [Hi Sens], it may be necessary 
to adjust the exposure for the target. Adjust the 
exposure so that shade on the target does not appear.
 “Diameter Extraction Settings” (page 4-78)
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Stabilizing the OCR Tool
This section explains how to adjust the OCR tool when the 
judgment for an “OK” and “NG” image is not stable.
 “OCR Tool” (page 4-97)

When the text or date on the object cannot 
be read

	y If the text or date on the object are not clear, reading 
may fail.
Adjust the target image capture conditions and clearly 
display the text or date.
	�“Stabilizing the Judgment Process by Taking a 
Clear Image of the Target” (page 6-16)

	ySet the OCR algorithm to [High Accuracy].
	�“OCR Algorithm” (page 4-103)

When unwanted text or date are read
Adjust with the mask function.
Mask the region that contains the unwanted text or 
date.

	�“Mask settings” (page 4-38)

When reading dot characters from an IJP (ink 
jet printer) is not stable

	z Dot Matrix Print
When reading dot characters as such from an IJP 
(ink jet printer) and the inspection is not stable due to 
the influence of misalignment of the dot position, set 
[Enable]. Select [Print Type] according to the print to be 
read.

	�“Dot Matrix Print” (page 4-104)

Stabilizing the Blob Count tool
This section explains how to adjust the Blob Count tool 
when the count judgment is not stable.

 “Blob Count Tool” (page 4-115)

When color (brightness) blobs to be counted 
cannot be extracted

	yPress and extract the color or the brightness to be the 
reference for judgment. 
	y If the areas of color or brightness that have not been 
extracted are pressed repeatedly, the extraction range 
can be expanded.
	yAdjust the extraction range with the extraction range 
zoom in/zoom out ([+]/[-]). Press [+] to expand the 
color or brightness range currently being extracted. 
Press [-] to reduce the range.
 “Advanced Color Extraction/Advanced Brightness 

Extraction” (page 4-118)

If the area search becomes unstable due to 
unwanted colors being extracted

Select [Exclude], and then press the color that was 
unnecessarily extracted to exclude it.

 “Advanced Color Extraction/Advanced Brightness 
Extraction” (page 4-118)

When counting targets that are clearly 
different in size from one to be counted

Set the range of a size for counting.
By adjusting the range, objects with different sizes 
from the target to be counted can be excluded from the 
target for counting.

 “Size Limit Setting” (page 4-119)
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This section explains how to adjust the device to shorten 
the processing time.
To shorten the processing time, perform adjustments to 
shorten the processing times of the imaging process and 
the detection tools.

	yShortening the Imaging Processing Time(page 6-27)
	yShortening the processing time of each tool(page 6-28)
	yShortening the processing time of the Outline tool(page 
6-28)
	yShortening the processing time of the Color Area/Area/
Width/Diameter/Edge/Pitch/Edge Pixel/Color Prohibition/
Brightness Prohibition/Blob Count tool(page 6-28)
	yShortening the Processing Time of the OCR Tool(page 
6-29)
	yShortening the Processing Time of the Position 
Adjustment(page 6-29)

If the processing time is shortened, the stability 
of judgment may decrease. The processing time 
should therefore be adjusted while maintaining 
balance with the stability of the judgment 
process.

For the Processing Time
The processing time is the period of time from when an 
external or internal trigger is received until the status result 
is finalized.
The processing time is displayed on the run screen or the 
test screen.

Processing time

	� Flow of the internal process

Trigger input

(Trigger delay)/imaging

Image transfer

(Brightness)/(Position 
Correction)

Tool 1 process

Tool 2 process

Tool n process

Processing 
time

Capture 
process

Image 
process

Status output

(SD data transfer)

Methods to shorten the processing time are as follows.
	yShortening the imaging processing time.
	yShortening the processing time of each tool.
	yDo not use position/brightness adjustment.
	yDo not use the FTP/SFTP client function.
	yDo not use the SD data transfer function.
	yDo not use a field network.

Shortening the Processing Time
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Shortening the Imaging Processing Time

	z Exposure time
The processing time can be shortened by shortening 
the exposure time (Page 4-13). A longer exposure time 
makes the processing time longer, as it takes longer to 
take the image.
By adjusting the "Brightness" slider of the brightness 
adjustment, the exposure time can be shortened.

The exposure time can be also shortened 
using the following method.

	yUse the AI Lighting unit.
	yRemove the polarizing filter or dome 
attachment.

Selecting the tool
	yThe processing time will be shorter than the Outline 
tool when using the Color Area/Area/Width/Diameter/
Edge/Pitch/Edge Pixel/Color Prohibition/Brightness 
Prohibition tool. When judgment can be made using the 
Color Area/Area/Width/Diameter/Edge/Pitch/Edge Pixel/
Color Prohibition/Brightness Prohibition tool, select one 
mentioned above.
	yThe processing time will be shorter for the High-Speed 
Position Adjustment tool than the normal Position 
Adjustment tool. If the High-Speed Position Adjustment 
tool can be used, select the High-Speed Position 
Adjustment tool.
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Shortening the processing time of each 
tool

Shortening the processing time of the 
Outline tool

The processing time can be shortened by adjusting the 
settings for the search range, rotation range, and search 
algorithm.

Search Range
Rotation Range

	z Search Range
The time for searching for a target in the field of view 
can be shortened by reducing the search range and 
setting the search region from [Entire] (default value) to 
[Partial].
Make sure that the range of the positions for the target 
does not exceed the search region.

 “Search Range Settings” (page 4-50)

	z Rotation Range
The search time for a target that is rotated in relation 
to the master image can be shortened by reducing the 
rotation range. (default value: ± 20°)
Make sure that the range of installation angles for the 
target does not exceed the rotation range.

 “Rotation Range” (page 4-51)

	z Search Algorithm
Select [High Speed]. This will decrease judgment 
accuracy, but the processing time will be shorter.

 “Search Algorithm” (page 4-51)

	z Producing an image with less unwanted 
outlines
The processing time becomes longer for images 
with multiple unwanted outlines other than the target 
outlines.

	yMake an image with no unwanted outlines by making 
the target background plain, etc.
	ySet the search area so that non-target images 
containing unwanted outlines are not searched.

 “Search Range Settings” (page 4-50)

Shortening the processing time of the Color 
Area/Area/Width/Diameter/Edge/Pitch/
Edge Pixel/Color Prohibition/Brightness 
Prohibition/Blob Count tool

The processing time can be shortened by adjusting the 
window shape settings.

Window Shape

	z Window Shape
If the current window shape is [Entire], change and 
reduce the window size by modifying the window shape 
setting to [□ Rect] or [○ Circle].
The processing time can be shortened by reducing the 
size of the window.

 “Color Area/Area tool” (page 4-52)
 “Width Tool” (page 4-70)
 “Diameter Tool” (page 4-76)
 “Edge Tool” (page 4-82)
 “Pitch tool” (page 4-86)
 “EdgePixels tool” (page 4-105)
 “Color Prohibition/Brightness Prohibition tool” 

(page 4-109)
 “Blob Count Tool” (page 4-115)

	z Window orientation
For the Width/Edge/Pitch tool, do not rotate the tool 
window (secure the orientation horizontally or vertically) 
to reduce processing time.
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Shortening the Processing Time of the OCR 
Tool

If you are using the OCR tool, you can shorten the 
processing time by clearly displaying the object text and 
date.

	yMake an image with no unwanted background information 
by making the target background plain, etc.
	yAdjust the target image capture conditions and clearly 
display the text or date.

Shortening the Processing Time of the 
Position Adjustment

When position adjustment is performed, the processing 
time can be shortened by adjusting the search range 
settings or rotation range settings.

Search Range
Rotation Range

	z Search Range
The time for searching for a target in the field of view 
can be shortened by reducing the search range and 
setting the search region from [Entire] (default value) to 
[Partial].
Note that when the search region is reduced in size, the 
range of target positions that the position adjustment 
tool can correct for becomes narrower.

 “Search Range Settings” (page 4-68)

	z Rotation Range
The search time for a target that is rotated in relation 
to the master image can be shortened by reducing the 
rotation range. (default value: ± 20°)
Note that the range of target angles that the position 
adjustment function can correct for becomes narrower 
when reducing the rotation range.

 “Rotation Range” (page 4-69)

	z Search Algorithm
Select [High Speed]. This will decrease the positioning 
accuracy, but the processing time will be shorter.

 “Search Algorithm” (page 4-69)

	z Producing an image with less unwanted 
outlines
The processing time becomes longer for images 
with multiple unwanted outlines other than the target 
outlines.

	yMake an image with no unwanted outlines by making 
the target background plain, etc.
	ySet the search area so that non-target images 
containing unwanted outlines are not searched.
 “Search Range Settings” (page 4-68)

	z Using High-Speed Position Adjustment tool
Compared with the normal position adjustment tool, 
the High-Speed Position Adjustment tool has a faster 
processing time.
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MEMO
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7 

Various Functions

In this section, the program function, [I/O Settings] screen, 
[Sensor Advanced] screen, and menu bar operation method 
are explained.

Changeover for a Target (Program Functions)..................7-2
Using Program Auto-Switching........................................7-11
Setting the Input and Output Information of the 
Sensor.................................................................................7-13
Setting the Advanced Information of the Sensor............7-19
Operating from the Menu Bar............................................7-27
Converting IV3P Data to BMP Data Using the 
IV3P‑Converter...................................................................7-32

Chapter 

7

Various Functions



7-2 IV3 Series User’s Manual (PC Software)

Changeover for a Target (Program Functions)

Changeover for a Target (Program Functions)

Overview of the Program Functions
The sensor can save the judgment conditions set in the 
Settings Navigator as program files. Up to 32 programs can 
be saved in the sensor, representing 32 types of target (32 
products).
Additionally, if the transfer program settings for the SD card 
(Page 8-11) is set to [Enable], up to 128 programs can be 
saved, representing 128 types of targets (128 products).
By reading the judgment condition which has been saved 
according to each product, target changeover can be done 
easily.

Sensor

Sensor Advanced
	y I/O Settings
	yDevice Settings
	yUtilities

No SD card expansion
(32 types)

P127: Product ZZ

۔ ۔ ۔

P032: Product YY

P031: Product XX

۔ ۔ ۔

P002: Product C

P001: Product B

P000: Product A

Settings Navigator
	y Standard mode / Sorting mode
	y Imaging Settings*1

	yMaster Image
	y Tool Settings/Part Settings*2

	yOutput Assignment

Learned Image History

SD card expansion
(128 types)

*1	 Includes the focusing position.
*2	 Includes the threshold of each tool/detection 

window.

The [SD Card Access] function creates 96 setting 
types (P. 032 to P. 127) on the SD card.

Operations that can be performed with 
the program functions
	ySaves 128 types (128 products) of judgment conditions 
(programs).

	� “Chapter 4 Settings Navigator” (page 4-1)

	yReads and operates the saved program.
	� “Using the Program Functions (Changing Over)” (page 
7-5)

	ySelects the reading method of the program.
 “Program Switching Method” (page 7-14)

	y Imports programs from a batch backup file.
 “Importing a Program” (page 7-9)

	yAppends any name, such as the manufactured product 
name, to the judgment conditions (programs).
 “Editing a Program Name” (page 7-10)

	yCopies and uses the judgment conditions (programs) for 
another program number.
 “Copying a Program” (page 7-8)

	yReturns the judgment conditions (programs) to the status 
before setting.
 “Initializing a Program” (page 7-10)7
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Preparing the Program Functions
Registers the judgment condition for each product to the 
program before running.

Preparation Flow

(1)	 Prepare the SD card
If there will be changeover with between 33 to 128 
different types or programs, set [SD Card Access] for 
the SD card to [Enable].

 “Transferring Program Settings” (page 8-11)
This setting is not required if there are 32 or fewer 
changeover types.

(2)	 Select the program number
Select a program number to register a judgment 
condition from P000 to P031.
Select a program number from P000 to P127 if [SD 
Card Access] is enabled.

(3)	 Set the judgment conditions in the Settings 
Navigator
Set the judgment condition for a product in the Settings 
Navigator.

(4)	 Select a program switch method
Select the method to switch the program.

	ySwitch from an external input line
	ySelecting the program from the main screen in [Run].
	yDisplaying the Program Details screen and selecting 
the program.
	ySwitch from a field network
	ySwitch automatically using the program auto-switching 
settings

The following functions can be used to prepare 
programs for changeover.

	y Imports programs from a batch backup file.
 “Importing a Program” (page 7-9)

	y The product name can be registered to the 
program.

 “Editing a Program Name” (page 7-10)
	y To register a similar product, the program can be 
copied, and then the settings can be edited.

 “Copying a Program” (page 7-8)
	y Initializes and returns the judgment condition 
registered in the program to the status before 
setting.

 “Initializing a Program” (page 7-10)

Preparing the SD card
To use the program function to changeover between 33 
and 128 types of targets, insert an SD card into this device 
and set [SD Card Access] for the SD card to [Enable].

Supported SD card Ultra-compact model: CA-SD16G/KV-
M4G
Built-in amplifier type: IV3-MSD8G

1	Insert the SD card into SD card slot on the 
sensor amplifier.

 “Inserting/Removing the SD Card” (page 8-9)

2	Set [SD Card Access] for the SD card to [Enable].
 “Transferring Program Settings” (page 8-11)

Transfer program settings information is created on the 
SD card.

Preparation procedures

1	Display the main screen in [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Select a program number to register the 
judgment conditions for a product.

Select the program

The program can also be selected from the 
[Details] button (Page 7-8).

3	Set the judgment conditions in the Settings 
Navigator.

	� “Chapter 4 Settings Navigator” (page 4-1)

4	Repeat steps 2 and 3 to register programs for the 
number of products that are to be changed over.
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5	If necessary, set the program switching method.
 “Program Switching Method” (page 7-14)

	z External Input
Use this setting to switch programs by inputting signals 
from the PLC to the input line of the sensor

	z Panel/PC/Communication/Auto-Switching
Use this settings to switch programs from a PC or a 
field network, or by the program auto-switching settings.

6	If [Program Switching Method] is set to [External 
Input], set [Input Assignment].
 “Input Assignment” (page 7-14)

The bits that are required to be set will differ depending 
on the number of programs to be registered.

Product 
numbers to be 

registered
(Program 
numbers)

bit to be assigned to the input line

2 bit0

3 to 4 bit0/bit1

5 to 8 bit0/bit1/bit2

9 to 16 bit0/bit1/bit2/bit3

17 to 32 bit0/bit1/bit2/bit3/bit4

33 to 64 bit0/bit1/bit2/bit3/bit4/bit5

65 to 128 bit0/bit1/bit2/bit3/bit4/bit5/bit6

	y Setting “SD Card Access” (Page 8-11) 
to [Enable] allows 33 or more programs 
(maximum of 128) to be set.
	yWhen switching programs on the built-in 
amplifier type by external input, up to 32 
programs can be set.

Setup example
When 7 programs are to be registered, bit0, bit1, 
and bit2 are assigned to arbitrary IN terminals. 
bit3 to bit6 are not assigned.
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Using the Program Functions (Changing 
Over)

	z Precautions when [SD Card Access] for the SD 
card is set to [Enable]

	yDo not open the SD card slot cover or 
remove the SD card while the device is being 
activated. Also do not perform the procedure 
to remove the SD card (Page 8-10).
	yDo not use SD cards other than ones 
specified by KEYENCE.
	y If you perform any of the following 
operations, a program switch error will 
occur:
-	� Switching to a program saved on the SD 

card while the device is running when an 
SD Card is not recognized.

-	� When operation stops because the SD 
card is not recognized while running a 
program on the SD card.

-	� After the power is turned off with a 
program in the SD card selected, as the 
SD card is not recognized by the sensor 
during startup.

-	� Switching to a program on the SD 
card when [SD card Access] is set to 
[Disable].

	yResolving a program switch error:
-	� Stop operation. When the error is 

canceled, the settings screen opens.
	yA program switch error in RUN mode can 
be assigned to an external output line and 
output to an external device. It can also be 
obtained using a field network PLC.
	y To back up the sensor settings or copy 
settings to different sensors, use the batch 
backup function (Page 8-3). The settings 
cannot be correctly saved by only copying 
data on the SD card.
	y Precautions when using the transfer 
program settings in combination with the 
function to transfer data to the SD card:
-	� Export data on the SD card when the 

device is not running.
-	� After inserting the SD card, the data 

transfer function will automatically be 
restored when operation starts or the 
power is turned on.

	z How to clear a program switching error
Clear the error messages by operation of the control 
panel or PC (IV3-Navigator). The error will be canceled 
and the settings screen will appear. Clear error input is 
disabled. Thereafter, perform the following operations:

	yWhen using the advanced program, re-read the SD 
card on which the correct advanced program is saved.
	yWhen not using [SD card Access], set the [SD card 
Access] to [Disable].

When [Program Switching Method] is set to 
[Panel/PC/Communications/Auto-Switching]

	�When switching the program in the main 
screen in [Run]

1	Start the run mode.
 “Starting an Operation” (page 5-2)

2	Select the program number to which the product 
to be judged is registered.

Select the program

The confirmation screen opens.

The program number can also be selected 
while confirming the master image by pressing 
[Details] (Page 7-8).

3	Start run mode with the new program number by 
pressing [OK].
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	�When switching the program in the [Program 
Details] screen

1	Start Run mode.
 “Starting an Operation” (page 5-2)

2	Displays the Program Details screen.
 “Displaying the [Program Details] screen” (page 7-8)

3	Select the program to which the product to 
be judged is registered, and press [Change 
Program].

Select the 
program

4	Start run mode with the new program number by 
pressing [OK].

	� To switch a program from a field network
For details of how to switch programs using a field 
network, refer to “IV3 Series User’s Manual (Field 
Network).”

When Setting the [Program Switching 
Method] to [External Input].

1	Start the run mode.
 “Starting an Operation” (page 5-2)

2	Select the program number to which the product 
to be judged is registered using the input lines.

	yChange the status of the input lines IN2 to IN8 on which 
bit0 to bit6 are assigned to in the input assignment 
(Page 7-14) to change the program number (for 
the ultra-compact model: IN2 to IN8, for the built-in 
amplifier type: IN2 to N3 and I/O1 to I/O3). Once the 
program has been changed, save the settings. Start 
RUN mode with the new program number.
For details, refer to the following.

	� “Assignment of program numbers using bit0 to 
bit4 (when [SD Card Access] is set to [Disable])” 
(page 7-6)

	� “Assignment of program numbers using bit0 to 
bit6 (when [SD Card Access] is set to [Enable])” 
(page 7-7)

	yThe ON/OFF state of the input lines corresponding to 
the sensor polarity is as follows.

Polarity ON OFF
NPN The state shorted with 0 V line Open
PNP The state that voltage is applied Open

For details of the controlling method and the timing 
chart, refer to  “Changing Over” (page 11-10).

	z Assignment of program numbers using bit0 to 
bit4 (when [SD Card Access] is set to [Disable])

Program  
number

bit4
(MSB)

bit3 bit2 bit1
bit0 

(LSB)
P000 OFF OFF OFF OFF OFF
P001 OFF OFF OFF OFF ON
P002 OFF OFF OFF ON OFF
P003 OFF OFF OFF ON ON
P004 OFF OFF ON OFF OFF
P005 OFF OFF ON OFF ON
P006 OFF OFF ON ON OFF
P007 OFF OFF ON ON ON
P008 OFF ON OFF OFF OFF
P009 OFF ON OFF OFF ON
P010 OFF ON OFF ON OFF
P011 OFF ON OFF ON ON
P012 OFF ON ON OFF OFF
P013 OFF ON ON OFF ON
P014 OFF ON ON ON OFF
P015 OFF ON ON ON ON
P016 ON OFF OFF OFF OFF
P017 ON OFF OFF OFF ON
P018 ON OFF OFF ON OFF
P019 ON OFF OFF ON ON
P020 ON OFF ON OFF OFF
P021 ON OFF ON OFF ON
P022 ON OFF ON ON OFF
P023 ON OFF ON ON ON
P024 ON ON OFF OFF OFF
P025 ON ON OFF OFF ON
P026 ON ON OFF ON OFF
P027 ON ON OFF ON ON
P028 ON ON ON OFF OFF
P029 ON ON ON OFF ON
P030 ON ON ON ON OFF
P031 ON ON ON ON ON

For program switching by external input of 
the built-in amplifier type, up to 32 programs 
can be set. When it is required to switch 33 
programs or more, change programs from a 
field network or the control panel.
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	z Assignment of program numbers using bit0 to bit6 (when [SD Card Access] is set to [Enable])

Program  
number

bit6
(MSB)

bit5 bit4 bit3 bit2 bit1
bit0 

(LSB)
P000 OFF OFF OFF OFF OFF OFF OFF
P001 OFF OFF OFF OFF OFF OFF ON
P002 OFF OFF OFF OFF OFF ON OFF
P003 OFF OFF OFF OFF OFF ON ON
P004 OFF OFF OFF OFF ON OFF OFF
P005 OFF OFF OFF OFF ON OFF ON
P006 OFF OFF OFF OFF ON ON OFF
P007 OFF OFF OFF OFF ON ON ON
P008 OFF OFF OFF ON OFF OFF OFF
P009 OFF OFF OFF ON OFF OFF ON
P010 OFF OFF OFF ON OFF ON OFF
P011 OFF OFF OFF ON OFF ON ON
P012 OFF OFF OFF ON ON OFF OFF
P013 OFF OFF OFF ON ON OFF ON
P014 OFF OFF OFF ON ON ON OFF
P015 OFF OFF OFF ON ON ON ON
P016 OFF OFF ON OFF OFF OFF OFF
P017 OFF OFF ON OFF OFF OFF ON
P018 OFF OFF ON OFF OFF ON OFF
P019 OFF OFF ON OFF OFF ON ON
P020 OFF OFF ON OFF ON OFF OFF
P021 OFF OFF ON OFF ON OFF ON
P022 OFF OFF ON OFF ON ON OFF
P023 OFF OFF ON OFF ON ON ON
P024 OFF OFF ON ON OFF OFF OFF
P025 OFF OFF ON ON OFF OFF ON
P026 OFF OFF ON ON OFF ON OFF
P027 OFF OFF ON ON OFF ON ON
P028 OFF OFF ON ON ON OFF OFF
P029 OFF OFF ON ON ON OFF ON
P030 OFF OFF ON ON ON ON OFF
P031 OFF OFF ON ON ON ON ON
P032 OFF ON OFF OFF OFF OFF OFF
P033 OFF ON OFF OFF OFF OFF ON
P034 OFF ON OFF OFF OFF ON OFF
P035 OFF ON OFF OFF OFF ON ON
P036 OFF ON OFF OFF ON OFF OFF
P037 OFF ON OFF OFF ON OFF ON
P038 OFF ON OFF OFF ON ON OFF
P039 OFF ON OFF OFF ON ON ON
P040 OFF ON OFF ON OFF OFF OFF
P041 OFF ON OFF ON OFF OFF ON
P042 OFF ON OFF ON OFF ON OFF
P043 OFF ON OFF ON OFF ON ON
P044 OFF ON OFF ON ON OFF OFF
P045 OFF ON OFF ON ON OFF ON
P046 OFF ON OFF ON ON ON OFF
P047 OFF ON OFF ON ON ON ON
P048 OFF ON ON OFF OFF OFF OFF
P049 OFF ON ON OFF OFF OFF ON
P050 OFF ON ON OFF OFF ON OFF
P051 OFF ON ON OFF OFF ON ON
P052 OFF ON ON OFF ON OFF OFF
P053 OFF ON ON OFF ON OFF ON
P054 OFF ON ON OFF ON ON OFF
P055 OFF ON ON OFF ON ON ON
P056 OFF ON ON ON OFF OFF OFF
P057 OFF ON ON ON OFF OFF ON
P058 OFF ON ON ON OFF ON OFF
P059 OFF ON ON ON OFF ON ON
P060 OFF ON ON ON ON OFF OFF
P061 OFF ON ON ON ON OFF ON
P062 OFF ON ON ON ON ON OFF
P063 OFF ON ON ON ON ON ON

Program  
number

bit6
(MSB)

bit5 bit4 bit3 bit2 bit1
bit0 

(LSB)
P064 ON OFF OFF OFF OFF OFF OFF
P065 ON OFF OFF OFF OFF OFF ON
P066 ON OFF OFF OFF OFF ON OFF
P067 ON OFF OFF OFF OFF ON ON
P068 ON OFF OFF OFF ON OFF OFF
P069 ON OFF OFF OFF ON OFF ON
P070 ON OFF OFF OFF ON ON OFF
P071 ON OFF OFF OFF ON ON ON
P072 ON OFF OFF ON OFF OFF OFF
P073 ON OFF OFF ON OFF OFF ON
P074 ON OFF OFF ON OFF ON OFF
P075 ON OFF OFF ON OFF ON ON
P076 ON OFF OFF ON ON OFF OFF
P077 ON OFF OFF ON ON OFF ON
P078 ON OFF OFF ON ON ON OFF
P079 ON OFF OFF ON ON ON ON
P080 ON OFF ON OFF OFF OFF OFF
P081 ON OFF ON OFF OFF OFF ON
P082 ON OFF ON OFF OFF ON OFF
P083 ON OFF ON OFF OFF ON ON
P084 ON OFF ON OFF ON OFF OFF
P085 ON OFF ON OFF ON OFF ON
P086 ON OFF ON OFF ON ON OFF
P087 ON OFF ON OFF ON ON ON
P088 ON OFF ON ON OFF OFF OFF
P089 ON OFF ON ON OFF OFF ON
P090 ON OFF ON ON OFF ON OFF
P091 ON OFF ON ON OFF ON ON
P092 ON OFF ON ON ON OFF OFF
P093 ON OFF ON ON ON OFF ON
P094 ON OFF ON ON ON ON OFF
P095 ON OFF ON ON ON ON ON
P096 ON ON OFF OFF OFF OFF OFF
P097 ON ON OFF OFF OFF OFF ON
P098 ON ON OFF OFF OFF ON OFF
P099 ON ON OFF OFF OFF ON ON
P100 ON ON OFF OFF ON OFF OFF
P101 ON ON OFF OFF ON OFF ON
P102 ON ON OFF OFF ON ON OFF
P103 ON ON OFF OFF ON ON ON
P104 ON ON OFF ON OFF OFF OFF
P105 ON ON OFF ON OFF OFF ON
P106 ON ON OFF ON OFF ON OFF
P107 ON ON OFF ON OFF ON ON
P108 ON ON OFF ON ON OFF OFF
P109 ON ON OFF ON ON OFF ON
P110 ON ON OFF ON ON ON OFF
P111 ON ON OFF ON ON ON ON
P112 ON ON ON OFF OFF OFF OFF
P113 ON ON ON OFF OFF OFF ON
P114 ON ON ON OFF OFF ON OFF
P115 ON ON ON OFF OFF ON ON
P116 ON ON ON OFF ON OFF OFF
P117 ON ON ON OFF ON OFF ON
P118 ON ON ON OFF ON ON OFF
P119 ON ON ON OFF ON ON ON
P120 ON ON ON ON OFF OFF OFF
P121 ON ON ON ON OFF OFF ON
P122 ON ON ON ON OFF ON OFF
P123 ON ON ON ON OFF ON ON
P124 ON ON ON ON ON OFF OFF
P125 ON ON ON ON ON OFF ON
P126 ON ON ON ON ON ON OFF
P127 ON ON ON ON ON ON ON
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Displaying the [Program Details] screen
This section explains the Program Details screen displayed 
when [Details] is pressed on the main screen of the IV3-
Navigator.

When the Program Details screen is opened by 
pressing [Details] on the main screen in [Run], 
only [Change Program] can be pressed.

1	Display the main screen in [Run] or [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Press [Details].

The [Program Details] screen opens.

3	Configure the program settings.
 “Editing a Program Name” (page 7-10)
 “Importing a Program” (page 7-9)
 “Copying a Program” (page 7-8)
 “Initializing a Program” (page 7-10)

4	Press [Close].

Copying a Program
Copies a set program to another program number. Re-uses 
the set items and creates a new program.

1	Display the [Program Details] screen.
 “Displaying the [Program Details] screen” (page 

7-8)

2	Select the program to be copied and press 
[Copy].

Select the 
program

3	Select the program number to which the source 
program will be copied and press [OK].

Select the 
program

The source program is copied to the copy destination.

Copied 
program
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Importing a Program
Imports one program from an individual program backup 
file (*.iv3a) or a batch backup file (*.iv3a). Re-uses the 
imported program settings to create a new program.

 “Backing up in a Batch” (page 8-3)
 “Backing up the Program Individually” (page 8-4)

Programs cannot be imported from the SD card.

1	Display the main screen in [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Display the [Program Details] screen.
 “Displaying the [Program Details] screen” (page 7-8)

3	Press [Import from File].

4	Press .

5	Select a batch backup file (*.iv3a) or an individual 
program backup file (*.iv3a) and press [Open].

Select the file

6	Select the number of the source program and the 
number of the destination program, and press 
[OK].

The source program is copied to the destination 
program number.

Imported 
programs
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Initializing a Program
Initializes settings in the program and resets the program to 
the default.

1	Display the [Program Details] screen.
 “Displaying the [Program Details] screen” (page 

7-8)

2	Select the program to be initialized and press 
[Initialize].

Select the 
program

The confirmation screen opens.

3	Press [OK].
The system returns to the [Program Details] screen.
The initialized program will display [No Master Image].

Editing a Program Name
Edits the program name.

1	Display the [Program Details] screen.
 “Displaying the [Program Details] screen” (page 

7-8)

2	Select the program to change the program name 
and press [Change].

Select the 
program

The [Rename Program] screen opens.

3	Enter the user-defined program name and press 
[OK].

You can enter up to 16 alphanumeric characters.

If the display language (Page 7-30) is changed, 
the device name might be replaced and 
displayed as hyphens (-).
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	z Program Auto-Switching
If multiple programs are used to perform a single examination, examinations can be performed continuously without 
controlling the program switching with a PLC etc.

 “Program Auto-Switching” (page 4-152)
 “Importing the Status Output (When Program Auto-Switching is “Enable”)” (page 11-8)

The following flow can be set easily.

	z Setup example
	yOutput the total status OK to OUT1 when all judgments in programs 000 to 002 are OK.
	yOutput the total status NG to OUT4 when any of judgments in programs 000 to 002 are NG.
	yReturn to the program 000 after determining the judgment.

Flowchart

Check start program
Program 000

Output NG to OUT4

External trigger Internal trigger Internal trigger

Program auto-
switching

to program 001

Output NG to OUT4

Program auto-
switching

to program 002

Output NG to OUT4 Output OK to OUT1

Judgment Judgment Judgment

Program auto-
switching to check 

start program (P000)

OK OK OK

NG NG NG

Each program setting (for the ultra-compact model)
P000 P001 P002

Trigger External Internal Internal

Switching 
destination

Total Status OK P001 P002 P000

Total Status NG P000 *1 P000 P000

Output 
Assignment

OUT1 OFF OFF Total Status OK

OUT4 *2 Total Status NG Total Status NG Total Status NG

*1 �Do not select “None” but select “P000”. When selecting “None”, the judgment is not reset.
*2 �The output of built-in amplifier type is limited to OUT3, thus set the desired output number.

By assigning the total status OK to OUT1 for P002 only, you can prevent the total status OK from being 
output for the program in the middle of the process.

Using Program Auto-Switching
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	z Setting procedures
This section explains the settings using program 000 as 
an example.

1	Set the trigger options.
Select the external trigger for program 000.
Select the internal trigger for programs 001 and 002.

 “Setting the Trigger Options” (page 4-10)

2	Enable the program auto-switching by selecting 
the [4. Output Assignment] → [Extra2] tab.

 “Program Auto-Switching” (page 4-152)

3	Select the program switching destination at 
the total status OK and program switching 
destination at the total status NG.

4	Select the [Output Assignment] tab, and select 
“Total Status NG” for OUT4.

 �“4. Output Assignment (Setting Details of Outputting 
to Output Line)” (page 4-147)

5	With the same procedures, set P001 and P002 
according to each program.

	y To use program auto-switching, select 
"Panel/PC/Communications/Auto-
Switching" as the program switching 
method.

 “Program Switching Method” (page 7-14)
	y The statistical information will be reset 
because the program is switched.
	y To use program auto-switching, change 
manually to the start point program before 
starting operation.
	y The program number switched by program 
auto-switching will not be saved in the 
internal sensor ROM.
	y The life-span for the operation of the 
focusing function (program switch count) 
is 100,000 times. If the focusing position 
does not need to be changed in each 
program, set [Auto Focus Adj Pos] to 
[Common] to extend its duration.

 “Auto Focus Adj Pos” (page 7-19)
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I/O Settings
This section explains the [I/O Settings] screen displayed 
when [I/O Settings] on the main screen is pressed.

The settings for inputting and outputting for 
the sensor can only be changed when [I/O 
Settings] is pressed while on the main screen of 
[Program].

 “Input Settings” (page 7-13)
 “Output Settings” (page 7-15)
 “I/O Monitor” (page 7-17)

Input Settings
Set the input settings for the sensor.

1	Press [I/O Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “I/O Settings” (page 7-13)

2	Press the [Input] tab and make settings.
For the ultra-compact model

For the built-in amplifier type

Setting the Input and Output Information of the 
Sensor
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	z Input Assignment

	� IN1
Sets the detection timing of the trigger input for IN1 
input line.

	yExt. Trigger ↑ (Default)
Sets the sensor so that the trigger input is received 
with the rising edge of the external trigger.

	yExt. Trigger ↓
Sets the sensor so that the trigger input is received 
with the falling edge of the external trigger.

	� IN2 to IN8 (for the ultra-compact model)
Sets the roles for input lines IN2 to IN8.

	yOFF (default)
Disregards the input.

	yProgram Bit0 to Bit6
Specifies the number for switching programs.

 “Changeover for a Target (Program Functions)” 
(page 7-2)

	yClear Error
Used to clear error outputs.

 “Clearing Errors” (page 11-13)
	yExt. Master Save

Registers a new master image using the external 
input.

 “Registering the Master Image” (page 11-11)
	ySD Card Save Stop

Stop data transfer to the SD card and access to the 
expansion programs. The SD card indicator light 
turns off.

 �“Behavior When the Sensor Power is Turned On 
or Off” (page 11-14)

	� IN2 to IN3, I/O1 to I/O3 (for the built-in amplifier 
type)
Sets the roles for input lines IN2 to IN3 or I/O1 to I/O3. 
The detailed setting methods are the same as those of 
the ultra-compact model input lines IN2 to IN8.
When I/O1 to I/O3 are set to OUT (output) in the I/O 
mapping settings, the input lines cannot be set.

	z Option

	�Program Switching Method
Sets the method for switching the program number.

 �“Changeover for a Target (Program Functions)” (page 
7-2)

	yPanel/PC/Communication/Auto-Switching 
(Default)

The program number can be switched from the 
control panel, PC (IV3-Navigator), field network, 
DL, nonprocedural command, or program auto-
switching.

	yExternal Input
The program number can be switched using 
external input.

If [External Input] is set, one of the program 
Bit0 to Bit6 must be assigned to one of IN2 to 
IN8 in [Input Assignment].

 “Input Assignment” (page 7-14)

	�Write to ROM when using Ext. Master Save

	yEnable
Writes data to the ROM of the sensor when master 
image registration is performed using the external 
input or field network.

 �“Registering the Master Image” (page 11-11)
	yDisable (default)

Writes only the master images of active programs 
selected in the settings mode to the ROM of the 
sensor. The other data will not be written.

The target programs that write to ROM are 
P000 to P031.
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	z Internal Trigger Control with IN1 Input

	yEnable
Imaging and judgment will be performed at the 
intervals of the internal trigger while the input to IN1 
is ON.

 “Setting the Trigger Options” (page 4-10)
	yDisable (default)

Does not control the internal trigger with input to 
IN1.

	y [Internal Trigger Control with IN1 Input] 
is the common setting for all programs. It 
cannot be set for each program.
	y If [Trigger Options] is set to [External 
Trigger], IN1 input will be accepted as an 
external trigger.
	y This setting is disabled when 
communicating via a field network.

	z Reset Status Output on Clear Error Execution

	yEnable
Resets status output when clear error is input. 
Judgment-related outputs and errors will be turned 
off until the judgment result by the next trigger input 
is output.

	yDisable (default)
Does not reset status output when clear error is 
input.

Judgment output cannot be reset using the 
Clear Error Input via the field network.

3	Press [OK].
The system returns to the main screen in [Program].

Output Settings
Set the Output Settings of the sensor.

1	Press [I/O Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “I/O Settings” (page 7-13)

2	Press the [Output] tab and make settings.
For the ultra-compact model

For the built-in amplifier type
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	z Output Type (OUT1 to OUT8) (for the ultra-
compact model)
Specifies the output format of the output line with [N.O.] 
or [N.C.].

	z Output Type (OUT1 to OUT3, I/O1 to I/O3) 
(for the built-in amplifier type)
Specifies the output format of the output line with [N.O.] 
or [N.C.].
When I/O1 to I/O3 are set to IN (input) in the I/O 
mapping settings, the output lines cannot be set.

	z Output Settings
	�“Changing the timing of status outputs” (page 11-7)

	�[Latching] (default)
Outputs the result simultaneously with the judgment 
condition of the sensor.

	�[One-Shot]
Outputs the result as a one-shot. The one-shot time and 
ON delay time for the one-shot output can be set.

	yOne-Shot ON Time
Specifies the length of time for which the one-shot 
will be active within 10 to 1000 ms.
(Default value: 100 ms)

	yON-Delay Time
Specifies the delay before the one-shot turns on 
within 0 to 5000 ms.
(Default value: 100 ms)

	z BUSY Output Configuration
Sets the Busy output length.

	�Until Judgment is Complete (default)
The BUSY output turns on when the trigger is input and 
turns off when the judgment results are updated.

Trigger input

BUSY output

Status result 
output

Data transfer
(SD card)

	�Until Data Transfer is Complete
The BUSY output turns on when the trigger is input 
and turns off when data transfer is complete, after the 
judgment results are updated. This setting prevents a 
trigger input while data is being transferred when using 
the function to transfer data to the SD card.

Trigger input

BUSY output

Status result 
output

Data transfer
(SD card)

This setting is not valid for data transfer 
(FTP). BUSY output does not turn on during 
FTP/SFTP data transfer.

3	Press [OK].
The system returns to the main screen in [Program].
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I/O Monitor
Use the I/O monitor to confirm the correct function and 
wiring for the I/O lines.

1	Press [I/O Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “I/O Settings” (page 7-13)

2	Press the [I/O Monitor] tab and control the 
monitor.
For the ultra-compact model

For the built-in amplifier type

	z Input Monitor
Displays the input status of external input in real time. 
Whether or not the ON/OFF output from the external 
input is being correctly input can be confirmed.

	z Output
Press [ON] to turn ON each OUT output. Press [OFF] to 
turn them OFF.
Confirm that the output destination is correctly receiving 
the output.

3	Press [OK].
The system returns to the main screen in [Program].

Polarity
Sets the sensor polarity.

1	Press [I/O Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “I/O Settings” (page 7-13)

2	Press [Polarity].

3	Select [NPN] or [PNP] under Polarity.

	yNPN
Output circuit.....Photo MOS relay
Input circuit........non-voltage input
	yPNP
Output circuit.....Photo MOS relay
Input circuit........voltage input
 �“Cables” (page 2-15)

4	Select [12 pin] or [4 pin] for the cable type in the 
case of the built-in amplifier type.

	y 12pin
Select this to use a power I/O cable (OP-88654/88655 
/88656).
	y 4pin
Select this to use a conversion connector for the 
power I/O cable (OP-88631/88632).

 �“Cables” (page 2-15)

5	Press [OK].
If the polarity is switched, the confirmation dialog opens.

6	Press [OK].
Returns to the [I/O Settings] screen.

7	Press [OK].
The system returns to the main screen in [Program].
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I/O Mapping (Built-In Amplifier Type)
Sets whether to use IN or OUT for ports where input and 
output can be switched (I/O ports).

1	Press [I/O Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “I/O Settings” (page 7-13)

2	Press [I/O Mapping].

3	Set the I/O ports.

	y IN
The corresponding I/O port can be used as an input 
(IN) port.
	yOUT
The corresponding I/O port can be used as an output 
(OUT) port.

When changing IN/OUT, the input settings, 
output settings, and I/O monitor settings will 
be influenced. Check each setting again after 
it is changed.

4	Press [OK].
If the I/O port settings are switched, the confirmation 
screen opens.

5	Press [OK].
Returns to the [I/O Settings] screen.

6	Press [OK].
The system returns to the main screen in [Program].
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Setting the Advanced Information of the Sensor

Sensor Advanced Settings
This section explains the [Sensor Advanced] screen 
displayed when [Advanced Settings] on the main screen is 
pressed.

The advanced settings of the sensor can only be 
changed when [Advanced Settings] is pressed 
in the main screen in [Program].

[Device Settings] tab

	z Device Settings
Sets a sensor name and changes the network settings.
 “Device Settings” (page 7-21)

	z Security
Sets the password lock setting.
 “Security” (page 7-22)

	z Sensor Date/Time
Confirms or changes the time set in the sensor.
 “Sensor Date/Time” (page 7-23)

	z Judgment Notation
Sets the notation (OK/NG) of the status results to a 
user-defined notation.
 “Judgment Notation Settings” (page 7-23)

[Image/Result Output] tab

	z Output Destination
Sets the SD card data transfer function or FTP/SFTP 
client function settings for the sensor.
 �“Transferring Judgment Results or Judged Images to 
the SD Card” (page 8-13)
 �“Saving Judgment Results and Judged Images to an 
FTP/SFTP Server” (page 9-2)

[Utility] tab

	z FieldNet/Comm. Unit (DL)
Sets the field network settings for the sensor and the 
settings for when the system is connected to the (DL 
series) communication unit.

 “Connecting to a Field Network” (page 9-10)

	z High-Speed Program Switching
Selects the programs to be used for high-speed 
program switching.
 “High-Speed Program Switching” (page 7-24)

	z SD Card Settings Backup
Automatically backs up the sensor settings to an SD card 
when the sensor settings are changed.

	� “Automatically Back Up/Restore the Settings on the 
SD Card” (page 8-20)

[Setup Adjustment] tab

	z White Balance (for color type only)
Adjusts the white balance of the image displayed on the 
screen.

 “White Balance (for Color Type Only)” (page 7-24)

	z Image Display Direction
Rotates the screen display 180°.
 “Image Display Direction” (page 7-25)

	z Auto Focus Adj Pos
Sets whether or not to make the adjustment position for 
the auto focus common to all programs.
 “Auto Focus Adj Pos” (page 7-26)
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[Backup/Data Transfer] tab

	z Batch Backup
Saves the settings data or image history saved in the 
sensor to the PC.

 “Backing up in a Batch” (page 8-3)

	z Individ. Program Backup
Save the setting data saved in the sensor into the PC 
for each individual program. The image history can also 
be saved.

 “Backing up the Program Individually” (page 8-4)

	z Transfer Batch Backup
Transfers all settings data saved in the PC to the 
sensor.

 �“Transferring the Backed up Settings to the Sensor” 
(page 8-6)

	z Transfer Individ. Backup
Transfers each individual program settings data saved 
in the PC to the sensor.

 �“Transferring the Backed up Settings to the Sensor” 
(page 8-6)

[Initialize/Update] tab

	z Initialize Sensor
Initializes the information set in the sensor.

 “Initializing the Sensor” (page 3-12)

	z Update Sensor
Updates the operation software of the sensor.
For details, refer to KEYENCE homepage.
URL: www.keyence.com/glb

[SD Card] tab
Configure the SD card data settings.

 “Setting up the SD Card” (page 8-9)

[Sensor Information] button

Displays the information set in the sensor.
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Device Settings

Setting a Device Name

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Device Settings] tab.

3	Set the environment settings of the sensor.

	z Device Name
Displays the sensor name.
To change the sensor name, press [Change Device 
Name] and input a user-defined name in the Device 
Name screen.
The sensor can be arbitrarily named and controlled.

If the display language (Page 7-30) is 
changed, the device name might be replaced 
and displayed as hyphens (-).

	z MAC Address
Displays the MAC address of the sensor.
The MAC address cannot be changed.

4	When setting is completed, press [OK].
The system returns to the main screen in [Program].

Changing the Network Settings

	yHow to use the network setting
	y The IP address of the connected sensor can 
be changed.
	y The network settings of the sensor can be 
initialized.  
The settings can also be initialized using the 
IP reset switch (Page A-23) of the sensor.

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Device Settings] tab and press 
[Change Network Settings].

3	Set the network address of the sensor.

	z IP Address/Subnet Mask/Default Gateway/
PORT
Displays the address for each network and port number.
Set the desired address and port number, and press 
[OK].

	z [Reset] button
By pressing [Reset], resets the IP Address / Subnet 
Mask / Default Gateway.
“Not Set” will be displayed after the reset.

By pressing [OK], the confirmation dialog appears.

By pressing [OK], the network settings will reset and the 
system returns to the Activation Menu screen.

4	Press [OK].
The connection to the sensor will be disconnected and 
reconnected. If reconnection is successful, the main 
screen of [Program] will be displayed. If reconnection 
fails, the [Activation Menu] screen opens.
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Security
Sets a password on the sensor to prevent incorrect 
operation.
Two levels of security authorizations (supervisor password 
and operator password) can be set.

	z Enable the security
Display the main screen in [Run]. The “Lock Enabled” 
message appears in the lower right of the screen.

In the main screen in [Run], the following operation can 
be locked, and it can be unlocked using passwords 
according to their authorizations.

Operation that can be unlocked using an operator 
password

	yManual Trigger Button
	y Image Additional Learning
	y Limit Adjustment
	yReset Statistics
	yClear NG HOLD
	y Stop logging when opening running history display
	yDisplay the learning history

Operation that can be unlocked using a supervisor 
password

	yOperation that can be unlocked using a user 
password
	y Transition to the main screen in [Program]
	yClearing NG Count on the list of NG occurrences
	yConnection with the sensor where the security is 
enabled
	y Transferring program settings

	z Unlock the security
Input the password when the input dialog for the 
password opens.

The “Lock Disabled” message appears in the lower right 
of the screen.

If the security is unlocked, operation will be locked 
again by pressing [Lock Disabled] on the status bar 
on the bottom of the screen. After 60 seconds passes 
without performing any of the above locked operations, 
the sensor will return to a locked state.
If the security is unlocked and the sensor is returned to 
the main screen in [Program], the password lock will be 
disabled until the sensor returns to the main screen in 
[Run].

Setting the Password

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Device Settings] tab and press 
[Settings] of [Security].

3	Select a target for enabling a password.

	yOFF
Disables all passwords.
	ySupervisor
Enables the supervisor password. The settings can 
be changed in the settings mode using the supervisor 
password.
	ySupervisor/Operator
Enables both the supervisor password and operator 
password. Although the threshold changing and 
statistics reset and others in operation are available 
when the operator password is used, the settings 
cannot be changed in the settings mode.

4	Input a user-defined password.
	y Input a password into the [Supervisor Password] and 
the [Confirmation] fields.
	y Input a password into the [Operator Password] and 
the [Confirmation] fields.
	yUp to 8 characters can be set.
	yDefault: None (blank)

The password will always be displayed as 
"********", regardless of the characters entered.
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5	Press [OK].
The system returns to the main screen in [Program].

	y After setting a password and displaying the run 
screen, the security becomes enabled.
	y To disable the security, select [OFF] of [Password 
Level] in step 3.

Sensor Date/Time

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Device Settings] tab and press 
[Settings] of [Sensor Date/Time].

3	Set the sensor date settings.

When pressing [Copy PC Date/Time], the PC 
date and time can be copied.

4	Press [OK].
The system returns to the [Sensor Advanced] screen.

5	Press [OK].
The system returns to the main screen in [Program].

Judgment Notation Settings
Sets the notation (OK/NG) of the total status results on the 
run screen to a user-defined notation.

	yOnly the characters for the total status results 
on the run screen can be changed. This setting 
will not be applied to other screens or output 
information.
	y This setting will not be applied to sorting 
mode.

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Device Settings] tab and press 
[Settings] of [Judgment Notation].

3	Select the [User Settings] button, and set 
arbitrary notations to [PASS notation] and [FAIL 
notation].

	z Notation selection

	�OK/NG
[OK] is displayed if the total status result is good and
[NG] if it is bad.

	�User Settings
Any desired character string can be set.
(Up to 8 one-byte alphanumeric characters)
If user settings were selected, input character strings for 
both good and bad products.

4	Press [OK].
The system returns to the [Sensor Advanced] screen.

5	Press [OK].
The system returns to the main screen in [Program].
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High-Speed Program Switching
Selects the programs to be used for high-speed program 
switching.
By reading to retain the setting contents of the target 
program, switching between the target programs can be 
performed at high speed.

	y The approximate time to switch to the target 
program is within 100 ms (The time for focus 
adjustment is not included).
	y By setting high-speed program switching, 
additional processing time will be required when 
the sensor starts and when settings are changed (it 
may take several tens of seconds).

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Utility] tab and press [Settings] of 
[High-Speed Program Switching].

3	Select the number of target programs from 
[Number of Target Programs], and then press 
[OK].

0 Program 
(Disable)

High-speed program switching 
disabled

2. Program 
(P000 to P001)

High-speed switching enabled,  
only for two programs of P000 to 
P001

4. Program 
(P000 to P003)

High-speed switching enabled,  
only for four programs of P000 to 
P003

8. Program 
(P000 to P007)

High-speed switching enabled,  
only for eight programs of P000 to 
P007

A progress bar will be displayed while preparing high-
speed program switching.

White Balance (for Color Type Only)
Adjusts the white balance (color tint) of the built-in camera 
of the sensor.

The white balance is adjusted by default.

When using the AI Lighting unit or polarizing 
filter, perform the white balance with the 
attachment mounted.

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Setup Adjustment] tab.

3	Place the check mark ON for the [White Balance 
Adjustment] check box and press [Settings].

4	Image a white-colored target and press [Go].

If the displayed taken image is not suitable 
for adjusting the white balance, press the 
[Capture Adjustment] tab to adjust the taken 
image.
If the white balance setting has been set to 
[Enable], the image will be displayed with the 
white balance adjustment applied.
The following adjustments can be made.

	y  “Brightness/Focus Adjustment” 
(page 4-12)
	y  “Setting the lighting conditions” 
(page 4-15)
	y  �“Setting the lighting mode for the light” 

(page 4-19)
	y  “Setting the digital zoom” (page 4-17)

When adjustment is completed, the message, “White 
balance adjustment has been completed.” opens.

7

Various Functions



7-25IV3 Series User’s Manual (PC Software)

Setting the Advanced Information of the Sensor

5	Press [OK].

The system returns to the [Sensor Advanced] screen.

6	Press [OK].
The system returns to the main screen in [Program].

After changing the white balance, a message 
prompting you to re-register the master 
image opens.
Press [OK] and then re-register the master 
image.

	� “2. Master Image Registration 
(Registering an Image as a Reference)” 
(page 4-20)

Image Display Direction
Due to the installation restrictions of the sensor or the 
target, the image may be rotated.
The image can be rotated by 180 degrees using [Image 
Display Direction].

Target

Before 180° rotation After 180° rotation

The image is displayed after being rotated 180°.
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1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Setup Adjustment] tab and press 
[Rotate 180°].

If [Image Display Direction] was changed, a 
message prompting the re-registration of the 
master image opens.
Press [OK] and then re-register the master 
image.

	� “2. Master Image Registration 
(Registering an Image as a Reference)” 
(page 4-20)

3	Press [OK].
The system returns to the main screen in [Program].

Auto Focus Adj Pos
Sets whether or not to make the adjustment position for the 
auto focus common to all programs.

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Setup Adjustment] tab, and set [Auto 
Focus Adj Pos].

	z Individual
Sets the focus adjustment position in each program. 
Select this when the focus position is different for each 
target registered in each program. Re-adjusts the 
focusing position when the program number is switched. 
Switching programs takes longer with this option due to 
the time needed to adjust the focusing position.

	z Common
Sets the focus adjustment position common to all 
programs. Select this when the focus position of the 
target registered in each program is the same. The 
program can be quickly switched because re-adjustment 
of the focusing position will not be performed when the 
program number is switched.

The life-span for the operation of the 
focusing function (program switch count) 
is 100,000 times. If the focusing position 
does not need to be changed in each 
program, set [Auto Focus Adj Pos] to 
[Common] to extend its duration.

3	When setting is completed, press [OK].
The system returns to the main screen in [Program].

When [Auto Focus Adj Pos] is changed, a 
message recommending re-registration of 
the master image opens.
Press [OK] and then re-register the master 
image.

	� “2. Master Image Registration 
(Registering an Image as a Reference)” 
(page 4-20)
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[File] Menu

Batch Backup
Backs up the data saved in the sensor to the PC in a 
batch.

 “Backing up in a Batch” (page 8-3)

Individual Program Backup
Backs up the setting data saved in the sensor into the 
PC individually for each program.

 “Backing up the Program Individually” (page 8-4)

Transfer Batch Backup
Transfers the setting data (batch backup file) saved in 
the PC to the sensor.

 “Transfer in a Batch” (page 8-6)

Transfer Individ. Backup
Transfers the settings data saved in the PC to the 
sensor for each individual program.
 “Transferring the program individually” (page 8-7)

SD Card

	� Check Capacity
Checks the SD card capacity.

 “SD Card Capacity” (page 8-10)

	� Remove
Removes the SD card.

 “Removing the SD card” (page 8-10)

Export

	� Save Program Settings List
Outputs the information set as sensor in the Tab 
delimited text.

1	Display the main screen in [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Select [File] → [Export] → [Save Program 
Settings List] from the menu bar.
The Program Settings List screen opens.

3	Press [Save].

Change the save destination of the file and file 
name as needed.

The save completion message opens.

4	Press [OK].
The system returns to the main screen in [Program].

The example for displaying the saved Program 
settings list file with Microsoft Excel is below.

Operating from the Menu Bar
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	� Save Statistics/Histogram Data
Outputs the statistical information and histogram 
information as tab-delimited text.

1	Select [File] → [Export] → [Save Statistics/
Histogram Data] from the menu bar.
The Save Statistics/Histogram Data screen opens.

2	Press [Save].

Change the save destination of the file and file 
name as needed.

The save completion message opens.

3	Press [OK].
The system returns to the main screen in [Run] or 
[Program].

The example for displaying the saved Statistics/
histogram data file with Microsoft Excel is 
below.

Additional Learning from File
 �“Additional Learning from Files Saved in the PC” 
(page 6-13)

Exit
Exits the IV3-Navigator.

1	Select [File] → [Exit] from the menu bar.
The IV3-Navigator exits.

[View] Menu

Statistical Information
Controls whether to display or hide the statistical 
information.

 “Statistical Information Display” (page 5-9)

Tool Information
Controls whether to display or hide the tool data.

 “Tool Information Display” (page 5-10)

Sensor List
Controls whether to display or hide the sensor list.
 “Displaying the sensor list” (page 3-17)
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[Sensor] menu

Disconnect
Disconnects the connection between the sensor and 
PC, and displays the connection menu screen.

1	Select [Sensor] → [Disconnect] from the menu 
bar.
The system returns to the Activation Menu screen.

Reset Statistics
Resets the statistical information and histograms.

1	Display the main screen in [Run].

2	Select [Sensor] → [Reset Statistics] from the 
menu bar.
The confirmation screen opens.

3	Press [Yes].
The statistical information and histograms will be reset.

Initialize Sensor
Initializes the information set in the sensor and sets it to 
the factory default.

 “Initializing the Sensor” (page 3-12)

Update Sensor
Updates the operation software of the sensor.
For details, refer to KEYENCE homepage.
URL: www.keyence.com/glb

[Image] Menu

Zoom

	� Reduce (Zoom Out)
Reduces the image displayed on the IV3-Navigator.
Select [Image] → [Zoom] → [Reduce (Zoom Out)] from 
the menu bar. The image will be reduced with each 
selection.

The image can be reduced to a minimum size of 
25%.

	� Enlarge (Zoom In)
Magnifies the image displayed on the IV3-Navigator.
Select [Image] → [Zoom] → [Enlarge (Zoom In)] from 
the menu bar. The image will be magnified with each 
selection.

The image can be magnified to a maximum size 
of 250%.

	� Fit Window
Fits the image displayed on the IV3-Navigator to the 
screen size and displays it.
Select [Image] → [Zoom] → [Fit Window] from the menu 
bar.

Display Tools
Switches the display method for the tools.
Select [Image] → [Display Tools] from the menu bar and 
select a display method.
Selectable display methods are as follows.

OFF/Window/Process
For details of each display method, refer to  “Tool 
Information Display” (page 5-10).

Manual Trigger
Issues a trigger one time for each selection of [Image] → 
[Manual Trigger] from the menu bar. This button is used 
when the external trigger cannot be input.
Enabled when [External Trigger] is selected or [Enable 
Internal Trigger Control with IN1 Input Input] is set to 
[Enable].
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Capture

	� Save Image
Saves a bmp format file of the captured image and an 
iv3p format file which can be used for master image 
registration or additional learning at the same time.
A screen capture of the IV3-Navigator screen will also 
be saved at the same time.
Select [Image] → [Capture] → [Save Image] from the 
menu bar.

	� Show saved image file location
Opens the save destination folder for the captured 
image.
Select [Image] → [Capture] → [Show saved image file 
location] from the menu bar.

	� Change saved image file location
Opens the reference screen for the folder and changes 
the save destination for the captured image.

1	Select [Image] → [Capture] → [Change saved 
image file location] from the menu bar.

2	In the reference screen of the folder, select a 
user-defined folder and press [OK].

[Setting] Menu

Manual Trigger Button
When [External Trigger] is selected or [Enable Internal 
Trigger Control with IN1 Input Input] is set to [Enable], use 
this setting to show/hide the [Manual Trigger] button.
Select [Setting] → [Manual Trigger Button] from the menu 
bar and select [Show]/[Hide].

When an internal trigger is set, the Manual 
trigger button will not be displayed.

NG Hold Function
Switch to enable/disable NG Hold function.
Select [Setting] → [NG Hold Function] from the menu bar, 
and select [Disable]/[Enable].

 “Holding the Image of the Sensor on which NG Occurred 
(NG Hold Function)” (page 5-16)

List of NG Sensor Occurrences
Displays the list screen of NG Sensor Occurrences.
Select [Setting] → [List of NG Sensor Occurrences] from 
the menu bar.
 “Confirming the NG Occurrence Status of the Sensor 

Connected (List of NG Sensor Occurrences)” (page 5-13)

Language
Switches the display language of the IV3-Navigator.

1	Select [Setting] → [Language] from the menu bar 
and select the desired language.
The confirmation screen opens.

2	Press [OK].

3	Exits the IV3-Navigator.
 “Exit” (page 7-28)

4	Start the IV3-Navigator again.
The display language of the IV3-Navigator will be 
switched to the language selected in step 1.
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[Window] Menu

Program Details
Displays the Program Details screen.
Select [Window] → [Program Details] from the menu bar.

 “Operations that can be performed with the program 
functions” (page 7-2)

Running Image History
Display the running image history screen.
Select [Window] → [Running Image History] from the menu 
bar.
 “Confirming the Images Whose Judgment are NG 

(Running Image History)” (page 5-17)

I/O Settings
Displays the I/O Settings screen.
Select [Window] → [I/O Settings] from the menu bar.

 “Setting the Input and Output Information of the Sensor” 
(page 7-13)

Sensor Advanced
Displays the sensor advanced settings screen.
Select [Window] → [Sensor Advanced] from the menu bar.

 “Setting the Advanced Information of the Sensor” 
(page 7-19)

[Help] Menu

About
Displays the version information of the IV3-Navigator.
Select [Help] → [About] from the menu bar.
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Converting IV3P Data to BMP Data Using the 
IV3P‑Converter
IV3P-Converter is a software for transferring images from 
the IV3P format, which have been saved individually in the 
image history or saved by the FTP/SFTP client function, to 
the BMP format.
The operating method used to display files is generally the 
same as the operating method used for the explorer in the 
Windows operating system.

Installing the IV3P-Converter
When the IV3-Navigator is installed on the PC, the IV3P-
Converter is installed simultaneously.
Therefore, there is no need to install the IV3P-Converter 
separately.

	y For the details of the IV3-Navigator installing 
procedure, refer to  “Installing IV3-Navigator 
(IV3-H1)” (page 2-22).
	yWhen you install the IV3-Navigator, the shortcut 
icon of the IV3P-Converter is also created on the 
PC desktop.

Starting up the IV3P-Converter

1	Double-click the [IV3P-Converter] icon on the 
desktop.

The IV3P-Converter starts.

Main screen of the IV3P-Converter
This section explains the main screen of the IV3P-
Converter.

(4) (5) (6)

(2)

(3)

(1)

(1)	 Conversion source folder
Specifies the folder where the IV3P data to be 
converted is stored.

(2)	 [...] button
Opens the folder menu to specify the conversion source 
folder.

(3)	 [Convert] button
Converts all of the IV3P data that is stored in the 
folder specified at the conversion source folder and its 
subfolders to BMP data.

(4)	 [About] button
Displays the About IVP-Converter screen.

(5)	 [Language] button
Displays the language selection screen. The display 
language can be changed to the desired language.

(6)	 [Close] button
Exits the IV3P-Converter.
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Converting IV3P data to BMP data
Saves IV3P data as BMP data, which can be opened in 
other applications.

1	By pressing [...], specifies the folder where the 
IV3P data to be converted is stored.

All of the IV3P data that is stored in the specified folder 
and its subfolders are the conversion targets.

2	Press [Convert] to execute BMP conversion.

BMP data is saved in the conversion source folder.

	y The BMP data is saved in the same folder as 
the pre-converted IV3P files.
	yDuring the conversion, the following screen is 
displayed and the total amount of IV3P data 
and conversion progress can be confirmed.

	y If there are BMP files with the same names, 
they will be over written.
	yUp to 100,000 files of IV3P data can be 
converted at a time.
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8 

Saving Settings and 

This section explains how to save the sensor setup or image 
files, and how to set the SD card.

Saving Settings and Images, SD Card...............................8-2
Saving the Sensor Settings and Images............................8-3
Setting up the SD Card........................................................8-9
Transferring Judgment Results or Judged Images to 
the SD Card.........................................................................8-13
Automatically Back Up/Restore the Settings on the 
SD Card...............................................................................8-20

Images, SD Card

Chapter 
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Saving Settings and Images, SD Card

Saving Settings and Images, SD Card

This device can use external media (SD card).
An SD card can be used by inserting it into the sensor for the built-in amplifier type, and into the sensor amplifier for the 
ultra-compact model.

SD card

Ultra-compact model
Sensor amplifier

PC

Built-in amplifier type
Sensor

SD card

Available function

Available function with PC

What can be performed Function Ref.

Saving device settings on PC
All Batch Backup 8-3

Individual programs Individual Program Backup 8-4

Saving device running image history on PC
All Batch Backup 8-3

Individual programs Individual Program Backup 8-4

Importing settings backed up on PC (all programs in a batch) to the 
device Transfer Program Settings 8-13

Importing individual programs from setting files backed up on PC to the 
device Program Details Function 7-8

Capturing an image of the PC screen for saving Screen Capture Function 8-5

Capturing images shot by the sensor for saving Screen Capture Function 8-5

Using images saved on PC to set up the 
device

Additional Learning
(learning tool) Additional Learning 6-2

Master Registration Master Registration 4-20

Color Extraction Color Area tool
Blob count tool

4-57
4-118

Updating operating software Update Sensor 7-29

SD card

What can be performed Function Ref.

Transferring image data and status results to external media Data Transfer (SD card) 8-13

Increasing the number of programs to be changed over
(Expanding the number of programs to 128) Transfer Program Function 8-11

Automatically back up the settings for this device Automatically back up/restore the 
settings on the SD card 8-20

Use the settings automatically backed up for restoration
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Saving the Sensor Settings and Images

Backs up the data saved in the sensor, transfers the setting 
data, and captures an image.

Saving the Sensor Settings or the Image 
History

Backing up in a Batch
Backs up the data saved in the sensor to the PC in a batch.
When multiple sensors are to be used, the settings can be 
copied based on the batch backup data.

	y It is recommended to perform a batch backup 
of the data saved in the sensor in case of 
malfunction of the product.
	y The saving time increases when this is 
performed in [Run]. Execution while in the 
[Program] mode is recommended.
	y If [SD Card Access] is set to [Enable], the 
program data saved on the SD card is also 
backed up.

1	Display the main screen in [Run] or [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Press [Advanced Settings].

3	Select the [Backup/Data Transfer] tab and press 
[Batch Backup].

[Backup/Data Transfer] tab

The Batch Backup screen opens.

4	Configure the Batch Backup settings.

	z Save Running Hist.
To back up all the images of the image history in 
addition to the sensor settings (Sensor Setup (Settings 
Navigator) and advanced settings of all programs), 
place a check mark ON in the [Save Running Hist.] 
check box.

	z Filter
This setting can be set when [Save Running Hist.] is 
ON.
[All] or [NG Only] can be selected for the running image 
history to be saved.

	z History images to save
The maximum number of the image histories to be 
saved is 100. It can be selected from 20/50/100.

	z Required
Displays the expected size of the backup file.

5	Press [Go].

When the running image history has been 
saved while in [Run], the images saved 
object may be updated and deleted during 
the batch backup. A deleted image is not 
saved. Because of this, saving while in 
[Program] is recommended.

The Save As screen opens.

6	Press [Save].

Change the save destination of the file and file 
name as needed.

The backup completion message opens.

7	Press [OK].
The system returns to the sensor advanced screen.

Saving the Sensor Settings and Images
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Saving the Sensor Settings and Images

Backing up the Program Individually
Backs up the setting data saved in the sensor into the PC 
individually for each program.

The saving time increases when this is 
performed in [Run]. Execution while in the 
[Program] mode is recommended.

1	Display the main screen in [Run] or [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Press [Advanced Settings].

3	Select the [Backup/Data Transfer] tab and press 
[Individ. Program Backup].

[Backup/Data Transfer] tab

The Individual Program Backup screen opens.

4	Set the individual program backup settings.

	z Save Running Hist.
To back up all the images of the running image history 
in addition to the program settings, place a check mark 
ON to the [Save Running Hist.] check box.

	z Saved Program
Select a program to back up from the drop-down menu.

	z Filter
This setting can be set when [Save Running Hist.] is 
ON.
[All] or [NG Only] can be selected for the running image 
history to be saved.

	z History images to save
The maximum number of the image histories to be 
saved is 100. It can be selected from 20/50/100.

	z Required
Displays the expected size of the backup file.

5	Press [Go].

When the running image history has been 
saved while in [Run], the images saved 
object may be updated and deleted during 
the batch backup. A deleted image is not 
saved. Because of this, saving while in 
[Program] is recommended.

The Save As screen opens.

6	Press [Save].

Change the save destination of the file and file 
name as needed.

The backup completion message opens.

7	Press [OK].
The system returns to the sensor advanced screen.
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Saving the Sensor Settings and Images

Saving Images and Screens Displayed on 
the IV3-Navigator Individually

Using the screen which displays the [Save] button on the 
image tool bar, the image displayed on the IV3-Navigator 
can be saved to the PC. An iv3p format file which can be 
used for master image registration or additional learning 
will also be saved at the same time.
A screen capture of the IV3-Navigator screen will also be 
saved at the same time.
The screens which display the [Save] button are as follows.

	yMain screen in [Run]
	yMain screen in [Program]
	ySettings Navigator
	y Limit Adjustment
	yTool Auto Tuning
	yProgram Details
	yRunning Image History
	y Learned image history

This section explains the procedure for saving images by 
using an example from the main screen in [Run].

	� Saving procedure

1	Press [Save].

A message opens, and the image file (jpeg format and 
iv3p format) and image capture file (bmp format) will be 
saved to the save destination.

	� Confirming the save destination of an image

1	Press [▼] button, and press [Show Saved Image 
File Location].

The folder which has been set as the save destination 
opens.

	� Changing the save destination of an image

1	Press [▼] and select [Change Saved Image File 
Location].

The Browse For Folder screen opens.

2	Specify the desired save destination and press 
[OK].
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Saving the Sensor Settings and Images

Transferring the Backed up Settings to 
the Sensor

	yOperation cannot be cancelled during 
transmission of the settings data.
	y It is recommended to back up the data saved 
in the sensor in a batch before transferring 
settings.

	� “Saving the Sensor Settings or the Image 
History” (page 8-3)

	y The image data in the image history will not be 
transferred.
	y The settings file of a different model of the 
sensor head cannot be transferred.
	yWhen the following functions are enabled, 
the setting data cannot be transferred to the 
sensor while the device is is in [Run] mode.

	y FTP/SFTP client function
	y Field network/Communication unit (DL)

	y In the case of a built-in amplifier model, the 
settings file of a sensor with a different power 
supply method cannot be transferred. For 
instance, a settings file saved from a PoE 
Power Class 3 sensor cannot be transferred to 
a sensor with PoE Power Class 6 or a power I/
O cable (24 V DC).

Transfer in a Batch
Transfers the setting data (batch backup file) saved in the 
PC to the sensor.

 “Backing up in a Batch” (page 8-3)
 “Backing up the Program Individually” (page 8-4)

1	Display the main screen in [Run] or [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Press [Advanced Settings].

3	Select the [Backup/Data Transfer] tab and press 
[Transfer Batch Backup].

[Backup/Data Transfer] tab

The confirmation screen opens.

4	Press [Yes].
The screen to select the batch backup file opens.

5	Select a batch backup file to be transferred 
(*.iv3a), and press [Open].

Select the file

The [Transfer Program Settings] screen opens.

6	Confirm the information of the setting file to be 
transferred and press [Transfer].

After the transfer of files has completed, the transfer 
completion message opens.

	y If you would like to transfer the I/O polarity 
(NPN/PNP) and the network settings, check 
the [Send the settings below.] check box 
ON for [Setting Transfer Options].

	y The setting for [Setting Transfer Options] 
is reset to OFF after the setting data is 
transferred or when the setting is canceled.
	yWhen the protocol setting has been 
changed, connection is terminated and the 
sensor restarts.

7	Press [OK].
The system returns to the sensor advanced screen.

When a file was transferred while the [Send the 
settings below.] check box of [Setting Transfer 
Options] is checked ON, the connection with the 
sensor is terminated and the system returns to 
the Activation Menu screen.
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Saving the Sensor Settings and Images

Transferring the program individually
Transfers the program (individual backup file) saved in the 
PC to the sensor.

 “Backing up in a Batch” (page 8-3)
 “Backing up the Program Individually” (page 8-4)

1	Display the main screen in [Run] or [Program].
 “Overview of the Screen in [Run] / [Program]” 

(page 5-3)

2	Press [Advanced Settings].

3	Select the [Backup/Data Transfer] tab and press 
[Transfer Individ. Backup].

[Backup/Data Transfer] tab

The confirmation screen opens.

4	Press [Yes].
The screen to transfer individual program settings 
opens.

5	Press [ ].
The screen to select the individual backup file opens.

6	Select a batch backup file (*.iv3a) or an individual 
program backup file (*.iv3a) including the 
individual program to transfer, and press [Open].

Select the file

The system returns to the individual program settings 
transfer screen.

7	Select the number of the source program and the 
number of the destination program, and press 
[OK].

When the destination program is already set, 
the confirmation screen appears. Press [OK].

The source program is transferred to the destination 
program. When the transfer is completed, a confirmation 
screen to switch to the transferred program will appear.

8	Press [Yes] or [No].
	yYes.............. �Switches to the transfer destination 

program.
	yNo............... �The program remains as it was before 

the transfer.

The system returns to the sensor advanced screen.
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Saving the Sensor Settings and Images

Folder Composition and File Naming Rules

	z Batch Backup
Batch saves all the settings in the sensor.
All the images in the image history can also be saved along with the settings.

Storage folder A user-defined folder can be specified.
(Default) C:¥Users¥(Login user name)¥Documents¥IV3-Navigator

File name YYYYMMDD_hhmmss *1, 2

Extension iv3a

 “Backing up in a Batch” (page 8-3)

	z Individual Program Backup
Save the settings inside the sensor by individual program.
All the images in the image history can also be saved along with the settings.

Storage folder A user-defined folder can be specified.
(Default) C:¥Users¥(Login user name)¥Documents¥IV3-Navigator

File name YYYYMMDD_hhmmss *1, 2

Extension iv3a

 “Backing up the Program Individually” (page 8-4)

	z Save (save images)
Captured .jpeg image files, files with the format specifically for the IV3 Series, and screen capture files for the IV3-Navigator 
are simultaneously saved.

Storage folder A user-defined folder can be specified.

(Default) C:¥Users¥(Login user name)¥Documents¥IV3-Navigator¥IMAGE

File name YYYYMMDD_hhmmss *1, 3

YYYYMMDD_hhmmss_screen *1, 4

Extension jpeg, iv3p, bmp

 “Saving Images and Screens Displayed on the IV3-Navigator Individually” (page 8-5)

*1  YYYY: Year, MM: Month, DD: Day, hh: Hour, mm: Minute, ss: Second
*2  Changes to the arbitrary file name and saves it.
*3  Taken image file. Saved in jpeg format and iv3p format.
*4  Screen capture file of the IV3-Navigator. Saved in bmp format.
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Setting up the SD Card

Setting up the SD Card

Insert the SD card into the sensor amplifier to configure 
various settings such as transferring data and expanding 
the number of programs.

	yUsable SD cards
Ultra-compact model	:	CA-SD16G
		  KV-M4G
Built-in amplifier type	:	IV3-MSD8G

	ySupported format	 :	FAT32

	yUse the KEYENCE recommended product.
	yClose the cover of the SD card slot while in 
use.
	yWhen removing the SD card, be sure to 
perform [SD Card Removal] before removing.
	yDo not remove the SD card while accessing 
the SD card. Also, do not turn off the power 
while accessing the SD card. Otherwise, 
all or part of the setting data may be lost or 
damage may occur to the memory.

When formatting the SD card on the PC, 
configure the settings below. If the format is 
different, the SD card may not be recognized.

	y File system: FAT32
	yAllocation unit size: 32 kB

Inserting/Removing the SD Card

Inserting the SD Card

	�Mounting to the Ultra-Compact Model

1	Open the SD card slot cover on the sensor amplifier.

2	Insert the SD card into the SD card slot.

	yMake sure the notch on the SD card is 
facing downwards and insert it until you 
hear a clicking sound.
	y Unlock the SD card before use.

SD card
Indicator light

SD card

Notch

SD card 
slot

Cover

3	Close the cover.
The SD card indicator light turns on (green).

After inserting the SD card, make sure to close 
the cover. If the cover is left open, the sensor 
amplifier cannot recognize the SD card.

	�Mounting onto the Built-In Amplifier Type

1	Open the SD card slot cover on the sensor.

2	Insert the SD card into the SD card slot.

Make sure the notch on the SD card is on 
the right side and insert it until you hear a 
clicking sound.

SD card

Notch

SD card 
slot

The built-in amplifier type cannot detect 
whether the cover is open or closed. When 
the SD card is set, the operation indicator 
light and the SD card indicator light in the 
slot part will light up (green).

3	Close the cover, and fix the sensor with two fall 
prevention screws.

	yTightening torque: 0.15 to 0.20 N·m
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Setting up the SD Card

Removing the SD card

	yAlways perform the [SD Card Removal] 
procedure before removing the SD card.
	yOnly when [Advanced Settings] is pressed in 
the main screen in [Program], the SD card can 
be removed.
	y To re-recognize an SD card after performing 
the [SD Card Removal] removal procedure, 
remove the SD card from the SD card slot, 
reinsert the card, and then close the cover.
	y For the ultra-compact model, if you do not 
perform the [SD Card Removal] procedure 
and you open the SD card cover, the device 
will stop accessing. This may corrupt data 
or settings that are being written to the card. 
Alternatively, the IV3-Navigator may restart.

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [SD Card] tab and press [SD Card 
Removal].

3	Press [OK] in the confirmation screen.

4	Press [OK].

5	Check that the SD card indicator light has turned 
off and open the cover.

6	Press the SD card inward to release and remove 
the card.

When the lock is disengaged, it will make a 
clicking sound and the SD card can now be 
removed.

7	Close the cover.
	yBuilt-in amplifier type: tightening torque: 0.15 to 0.20 
N·m

Displaying the SD Card Screen
This section explains how to set the SD card.

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [SD Card] tab.

The following buttons are enabled when the SD 
card is inserted:

	y [SD Card Removal] button
	y [SD Card Capacity] button
	y [SD Card Format] button
	y [SD Card Programs] button

	z SD Card Removal
Allows the SD card to be properly remove.

 “Removing the SD card” (page 8-10)

	z SD Card Capacity
Displays the amount of memory available on the SD 
card.

	z SD Card Format
Formats the SD card.

 “Formatting the SD card” (page 8-11)

	z SD Card Programs
Expands the number of available programs on the 
sensor to a maximum of 128.

 “Transferring Program Settings” (page 8-11)

	z Slot cover open/close detection
Use this button if the SD card slot cover breaks.

 “Slot cover open/close detection (ultra-compact 
model only)” (page 8-12)
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Setting up the SD Card

Formatting the SD card

If [SD Card Access] (Page 8-11) is set to 
[Enable] and the [SD Card Format] procedure is 
performed, the transfer program settings will be 
disabled.

1	Display the [SD Card] screen.
 “Displaying the SD Card Screen” (page 8-10)

2	Press [SD Card Format].

3	Press [OK].

4	Once formatting is complete, press [OK].

The SD card will be formatted with the following 
settings:

	y File system: FAT32
	y Allocation unit size: 32 kB

5	Press [OK].
The system returns to the main screen in [Program].

Transferring Program Settings

1	Display the [SD Card] screen.
 “Displaying the SD Card Screen” (page 8-10)

2	Press [SD Card Programs].

3	Press [Create an extension file].

4	Press [Yes] in the confirmation screen.
Once the transfer program settings file is created, the 
file information screen opens.

5	Press [OK].
The transfer program settings are enabled and up to 
128 programs can be set.

	y If the expansion file is found on the SD 
card, [SD Card Access] is automatically 
enabled.
	y To set [SD Card Access] to [Disable], 
remove the SD card or press [Delete the 
extension file].
	y Expansion files created on a different 
sensor head model cannot be recognized.

6	Press [OK].
The system returns to the main screen in [Program].
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Setting up the SD Card

Slot cover open/close detection (ultra-
compact model only)

If the SD card slot cover or open/close detection switch 
breaks, the device the SD card is used on will no longer 
run.
[Slot cover open/close detection] is a function that enables 
the device to run by temporarily disabling cover open/close 
detection (a protective function that stops access to the SD 
card). Handle the SD card with care.

In most situations, use the device with this 
function set to [Enable] (default).
Re-enable the function once the device has been 
repaired.

The built-in amplifier type will not be displayed.

1	Display the [SD Card] screen.
 “Displaying the SD Card Screen” (page 8-10)

2	To disable the function [Slot cover open/close 
detection], press [Disable].

	z Enable (default)
Detects whether the SD card slot cover is open or 
closed.
If the cover is open, the device will stop accessing the 
SD card.

	z Disable
Does not detect whether the SD card slot cover is open 
or closed.
Even if the cover is open, the device can access the SD 
card.

3	Press [OK].
The system returns to the main screen in [Program].

8

Saving Settings and Im
ages, SD

 C
ard



8-13IV3 Series User’s Manual (PC Software)

Transferring Judgment Results or Judged Images to the SD Card

Overview of the SD Card Data Transfer 
Function

Automatically transfers the image data and status result 
information saved in the sensor memory to an SD card.

 “Setting up the SD Card” (page 8-9)

Setting up the SD Card Data Transfer 
Function

1	Insert the SD card into the sensor amplifier.
 “Inserting the SD Card” (page 8-9)

2	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

3	Select the [Image/Result Output] tab and press 
[SD Card] from [Output Destination].

	y You can select any of [FTP], [SFTP], or [SD 
Card] as the output destination.
You cannot transfer data to all destinations 
at the same time.
	yWhen you change the output destination 
from [SD Card], the [Index Upper Limit] and 
[Create Subfolder] settings are initialized.

4	Configure the SD card data transfer settings.
 “Global Settings” (page 8-14)
 “Setting the Transfer Conditions” (page 8-15)
 “Setting the Transfer Destination Folder and File 

Names” (page 8-17)

5	Press [OK].

6	Start the run mode.
Once the target is judged, the specified data file is 
automatically transferred to the SD card.

	yWhen the transfer condition is set to [All], 
adjust the processing time so that all the 
images can be transferred.
	y Setting the “BUSY Output Configuration” 
(page 7-16) to [Until Data Transfer is 
Complete] and controlling the trigger with 
the BUSY output prevents data from being 
lost while being transferred.
	yWhen the transfer could not be done on 
time, the data is saved in the internal 
buffer. The internal buffer can save up to 20 
images.
	y Image data is transferred in the sequence 
that the images have been saved to the 
internal buffer.
	yWhen the remaining capacity of the 
internal buffer is insufficient, the image 
data transfer fails. The transfer fails can 
be output using an SD card transfer error 
(Page 8-14).
	yWhen the transfer condition is set to [All], 
confirm that there is sufficient storage on 
the SD card.

Transferring Judgment Results or Judged Images 
to the SD Card
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Transferring Judgment Results or Judged Images to the SD Card

Global Settings

1	Press [Settings] of the Global Settings.

The Global Settings screen appears.

2	Configure the Global Settings.

	z File Format
Selects the file saving format for image data.
(IV3P, IV3P/BMP, JPEG, IV3P/JPEG)

	� IV3P
Transfers the image data as the format which can 
be opened by IV3-Navigator. Operation results can 
be confirmed in the simulator function by using the 
transferred image data.
Moreover, the image data can be converted to BMP by 
using the IV3P-Converter.

	�BMP
Transfers the image data as the format which can be 
opened by other applications.

	�JPEG
Transfers the image data as the format which can be 
opened by other applications.
The file size of these images is smaller than a BMP 
image. However, the image quality will slightly 
decrease.

	z Transfer Judgment Results
To transfer judgment results in a text file simultaneously 
with the image data, select [Enable].
Judgement results are transferred as a tab delimited 
text.

The example for displaying the saved results file 
with Microsoft Excel is as follows.

	z SD card transfer error
To turn ON the error output and SD card error output 
function for when an SD card transfer error occurs, 
press [Enable].

The behavior when file transfer fails is as 
follows:

	yAn error message opens.
-	�SD card access error
-	�SD card transfer error (transfer failed)
-	�SD card transfer error (insufficient data 
buffer)

	y The error output and SD card error output 
function turns ON.
-	�SD card access error output is always 
enabled.

-	�To output an SD card transfer error 
(transfer failed/insufficient data buffer), 
set this setting to [Enable].

	y To import SD card errors individually, use 
SD card error output.
	y The sensor indicator light blinks (red).
	y If an error occurs while the device is 
running, the error condition will continue 
until the error is cleared.

 “Clearing Errors” (page 11-13)

	z Add Result to Images
Press [Enable] to add the tool window (frame), total 
status results (standard mode: OK/NG, sorting mode: 
master number), program number, matching rate for 
each tool and status result, and capture date information 
to the image data to be transferred to the SD card.
The setting can be made only when BMP or JPEG are 
included in the file format.

Example of the image to be transferred (sorting mode)

Example of the image to be transferred (standard mode)

Part Type Discrimination 
MASTER00

Total Status OK

Part Type Discrimination 
MASTER01

Total Status NG

The judgment notation settings (Page 7-23) are 
not applied.

	z Image Size
Selects the saving size for image data.

Criteria Info Addition to Image Image Size (pixel)

Enable

Total: 33 tools or less
Full 1520 x 960 

Half 760 x 480

Total: 34 tools or more
Full 1760 x 960 

Half 880 x 480

Disable ―
Full 1280 x 960 

Half 640 x 480

 “Approximate image size to save” (page 8-19)

3	Press [OK].
The system returns to the [Sensor Advanced] screen.
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Transferring Judgment Results or Judged Images to the SD Card

Setting the Transfer Conditions
Up to 4 transfer conditions can be set. The setting contents 
of each transfer condition are the same.

Each transfer condition operates independently. 
Therefore, if judgment is duplicated, the file may 
be overwritten.

1	Press [Enable] of the Condition 1 to 4 to be enabled.

2	Press [Settings] of the enabled condition.

The Transfer Condition screen opens.

3	Set the file transfer conditions.
Select the target image and the status result respectively, 
and set transfer conditions of the image data.

Transfer 
Condition 1

Transfer 
Condition 2

	z Transfer Condition 1 (Target Image)
	�All
Transfers all the images that are judged. If this option is 
selected, the status conditions cannot be selected.

	�Total Status
Transfers only the images that match the status results, 
targeting images to which the total status has been 
processed.

	�Tool 00 to 64 (Standard Mode Only)
Transfers only the images that match the status 
results, targeting images to which judgment has been 
processed using a selected tool.
This option is enabled for standard mode only.

	�Master 00/Part 0 to Master07/Part 7
	yMaster 00 to Master 07 (standard mode)
Transfers images that match the status results of 
detection tools set for the selected master image 
when multiple master image settings are enabled.
	yPart 0 to Part 7 (sorting mode)
Transfers images that match the status results, 
targeting images to which judgment has been 
processed based on a selected part type master 
image.

	�Logic 1 to 4 (Standard Mode Only)
Transfers only the images that match the status 
results, targeting images to which judgment has been 
processed using a selected logic.
This option is enabled for the standard mode only.
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	z Transfer Condition 2 (Judgment Result)

	�OK
Transfers images whose status results selected in the 
transfer condition 1 are OK.
Standard Mode
When multiple master image settings are disabled

	yTotal status/tool/logic: Transferred when the result is 
OK
	yMaster 00: Transferred when the status of all tools is 
OK
	yMaster 01-07: Not transferred.

When master image settings are enabled
	yTotal status/tool/logic: Transferred when the result is 
OK
	yMaster 00-07: �Transferred when the status of all tools 

set for the selected master image is OK
Sorting Mode

	yTotal status: Transferred when matching any part type
	yTool/logic: Not transferred.
	yPart 0-7: Transferred when matching the selected part 
type

	�NG
Transfers images whose status results selected in the 
transfer condition 1 are NG.
Standard Mode
When multiple master image settings are disabled

	yTotal status/tool/logic: Transferred when the result is 
NG
	yMaster 00: Transferred when the status of any tool is 
NG
	yMaster 01-07: Not transferred.

When master image settings are enabled
	yTotal status/tool/logic: Transferred when the result is 
NG
	yMaster 00-07: �Transferred when the status for any tool 

set for the selected master image is NG
Sorting Mode

	yTotal status: Transferred when not matching any part 
type
	yTool/logic: Not transferred.
	yPart 0-7: Transferred when not matching the selected 
part type

	�NG/near threshold OK
The following images will be transferred:

	yThe images where any of the matching rates of the 
learning tool is close to the threshold, among the 
images where the judgment results selected in the 
transfer condition 1 are OK*

	yThe images whose status results selected in the 
transfer condition 1 are NG

*�Except when "Logic 1 to 4" is selected in the transfer 
condition 1.

If saving OK images where the matching rates 
are close to the threshold, the images that 
should be judged as NG which have been 
mistakenly judged as OK can be searched.

	z Transfer Destination Folder
Sets the transfer destination folder and file name of an 
image to be transferred to the SD card.

 “Setting the Transfer Destination Folder and File 
Names” (page 8-17)

	z Add Total Status Condition
When this is enabled, the program number, total 
status result (standard mode: OK/NG), or part type 
discrimination result (sorting mode: M00 to M07/NG) is 
assigned to the image file name to be transferred to the 
SD card.

e.g., In the standard mode: filename_001_OK.iv3p
filename_001_NG.iv3p

In the sorting mode: filename_002_M00.iv3p
filename_002_M01.iv3p

	z Time Stamp
When this is enabled, the date and time are assigned 
to the image file name to be transferred to the SD card. 
The time stamp is provided in the format "YYYYMMDD_
hhmmss".

	yYYYYMMDD: 	 Date (year, month, and day)
	y hhmmss: 	 Time (hour, minute, and second)

e.g., 	filename_20210106_141510.iv3p

4	Press [OK].
The system returns to the [Sensor Advanced] screen.
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Setting the Transfer Destination Folder and 
File Names

For detailed specifications of the transfer destination 
folder and file name, refer to the following:

	y  “Details of the transfer destination folder” (page 
8-18)
	y  “Details of the file name” (page 8-19)

1	Press [Settings] in the Transfer Destination Folder.

The Transfer Destination Folder screen opens.

2	Specify the transfer destination folder and file 
name on the SD card.

	z Folder
Specifies the transfer destination folder of the SD card.
(Default: Not set (blank))
Up to 16 characters can be set for the desired folder 
name.

	y Input is not necessary if the image data is to be 
transferred to the root folder.
	yTo specify a subfolder, break the name with “/” (one-
byte slash).
	y If the specified folder does not exist, a new folder will 
be created.

Set a transfer destination folder name.

	y “/” (one-byte slash), “.” (one-byte point)  
and “ “ (one-byte space) cannot be used as 
the first nor last letter of the folder name.
	y “/” (one-byte slash) cannot be used multiple 
times in a row.

	z File Name
Sets the file name of the transfer files.
(Default: Not set (blank))
Up to 16 characters can be set for the file name.

	y If there is a file with the same name at 
the transfer destination, that file will be 
overwritten. When you transfer image data 
from multiple IV3 Series devices, specify 
different transfer destinations so that the 
image data is not overwritten accidentally.
	y If the transfer destination folder is read 
only or is open, the image data transfer will 
fail.

	z Index Upper Limit
Sets the upper limit of the number of image data that 
can be transferred to the transfer destination folder to a 
number between 0 and 3999.
(Default value: 499)
When the file index quantity has reached the index 
upper limit, the following occurs.

	yWhen the [Create Subfolder] is set to any setting other 
than [No Sorting with Folders], the folder of the next 
sequence number is created in the same subfolder 
(4-digit number). The file index value returns to [0].
	yWhen [Create Subfolder] is set to [No Sorting with 
Folders], the file index quantity returns to “0”. If 
there is a file with the same name, that file will be 
overwritten.

When you change the transfer destination to 
FTP/SFTP, the settings are initialized.

	z Create Subfolder
Select this setting to create a subfolder and sort files.

	�No Sorting with Folders
A subfolder, program number folder, and YYMMDD 
folder will not be created.

	�Subfolder only (default value)
Only a subfolder will be created.
A program number folder and YYMMDD folder will not 
be created.

	�Program
A program number folder/subfolder will be created.

	�Date
A YYMMDD folder/subfolder will be created.

	�Program/Date
A program number folder/YYMMDD folder/subfolder will 
be created.

	�Date/Program
A YYMMDD folder/program number folder/subfolder will 
be created.

	y The default for subfolders is “IV00001”.
	y The upper limit is “IV99999”. When the 
upper limit has been reached, the count 
continues by returning to “IV00000”.
	y The subfolder name cannot be initialized.
	y The upper limit of the count number of 
folders in the subfolder is “9999”. When 
the number exceeds the upper limit, the 
transfer stops.

3	Press [OK].
The system returns to the [Sensor Advanced] screen.
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	z Details of the transfer destination folder
Root folder ......................(1)

................ (2)

.......... (3)

....(4)

.............. (6)

.............. (6)

Folder

YYYYMMDD (year, month, day folder)

Pnnn (program number folder)

IVmmmmm (subfolder)

0002

0001

0000

IVmmmmm (subfolder)

0001

0000

....(5)

....(5)

(1)	Root folder
This is the root folder for the SD card.
If [Folder] is not set and [Create Subfolder] is set to [No 
Sorting with Folders], files will be transferred to the root 
folder.

(2)	Folder
A folder specified in [File Name] (Page 8-17) will be 
created.
If [Create Subfolder] is set to [No Sorting with Folders], 
files will be transferred to this folder. If no folder has 
been set, a folder will not be created.

(3)	YYMMDD folder
If [Create Subfolder] is set to [Date], [Program/Date], or 
[Date/Program], a YYMMDD folder is created and files 
can be sorted.

(4)	Program number folder
If [Create Subfolder] is set to [Program], [Program/
Date], or [Date/Program], a program number folder is 
created and files can be sorted.
nnn: 000 to 127

(5)	Subfolder
If [Create Subfolder] is set to a value other than [No 
Sorting with Folders], this folder will be created.
Files will be transferred to sequentially numbered 
folders (6) created directly under this folder.
mmmmm is a sequential number created every time the 
sensor is restarted or the SD card settings are changed.
Default value: IV00001

(6)	Sequentially numbered folder
If [Create Subfolder] is set to a value other than [No 
Sorting with Folders], this folder will be created. The 
sequential numbers are “0000” to “9999”.
When the number of transferred files reaches the index 
upper limit (Page 8-17), a new folder with the next 
sequential number will be created.

	y You can create any YYMMDD folder and 
program number folder. You can also select any 
hierarchical order.
	y You cannot transfer files to program number 
folders.
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	z Details of the file name

Setting Items File name
Sequential 

number
Program 
number

Add Total Status 
Condition

Time stamp Extension

File name aaaa _bbbbb _ccc _ddd _YYYYMMDD_hhmmss .eee

	�Explanation of file names
	y aaaa..................�Set file name (Page 8-17). If this setting is blank, a name will not be appended.
	y bbbbb................�The sequential number every time a file is transferred. This number has a fixed 5 digits when zero 

suppression is not used. The default value is 00000.
	 If the index upper limit (Page 8-17) is reached, the number will return to “00000”.
	y ccc.....................�The program number. This number has a fixed 3 digits when zero suppression is not used.
	y ddd....................�In standard mode  The total status result (OK or NG).
	 In sorting mode part type discrimination result M00 to M07 or NG.
	  “Add Total Status Condition” (page 8-16).
	yYYYYMMDD.....The date (year, month, and day) the file is transferred.  “Time Stamp” (page 8-16)
	y hhmmss............The time (hour, minutes, and seconds) the file is transferred.
	y eee....................The following extensions.
	 bmp: Image file (no compression)
	 jpeg: Image file (compressed)
	 iv3p: File format especially for the IV3 Series
	 txt: A text file with the status result

	y The settings to overwrite files with the same name in the same folder every time a file is transferred are as 
follows:
The file names will become "00000.eee".

	y File Name: Blank
	y Index Upper Limit: 0
	yCreate Subfolder: No Sorting with Folders
	y Add Total Status Condition: Disable
	y Time Stamp: Disable

	y The settings to save only the most recent desired number of files (e.g., 100) are as follows:
	y Index Upper Limit: 99
	yCreate Subfolder: No Sorting with Folders
	y Add Total Status Condition: Disable
	y Time Stamp: Disable

	z Approximate image size to save

Criteria Info Addition to Image Image Size IV3P BMP JPEG

Enable

Total: 33 tools or less
Full

1204 KB

4300 KB 210 KB

Half 1070 KB 65 KB

Total: 34 tools or 
more

Full 5000 KB 240 KB

Half 1240 KB 70 KB

Disable ―
Full 3600 KB 160 KB

Half 900 KB 45 KB

 “Image Size” (page 8-14)
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Automatically Back Up/Restore the Settings on the 
SD Card
Overview of the SD Card Settings Backup 
Function

This function automatically backs up the settings for 
this device on an SD card. Additionally, the settings 
automatically backed up on the SD card can be used to 
restore the settings.
Usage examples:

	yRestoring settings when the sensor is replaced
	yCopying the same settings to multiple sensors (P000 to 
P031)

	yBackup when settings are updated and 
restoration when a sensor is replaced are 
performed automatically. Operation from IV3-
CP50 is not necessary.
	yA USB memory stick can also be used for 
backing up and restoring settings.
	y To copy settings for sensors that have 
expansion programs enabled to multiple 
sensors, use a USB memory stick or IV3-
Navigator to backup and transfer the settings. 
For SD card settings backup, P032 to P127 
settings cannot be copied.
 �“Saving the Sensor Settings or the Image 
History” (page 8-3)
 �“Transferring the Backed up Settings to the 
Sensor” (page 8-6)

Setting Up SD Card Settings Backup

1	Insert the SD card into the sensor.

2	Press [SD Card Settings Backup] on the Sensor 
Advanced screen.

3	Set [Backs up to SD card when settings are 
modified.] to [Enable].

4	If the settings have yet to be backed up on the 
SD card, press [Back up the current settings].
A dialog box appears indicating that backup is in 
progress.

Press [OK] when a backup completion dialog box 
appears.

5	Press [OK].
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Checking Backups When Changing 
Sensor Settings

1	After changing sensor settings, go to the run 
screen.
A dialog box appears confirming backup.

2	Press [Yes].

A dialog box appears indicating that backup is in 
progress.

Press [OK] when a backup completion dialog box 
appears.

	y If the SD card settings backup is set to 
[Enable], initializing the sensor (Page 
3-12) also initializes the backup files on 
the SD card. To use an SD card that has 
not yet been initialized to restore different 
sensor settings, remove the SD card before 
initialization.
	y If the SD card settings backup is set to 
[Enable] and the sensor settings are changed 
with one of the following methods, a backup 
confirmation dialog box will appear:

	y Settings are changed with Settings 
Navigator.
	yAdditional learning is performed.
	y Program name change, initialization, 
copying, or import from file is performed 
on the program details screen.
	y Settings data is transferred.
	y Learning images are deleted and 
additional learning is performed on the 
learning history screen or additional 
learning is performed from a file.
	yAdditional learning is performed on the 
image history screen.
	y Threshold values adjusted during 
operation are not backed up.

 ��“Adjusting Thresholds for Judgment” 
(page 6-15)

Restoring Settings from the SD Card
Settings can be restored for the following types of sensors:

	ySensors with the factory default settings
	ySensors that have been initialized

1	Turn off the power to the sensor for which the 
settings are going to be restored.

2	Insert the SD card with the backed up settings 
into the sensor.
For an ultra-compact model sensor amplifier, close the 
SD card cover.

3	Turn on the power to the sensor.
The backed up settings will be automatically restored.
While the settings are being restored, the [OUT] 
indicator light turns orange.

4	Once the settings are restored, the sensor will 
start.
Once the settings are restored, the control panel and 
the sensor can be connected.

If restoring settings to multiple sensors, 
the IP address will conflict. Restore the 
settings with the sensor disconnected from 
the network and then initialize the sensor 
network settings.
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MEMO
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Connecting to a 

This chapter explains the procedures to connect this device to 
a network.

Saving Judgment Results and Judged Images to an 
FTP/SFTP Server..................................................................9-2
Connecting to a Field Network..........................................9-10
Web monitor........................................................................9-12

Network
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Overview of the FTP/SFTP Data Transfer 
Function

Automatically transfers the image data and status result 
information saved in the sensor memory to an FTP/SFTP 
server.

FTP/SFTP server

LAN

FTP/SFTP client

Data transfer via FTP/SFTP

Required environment

	z Hardware
FTP/SFTP server
(A PC/NAS/PLC or the like that runs FTP/SFTP server 
software)

Setting up the FTP/SFTP data transfer 
function

1	Configure the network settings for the sensor.
Set the IP address, subnet mask, and default gateway 
for the sensor.
 “Changing the Network Settings” (page 7-21)

2	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

3	Select the [Image/Result Output] tab and press 
[FTP] or [SFTP] from [Output Destination].

	y You can select any of [FTP], [SFTP], or [SD 
Card] as the transfer destination.
You cannot transfer data to the all ones at 
the same time.
	yWhen you change the transfer destination 
from [FTP] or [SFTP], the [Index Upper 
Limit] and [Create Subfolder] settings are 
initialized.

4	Configure the FTP/SFTP data transfer settings.
 “Setting the Connection Destination” (page 9-3)
 “Global Settings” (page 9-3)
 “Setting the Transfer Conditions” (page 9-4)
 “Setting the Transfer Destination Folder and File 

Names” (page 9-6)
 “Testing data Transfer via FTP/SFTP” (page 9-9)

5	Press [OK].
The system returns to the main screen in [Program].

6	Start run mode.
Once the target is judged, the specified data file is 
automatically transferred to the FTP/SFTP server.

	yWhen the transfer condition is set to [All], 
adjust the processing time so that all the 
images can be transferred.
	yWhen the transfer could not be done on 
time, the data is saved in the internal buffer. 
The internal buffer can save up to 20 images.
	y Image data is transferred in the sequence 
that the images have been saved to the 
internal buffer.
	yWhen the remaining capacity of the internal 
buffer is insufficient, the image data 
transfer fails.
	yWhen the transfer condition is set to [All], 
confirm that there is sufficient storage on 
the FTP/SFTP server.

Saving Judgment Results and Judged Images to 
an FTP/SFTP Server
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Setting the Connection Destination

You only need to configure these settings if the 
transfer destination is set to [FTP] or [SFTP].

1	Press [Settings] of the Network Connection.

2	Set the network address of the FTP/SFTP server.

	z IP Address
Displays the IP address of the FTP/SFTP server.
Set a user-defined address.

	z Port
Displays the port number.
(Default: 21 for FTP, 22 for SFTP)
Normally, there is no need to change.

	z User Name
Input the user name (max.: 48 characters) to log in to 
the FTP/SFTP server.
(Default: Not set (blank))

	z Password
Input the password (max.: 16 characters) to log in to the 
FTP/SFTP server.
(Default: Not set (blank))

	z Passive Mode
To use the passive mode for FTP, select [Enable]. Note 
that the passive mode cannot be used for SFTP.

3	Press [OK].
The system returns to the [Sensor Advanced] screen.

Global Settings

1	Press [Settings] of the Global Settings.

The global settings screen appears.

2	Configure the global settings.

	z File Format
Selects the file saving format for image data.
(IV3P, IV3P/BMP, JPEG, IV3P/JPEG)

	� IV3P
Transfers the image data as the format which can 
be opened by IV3-Navigator. Operation results can 
be confirmed in the simulator function by using the 
transferred image data.
Moreover, the image data can be converted to BMP by 
using the IV3P-Converter.

	�BMP
Transfers the image data as the format which can be 
opened by other applications.

	�JPEG
Transfers the image data as the format which can be 
opened by other applications.
The file size of these images is smaller than a BMP 
image. However, the image quality will slightly 
decrease.

	z Transfer Judgment Results
To transfer judgment results in a text file simultaneously 
with the image data, select [Enable].
Judgement results are transferred as a tab delimited 
text.

The example for displaying the saved results file 
with Microsoft Excel is as follows.
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	z FTP Error
To turn ON the error output when a file transfer failed, 
press [Enable].

When this item is set to [Enable], the 
following occurs if a file transfer fails.

	y The following error messages are displayed 
in response to the causes of failure.
- FTP Connection Error
- FTP Transfer Error (Transfer Failed)
- FTP Transfer Error (Insufficient Data 
Buffer)

 �“Remedy when data transfer via FTP/
SFTP is unavailable” (page A-21)

	y The error output function turns ON.
	y The indicator light of the sensor blinks in 
red.
	y If “File Transfer Error” has occurred while 
the sensor is running, the error condition 
will continue until the error is cleared.

 “Clearing Errors” (page 11-13)

	z Add Result to Image
Press [Enable] to add the tool window (frame), total 
status results (standard mode: OK/NG, sorting mode: 
master number/NG), program number, matching 
rate for each tool and status result, and capture date 
information to the image data to be transferred to the 
FTP/SFTP server.
The setting can be made only when BMP or JPEG are 
included in the file format.

Example of the image to be transferred (sorting mode)

Example of the image to be transferred (standard mode)

Part Type Discrimination 
MASTER00

Total Status OK

Part Type Discrimination 
MASTER01

Total Status NG

The judgment notation settings (Page 7-23) are 
not applied.

	z Image Size
Selects the saving size for image data.

Criteria Info Addition to Image Image Size (pixel)

Enable

Total: 33 tools or less
Full 1520 x 960 

Half 760 x 480

Total: 34 tools or more
Full 1760 x 960 

Half 880 x 480

Disable ―
Full 1280 x 960 

Half 640 x 480

 “Approximate image size to save” (page 9-8)

3	Press [OK].
The system returns to the [Sensor Advanced] screen.

Setting the Transfer Conditions
Up to 4 transfer conditions can be set. The setting contents 
of each transfer condition are the same.

Each transfer condition operates independently. 
Therefore, if judgment is duplicated, the file may 
be overwritten.

1	Press [Enable] of the Condition 1 to 4 to be enabled.

2	Press [Settings] of the enabled condition.

The Transfer Condition screen opens.

3	Set the file transfer conditions.
Select the target image and the status result respectively, 
and set transfer conditions of the image data.

Transfer 
Condition 1

Transfer 
Condition 2
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	z Transfer Condition 1 (Target Image)
	�All
Transfers all the images that are judged. If this option is 
selected, the status conditions cannot be selected.
	�Total Status
Transfers only the images that match the status results, 
targeting images to which the total status has been 
processed.
	�Tool 00 to 64 (Standard Mode Only)
Transfers only the images that match the status 
results, targeting images to which judgment has been 
processed using a selected tool.
This option is enabled for standard mode only.
	�Master 00/Part 0 to Master07/Part 7

	yMaster 00 to Master 07 (standard mode)
Transfers images that match the status results of 
detection tools set for the selected master image 
when multiple master image settings are enabled.
	yPart 0 to Part 7 (sorting mode)
Transfers images that match the status results, targeting 
images to which judgment has been processed based 
on a selected part type master image.

	�Logic 1 to 4 (Standard Mode Only)
Transfers only the images that match the status 
results, targeting images to which judgment has been 
processed using a selected logic.
This option is enabled for the standard mode only.
	z Transfer Condition 2 (Judgment Result)
Selects the transfer condition of image data.
	�OK
�Transfers images whose status results selected in the 
transfer condition 1 are OK.
Standard Mode
When multiple master image settings are disabled

	yTotal status/tool/logic:	�Transferred when the result is OK
	yMaster 00:	� Transferred when the status 

of all tools, except the position 
adjustment tool, is OK

	yMaster 01-07:	 Not transferred.
When master image settings are enabled

	yTotal status/tool/logic:	�Transferred when the result is OK
	yMaster 00-07:	 �Transferred when the status 

of all tools set for the selected 
master image, except the 
position adjustment tool, is OK

Sorting Mode
	yTotal status:	� Transferred when matching any 

part type
	yTool/logic:	 Not transferred.
	yPart 0-7:	 �Transferred when matching the 

selected part type
	�NG
Transfers images whose status results selected in the 
transfer condition 1 are NG.
Standard Mode
When multiple master image settings are disabled

	yTotal status/tool/logic:	�Transferred when the result is NG
	yMaster 00:	� Transferred when the status 

of any tool, except the position 
adjustment tool, is NG

	yMaster 01-07:	 Not transferred.
When master image settings are enabled

	yTotal status/tool/logic:	�Transferred when the result is NG
	yMaster 00-07:	 �Transferred when the status 

of any tool set for the selected 
master image, except the position 
adjustment tool, is NG

Sorting Mode
	yTotal status:	� Transferred when not matching 

any part type
	yTool/logic:	 Not transferred.
	yPart 0-7:	 �Transferred when not matching 

the selected part type

	�NG/near threshold OK
The following images will be transferred:

	yThe images where any of the matching rates of the 
learning tool is close to the threshold, among the 
images where the judgment results selected in the 
transfer condition 1 are OK*

	yThe images whose status results selected in the 
transfer condition 1 are NG

*�Except when "Logic 1 to 4" is selected in the transfer 
condition 1.

If transferring OK images where the matching 
rates are close to the threshold, the images 
that should be judged as NG which have been 
mistakenly judged as OK can be searched.

	z Transfer Destination Folder
Sets the transfer destination folder and file name of an 
image to be transferred to the FTP/SFTP server.

 “Setting the Transfer Destination Folder and File 
Names” (page 9-6)

	z Add Total Status Condition
When this is enabled, the program number, total 
status result (standard mode: OK/NG), or part type 
discrimination result (sorting mode: M00 to M07/NG) is 
assigned to the image file name to be transferred to the 
FTP/SFTP server.

e.g., In standard mode: filename_001_OK.iv3p
filename_001_NG.iv3p
filename_001_--.iv3p *

In sorting mode: filename_002_M00.iv3p
filename_002_M01.iv3p

* �When the Program Auto-Switching is set to “Enable” and 
the NG image is transferred during retry or judgment 
waiting time. In this case, judgment result on the image is 
“NG”.

	z Time Stamp
When this is enabled, the date and time are assigned 
to the image file name to be transferred to the FTP/
SFTP server. The time stamp is provided in the format 
"YYYYMMDD_hhmmss".

	yYYYYMMDD: 	 Date (year, month, and day)
	y hhmmss: 	 Time (hour, minute, and second)

e.g., 	filename_20210106_141510.iv3p

4	Press [OK].
The system returns to the [Sensor Advanced] screen.
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Setting the Transfer Destination Folder and 
File Names

For detailed specifications of the transfer destination 
folder and file name, refer to the following:

	y  “Details of the transfer destination folder” 
(page 9-7)
	y  “Details of the file name” (page 9-8)

1	Press [Settings] in the Transfer Destination Folder.

The Transfer Destination Folder screen opens.

2	Specify the transfer destination folder and file 
name on the FTP/SFTP server.

	z Folder
Specify the transfer destination folder of the FTP/SFTP 
server.
(Default: Not set (blank))
Up to 128 characters can be set for the desired folder 
name.

	y Input is not necessary if the image data is to be 
transferred to the root folder.
	yTo specify a subfolder, break the name with “/” (one-
byte slash).
	y If the specified folder does not exist, a new folder will 
be created.

Set a user-defined transfer destination folder name.

	y “/” (one-byte slash), “.” (one-byte point)  
and “ “ (one-byte space) cannot be used as 
the first nor last letter of the folder name.
	y “/” (one-byte slash) cannot be used multiple 
times in a row.

	z File Name
Sets the file name of the transfer files.
(Default: Not set (blank))
Up to 64 characters can be set for the desired file name.

	y If there is a file with the same name at 
the transfer destination, that file will be 
overwritten. When you transfer image data 
from multiple IV3 Series devices, specify 
different transfer destinations so that the 
image data is not overwritten accidentally.
	y If the transfer destination folder is read 
only or is open, the image data transfer will 
fail.

	z Index Upper Limit
Sets the upper limit of the number of image data that 
can be transferred to the transfer destination folder to a 
number between 0 and 65535.
(Default value: 499)
When the file index quantity has reached the index 
upper limit, the following occurs.

	yWhen the [Create Subfolder] is set to any setting other 
than [No Sorting with Folders], the folder of the next 
sequence number is created in the same subfolder 
(4-digit number). The file index value returns to [0].
	yWhen [Create Subfolder] is set to [No Sorting with 
Folders], the file index quantity returns to “0”. If 
there is a file with the same name, that file will be 
overwritten.

When you change the transfer destination to 
FTP/SFTP, the settings are initialized.

	z Create Subfolder
Select this setting to create a subfolder and sort files.

	�No Sorting with Folders
A subfolder, program number folder, and YYMMDD 
folder will not be created.

	�Subfolder only (default value)
Only a subfolder will be created.
A program number folder and YYMMDD folder will not 
be created.

	�Program
A program number folder/subfolder will be created.

	�Date
A YYMMDD folder/subfolder will be created.

	�Program/Date
A program number folder/YYMMDD folder/subfolder will 
be created.

	�Date/Program
A YYMMDD folder/program number folder/subfolder will 
be created.

	y The default for subfolders is “IV00001”.
	y The upper limit is “IV99999”. When the 
upper limit has been reached, the count 
continues by returning to “IV00000”.
	y The subfolder name cannot be initialized.
	y The upper limit of the count number of 
folders in the subfolder is “9999”. When 
the number exceeds the upper limit, the 
transfer stops.

3	Press [OK].
The system returns to the [Sensor Advanced] screen.

9

C
onnecting to a N

etw
ork



9-7IV3 Series User’s Manual (PC Software)

Saving Judgment Results and Judged Images to an FTP/SFTP Server

	z Details of the transfer destination folder
Root folder ......................(1)

................ (2)

.......... (3)

....(4)

.............. (6)

.............. (6)

Folder

YYYYMMDD (year, month, day folder)

Pnnn (program number folder)

IVmmmmm (subfolder)

0002

0001

0000

IVmmmmm (subfolder)

0001

0000

....(5)

....(5)

(1)	Root folder
This is the root folder for the FTP/SFTP server.
If [Folder] is not set and [Create Subfolder] is set to [No 
Sorting with Folders], files will be transferred to the root 
folder.

(2)	Folder
A folder specified in [File Name] (Page 9-6) will be 
created.
If [Create Subfolder] is set to [No Sorting with Folders], 
files will be transferred to this folder. If no folder has 
been set, a folder will not be created.

(3)	YYMMDD folder
If [Create Subfolder] is set to [Date], [Program/Date], or 
[Date/Program], a YYMMDD folder is created and files 
can be sorted.

(4)	Program number folder
If [Create Subfolder] is set to [Program], [Program/
Date], or [Date/Program], a program number folder is 
created and files can be sorted.
nnn: 000 to 127

(5)	Subfolder
If [Create Subfolder] is set to a value other than [No 
Sorting with Folders], this folder will be created.
Files will be transferred to sequentially numbered 
folders (6) created directly under this folder.
mmmmm is a sequential number created every time the 
sensor is restarted or the SD card settings are changed.
Default value: IV00001

(6)	Sequentially numbered folder
If [Create Subfolder] is set to a value other than [No 
Sorting with Folders], this folder will be created. The 
sequential numbers are “0000” to “9999”.
When the number of transferred files reaches the index 
upper limit (Page 9-6), a new folder with the next 
sequential number will be created.

	y You can create any YYMMDD folder and 
program number folder. You can also select any 
hierarchical order.
	y You cannot transfer files to program number 
folders.
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Saving Judgment Results and Judged Images to an FTP/SFTP Server

	z Details of the file name

Setting Items File name
Sequential 

number
Program 
number

Add Total Status 
Condition

Time stamp Extension

File name aaaa _bbbbb _ccc _ddd _YYYYMMDD_hhmmss .eee

	�Explanation of file names
	y aaaa..................�Set file name (Page 9-6). If this setting is blank, a name will not be appended.
	y bbbbb................�The sequential number every time a file is transferred. This number has a fixed 5 digits when zero 

suppression is not used. The default value is 00000.
	 If the index upper limit (Page 9-6) is reached, the number will return to “00000”.
	y ccc.....................�The program number. This number has a fixed 3 digits when zero suppression is not used.
	y ddd....................�In standard mode  The total status result (OK or NG).
	 In sorting mode part type discrimination result M00 to M07 or NG.
	  “Add Total Status Condition” (page 9-5).
	yYYYYMMDD.....The date (year, month, and day) the file is transferred.  “Time Stamp” (page 9-5)
	y hhmmss............The time (hour, minutes, and seconds) the file is transferred.
	y eee....................The following extensions.
	 bmp: Image file (no compression)
	 jpeg: Image file (compressed)
	 iv3p: File format especially for the IV3 Series
	 txt: A text file with the status result

	y The settings to overwrite files with the same name in the same folder every time a file is transferred are as 
follows:
The file names will become "00000.eee".

	y File Name: Blank
	y Index Upper Limit: 0
	yCreate Subfolder: No Sorting with Folders
	y Add Total Status Condition: Disable
	y Time Stamp: Disable

	y The settings to save only the most recent desired number of files (e.g., 100) are as follows:
	y Index Upper Limit: 99
	yCreate Subfolder: No Sorting with Folders
	y Add Total Status Condition: Disable
	y Time Stamp: Disable

	z Approximate image size to save

Criteria Info Addition to Image Image Size IV3P BMP JPEG

Enable

Total: 33 tools or less
Full

1204 KB

4300 KB 210 KB

Half 1070 KB 65 KB

Total: 34 tools or 
more

Full 5000 KB 240 KB

Half 1240 KB 70 KB

Disable ―
Full 3600 KB 160 KB

Half 900 KB 45 KB

 “Image Size” (page 9-4)
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Saving Judgment Results and Judged Images to an FTP/SFTP Server

Testing data Transfer via FTP/SFTP

1	Press [Settings] of the Network Connection.

2	Press [Connect Test] to test the connection with 
the connection destination.

The connection test is performed and the result window 
opens.

	y If “Successfully connected.” is displayed, setting is 
completed.
	yThe folder “IV3_Series_FTP_Test” is created in the 
folder specified for [Folder] on the FTP/SFTP server 
and the file “IV3_Series_FTP_Test.txt” is transferred.

When the test is executed, the connection 
with the FTP/SFTP server, the ability to create 
folders at the transfer destination, and the ability 
to create data files are tested. The data file will 
be created in the root folder when all the transfer 
conditions are disabled, or in the folder on the 
condition of a smaller number when any of the 
conditions is enabled.

If data is not transferred properly with the 
FTP/SFTP client, refer to  “Remedy when 
data transfer via FTP/SFTP is unavailable” 
(page A-21).
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Connecting to a Field Network

Field Network
Communicates with a PLC via a field network and 
the status result, etc., can be input to the PLC as 
communication data.
You can select the following communications protocol:

	yEtherNet/IP™
	yPROFINET
	yTCP/IP non-procedural communications
	yCommunication unit (DL)

Host device such as PLC

Other connection 
devices

Communication unit (DL)
(ultra-compact model only)

Ultra-compact 
model

Sensor amplifier

Built-in amplifier 
type

Sensor

	yWhen the protocol setting has been changed, 
connection is terminated and the sensor 
restarts.
	y For details of the field network function, 
refer to “IV3 Series User’s Manual (Field 
Network)”.
	y For details of the communication unit (DL) 
function, refer to the DL Series User’s Manual.

1	Press [Advanced Settings] in the main screen in 
[Program].

 “Overview of the Screen in [Run] / [Program]” 
(page 5-3)
 “Sensor Advanced Settings” (page 7-19)

2	Select the [Utility] tab, and press [Settings] of 
[FieldNet/Comm. Unit (DL)].

3	Select the protocol.

Connecting to a Field Network
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Connecting to a Field Network

4	Configure the communications settings.
The settings differ according to the selected protocol.

	z EtherNet/IP(TM) or PROFINET

	�Handshake Control
	yDisable (default)

Select if the trigger interval is greater than the send 
cycle (RPI).
A status result can be obtained in real time. In most 
situations, select [Disable].

	yEnable
Select if the trigger interval is less than the send 
cycle (RPI) and the trigger count is 10 or less.
If the status result is not be picked up due to the 
trigger interval being faster than the send cycle, the 
status result can be saved up to ten times in the 
buffer.

	�Byte Swap
You can change the order of storing the characters read 
by OCR tool and the FTP/SFTP transfer file names into 
PLC data memory (2 byte) in unit of bytes. Set the order 
according to the PLC specifications.

	yDisable: First byte to Last byte (default) 
(Example of string “AB” : 0x4142)
	yEnable: Last byte to First byte 
(Example of string “AB” : 0x4241)

	�PROFINET Device Name (when PROFINET is 
selected)
The PROFINET device name can be set (up to 240 
alphanumeric characters).

Up to 128 characters can be set if using the 
control panel to set the name.

	z Nonprocedural command

	�Port
Default value: 8500
Set the port number for the TCP/IP no protocol 
communications function on the device. In most 
circumstances, you do not have to change the settings.
The port number assigned to IV3-CP50/IV3-Navigator 
(default: 63000) cannot be used.

	z Comm. Unit (DL)

	�Byte Swap
You can change the order of storing the characters read 
by OCR tool and the FTP/SFTP transfer file names into 
PLC data memory (2 byte) in unit of bytes. Set the order 
according to the PLC specifications.

	yDisable: First byte to Last byte (default) 
(Example of string “AB” : 0x4142)
	yEnable: Last byte to First byte 
(Example of string “AB” : 0x4241)

	�Comm. Unit (DL) Valid Tools
Select the maximum number of tools available when 
using the communication unit (DL).

	y 7 Tools (default)
Select this setting to communicate with the tool 01 
to 06 and position adjustment tool.

	y 14 Tools
Select this setting to communicate with the tool 01 
to 13 and position adjustment tool.

	yNo more than 13 tools can be used on the 
DL series.
	yWhen using a DL series other than DL-
RS1A to communicate the standard mode 
master number and sorting mode total 
status part type, select [14 Tools].

5	Press [OK].
The confirmation screen opens.

6	Press [OK].
The sensor restarts and the run screen opens.
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Web monitor

Web monitor

Overview of the Web monitor function
Use a Web browser (Google Chrome or a similar browser) 
on a device such as a computer connected to the network 
to check the image capture and operation history of the 
sensor.

The web monitor function has multiple interfaces.
	yWeb Monitor: it can display image capture and 
operation history.
	yWeb Image: it can displays image capture only

Wireless LAN
access point

Smartphone
Tablet

Access with Web browser

Ultra-compact model Sensor

LAN

Built-in amplifier 
type Sensor

Required environment

Supported Web 
browsers

	yGoogle Chrome 88 or later
	y Internet Explorer 11 or later
	yMicrosoft Edge 44 or later
	y Safari 14 or later

Max. no. of 
simultaneous 
connections

2 units *

Languages English

* �When connecting 3 or more units at the same time, the 
screen update cycle will be slower. 

Connection method

1	Configure the network settings for the sensor.
Set the IP address, subnet mask, and default gateway 
for the sensor.
Use [Network Connection] for the PC and sensor 
connections.
 “Changing the Network Settings” (page 7-21)
 “Operation for Initial Startup of the IV3-Navigator” 

(page 3-6)

2	Start the Web browser.

3	Input the following URL into the address bar.
	yWeb Monitor: 
http://(IP_address_of_sensor_amplifier)/iv3-wm.html
	yWeb Image: 
http://(IP_address_of_sensor_amplifier)/iv3-wm-i.html

If the IP address for the sensor amplifier is 
192.168.10.10:

http://192.168.10.10/iv3-wm.html
If connection is successful, the [IV3 Web Monitor] 
screen appears.
Web Monitor: 

Web Image: 
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Web monitor

Monitoring screen
Select a screen to monitor information from the sensor.

(1) (2) (3) (4) (5) (6)

	y For details of the displayed information, see  
“Names and Functions of the Screen in [Run] / 
[Program]” (page 5-4).
	y To reset statistical information, use the IV3-CP50 
or IV3-Navigator.
	yResponsive Web design is supported. The screen 
changes in accordance with the displayed device. 
Select the screen to be displayed on the menu 
button.

Menu 
button

(1)	 Monitor
Displays the operation information.

	z Running Information
Displays the program number, mode (standard or 
sorting), trigger type, and processing time.

	z Image
Displays the image and the tool window frame. The 
processing screen cannot be displayed. Press the 
image to enlarge the Live image.
An image cannot be displayed during setup (No Image).

	z Summary
Displays the number of triggers, judgment count for OK 
and NG, and number of trigger errors.

	z Stats
When standard mode, displays the OK judgment retio 
for the statistical information.
When sorting mode, displays the part judgment retio for 
the statistical information.

	z Total status
Displays the total status result and the status results of 
each tool.
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Web monitor

(2)	 Histogram
Check the status results of each tool.

	y For details of the displayed information, see 
 “Tool Information Display” (page 5-10).

	y To reset statistical information, use the IV3-
CP50 or IV3-Navigator.
	yWhen using sorting mode, histogram of 
outline, color/brightness average, width, 
diameter tool are not displayed.

	z Tool
Selects the tool to be checked.

	z Summary
Displays the number of triggers, judgment count for OK 
and NG.

	z Statistics
Displays the information (MAX, MIN, AVE) for the 
matching rate.

	z Histogram
Displays the histogram of the selected tool.

(3)	 History
Check the operation result history.
Use the [UpdateView] button to refresh the display.

Automatic update will not be performed 
regardless of the update frequency setting. 
Use the [UpdateView] button to refresh the 
display.

	z Recent History
Displays up to 10 latest status result histories.
The image can be checked with the [Img] button ( ).

	z Recent NG
Displays up to 10 histories of the latest status results 
that were NG.
The image can be checked with the [Img] button ( ).
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Web monitor

(4)	 info
Displays the information set in the sensor.

(5)	 Update frequency
Sets the frequency to refresh the displayed information.

Automatically updates the information once a 
second.

Automatically updates the information once 
every five seconds.

Stops updates. It is only available on the Web 
Monitor. 

The frequency is fixed for 2 seconds on the Web Image.
(6)	 Communication timeout

Displayed when a communication timeout occurs. 
Check the connection with the sensor amplifier.
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Web monitor

MEMO
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10 

Simulator

This chapter explains the functions and operations of the 
Simulator.

Simulator.............................................................................10-2
Basic operation of simulator.............................................10-3
Names and functions of the screen..................................10-6
Settings Navigator (Sensor Settings Simulation)............10-7
Operation Simulation.......................................................10-12
Operating from the Menu Bar..........................................10-15
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10

Sim
ulator



10-2 IV3 Series User’s Manual (PC Software)

Simulator

The Simulator is a function for checking/changing the program settings with the IV3-Navigator without being connected 
with the sensor, using a batch backup file (*.iv3a) or an individual program backup file (*.iv3a), and for performing operation 
simulation based on history images.
It is also possible to transfer the data to the sensor and to perform operation again after changing the setting data with the 
Simulator.

(1) Operate using the sensor
(Save the running image history)

(3) Change the settings (4) Confirm the operation 
status

(5) ‌�Transfer the batch backup file (*.iv3a) or  
the individual program backup file (*.iv3a) to the 
sensor

(2) ‌�Save the batch backup file (*.iv3a) or  
the individual program backup file (*.iv3a) from 
the sensor

Simulator

The three main operations which can be performed with the Simulator function are as follows.

	z Sensor Settings Simulation
With no sensor being connected, the settings for the various tools settings etc. can be edited and saved based on the 
image settings saved in the batch backup file (*.iv3a) or the individual program backup file (*.iv3a).

The screen to be displayed is the same as the Settings Navigator (Sensor Setup). However, some functions that 
cannot be used by Simulator are hidden.

	z Operation simulation
With no sensor connected, the operation results can be checked based on the program and the image history saved in 
the batch backup file (*.iv3a) or the individual program backup file (*.iv3a).
It is also possible to perform additional learning for learning tool and adjust the settings by changing the various tools 
thresholds during simulation.

	z Confirming the image history
The image history saved in the batch backup file (*.iv3a) or the individual program backup file (*.iv3a) can be checked. 
Moreover, additional learning of the learning tool can be performed by using an image from the image history.

Simulator
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Basic operation of simulator

Operation flow of the simulator

Saving the batch backup file (*.iv3a)or the individual 
program backup file (*.iv3a) from the sensor
Save the settings and the sensor image history from the 
operating sensor.

 “Saving the Batch Backup File/Individual Program 
Backup File” (page 10-3)

Operation simulation
Check the operation status based on 
the images of the running image history.

 “Operation Simulation” (page 10-12)

Exiting the Simulator
Save the batch backup file (*.iv3a)/individual program 
backup file (*.iv3a).

 “Exiting the Simulator” (page 10-5)

Transferring to the sensor
Transfer the batch backup file (*.iv3a)/individual program 
backup file (*.iv3a) to the sensor.

 “Transferring to the sensor” (page 10-5)

Sensor Settings Simulation
Check/Change the settings.

 “Settings Navigator (Sensor Settings 
Simulation)” (page 10-7)

Starting the Simulator
Open the batch backup file (*.iv3a)/individual program 
backup file (*.iv3a) to start the Simulator.

 “Starting the Simulator” (page 10-4)

Saving the Batch Backup File/Individual 
Program Backup File

1	If performing the “Operation Simulation”, save 
the running image history into the memory of the 
sensor.
 “Confirming the Images Whose Judgment are NG 

(Running Image History)” (page 5-17)

2	Save the batch backup file (*.iv3a) or the 
individual program backup file (*.iv3a) from the 
sensor.
The saved settings are used for the Sensor Settings 
Simulation.
For use of the “IV Sensor Simulation”, also save the 
image history.

 “Backing up in a Batch” (page 8-3)
 “Backing up the Program Individually” (page 8-4)

The batch backup file (*.iv3a) or individual program 
backup file (*.iv3a) can also be saved using a 
control panel (IV3-CP50). For details, refer to “IV3 
Series User’s Manual (Control Panel)”.

Basic operation of simulator
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Basic operation of simulator

Starting the Simulator

1	Double-click the [IV3-Navigator] icon on the 
desktop.

The Activation Menu screen opens.

2	Press [Simulator].

	y If [Language] is pressed, the Select language 
screen opens. The display language can be 
changed to the desired language.
	y The Simulator can be started by opening an 
iv3a file.

The [Open] screen opens.

3	Select a file and press [Open].

Select the file

Files with the formats other than the iv3a 
format cannot be used.

The main screen for the Simulator opens.
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Basic operation of simulator

Simulator screen and operation flow
This section explains the screen to be displayed in the Simulator and the operation flow.
For details of what can be set on each screen and its operations, refer to the applicable section.

Main screen of the Simulator
(Page 10-6)

Settings Navigator
(Sensor Setup Simulation)
Check/Edit the program settings.
(Page 10-7)

Operation Simulation
Perform the “Operation Simulation” based on 
the running image history.
(Page 10-12)

Exiting the Simulator

1	The system returns to the main screen for the 
Simulator.
If the [Sensor Settings Simulation] or [Operation 
Simulation] is activating, exit it.

2	Select [File] → [Terminate IV3-Simulator] from 
the menu bar.
When the program setting or image history has been 
changed, the confirmation dialog to save opens.

3	Press [Yes].
The Batch Backup screen opens.

4	Press [Go].
The Save As screen opens.

5	Press [Save].

Change the save destination of the file and file 
name as needed.

The changed contents are saved in the batch backup 
file (*.iv3a)/individual program backup file (*.iv3a), then 
the software returns to the Activation Menu screen.

If you want to reduce the file size, delete the entire 
image history with the [RUN/Learned Img. History] 
on the main screen of the Simulator or the [Delete] 
button of [Operation Simulation] before saving the 
file. Only the settings are saved and the file size 
becomes smaller.

Transferring to the sensor

1	Transfer the saved batch backup file or individual 
program backup file to the sensor.

 “Transferring the Backed up Settings to the Sensor” 
(page 8-6)

The batch backup file (*.iv3a) or individual program 
backup file (*.iv3a) can also be transferred to 
the sensor using a control panel (IV3-CP50). For 
details, refer to “IV3 Series User’s Manual (Control 
Panel)”. 10
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Names and functions of the screen

Names and functions of the screen

Main Screen of the Simulator

(1)

(2)
(3)
(4)

(5)

(6)

(7)

(8)

(9)

(10)

(1)	 Menu bar
 “Operating from the Menu Bar” (page 10-15)

(2)	 Settings button

(c)(a) (b) (d) (e) (f) (g)

No. button Function Ref.

(a) File name

Displays the file name 
of the batch backup file 
(*.iv3a) or individual program 
backup file (*.iv3a) which is 
displayed in the Simulator.

-

(b) Save

Saves the contents set in 
the Simulator to the batch 
backup file (*.iv3a) or the 
individual program backup 
file (*.iv3a).

10-15

(c) Program 
information

Displays the program 
number and program name.
Programs can be switched 
from the drop-down menu.

7-2

(d) Details Displays the Program Details 
screen. 7-8

(e)
RUN/
Learned 
Img. History

Displays the running image 
history and learned image 
history (Learning tool only) 
saved in the open batch 
backup file (*.iv3a) or the 
open individual program 
backup file (*.iv3a).

5-17
6-7

(f) I/O Settings Displays the I/O Settings 
screen. 10-17

(g) Advanced 
Settings

Displays the sensor 
advanced settings screen. 10-17

(3)	 Status bar
Displays the image type (Master/Part), the number of 
learned images (Learning tool only) and trigger type.

(4)	 Image tool bar
Displays the tools for controlling the image displayed in 
the Simulator.

 “Operation of the Image Tool Bar” (page 3-13)
(5)	 Tool window

Displays the set region of the tool set in the program.
The tool window selected can be changed by pressing 
a different tool region.

 “Selecting the Display Method of the Tool Window” 
(page 5-7)

(6)	 Master image display
Displays the master image registered to the currently 
selected program.

If the search range of the selected tool is 
being set to [Partial], the search range will be 
displayed with a light blue frame. If the position 
adjustment is set, the search range after position 
adjustment will be displayed.

(7)	 Sensor Information
Displays the model and device name (Page 7-21) of 
the sensor.

(8)	 Mode
Displays the program mode (Standard Mode/Sorting 
Mode).

(9)	 [Sensor Settings Simulation] button
Displays the Settings Navigator (Sensor Settings 
Simulation) screen.

 “Settings Navigator (Sensor Settings Simulation)” 
(page 10-7)

(10)	[Operation Simulation] button
Displays the Operation Simulation screen.

	�“Operation Simulation” (page 10-12)
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Settings Navigator (Sensor Settings Simulation)

Settings Navigator Screen and Operation Flow
This section explains each setting screen to be displayed in the Settings Navigator and the operation flow.
For details of the contents which can set on each setting screen and its operations, refer to the applicable sections.

3. Part Registration
 “3. Part Registration” 

(page 10-10)

When the [Sorting Mode] 
program is selected

When the [Standard Mode] 
program is selected

3. Tool Settings
 “3. Tool Settings” 

(page 10-9)

2. Master Registration
 “2. Master Registration” (page 10-8)

1. Image Optimization
 “1. Image Optimization” (page 

10-8)

4. Output Assignment
 “4. Output Assignment” (page 10-11)

Settings Navigator (Sensor Settings Simulation)
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Settings Navigator (Sensor Settings Simulation)

1. Image Optimization
Confirm the Image Optimization settings used for taking an 
image of a target.

In the Settings Navigator of the Simulator, the 
settings of the Image Optimization can only be 
confirmed. Image Optimization settings cannot 
be changed.

Main screen for the Image Optimization

(7) (8)

(1)

(2)

(3)

(4)

(5)

(6)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 Title
Displays the program number (Page 7-2), program 
name (Page 7-10), and trigger type.

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Image display screen
Only displays a message. The image will not be 
displayed.

(5)	 Settings button
Displays the settings to be set for Image Optimization.

 “Settings of Smart Image Optimization” (page 4-9)
 “Setting the Trigger Options” (page 4-10)
 “Brightness/Focus Adjustment” (page 4-12)
 “Advanced settings for image optimization” (page 4-16)

(6)	 Setting confirmation screen
Displays the settings of the selected menu in the tab 
format.

(7)	 [Next to STEP2] button
Proceeds to “2. Master Registration”.

 “2. Master Registration” (page 10-8)
(8)	 [Quit] button

Finishes the Settings Navigator.
 “Settings Navigator Screen and Operation Flow” 

(page 10-7)

2. Master Registration
Registers a master image used as the reference for 
judgment. Also, set Brightness Correction.

In the Settings Navigator of the Simulator, the 
following images can be registered as master 
image.

	y The running image history saved in the batch 
backup file (*.iv3a) or the individual program 
backup file (*.iv3a) that are open currently.
	y The running image history or master image 
saved in another batch backup file (*.iv3a) or 
individual program backup file (*.iv3a).
	y Image capture file (*.iv3p)

Main screen for the master registration

(7)(6) (8)

(1)

(2)

(3)

(4)

(5)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 [Image Type] display
 “Image Types of the Settings Navigator” (page 4-5)

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Master Image
Displays the master image.

(5)	 Settings button
Displays the settings used in the Master Registration.

 “Master Registration from a Running Image History” 
(page 10-9)

 “Master Registration Using the File Saved in the PC” 
(page 10-9)

 “Advanced settings items for the master registration” 
(page 4-24)

(6)	 [Back] button
Returns to the settings screen for Image Optimization.

 “1. Image Optimization” (page 10-8)
(7)	 [Next to STEP3] button

Proceeds to “3. Tool Settings” (Standard Mode) or 
“3.Part Registration” (Sorting Mode).

	� “3. Tool Settings” (page 10-9)
	� “3. Part Registration” (page 10-10)

(8)	 [Quit] button
Finishes the Settings Navigator.

 “Settings Navigator Screen and Operation Flow” 
(page 10-7)
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Settings Navigator (Sensor Settings Simulation)

Registering the master image

	�Master Registration from a Running Image 
History
The image history saved in the batch backup file 
(*.iv3a) or the individual program backup file (*.iv3a) is 
registered as a master image.

To perform a master image registration from 
the image history in a sensor, the image 
to be registered as a master image in the 
running image history must be saved in 
advance.

 “Confirming the Images Whose Judgment 
are NG (Running Image History)” (page 5-17)

For details about steps, refer to  “Register From a 
Running Image History” (page 4-21).

	�Master Registration Using the File Saved in 
the PC
Select a batch backup file (*.iv3a), an individual 
program backup file (*.iv3a) or an image capture file 
(*.iv3p) stored in the PC, and register it as the master 
image.

	y Save the image to be registered as the 
master image into the PC in advance.
	y The files which can be registered as a 
master image are batch backup files 
(*.iv3a), individual program backup file 
(*.iv3a) or image capture files (*.iv3p).

 “Folder Composition and File Naming 
Rules” (page 8-8)
	yRegister images taken with a sensor with 
the same installation conditions and the 
same image-related settings (exposure 
conditions etc.). Otherwise correct 
judgment may not be possible.

For details about steps, refer to  “Registering from 
the File Saved in the PC” (page 4-22).

3. Tool Settings
Tools for judgment of the target can be added, edited, 
copied, and deleted.
 �“3. Tool Settings (Setting the Judgment Method of the 
Target of Standard Mode)” (page 4-28)

In the Settings Navigator for the Simulator, the 
following buttons will not be displayed.

	y [Live Adjustment] button for adjustment of the 
threshold of each tool
	y The [LIVE image] button which displays the 
live image during tool setting.

Main screen for the Tool Settings

(8)(7) (9)

(1)

(2)

(3)

(4)

(5)

(6)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 [Image Type] display
 “Operation of the Image Tool Bar” (page 3-13)

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Master Image
Displays the master image and tool window. If a search 
range is set, a tool window which indicates the range 
(light blue) will be displayed.

(5)	 Tool settings button
Adds, edits, copies, or deletes the tool.

	� “Adding/Editing/Copying/Deleting a Tool” (page 4-36)
(6)	 Tool list

Displays a list of tools set in the program and a 
threshold for each tool.

(7)	 [Back] button
Returns to the master registration screen.

	� “2. Master Registration” (page 10-8)
(8)	 [Next to STEP4] button

Proceeds to the Output Assignment settings.
	� “4. Output Assignment” (page 10-11)

(9)	 [Quit] button
Finishes the Settings Navigator.

 “Settings Navigator Screen and Operation Flow” 
(page 10-7)
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Settings Navigator (Sensor Settings Simulation)

3. Part Registration
Performs adding/editing/copying/deleting of the tool window 
and position adjustment window. In addition, registers an 
image to judge the part type to perform learning.
 �“3. Part Registration Settings (Setting the Judgment 
Method of the Target of Sorting Mode)” (page 4-121)

In the Settings Navigator for the Simulator, the 
following buttons will not be displayed.

	y [Live Adjustment] button for [Limit Adjustment] 
of the position adjustment window

Main Screen for the Part Registration 
Settings

(11)(10) (12)

(1)

(2)

(8)
(7)

(9)

(3)

(4)

(5)

(6)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 [Image Type] display
 “Image Types of the Settings Navigator” (page 4-5)

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Master Image
Displays the master image, tool window for the learning 
tool, and position adjustment window for the position 
adjustment tool. If a search range is set, a tool window 
which indicates the range (light blue) will be displayed.

(5)	 Tool operation button
Adds, edits, or deletes the learning tool and position 
adjustment tool.

(6)	 Tool selection button
Select the tool to confirm/edit/delete the setting 
conditions of the detection windows.

(7)	 Condition Display
Displays the condition of the learning settings.

Display Status

Learning Tool 
Not Set

The tool window for the learning tool 
is not set.

Not learned The learning for the target to judge 
the part type has not been completed.

Learned The target to judge the part type has 
been learned.

Relearning 
required

Relearning is needed because of a 
setting change.

(8)	 [Part Image Registration] button
Performs the learning for the work to judge the part 
type.

 “Part Image Registration” (page 4-140)
(9)	 [Limit/Outline Adjustment] button

This button adjusts the threshold for detection tools with 
the exception of the position adjustment and high speed 
adjustment tools and adjusts the outline for the outline 
tool.

 “Limit Adjustment” (page 4-145)
 “Adjusting the Outline” (page 4-146)

(10)	[Back] button
Returns to the master registration screen.

	� “2. Master Registration” (page 10-8)
(11)	[Next to STEP4] button

Proceeds to the Output Assignment settings.
	� “4. Output Assignment” (page 10-11)

(12)	[Quit] button
Finishes the Settings Navigator.

 “Settings Navigator Screen and Operation Flow” 
(page 10-7)
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Settings Navigator (Sensor Settings Simulation)

4. Output Assignment
Sets the output items to be assigned to the output line.

 “Cables” (page 2-15)
 “Chapter 11 Controlling with the Input/Output Line” (page 

11-1)

Main screen for the output assignment

(8)(7) (9)

(1)

(2)

(3)

(4)

(6)

(5)

(1)	 Navigation button
Moves steps in the Settings Navigator.

(2)	 [Image Type] display
 “Image Types of the Settings Navigator” (page 4-5)

(3)	 Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(4)	 Master Image
Displays the master image.

(5)	 Output Assignment button
	y [Output Asgmt.] tab
Assigns the output item to each output line.

 “Setting the Output Assignment” (page 4-148)
	y [Extra1] tab, [Extra2] tab  
(can be set only in the standard mode)
Sets the total status conditions, logics, and program 
auto-switching.

 “Total Status Conditions” (page 4-150)
 “Logic Settings” (page 4-151)
 “Program Auto-Switching” (page 4-152)

(6)	 [Enable]/[Disable] setting for the trigger error output
Selects whether to enable/disable the output when a 
trigger error occurs.

 “Error Messages” (page A-9)
(7)	 [Back] button

Returns to the learning settings screen, or tool settings 
screen.

	� “3. Tool Settings” (page 10-9)
	� “3. Part Registration” (page 10-10)

(8)	 [Complete] button
Finishes the Settings Navigator.

 “Settings Navigator Screen and Operation Flow” 
(page 10-7)

(9)	 [Quit] button
Finishes the Settings Navigator.

 “Settings Navigator Screen and Operation Flow” 
(page 10-7)
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Operation Simulation

Operation Simulation

Main Screen of the Operation Simulation

(17)(16) (18)

(1) (2) (4) (5) (6) (7)

(8)
(9)

(10)
(11)

(12)

(13)
(14)

(15)

(3)

(1)	 [Batch Retest] button
Performs batch operation simulation for all images.

(2)	 [Reset] button
Resets the result of batch operation simulation for every 
image. The status result will be [--].

(3)	 Operating button for operation simulation

 (Play)
�Start operation simulation one 
by one in order from the selected 
history image.

 (Stop) Stop the operation simulation being 
reproduced.

 (Back) Shift the history image selection 
one position to the left.

 (Next) Shift the history image selection 
one position to the right.

 (Repeat)

When this button is ON, the 
operation simulation is repeated 
from the first history image after 
the operation simulation for the 
last history image ends. Repeat 
can be switched ON/OFF during 
reproduction.

(Next OK Image)
Transition to the next OK image 
after the selected history image.

(Next NG Image)
Transition to the next NG image 
after the selected history image.

When  (Next OK Image) /  (Next NG 
Image) is executed after the settings for a 
threshold have been changed, the judgment 
result may be changed depending on the 
simulation result.

(4)	 [Add Image] button
Add an image to be used for the operation simulation 
from a batch backup file (*.iv3a), an individual program 
backup file (*.iv3a) or an image capture file (*.iv3p).

	y The image is added to the left (latest 
position) of the thumbnail image. You 
cannot add it at a user-defined position.
	yWhen the number of images reaches 100, 
the image will be deleted from the oldest 
one.

(5)	 [Delete All] button
Deletes all registered image.

(6)	 Number of OKs/NGs
Displays the number of images for which the judgment 
result from the operation simulation is OK or NG.

(7)	 Image number
Display the image No. of the images in the Simulator 
as “(Currently selected image No.)/(Total number of 
images)”.

(8)	 Thumbnail image (image history)
The image used as the target for operation simulation.
Displays the number of triggers, the status result of the 
operation simulation, and the thumbnail image.

	y For details about the number of triggers, refer to 
 “Statistical Information Display” (page 5-9).

	yUnnecessary images can be deleted ((5) 
[Delete All] button) and necessary images can 
be added from a different file ((4) [Add Image] 
button).
	y In the initial status, the newest image is at the 
left edge. The history becomes older from left 
to right.

(9)	 Image being selected (Orange frame)
Indicates the image currently selected.
Operation Simulation is performed automatically for the 
selected image and the judgment result is displayed.

(10)	Status result
Displays the judgment result for operation simulation for 
the selected thumbnail image.

(11)	Image tool bar
 “Operation of the Image Tool Bar” (page 3-13)

(12)	Magnified display screen
Magnifies the selected thumbnail image.
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Operation Simulation

(13)	[Add. Learning this Image] button (learning tool 
only)

 “Additional Learning from the Running Image 
History” (page 6-6)

(14)	Status gauge
Displays the status results of the tool window set in the 
program.
In standard mode
Displays the tool name, status results (OK/NG), a line 
indicating the threshold, and a value of the matching 
rate.

	y Judge is OK

	y Judge is NG

Tool Name

Limit

Matching rate and  
status result

In sorting mode
The tool name, status results, and the matching rate 
value will be displayed except for position adjustment 
tools. As a status result, the name of the part 
type (master) will be displayed when the part type 
discrimination is OK, whereas NG will be displayed 
when the part type discrimination is NG.
For position adjustment tools, it is the same as that of 
standard mode.

	y Part type discrimination OK

	y Part type discrimination NG

Tool Name
Status result and  

matching rate

For details about the status results, refer to  “Displaying 
and outputting the status result” (page A-4).

	y Both maximum and minimum values of 
the distances between all the pitches are 
displayed in the status gauge of the Pitch 
tool. Among all of the distances between 
pitches, the one which deviates the most from 
the average value is displayed to show the 
matching rate.
	y Threshold is not displayed for the High-Speed 
Position Adjustment tool.
	y If the scaling function is used with the Width/
Diameter/Pitch tool, the scaling unit is 
displayed.
	y Threshold is not displayed in the status gauge 
of OCR tool. When the characters/date is 
completely matching, the matching rate is 
indicated with 100. If either the text or date 
does not match, 0 is displayed.
	y If [Shade Contrast] of the OCR tool is set to 
[Enable], threshold is displayed. The value of 
the matching rate is associated with the shade 
contrast of the character/date.

(15)	Tool information
Displays the tool name of the selected tool.

(a)

(b)
(c)

(d)

(e)
(f)

(a)	Tool information
Displays the tool name of the selected tool.

(b)	Histogram
Displays the result of the operation simulation for the 
selected tool as a histogram (frequency distribution).
With the threshold being a border, the range for OK 
is displayed in green and for NG is displayed in red.

	yHorizontal axis	� Displays the distribution of the 
matching rate. The display of 
the range is fixed. It cannot be 
specified arbitrarily.

	yVertical axis	�Adjusts automatically according to the 
maximum value of the frequency. It 
cannot be specified arbitrarily.

Pitch tool displays the histogram (frequency 
distribution) of the selected pitches.

(c)	Judgment Record
Displays the number of images for OK or NG.

	yOK...............�Displays the number of images for 
“OK”.

	yNG...............�Displays the number of images for 
“NG”.

(d)	Matching rate information
	yMAX.............�Displays the maximum value of the 

matching rate.
	yMIN..............�Displays the minimum value of the 

matching rate.
	yAVE.............�Displays the average value of the 

matching rate.

AVE is not displayed in Edge tool and High-
Speed Position Adjustment tool.

(e)	Matching rate of the latest judgment process
Displays the matching rate of the latest judgment 
process.
The status result changes according to the setting of 
the threshold value.

(f)	 Limit
Displays the threshold of the selected tool. The 
threshold value can be changed by dragging the 
slider.

Threshold is not displayed in High-Speed 
Position Adjustment tool.

(16)	[Learning History] button (Learning tool only)
 “Additional Learning from the Learned Image 

History” (page 6-10)
(17)	Number of learned images (Learning tool only)

Displays the number of learned images and number of 
not reflected images.

(18)	[Close] button
The system returns to the main screen for the Simulator.
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Operation Simulation

Starting the operation simulation

1	Display the main screen for the Simulator.
 “Starting the Simulator” (page 10-4)

2	Press [Operation Simulation].

The message dialog opens.

3	Press [OK].
The Operation Simulation screen opens.

4	Perform the Operation Simulation by pressing 
[Batch Retest].

For operations of the operation simulation, refer to  
“Main Screen of the Operation Simulation” (page 10-12).

Please perform “Batch Retest” when the 
setting for “Color Extraction”/”Brightness 
Extraction” or the setting of the threshold 
has been changed.

	y If this is not done, pay attention to the 
following items.
	y The frequency distribution of the histogram 
is not displayed correctly (when the setting 
has been changed, the matching rate may 
change after retesting).
	y The “Number of OKs/NGs” and the 
“Judgment record” are not updated.

5	After the Operation Simulation is completed, 
press [Close] at the lower right on the screen.
The system returns to the main screen for the Simulator.

The test results will not be saved. If checking the 
test results again, perform Operation Simulation 
(Batch Retest) with the same settings and the 
same image history.
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Operating from the Menu Bar

Operating from the Menu Bar

[File] Menu

Open file
Open the batch backup file (*.iv3a) or the individual 
program backup file (*.iv3a) saved in the PC.

1	Select [File] → [Open file] from the menu bar.
The [Open] screen opens.

2	Select a file and press [Open].

Files with the formats other than the iv3a 
format cannot be used.

The main screen for the Simulator opens.

Save
Save the contents set in the Simulator to a PC as a batch 
backup file (*.iv3a) or an individual program backup file 
(*.iv3a).

1	Select [File] → [Save] from the menu bar.
Press [Batch Backup] or [Individ. Program Backup] on 
the saving method selection screen.

The batch backup screen or individual program backup 
screen opens.

2	Perform the backup.
In the case of the batch backup
Press [Go].

In the case of the individual program backup
Select the target program and press [Go].

The save as screen opens.

3	Press [Save].

Change the save destination of the file and file 
name as needed.

The save completion message opens.

4	Press [OK].
The system returns to the main screen for the Simulator.
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Operating from the Menu Bar

Export

	� Save Program Settings List
Outputs the sensor information held in the IV2-Simulator as 
tab-delimited text.
 “Save Program Settings List” (page 7-27)

Terminate IV3-Simulator
Terminates the Simulator and returns to the Activation Menu 
screen.

 “Exiting the Simulator” (page 10-5)

Exit
Exits the IV3-Navigator.

1	Select [File] → [Exit] from the menu bar.
When the program setting or image history has been 
changed, the confirmation dialog to save opens.

2	Press [Yes].
The changed contents are saved in the batch backup 
file (*.iv3a) or the individual program backup file (*.iv3a), 
and the IV3-Navigator is closed.

[View] Menu

Operation Simulation Startup Message
Switches whether to show/hide the message when pressing 
[Operation Simulation].
Select [View] → [Operation Simulation Startup Message] 
from the menu bar, and then select [Show]/[Hide].

[Image] Menu

Zoom

	� Reduce (Zoom Out)
Reduces the image displayed on the Simulator.
 “Reduce (Zoom Out)” (page 7-29)

	� Enlarge (Zoom In)
Enlarges the image displayed on the Simulator.
 “Enlarge (Zoom In)” (page 7-29)

	� Fit Window
Displays the image displayed on the Simulator by fitting 
it to the screen size.
 “Fit Window” (page 7-29)

Display Tools
Switches the display method for the tools.
 “Display Tools” (page 7-29)

Capture

	� Save Image
Saves the bmp format file of the image displayed in the 
Simulator and the iv3p format file which can be used for 
a master image registration or additional learning at the 
same time.
A screen capture of the IV3-Navigator screen will also 
be saved at the same time.
Select [Image] → [Capture] → [Save Image] from the 
menu bar.

	� Show saved image file location
Opens the save destination folder for the captured 
image.
Select [Image] → [Capture] → [Show saved image file 
location] from the menu bar.

	� Change saved image file location
Opens the reference screen for the folder and changes 
the save destination for the captured image.
 “Change saved image file location” (page 7-30)

[Setting] Menu

Language
Switches the display language of the IV3-Navigator.
 “Language” (page 7-30)

The displayed language can be switched on the 
Activation Menu screen of the IV3-Navigator 
(Page 3-2).
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Operating from the Menu Bar

[Window] Menu

Program Details
Display the [Program Details] screen.
Select [Window] → [Program Details] from the menu bar.
 “Displaying the [Program Details] screen” (page 7-8)

Running Image History
Display the [Run/Learned Img. History] screen.
Select [Window] → [Running Image History] from the menu 
bar.
 “Confirming the Images Whose Judgment are NG 

(Running Image History)” (page 5-17)
 “Displaying the [Learned image history] screen” (page 

6-7)

The following buttons and menus will not be 
displayed in the running image history screen of the 
Simulator.

	y [Refresh] button
	y [Recomm image to learn] button
	y [Batch Backup (*.iv3a)] menu

I/O Settings
Displays the [I/O Settings] screen.
Select [Window] → [I/O Settings] from the menu bar.

 “Setting the Input and Output Information of the Sensor” 
(page 7-13)

The [I/O Monitor] tab is not displayed on the I/O 
Settings screen with Simulator. The [Polarity] cannot 
be changed and can only be confirmed.

Sensor Advanced
Displays the sensor advanced settings screen.
Select [Window] → [Sensor Advanced] from the menu bar.

 “Setting the Advanced Information of the Sensor” 
(page 7-19)

The following limitations apply for the [Sensor 
Advanced] screen when using the Simulator.

	y The following tabs will not be displayed.
	y Backup/Data Transfer
	y Initialize/Update
	y SD Card

	y The setting contents of the sensor saved in the 
batch backup file (*.iv3a) or the individual program 
backup file (*.iv3a) can be checked.
	y The following settings can be changed.

	yDevice Name
	y Security
	y Image/Result Output
	yUtilitiy

[Help] Menu

About
Displays the version information of the IV3-Navigator.
 “About” (page 7-31)
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Operating from the Menu Bar

MEMO
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Controlling with the 

This chapter explains how the input / output terminal controls 
each operation.

Controlling Timing of Judgment with Triggers................11-2
Importing the Status Output (When Program Auto-
Switching is “Disable”)......................................................11-5
Importing the Status Output (When Program Auto-
Switching is “Enable”).......................................................11-8
Changing Over..................................................................11-10
Registering the Master Image......................................... 11-11
Clearing Errors.................................................................11-13
Behavior When the Sensor Power is Turned On or Off....11-14
Input Response Time.......................................................11-16
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Controlling Timing of Judgment with Triggers

For details about triggers, refer to  “Setting the Trigger Options” (page 4-10).

External Trigger
When the [Trigger Options] is set to [External Trigger], imaging and judgment are performed when inputting the external trigger.
To import the acceptance timing of the external trigger and status output, use the BUSY output.

(1)

(2)

(3)

Min 1.2 ms
Min
100 µs

Processing time

Trigger delay
Min 0.2 ms

External trigger input

BUSY output

Captured image/image 
processing (internal)

Trigger error output

Total status output
Status output of each tool/part

Position adjustment output
Output of each logic

Trigger 1

Max 3 ms

Previous result Result from Trigger 1 Result from Trigger 2 Result from Trigger 4

Max 3 ms

ON

OFF

ON

OFF

ON

OFF

ON

OFF

(4)

(5)

Trigger 2 Trigger 3 Trigger 4

(1)	� Position the target and input external trigger. The shortest input time for the input to be recognized as ON is 100 us. The shortest 
possible interval between trigger inputs (where input is OFF) is 1.2 ms.

(2)	 �BUSY output turns ON. Processing time differs depending on the settings.
(3)	� After the trigger delay time (Page 4-11) elapses, the target is imaged and the judgment process is performed.
(4)	� After the judgment process is completed, the status output updates and the BUSY output is turned OFF. If [Until Data Transfer is 

Complete] is set for “BUSY Output Configuration” (page 7-16), the BUSY output is turned OFF after data is transferred to the SD 
card. Confirm that the BUSY output is turned OFF, then import the status output.

(5)	� If the external trigger is input while BUSY is being output, the input is ignored and a trigger error occurs. Trigger 3 is not judged. To 
output the trigger error, set Trigger Error in the Output Assignment (Page 4-147) under the Settings Navigator to [Enable].

	yUse external trigger input and BUSY output to control the timing.
	y The ON status of each output is as follows.
When Output Settings (Page 7-15) are [N.O.]: �Status with output ON.
When Output Settings (Page 7-15) are [N.C.]: �Status with output OFF.

	y The ON status of each input indicates the input line is shorted when the Polarity (Page 7-17) is NPN, and indicates that voltage is 
applied within the input line when the Polarity is PNP.
	y The edge used for activating or deactivating timing can be set in the external trigger input settings. 

 “Input Settings” (page 7-13)
	y The trigger error output turns OFF when the next trigger is activated, when the error is cleared, when the program is switched, or when 
the system moves to the settings screen.
	yWhen the output mode of Output Settings (Page 7-16) is set to [Latching]. For [One-Shot], refer to  “Changing the timing of status 
outputs” (page 11-7).

Controlling Timing of Judgment with Triggers

11
C

ontrolling w
ith the Input/O

utput Line



11-3IV3 Series User’s Manual (PC Software)

Controlling Timing of Judgment with Triggers

Internal Trigger
When the [Trigger Options] is set to [Internal  Trigger], imaging and judgment are performed at the timing of the set trigger interval.
To import the status output, use the BUSY output.

Controlling timing using BUSY output

(6)

(4)

(1)

(2)

(3)

(5) (6)

Max (trigger interval) + 2 ms

Trigger Interval Trigger Interval Trigger Interval Trigger Interval Trigger Interval

Processing 
time

BUSY output

Internal trigger

Trigger error output

Internal Trigger Control 
with IN1 Input

Captured image/image 
processing (internal)

Total status output
Status output of each tool/part
Position adjustment output

Output of each logic

Trigger 1

Result from Trigger 1 Result from Trigger 2Previous result Result from Trigger 4 Result from Trigger 5

Min 0.2 ms

Max 2 ms

ON

OFF

ON

OFF

ON

OFF

ON

OFF

Trigger 2 Trigger 3 Trigger 4 Trigger 6Trigger 5

(1)	� Inputs internal trigger at the trigger interval set.
(2)	 �BUSY output turns ON when the internal trigger occurs. Processing time differs depending on the settings.
(3)	� The target is imaged and judged. No trigger delay settings.
(4)	 �After the judgment process is completed, the status output updates and the BUSY output is turned OFF. If “BUSY Output Configuration” 

(page 7-16) is set to [Until Data Transfer is Complete], BUSY output is turned OFF after data is transferred to the SD card. Confirm 
that the BUSY output is turned OFF, then import the status output.

(5)	� If the internal trigger is input while BUSY is being output, the input is ignored and a trigger error occurs. Trigger 3 is not judged. To 
output the trigger error, set Trigger Error in the Output Assignment (Page 4-147) under the Settings Navigator to [Enable].

(6)	� If [Internal Trigger Control with IN1 Input] is set to [Enable] (dotted line), the internal trigger stops when IN1 input is OFF. BUSY output 
does not turn ON for Trigger 6 (dotted line). Additionally, judgment processing is not performed (dotted line). If it is set to [Disable], 
the internal trigger is always on.

	y The ON status of each output is as follows.
When Output Settings (Page 7-15) are [N.O.]: �Status with output ON.
When Output Settings (Page 7-15) are [N.C.]: �Status with output OFF.

	y The trigger error output turns OFF when the next trigger is activated, when the error is cleared, when the program is switched, or when 
the system moves to the settings screen.
	yWhen the output mode of Output Settings (Page 7-16) is set to [Latching]. For [One-Shot], refer to  “Changing the timing of status 
outputs” (page 11-7).
	yWhen [Internal Trigger Control with IN1 Input Input] is set to [Enable], the minimum input ON time is 1 ms and the minimum input OFF 
time is 1.2 ms.
The actual interval from IN1 input to an internal trigger output is within “set trigger interval + 2ms”.

Set the trigger interval longer than the processing time. If the trigger interval is shorter than the processing time, the 
internal trigger will be input during the processing time, so the trigger error will occur.
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Controlling Timing of Judgment with Triggers

Operating in the shortest cycle
To input the internal trigger in the shortest cycle and perform the judgment process, set the trigger interval to 1 ms.
Set the Trigger Error in the Output Assignment (Page 4-147) in Settings Navigator to [Disable] and disregard the trigger error.
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Importing the Status Output (When Program Auto-Switching is “Disable”)

Importing the Status Output (When Program Auto-
Switching is “Disable”)
Imports the status output assigned to output lines of the I/O terminal block and power I/O cable. For details about assigning 
to output lines, refer to  “4. Output Assignment (Setting Details of Outputting to Output Line)” (page 4-147).
To use program auto-switching, refer to  “Importing the Status Output (When Program Auto-Switching is “Enable”)” (page 
11-8).

Importing the total status OK/total status NG output (standard mode only)
Total status results of multiple detection tools and the position adjustment for the examined target can be checked.
The operation is as follows.

Min 0.2 ms

Processing time

Assign the BUSY output
ON

OFF

External trigger/Internal trigger

Total status OK/total status NG is assigned
ON

OFF

If reset status output is set to [Enable]:
Clear error input is assigned

ON
OFF

Trigger

OUT2

OUT1

IN2

	y This is an example operation when the output mode of Output Settings (Page 7-16) is set to [Latching]. For [One-Shot], refer to 
 “Changing the timing of status outputs” (page 11-7).

	y The total status output turns ON when the total status results were OK. The total status NG output turns ON when the total status results 
were NG.

The total status conditions can be selected from [All Tools OK], [Any Tool OK] and [Logic 1] to [Logic 4].
	y [All Tools OK]
When all of the status results of the detection tools and the adjustment result of the position adjustment result were OK, 
the total status result is OK.
	y [Any Tool OK]
When any of the status results of the detection tools except that of the position adjustment was OK, the total status result 
is OK.
	y Logic
When the logical operation result of the set detection tools was OK, the total status result is OK.

	y The status result will be kept until the next status result output. However, the output function turns OFF when the program number is 
switched or an external master image is registered.
	y The ON status of each output is as follows.
When Output Settings (Page 7-15) are [N.O.]: �Status with output ON.
When Output Settings (Page 7-15) are [N.C.]: �Status with output OFF.

	yWhen [Reset Status Output on Clear Error Execution] is set to [Enable], the status output can be reset with the clear error input.
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Importing the Status Output (When Program Auto-Switching is “Disable”)

Importing the individual status output of each detection tool/part type/logic
The individual status result of the detection tool/part type and position adjustment for the examined target can be checked.
The operation is as follows.

Min 0.2 ms

Processing time

Assign the BUSY output
ON

OFF

External trigger/Internal trigger

Logic 1 is assigned
ON

OFF

Tool 2 is assigned
ON

OFF

Tool 1 is assigned
ON

OFF

If reset status output is set to [Enable]:
Clear error input is assigned

ON
OFF

Trigger

OUT1

OUT4

OUT3

OUT2

IN2

Previous result

Previous result

Previous result

Status result of Tool 1

Status result of Tool 2

Status result of Logic 1

	y This is an example operation when the output mode of Output Settings (Page 7-15) is set to [Latching]. For [One-Shot], refer to 
 “Changing the timing of status outputs” (page 11-7).

	y This is an example when the status results of Tool 1, Tool 2, and Logic 1 are to be checked individually in standard mode.
	y In the Sorting Mode, Part0 to Part7 will be assigned. The logic cannot be set.
	y The status output turns ON when the status result of each tool/logic or part type was OK. Turns OFF when the result was NG or --.
	y The ON status of each output is as follows.
When Output Settings (Page 7-15) are [N.O.]: �Status with output ON.
When Output Settings (Page 7-15) are [N.C.]: �Status with output OFF.

	y The status result will be kept until the next status result output. However, the output function turns OFF when the program number is 
switched or an external master image is registered.
	yWhen [Reset Status Output on Clear Error Execution] is set to [Enable], the status output can be reset with the clear error input.
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Importing the Status Output (When Program Auto-Switching is “Disable”)

Changing the timing of status outputs
The timing of status outputs can be selected from [Latching] which links to judgment and [One-Shot] which outputs for a 
certain time. For details of how to configure the settings, refer to  “Output Settings” (page 7-15).

Min 0.2 ms

Delay time  
+ Max 1.5 ms

Delay time  
+ Max 1.5 msOne-Shot ON Time One-Shot ON Time

Status output
(One-Shot output)

Status output
(Latching output)

BUSY output

External trigger/Internal trigger Trigger 1 Trigger 2

Previous status result Status result of Trigger 1 Status result of Trigger 2

Status result of Trigger 2Status result of Trigger 1
ON

OFF

ON

OFF

ON

OFF

	y In case of [Latching], updates the output by linking with judgment.
	y In case of [One-Shot], outputs for a set amount of time after the set delay time is passed.
	yWhen the program number is switched or the external master image is registered, the status output turns OFF.

Canceling One-Shot output
To use the One-Shot output function, the following condition needs to be met.

Trigger input interval (trigger interval) > Maximum value of processing time > One-Shot ON Time
If the above condition is not met, the One-Shot output that follows the current One-Shot output is canceled and will not be 
output.

Delay time  
+ Max 1.5 ms

Delay time  
+ Max 1.5 ms

Trigger input interval

Delay time  
+ Max 1.5 ms

One-Shot ON Time

One-Shot ON Time

One-Shot ON Time

External trigger/Internal trigger Trigger 1 Trigger 2

Status result of Trigger 2 (internal)

Status result of Trigger 1 (internal)

Status result of Trigger 1Judgment process
ON

OFF

Internal process of Trigger 2
ON

OFF

Internal process of Trigger 1
ON

OFF

BUSY output
ON

OFF

(1)

(2)

(3)

(1)	� This is an example of what happens when the trigger input interval is shorter than the One-Shot ON Time.
(2)	� Since the previous One-Shot output has been completed, the status result of Trigger 1 can be output as a One-Shot normally.
(3)	� Since the previous One-Shot output has not been completed,  the status result of Trigger 2 cannot be output as a One-Shot and will be 

canceled.
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Importing the Status Output (When Program Auto-Switching is “Enable”)

Importing the Status Output (When Program Auto-
Switching is “Enable”)
Program auto-switching is a function to change automatically to a pre-set program number according to the status result.
If multiple programs are used to perform a single examination, examinations can be performed continuously without 
controlling the program switching with a PLC etc. For details, refer to  “Using Program Auto-Switching” (page 7-11).

The operation in the setup example of “Using Program Auto-Switching” (page 7-11) is as follows.

When all judgments are OK
(1) External trigger input External trigger inputInternal trigger Internal trigger

(2)

(4)
(3) (3)

P000 P001 P002 P000

Internal processing

External trigger

Program number

BUSY output

Total Status OK Output (OUT1)
ON

OFF

ON

OFF

ON

OFF

When the judgment in the program 001 is NG
(1) External trigger input Internal trigger External trigger input

(3)

(2)

(4)

P000 P001 P000

Internal processing

External trigger

Program number

BUSY output

Total Status OK Output (OUT1)
ON

OFF

Total Status NG Output (OUT4)
ON

OFF

ON

OFF

ON

OFF

(1) �When the start point program is set as an external trigger and the other programs as internal triggers, the programs 
other than the start point program will be processed for judgment. Thereafter, the programs will be automatically 
switched to each switching destination according to the judgment.

(2) �The status output turns OFF before the BUSY output turns OFF. To acquire the total status result, obtain the rising of 
the total status OK and NG outputs.

(3) �The external output of status results is set by “Output Assignment” for each program. At this point, select “Do not 
output” for OUT1 of P000 and P001. For OUT1 of P002, select “Total Status OK”. For OUT4 of P000 to P002, select “Total 
Status NG”.

(4) �Status output time = Program switching time + Delay time 
The time from the determination of judgment to the execution of the program auto-switching can be changed by the 
delay settings.  
If extending the status output ON time and checking the status result on the screen or others, set the required delay 
time. 

 “Program Auto-Switching” (page 4-152)
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Importing the Status Output (When Program Auto-Switching is “Enable”)

<Reference ladder program>
KEYENCE KV Series

Line 1

REQ Trigger request

Total Status OK OK status outputDM2000

INC SHOT

DM2100

INC SHOT

Total Status NG NG status output

Line 2

Line 3

	z Line 1
Turn on REQ, and executes the trigger request.

	z Line 2/Line 3
Acquire the status result at rising of the total status OK or total status NG. When program auto-switching is “Enable”, 
the ON time of the total status output and total status NG output will be shorter. Therefore, ON time is adjusted using 
the one-shot circuit in the above reference ladder program. There is also a method to retain the output with a self-
holding circuit. Create a ladder program according to the necessary controlling method.
Additionally, the reference ladder above uses an increment instruction to count the number of OKs and NGs. Use it as 
needed.
In the reference ladder program above, the number of times OK and NG are recorded in DM2000 and DM2100.

	y The reference ladder program assumes that the trigger option of the start point program is "External Trigger", and the 
trigger options of other programs are "Internal Trigger".
	y The BUSY output cannot be used for importing the status output.
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Changing Over

Changing Over

The program set in the sensor can easily by changed by referencing the previously-saved judgment condition (program) with 
the input lines. For details about program functions, refer to  “Changeover for a Target (Program Functions)” (page 7-2).

(1) (5) (6) (7) (8)

(2)

(4)

(3)

Trigger error Program switch error

Program switch 
failed

T2

Min 10 ms

Min 0 ms

P000

P000 P001 P002 P000

P001

Switching time 
(T1) Switching time

Stopping operation Setting

P002 P099

Error output

BUSY output

Program bit0 to bit6 input

Program number

Trigger 1 Trigger 2 Trigger 3

Error 
occurred

Error 
canceled

Previous result Result from Trigger 1

RUN output
ON

OFF

ON

OFF

Total status output
Status output of each tool/part

Position adjustment output
Output of each logic

ON

OFF

ON

OFF

ON

OFF

(1)	� Switch the current program by inputting Program bit0 to bit6 and keeping the line active. Minimum input time is 10 ms.
 “When Setting the [Program Switching Method] to [External Input].” (page 7-6)

(2)	 �BUSY output turns ON while switching the programs. Switching time differs depending on the settings.
(3)	� The output status (Latching output and One-Shot output) turns OFF before the switching program is completed.
(4)	� If the program number is switched during a judgment process, the system cancels the judgment process (result of Trigger 2 is not 

output). The program switching process is delayed because the judgment must be canceled. Delay time depends on the settings.
(5)	� If a trigger occurs while switching programs (during the BUSY output), the trigger is ignored and a trigger error occurs. To output 

the trigger error, set Trigger Error in the Output Assignment (Page 4-147) under the Settings Navigator to [Enable]. In the case of a 
manual trigger, the trigger is processed after the program switching process has completed.

	y For details about T1 and T2, refer to  “Input Response Time” (page 11-16).
	yUse this function during operation. Programs cannot be switched with the external input during setup.
	y The trigger error output turns OFF when the next trigger is activated, when the error is cleared, when the program is switched, or when 
the system moves to the settings screen.
	y If the switched program is set to [Internal Trigger], the time for inputting the trigger after switching the program fluctuates. A delay of one 
trigger interval may occur.
	yDo not use with the external master registration input at the same time. The sequence for switching programs and the external master 
registration process will vary.
	y The response of the image displayed on the IV3-Navigator might be delayed until after switching programs (BUSY output OFF).

Program switch error
If using the program expansion function for the SD card (Page 8-11), a program switch error occurs when the advanced program 
information cannot be read from the SD card.
(6)	� For example, bit0 to bit6 input changes and switches to P099 when the SD card is removed.
(7)	 �A program switch error occurs. BUSY output turns OFF and error output turns ON.
	� Run output turns OFF and operation stops. The previous program number will be retained but the device cannot run. Clear error input 

is disabled. The PWR/ERR indicator light on the sensor amplifier turns ON (red). The sensor head operation indicator light blinks (red).
(8)	� Connecting the control panel or IV3-Navigator (IV3-H1) and clearing the error messages cancels the errors and the device changes 

to the settings screen. Error output turns off. The program number changes to “P000”.

For details about how to clear the program switch error, refer to  “How to clear a program switching error” (page 7-5).
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Registering the Master Image

The external master registration function can register the master image with using the input line.
For details, refer to  “2. Master Image Registration (Registering an Image as a Reference)” (page 4-20).

Judgment process (internal)

BUSY output

External master registration 
input

Total status output
Status output of each tool/part

Position adjustment output
Output of each logic

Master image (internal)

Error output

External trigger/Internal 
trigger

Previous result Result from Trigger 1 Result from Trigger 2

Previous master image

In case of failure

Image of Trigger 1

Image of Trigger 1

Master image registration time 
(T3)

(Min 2 ms) Min 2 ms

T4

(7)

(2)

(1)

(3)

(6)

(5)

(4)

ON
OFF

ON
OFF

ON
OFF

ON
OFF

ON
OFF

ON
OFF

Trigger 1 Trigger 2

(1)	� Takes an image to be registered as a master image by the external trigger or internal trigger.
(2)	� If the BUSY output is OFF, the external master registration input will be input. Minimum ON/OFF input time is 2 ms.
(3)	� The BUSY output turns ON and master registration starts. The master registration time depends on the settings.
(4)	� The status output (Latching output and One-Shot output) turns OFF before master image registration is completed.
(5)	� The image imaged in Trigger 1 will be registered as a master image.
(6)	� If the external master image registration fails, the error output turns ON. Check that the external master image registration succeeds 

with the error output. In case of failure, the image will not be updated from the previous master image. The error output turns OFF 
when the external master image registration succeeds or by the clear error input.

(7)	 �After master image registration is completed, the judgment process is performed with the new master image. Trigger 2 judges the 
target using the image of Trigger 1 as a master image.

	y For details about T3 and T4, refer to  “Input Response Time” (page 11-16).
	yUse this function during operation. External master image registration cannot be performed during setup.
	y If a trigger occurs while registering the master image (during BUSY output), the trigger is ignored and a trigger error occurs. The trigger 
error output turns OFF when the next trigger is activated, when the program is switched, or when the error is cleared. To output the 
trigger error, set Trigger Error in the Output Assignment (Page 4-147) under the Settings Navigator to [Enable].
	y If the external master registration input is input during the imaging process (BUSY) by the trigger, the system cancels the judgment 
process (taken image will not be registered). After the process is canceled, the image taken before cancellation is registered as a 
master image. The master image registration process is delayed by the cancelling process. Delay time depends on the settings.
	yDo not change over the programs at the same time that the external master registration input is being performed. The sequence of the 
external master registration and program switching process will vary.
	yWhen the learning tool or sorting mode is set, this cannot be used.
	yRegistered as master image 0 when master image settings are set to [Enable]. Images cannot be registered as master images 1 to 7.

Registering the Master Image
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Registering the Master Image

	z Saving a program (P000 to P031) on the internal sensor ROM

	y If the external master image registration is to be performed frequently, set [Write to ROM when using Ext. 
Master Save] of the input option to [Disable] to protect the nonvolatile memory of the internal sensor. For 
details of how to configure the settings, refer to  “Input Settings” (page 7-13).

ROM writing settings
Master image is registered externally when power 

is turned OFF

Number of times that external 
master image registration can 

perform (duration)

Enable
The master image is not deleted.
The image can be used as a master image after 
starting up the device next time.

100,000 times

Disable
The master image is deleted.
External master image registration needs to be 
performed after starting up the device.

No limit

	y If the setting for writing to ROM is set to [Disable], only the master images of active programs selected in the 
settings mode is written to ROM. 
An image for external master registration will not be reflected to the backup file (iv3a) of the batch backup/
individual program backup performed while running.
	y If the setting is set to [Enable], do not turn OFF the power during the master registration time (T3). Otherwise, 
all or part of the setting data may be lost.

	z Saving a program (P032 to P127) on an SD card

The operation will be the same as the one when [Write to ROM when using Ext. Master Save] is set to [Disable] 
for the programs saved in the ROM in the sensor, regardless of the settings of [Write to ROM when using Ext. 
Master Save].
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Clearing Errors

Clearing Errors

If an error occurs, the error that is output can be turned OFF using the clear error input.

Clear error input
ON

OFF

Error output
ON

OFF

SD card error output
ON

OFF

If reset status output is set to 
[Enable], status is output

ON

OFF

Error occurred

Min 2 ms(Min 2 ms)

T5

Access error

Previous result

If SD card transfer error is 
on

T5 T5
(1)

(2)

(3)

(4) (5)

SD card access 
error occurs

SD card transfer failed/  
transfer buffer insufficient

(1)	 If an error occurred, the error output turns ON.
(2)	� The error output can be turned OFF by the clear error input. Minimum ON/OFF input time is 2 ms.
(3)	 When [Reset Status Output on Clear Error Execution] is set to [Enable], the status output is reset.
(4)	 SD card access errors can be output to error output and SD card error output.
(5)	� If [SD card transfer error] for the SD card data transfer function is set to [Enable], errors can be output to error output and SD card 

error output.

	y For details about T5, refer to  “Input Response Time” (page 11-16).

Error types that can be output

Error type
Error output  

ON/OFF
Clear error input Ref.

System error
Enable Cannot be cleared  “Error Messages” (page A-9)

Startup memory readout error

Running program switch error Enable Cannot be cleared  “Changeover for a Target (Program Functions)” 
(page 7-2)

 “Changing Over” (page 11-10)
 “Transferring Program Settings” (page 8-11)Program switch error at startup Disable -

External master registration error
Enable Can be cleared

 “Registering the Master Image” (page 11-11)

SD card access error

Trigger error
OFF (default)/  

ON Can be cleared

 “4. Output Assignment (Setting Details of Outputting 
to Output Line)” (page 4-147)

 “Controlling Timing of Judgment with Triggers” 
(page 11-2)

FTP error  “FTP Error” (page 9-4)

SD card transfer error  “SD card transfer error” (page 8-14)
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Behavior When the Sensor Power is Turned On or Off

Behavior When the Sensor Power is Turned On or 
Off
The device behavior when the power is turned on or off is as follows. Check activation of the BUSY output when starting 
operation.

Power (DC24V)
ON

OFF

BUSY output
ON

OFF

Error output
ON

OFF

RUN output
ON

OFF

Stop saving the SD card 
input

ON

OFF

Total status output
Status output of each tool/part
Position adjustment output

Output of each logic

ON

OFF

Program number

Trigger

Determine  
the I/O settings

Turning on the 
power

Power turns 
off

Trigger

Min 0 ms

Min 2 ms

Initializing
2 seconds or longer Running RunningRunning

System 
errorSetting

BUSY
20 ms or longer

(1)

(3)

(2)

(5)

(6)

(7)

(4)

(1)	�� After the power is turned ON, the I/O Settings (NPN or PNP and N.O. or N.C.) will be determined.
 “Operation for Initial Startup of the Sensor” (page 3-8)
 “Polarity” (page 7-17)
 “Output Settings” (page 7-15)

(2)	 �The program number will be determined. If [Program Switching Method] (Page 7-14) is set to [External Input], the program number is 
determined according to the condition of the input lines.

(3)	� BUSY output turns ON.
	y In case of N.O. output, the output turns from OFF to ON.
	y In case of N.C. output, the output turns from OFF to OFF, so no changes occur.

(4)	� The BUSY output turns OFF and the system starts to operate.
	y In case of N.O. output, the output turns from ON to OFF.
	y In case of N.C. output, the output turns from OFF to ON.

By checking the activation of the BUSY output, operation in N.O./N.C. can be checked.
(5)	� If the startup error has occurred, the error output turns ON during the BUSY status.
(6)	� The RUN output turns ON when the sensor is running with no system error occurring.
(7)	 �To turn the power off when using data transfer to SD card:

	ySet [BUSY Output Configuration] to [Until Data Transfer is Complete].
	y In the case of an external trigger, check that BUSY output from input of [Stop saving the SD card] has turned off and then turn the 
power off.
	y In the case of an internal trigger, after input from [Stop saving the SD card], wait five seconds and then turn the power off.
	yOnce the current image has been transferred, stop transfer to the SD card. Images in the transfer buffer will be lost.
	y [Stop saving the SD card] is only enabled when the device is running.

Do not turn off the system power while the SD card is being accessed. Otherwise, all or part of the setting data 
may be lost or damage may occur to the memory.

	y The ON status of each output is as follows.
When Output Settings (Page 7-15) are [N.O.]: �Status with output ON.
When Output Settings (Page 7-15) are [N.C.]: �Status with output OFF.

	y The RUN output, BUSY output and error output will be output from the output line assigned in output assignment (Page 4-147) for 
program numbers determined after the power is turned ON. If the outputs are not being assigned, it will not be output.
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Behavior When the Sensor Power is Turned On or Off

Program switch error when the power is turned on
Behavior in the case that a program switch error occurs when the power is turned on is as follows.

Power (DC24V)
ON

OFF

BUSY output (N.O.)
ON

OFF

Error output (N.C.)
ON

OFF

Run output/status output 
(N.O.)

ON

OFF

Program number

Turning on the 
power Error occurred

P099 P000

Error canceled

Initializing Stopping operation
Setup mode or 

run mode

(1)

(2) (3)

If using the program expansion function for the SD card (Page 8-11), a program switch error occurs when the advanced program 
information cannot be read from the SD card.
(1)	�� For example, the power is turned on when the SD card is removed and P099 is selected.
(2)	� A program switch error occurs. The output (OUT1 to OUT8) does not operate and is OFF regardless of [N.O.] and [N.C.].
(3)	� You can connect the control panel or IV3-Navigator (IV3-H1) and clear the error message and error output.
	� If [Program Switching Method] is set to [External Input], the system will move to the settings screen. P000 is selected as the program 

number.
	� For [Panel/PC/Network/Auto-Switching], you can select to continue operating the device with P000 or change the system to the 

settings screen when you clear the error message.

	y For details about how to clear the program switch error, refer to  “How to clear a program switching error” (page 7-5).
	y The ON status of each output is as follows.
When Output Settings (Page 7-15) are [N.O.]: �Status with output ON.
When Output Settings (Page 7-15) are [N.C.]: �Status with output OFF.
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Input Response Time

Input Response Time

The following response times are the typical examples (typ.). The response times may differ depending 
on the settings or the image processing condition. Control by confirming “BUSY output” to prevent 
impact from different response times.

Response time for the switch program input
	yWhen not using high-speed program switching

T1 (Switch program time) = A + B + C + E [ms] (typ.)
T2 = 10 [ms] (typ.)

	yWhen using high-speed program switching
T1 (Switch program time) = A + C + 100 [ms] (typ.)
T2 = 10 [ms] (typ.)

Response time for the external master registration input
T3 (Master registration time) = A + B + D + 400 [ms] (typ.)
T4 = 5 [ms] (typ.)

Response time for the error clear input
T5 = 5 [ms] (typ.)

Description for symbols
Symbols Description Time

A Judgment process cancelling time

400 + trigger delay setting time (0 to 10000) [ms] (typ.)
Added when a program switching input or external master registration input is 
input during the judgment process.
The “Trigger delay time” is added only when [External Trigger] (Page 4-10) is 
selected for the trigger type.

B Tool registration time

Standard Mode
Tool registration time = Total of the “Registration time per tool x Number of set 
tools”

Sorting Mode
Tool registration time = (Learning tool registration time x Number of set tools)
  + ((Total of registration time for tools other than the learning tool x Number of 
set tools) x Number of registered part types)

Registration time per tool
	y Learning*1/OCR*2	 50 [ms] (typ.)
	yOutline/Position Adjustment (High Speed)	 330 [ms] (typ.)  
Position Adjustment (High Accuracy)	 450 [ms]
	yColor Area/Area/Color Average/Brightness Average/Color Prohibition/
Brightness Prohibition	 35 [ms] (typ.)
	y Blob count		  40 [ms] (typ.)
	yDiameter		  55 [ms] (typ.)
	y EdgePixels		  20 [ms] (typ.)
	yWidth/Edge/Pitch/Hi-Sp.Adj (1 axis) 2 [ms] (typ.)
	yHi-Sp.Adj (2 axes)	 15 [ms]

*1: Includes sorting mode.
*2: �After the power is turned ON, takes 550 ms (typ.) when moving to the 

program where the OCR has been set for the first time.

C Auto focus position adjustment time
240 [ms] (typ.)
Added only when auto focus-type sensor is used and the [Auto Focus Adj Pos] 
is set to [Individual]. (Page 7-26).

D The [Auto Focus Adj Pos] (Page 
7-24) is set to [Individual].

5000 [ms] (typ.)*3

	y [Write to ROM when using Ext. Master Save] (Page 7-14) is set to [Enable].
	y A program (P000 to P031) saved on the internal sensor ROM is in use.

*3: �When multiple masters are used: 5000 + 500 x (Number of registered 
master images - 1) [ms] (typ.).

E Program reading time

Standard Mode
	yWhen not using the learning tool: 1000 [ms] (typ.)*4

	yWhen using the learning tool: 1400 [ms] (typ.)
Sorting Mode: (700 x Number of part types) + 300 [ms] (typ.)
*4: �When multiple masters are used: 1000 + 500 x (Number of registered 

master images - 1) [ms] (typ.).
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Specifications

This chapter explains the specifications and dimensions of the 
sensor and software.
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Specifications

Ultra-compact model sensor head
Model IV3-G500CA IV3-G500MA IV3-G600CA IV3-G600MA
Type Standard Wide view

Installed distance*1 50 mm or more 50 mm or more

Field of view Installed distance 50 mm: 22 (H) × 16 (V) mm
Installed distance 3000 mm: 1184 (H) × 888 (V) mm

Installed distance 50 mm: 51 (H) × 38 (V) mm
Installed distance 3000 mm: 2730 (H) × 2044 (V) mm

Image sensor 1/2.9 inch  
color CMOS

1/2.9 inch  
monochrome CMOS

1/2.9 inch  
color CMOS

1/2.9 inch  
monochrome CMOS

Pixel 1280 (H) x 960 (V)
Focus adjustment Auto*2

Exposure time 12 µs to 9 ms 12 µs to 9 ms*3 12 µs to 9 ms 12 µs to 9 ms*3

Light
Light source White LED Infrared LED White LED Infrared LED

Lighting 
method

Pulse /continuous lighting 
is switchable. Pulse lighting Pulse /continuous lighting 

is switchable. Pulse lighting

Indicator light 2 (indicate the same status)

Environmental 
resistance

Ambient 
temperature 0 to +50°C (No freezing)*4

Relative 
humidity 35 to 85 % RH (No condensation)

Vibration*5 10 to 55 Hz; double amplitude 1.5 mm; 2 hours in each of the X, Y, and Z directions
Shock 

resistance*5 500 m/s2 6 different directions in 3 times

Enclosure 
rating*6 IP67

Material Body: zinc diecast, front cover: acrylic, indicator cover: TPU

Weight Approx. 75 g (without the AI Lighting unit)
Approx. 225 g (with the AI Lighting unit)

*1  �When using the product in a range of 3 m or more, it is recommended to remove the polarization filter.
*2  �The focus position can be automatically adjusted at the time of installation. Disabled during the operation. The focus position 

can be registered by program.
*3  �When the AI Lighting unit is mounted, the maximum exposure time is 6.25 ms.
*4  �When the temperature exceeds an operating ambient temperature of 40°C, after carrying out the installation stipulated by us, 

take an appropriate heat dissipation measure, and ensure that the case temperature does not exceed the rating of 65°C. 
For the case temperature, measure the surface where “IV3 series” is printed.

*5  �Except for mounting the dome attachment for (IV2-GD05/IV2-GD10).
*6  �Except when the polarizing filter (OP-88642/OP-88643/OP-88646/OP-88647) is mounted.

Ultra-compact model sensor amplifier
Model IV3-G120

Available mode Standard mode / Sorting mode

Tool
Mounted 

tools
Learning, Outline, Color area*1, Area*2, Edge pixel, Color average*1, Brightness average*2, Width, 
Diameter, Edge presence, Pitch, OCR, Color prohibit *1, Brightness prohibit, Position adjustment,  

High-speed position adjustment (1-axis edge/2-axis edge), Blob count
Number of 

tools *3 Total: 65 tools

Switch settings (programs) 128 programs (with SD card) /32 programs (without SD card)

Image 
history*4

Numbers 100 images
Condition Selectable between NG only, NG and OK near threshold*5, and All

Image data 
transfer

Transfer 
Destination SD card, FTP server and SFTP server is selectable

Transfer 
format Selectable between bmp, jpeg, iv3p, and txt, and file names can be modified

Transfer 
Condition Selectable between NG only, NG and OK near threshold*5, and All

Analysis 
information*6

Display 
Switch List by tools (judgment results, matching rate, matching bar display)

Run 
information

OFF/Histogram/Processing time/Count/Output monitor is switchable
Histogram:	� Histogram, matching rate (MAX, MIN, AVE), numbers of OKs, numbers of NGs
Processing time:	�� Processing time (latest value, MAX, MIN, AVE)
Count:		�  Trigger numbers, numbers of OKs, numbers of NGs, numbers of trigger errors
Output monitor:	� ON / OFF status for each output

Specifications
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Specifications

Model IV3-G120

Other 
functions

Imaging 
function Digital zoom (2×, 4×), HDR, High gain, Color filter*1, White balance*1, Brightness correction, AI capture

Tool 
functions

Additional Learning, Remove Outline, Mask function, Color extraction/Color exclusion*1,  
Color histogram function*1, Monochrome histogram function*2, Scaling function

Utilities

List of NG Sensor Occurrences, NG Hold Function, Test run, I/O monitor,  
Security settings (Two levels of passwords), Simulator*7, FTP/SFTP image information addition,  

multiple position adjustments, multiple master images, 
high-speed program switching, program auto-switching, Automatic backup and restoration of settings, 

Change of thresholds while running
Indicator light PWR/ERR, OUT, TRIG, STATUS, LINK/ACT, SD

Input

No-voltage input/voltage input is switchable
For no-voltage input:	� ON voltage 2 V or lower, OFF current 0.1 mA or lower, ON current 2 mA 

(short circuit)
For voltage input:	� Maximum input rating 26.4 V, ON voltage 18 V or higher, OFF current 0.15 

mA or lower, ON current 2 mA (for 24 V)
Inputs 8 inputs (IN1 to IN8)

Function
IN1: External trigger, IN2 to IN8: Enable by assigning the optional functions
Assignable functions:	� Program switching, Clear error, External master image registration, SD 

card save cancel

Output Photo MOS relay output, N.O./N.C. Switchable
Maximum rating 26.4 V 50 mA, remaining voltage 1.5 V or lower*8

Outputs 8 (OUT1 to OUT8)

Function
Enable by assigning the optional functions
Assignable functions:	� Total judgment (OK/NG), RUN, BUSY, Position adjustment result, 

Judgment result of each tool, Logical operation result of each tool, Error, 
SD card error, Part discrimination result, Master status result

Ethernet Standard 1000BASE-T/100BASE-TX
Connector RJ-45 8pin connector

Network function FTP client, SFTP client

Supported 
interface

Built-in 
Ethernet EtherNet/IP™, TCP/IP non-procedure communication

Communication 
unit*9 EtherCAT, CC-Link, DeviceNet, RS-232C, PROFIBUS

Expanded memory SD card (SD/SDHC)*10

Rating
Power voltage DC 24 V ± 10% (including ripple)
Consumption 

current
2.2 A or less (including a communication unit, without the AI Lighting unit, and including the output load)
3.4 A or less (including a communication unit, with the AI Lighting unit, and including the output load)

Environmental 
resistance

Ambient 
temperature 0 to +50°C (No freezing) *11

Relative 
humidity 35 to 85% RH (No condensation)

Material

Main unit case: PC Power connector: PA, POM

I/O terminal block: PA Sensor head connection connector: Zinc + Ni 
plating, PA

Ethernet connector: Copper alloy + Ni plating Radiator plate on rear of the main unit: Aluminum
DIN rail tab on rear of the main unit: POM Nameplate: PC

Weight Approx. 300 g

*1	� Color type only.
*2 	� Monochrome type only.
*3 	� Tools can be installed by programs. The number of tools for the detection tools and position adjustment tools combined. For 

the detection tools, up to 64 tools can be set. The number of detection tools in sorting mode is eight.
*4 	 �Saves to the sensor amplifier’s internal memory. 
	 �The images saved in the sensor amplifier can be backed up to the USB memory connected to the control panel (IV3-CP50) 

or to the PC by the PC software for IV3 Series (IV3-H1).
*5	� Learning tool only.
*6	� Can also be displayed on the control panel (IV3-CP50) or the software for the IV3 Series (IV3-H1).
*7	 �Usable on the software for the IV3 Series (IV3-H1).
*8	� Make sure to keep a total of each output with 160 mA or less.
*9	� When a communication unit (DL Series) is connected.
*10	� Use the KEYENCE recommended product for the SD card.
*11	� When the temperature exceeds an operating ambient temperature of 40°C, after carrying out the installation stipulated 

by us, take an appropriate heat dissipation measure, and ensure that the case temperature does not exceed the rating of 
65°C. 
For the case temperature, measure the metal part at the sensor amplifier rear.
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Specifications

Built-in amplifier type sensor

Model IV3-400CA IV3-400MA IV3-500CA IV3-500MA IV3-600CA IV3-600MA
Type Narrow view Standard Wide view

Installed distance*1 400 mm or more 50 mm or more 50 mm or more

Field of view

Installed distance 400 mm:  
58 (H) × 44 (V) mm  

Installed distance 3000 mm:  
464 (H) × 348 (V) mm

Installed distance 50 mm:  
22 (H) × 16 (V) mm  

Installed distance 3000 mm:  
1184 (H) × 888 (V) mm

Installed distance 50 mm:  
51 (H) × 38 (V) mm  

Installed distance 3000 mm:  
2730 (H) × 2044 (V) mm

Image sensor 1/2.9 inch  
color CMOS

1/2.9 inch  
monochrome 

CMOS

1/2.9 inch  
color CMOS

1/2.9 inch  
monochrome 

CMOS

1/2.9 inch  
color CMOS

1/2.9 inch  
monochrome 

CMOS
Pixel 1280 (H) x 960 (V)

Focus adjustment Auto*2

Exposure time 12 µs to 10 ms

Light

Light source White LED Infrared LED White LED Infrared LED White LED Infrared LED

Lighting 
method

Pulse/
continuous 

lighting
Switchable

Pulse lighting

Pulse/
continuous 

lighting
Switchable

Pulse lighting

Pulse/
continuous 

lighting
Switchable

Pulse lighting

Tool

Available 
mode

Standard mode / Sorting mode

Available 
Tool

Learning, Outline, Color area*3, Area*4, Edge pixel, Color average*3, Brightness average*4, Width, 
Diameter, Edge presence, Pitch, OCR, Color prohibition, Brightness prohibition, Position adjustment,  

High-speed position adjustment (1-axis edge/2-axis edge), Blob count
Number of 

tools *5
Total: 65 tools

Switch settings (programs) 128 programs (with SD card) /32 programs (without SD card)
Image 

history*6
Numbers 100 images
Condition NG only / NG and OK near the threshold*7 / All is selectable

Image data 
transfer

Transfer 
Destination

SD card / FTP server and SFTP server is selectable

Transfer 
format

Selectable between bmp, jpeg, iv3p, and txt, and file names can be modified

Transfer 
Condition

NG only / NG and OK near the threshold*7 / All is selectable

Analysis 
information*8

Display 
Switch

List by tools (judgment results, matching rate, matching bar display)

Run 
information

OFF/Histogram/Processing time/Count/Output monitor is switchable
Histogram	 :	� Histogram, matching rate (MAX, MIN, AVE), numbers of OKs, numbers of NGs
Processing time: �Processing time (latest, Max., Min., Ave.)
Count	:	� Trigger numbers, numbers of OKs, numbers of NGs, numbers of trigger errors
Output monitor	 :	� ON / OFF status for each output

Other 
functions

Imaging 
function

Digital Zoom (x2, x4), HDR, High Gain, Color Filters*3, White balance*3,  
Brightness correction, AI Capture

Tool 
functions

Additional learning, Mask outline, Masking function, Color extraction/exclusion*3,  
Color histogram function*3, Monochrome histogram function*4, Scaling function

Utilities

List of NG Sensor Occurrences, NG Hold Function, Test run, I/O monitor,  
Security settings (Two levels of passwords), Simulator*9, FTP/SFTP image information addition,  

multiple position adjustments, multiple master images, 
high-speed program switching, program auto-switching, Automatic backup and restoration of settings, 

Change of thresholds while running
Indicator light OUT, TRIG, STATUS, LINK/ACT, SD

Input

Switchable between non-voltage input and voltage input
For no-voltage input:	� ON voltage 2 V or lower, OFF current 0.1 mA or lower, ON current 2 mA (short 

circuit)
For voltage input:	� Maximum input rating 30 V, ON voltage 18 V or higher, OFF current 0.15 mA or 

lower, ON current 2 mA (for 24 V)
Inputs 6 ports, 3 ports are selectable as IN/OUT

Function

IN1: External trigger,
IN2, IN3, I/O1 to I/O3:	 Enable by assigning optional functions
Assignable functions:	� Program switching, Clear error, External master image registration, Stop saving 

for SD card
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Specifications

Model IV3-400CA IV3-400MA IV3-500CA IV3-500MA IV3-600CA IV3-600MA

Output Photo MOS relay output, N.O./N.C. Switchable
Maximum rating 30 V 50 mA, remaining voltage 1.5 V or lower*10

Outputs 6 ports, 3 ports are selectable as IN/OUT

Function
Enable by assigning the optional functions
Assignable functions:	� Total judgment (OK/NG), RUN, BUSY, Position adjustment result, 

Judgment result of each tool, Logical operation result of each tool, Error, 
SD card error, Part discrimination result, Master status result

Power/I/O Connector M12 12pin  A code  Male connector
PoE PoE power Class 3/4/6 *11

Ethernet Standard 1000BASE-T/100BASE-TX
Connector M12 8pin  X code  Female connector

Network function FTP client, SFTP client
Supported 
interface

Built-in 
Ethernet EtherNet/IP™, PROFINET*12, TCP/IP non-procedure communication

Expanded memory microSD card (microSD/microSDHC)*13

Rating

Power 
voltage 24 V DC ±10% (including ripple)*14

Consumption 
current

3.3 A or less (without the AI Lighting unit, and including the output load)
1.8 A or less (AI Lighting unit, and including the output load)*15

Environmental 
resistance

Ambient 
temperature 0 to +50°C (No freezing)*16

Relative 
humidity 35 to 85% RH (No condensation)

Vibration*17 10 to 55 Hz; double amplitude 1.5 mm; 2 hours in each of the X, Y, and Z directions
Shock 

resistance*17 500 m/s2, 6 times in each of the 3 directions

Enclosure 
rating*18 IP67

Material

Main unit case: Aluminum die-casting, PBT, TPU
Indicator light cover: TPU
Ethernet connector: Aluminum die-casting, LCP
Front cover: Acrylic (hard coating)

Power connector: Aluminum die-casting, LCP
Nameplate: PET
Water proof cap for the Power connector: PC+ABS alloy
Water proof cap for the Ethernet connector: PC

Weight Approx. 300 g (without the AI Lighting unit)
Approx. 495 g (with the AI Lighting unit)

*1	 When using the product in a range of 3 m or more, it is recommended to remove the polarization filter.
*2	� The focus position can be automatically adjusted at the time of installation. Disabled during the operation. The focus 

position can be registered by program.
*3	 Color type only.
*4	 Monochrome type only.
*5	 Tools can be installed by programs. The number of tools for the detection tools and position adjustment tools combined. 
	 For the detection tools, up to 64 tools can be set. In the sorting mode, 8 judgment tools are arranged.
*6	 Saves to the sensor’s internal memory. 
	� The images saved in the sensor can be backed up to the USB memory connected to the control panel (IV3-CP50) or to 

the PC by the PC software for IV3 Series (IV3-H1).
*7	 Learning tool only.
*8	 Can also be displayed on the control panel (IV3-CP50) or the software for the IV3 Series (IV3-H1).
*9	 Usable on the software for the IV3 Series (IV3-H1).
*10	 Make sure to keep a total of each output with 120 mA or less.
*11	� For PoE power supply devices, IEEE802.3at power Class 4 or higher is recommended when using the AI Lighting unit, 

and IEEE802.3bt power Class 6 or higher is recommended when not using the AI Lighting unit. 
When a device with less than the recommended electricity is used, the operation may be restricted due to electricity 
restriction.

*12	 Conformance Class B, applicable protocol: LLDP and SNMP
*13	 Use only products recommended by KEYENCE.
*14	 To use OP-88656 (10 m), 24 V DC +25%/-10% (including ripple).
*15	� The peak current is designed to be smaller if the AI Lighting unit is mounted. The peak current is greater if the AI Lighting 

unit is not mounted
*16	� When the temperature exceeds an operating ambient temperature of 40°C, after carrying out the installation stipulated 

by us, take an appropriate heat dissipation measure, and ensure that the case temperature does not exceed the rating of 
65°C. 
For the case temperature, measure the part where the model name is printed at the sensor rear.

*17	 Except for mounting the dome attachment for (IV3-D10).
*18	 Except when the polarizing filter (OP-88640/OP-88641/OP-88644/OP-88645) is mounted.
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Specifications

PC software for IV3/IV2/IV series

Model IV3-H1

Compatible sensor IV3 series, IV2 series, IV series

Recording software For IV3 Series: IV3-Navigator, 
For IV2 Series: IV2-Navigator, For IV Series: IV-Navigator

System 
requirements

Interface Equipped with the Ethernet (1000BASE-T) interface

OS*1

Windows 11 Home/Pro/Enterprise
Windows 10 Home/Pro/Enterprise
Windows 7 (SP1 or later) Home Premium/Professional/Ultimate;
either OS above needs to be pre-installed

Supported languages*2 Japanese/English/Simplified Chinese/Traditional Chinese/Korean/German/
Italian/French/Spanish/Portuguese/Czech/Hungarian/Polish/Thai

Processor Needs to be compliant with system requirements for OS.

Memory capacity 4 GB or more

Required capacity for 
installation

4 GB or more

Monitor Resolution: 1024 × 768 pixel or higher
Display color: High Color (16bit) or higher

Operating conditions .NET Framework 4.5.2 must be installed*3

Microsoft Visual C++ 2017 Redistributable Package needs to be installed*3.

*1	 Supports 32-bit and 64-bit versions.
*2	� When connected to the IV3 Series. When the IV2 series is connected, the language supported by the IV2-H1 is used and 

when the IV series is connected, the language supported by the IV-H1 is used.
*3	 If this software is not installed, it will be automatically installed when IV3-H1 is installed.
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Dimensions

Ultra-compact model sensor head

	y IV3-G500MA 	y IV3-G500CA 	y IV3-G600MA 	y IV3-G600CA

Sensor head/amplifier cable
2m/5m/10m

24

12

18
.4

44
.3

Center of light reception

51
.9

38
.1

3.
13.1

30.9
Indicator light

2xM4
Screw depth 3.5

(4
4.

3)

46
.4

38
.4

±1
.2

M
in

. 2
0

φ4
.8

φ12
18

24

2xM4
Screw depth 
3.5

Indicator light
2xφ3.2Plate through mounting hole

(30.9)

34.7 38.4±1.2 Min. 20
(93.1)

29
.7

35
.7

44
.3

(30.9)

(1
04

.8
)

	yWith vertical mounting bracket (OP-87908)
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53

6.
8

51
.1

33
.7

Center of light reception

R2.2

R2.2

16
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.2

2.
1

32
.5
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.2

φ2
0

8.5
24.5

5.2

Min. 20

9.
5
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.5
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5.

2)

30°

(30.9)

	yWith transverse mounting bracket (OP-87909)

R2.224

R2.2

9

14
.3

5

45

48
.1
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.6
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.1

8

Center of light
 reception

37
.9
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7.9
19.9
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. 2
0
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(1
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.6
)

Dimensions
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Dimensions

	yWith adjustable bracket for IV3 Series (OP-87910)

24
.1

24
.1

22
.2 4.
8

Center of light reception

* Strut φ12 is not supplied 
  with the OP-87910

14
.9

17
16

φ1
2

29.8
41.8

61.3

M
in

. 2
0(8

2.
6)

	yWith the polarizing filter for the ultra-compact model  
(OP-88642/OP-88643)

19
.4

24

Center of 
light reception

32.6
(4.8)

1.7

(4
6.

3)
4.

1

	yWith the AI Lighting unit (IV3-LG5C/IV3-LG5M/IV3-LG6C/IV3-LG6M)

70.3

83
.6

37
.3

Center of light reception

32
.3

49

23
23

.3

24.4

(6
1)
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9)
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0

M
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. 2
0

4xM3
 depth 4
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0.

1)

(9
4)

M
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. 2
0

M
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. 2
0

7.8

20.1

Rotating connector (at 90 degrees rotation)

12
Specifications



12-9IV3 Series User’s Manual (PC Software)

Dimensions

	yWith the AI Lighting unit  
(IV3-LG5C/IV3-LG5M/IV3-LG6C/IV3-LG6M),  
common mounting bracket (OP-88634)

35

97
85

83
.6

1.
5

φ4
.5

9.
5

R2.25

57
30

(8
8)

(1
00

)

M
in

. 2
0

M
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.
 2

0

42.4
Center of light reception

59

6

38.25

	yWith the AI Lighting unit  
(IV3-LG5C/IV3-LG5M/IV3-LG6C/IV3-LG6M),  
biaxial adjustment bracket (OP-88638)

70
.5

(1
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.3
)

(8
8)

M
in

.
20
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.
20
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Center of 
light 
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Range of 
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20
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37

.8
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9)
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.8
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16

.5
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(R45.8)
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.3

25
°

R2.25

	yWith the AI Lighting unit  
(IV3-LG5C/IV3-LG5M/IV3-LG6C/IV3-LG6M),  
adjustable bracket (OP-88639)

22
.5

7.
5 21

M
in

. 2
0

M
in

.
 2

0

50.1

Center of light
 reception

104.4
85.1

60
.3

28
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.3

Range of movement

(240°)

(9
9)(8

6)

φ12 (           )+0.04
-0.06

* Strut φ12 is not supplied 
  with the OP-88639

	yWith the AI Lighting unit  
(IV3-LG5C/IV3-LG5M/IV3-LG6C/IV3-LG6M),  
polarizing filter for the AI Lighting unit  
(OP-88646/OP-88647)

33
.9

70.3

83
.6

23
.3

23

4xM3
Screw depth

20
.5

35.15

37
.8

Center of light reception 12
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Dimensions

	yWith the Dome Attachment (IV2-GD05)

φ 8
4.3

1

Center of
light reception

71

28
56

.584
.5

43.2

40
.1

27.357

(φ 84.3)

Sensor head 
Distance from 
WD reference surface

	yWith the Dome Attachment (IV2-GD05),  
vertical mounting bracket (OP-87908)

Se
ns

or
 h

ea
d 

D
is

ta
nc

e 
fro

m
 W

D
 re

fe
re

nc
e 

su
rfa

ce

Center of
light reception

(7
8.

7)

(1
33

.2
)

40
.1

30°
(5.2) 32

.5
54

.5

φ 20

27.4

69.5
(φ 84.3)

14.7

32
.7

76
(8

4.
5)

8.
5

1

53

Min. 20

	yWith the Dome Attachment (IV2-GD05),  
transverse mounting bracket (OP-87909)

Se
ns

or
 h

ea
d 

D
is

ta
nc

e 
fro

m
 W

D
 re

fe
re

nc
e 

su
rfa

ce

1

Center of
light reception

40
.1

78
.2

26.9

15
.3

38
.1

43
.1

528

(1
01

.6
)

15.2
69

(84.3)

(1
29

.6
)

(8)

M
in

. 2
0

	yWith the Dome Attachment (IV2-GD05),  
adjustable bracket (OP-87910)

* Strut φ12 is not supplied
with the OP-87910

Se
ns

or
 h

ea
d 

D
is

ta
nc

e 
fro

m
 W

D
 re

fe
re

nc
e 

su
rfa

ce

3.
8 47

.1
(8

2.
6)

1

Center of
light reception

40
.1

19.5

φ 1
2

15
.8

55
.2 (7

1)

32.7 9.4
74.8

(φ 84.3)
(94.3)

3.
847

.1
37

.4

(8
4.

5)
(1

29
.6

)

M
in

. 2
0

	yWith the Dome Attachment (IV2-GD10)

φ 13
4

1

Center of
light reception

92.5

53
.3

81
.8

(1
35

.1
)

64.7

61
.6

52.782.4
(135.1)

Sensor head 
Distance from 
WD reference surface

	yWith the Dome Attachment (IV2-GD10),  
vertical mounting bracket (OP-87908)

1

Center of
light reception

(7
8.

7)

61
.6

(1
54

.7
)

30°

(5.2)

32
.5

27.4
94.9 40.2

(135.1)

76

Se
ns

or
 h

ea
d 

D
is

ta
nc

e 
fro

m
 W

D
 re

fe
re

nc
e 

su
rfa

ce

32
.7

10
1.

3
33

.9

53

(1
35

.1
)

Min. 20

12
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Dimensions

	yWith the Dome Attachment (IV2-GD10),  
transverse mounting bracket (OP-87909)

1

Center of
light reception

61
.6

99
.7

Se
ns

or
 h

ea
d 

D
is

ta
nc

e 
fro

m
 

W
D

 re
fe

re
nc

e 
su

rfa
ce

15
.3

38
.1

43
.1

5

10
1.

6

40.7 94.4
(135.1)

26.9

53
.3

(1
54

.9
)

(8)

M
in

. 2
0

	yWith the Dome Attachment (IV2-GD10),  
adjustable bracket (OP-87910)

* Strut φ12 is not supplied
with the OP-87910

1

Center of
light reception

61
.6

19.5

φ 1
2

15
.8

76
.7

(9
2.

5)

32.7
34.9100.2

(135.1)

Se
ns

or
 h

ea
d 

D
is

ta
nc

e 
fro

m
 W

D
 re

fe
re

nc
e 

su
rfa

ce

3.
872

.3

62
.8

(1
54

.9
)

(8
2.

6)

(1
35

.1
)

M
in

. 2
0

Ultra-compact model sensor amplifier
	y IV3-G120

(158.8) When using an Ethernet cable

LAN cable or Ethernet cable

(6
1.

6)
(3

3.
5)

96
94.7

(133.5)
86.8

Head/amplifier cable

(100.8)
(99.5)

95

46

20
.3

21.4

46

DIN rail

12
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Dimensions

Options for the ultra-compact model

AI Lighting unit
	y IV3-LG5C/IV3-LG5M/IV3-LG6C/IV3-LG6M

70.3

31.8

83
.6

Polarizing filter
	yPolarizing filter for the ultra-compact model  
(OP-88642/OP-88643)

19
.4

46
.3

23.8

Center of light 
reception

7.9

16.9

13
.7

φ3
.3

	yPolarizing filter for the AI Lighting unit  
(OP-88646/OP-88647)

33.4

66.9

36
.6

73
.5

Center of 
light 
reception

3.6
10.5

Mounting the dome attachment
IV2-GD05

(φ8
4.3)

43

84.584.3

54
.6

40
.1

S
en

so
r h

ea
d

D
is

ta
nc

e 
fro

m
 W

D
 re

fe
re

nc
e 

su
rfa

ce

IV2-GD10
φ1

34

76
.1

135.1 135.1

64
.5

61
.6

S
en

so
r h

ea
d

D
is

ta
nc

e 
fro

m
 W

D
 re

fe
re

nc
e 

su
rfa

ce

12
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Dimensions

Cable (option)

IV3 sensor head/amplifier cable
	yOP-88648 
(2m)

	yOP-88649 
(5m)

	yOP-88650 
(10m)

17
.5

28.6
φ4

.8

2000(OP-88648)
5000(OP-88649)

10000(OP-88650)

9.
2

(φ
12

)(38.4)

Mounting bracket (option)

Vertical mounting bracket
	yOP-87908

Material: A5052
t = 3.0

32
.5

38.1

10
°

4°

R2.2

R2.2

5

48

21

53

30°

R2.2

12.5

φ2
0

5.2

Transverse mounting bracket
	yOP-87909

Material: A5052
t = 3.0

48.1

9

10
°

10°

38.1
R2.2

R2.2

35

R2.2

12

8

38.1

40

21

Adjustable bracket
	yOP-87910

19.5
36.9

φ 
27

3.3
4.4φ 1

2

5
12

32

38.1
48.1

4.5

35

12.5

φ 4.4

φ 4
.4

* Strut φ12 is not supplied with the OP-87910

Material: A5052

Material: Zinc die-casting
Bracket

t = 3.0

Common mounting bracket (also for the 
built-in amplifier type)
	yOP-88634

17
.5

17
.5

97

63

85

49

30

5.
5

22
.5

45
.5

9.
5

R2.25

9.
5

7.9

φ 4.5
R1

.7

R2
.2

5

φ 3
.4

φ 3
.4

6

Biaxial adjustable bracket
	yOP-88638

49

23
8.

5

125.3

(93.1)

φ 
3.

4

23.5

78.3

41

R10

R
an

ge
 o

f 
m

ov
em

en
t

(3
9)

17
.5

41

16.5
33.5

Range of 
movement
(204°)

40

78

108.3

33
.5

R10

(R45.8)

R2.25

25
°

12
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Dimensions

Adjustable bracket (for the AI Lighting unit)
	yOP-88639

4910.5

12
23

42

11.4R1.7

76

85

20

21

28

43

30
9

7.
5

30

R1
3.

1

24
0°

R3.25

* Strut φ12 is not supplied 
  with the OP-88639

φ12 (           )+0.04
-0.06

12
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Dimensions

Built-in amplifier type sensor

	y IV3-400MA 	y IV3-400CA 	y IV3-500MA 	y IV3-500CA 	y IV3-600MA 	y IV3-600CA

Rotating connector (at 90 degrees rotation)

27

81.5

Min. 56.5

Min. 56.5

(107.9)

30

59
.6

29
.8

(119.9)

2xM4
(depth 4.1 mm)Center of light reception

5.5

14.2

58.5

38
.5

4059
.6

40

4xM2.5
(depth 3.4 mm)

4xM3
(depth 3.3 mm)

45
.3

111.9

φ 47

10

16 15

45
.3

(1
77

)

(1
65

)

91

12
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Dimensions

	yWith the common mounting bracket (OP-88634)

35

M
in

. 5
6.

5

M
in

. 5
6.

5

57
30

9.
5

11
.7

(1
11

.9
)

97

85

(1
81

) (1
69

)

42.5

Center of light
 reception

59

6

	yWith the biaxial adjustable bracket (OP-88635)

M
in

. 5
6.

5

M
in

. 5
6.

5(1
22

)

70
.578

97
.5

(1
10

)

54.3

Center of 
light 
reception

25
°

91.6

(R45.8)

R2
.2

5

67.6

108.6

40
12

.5
45

.3

R
an

ge
 o

f 
m

ov
em

en
t

(3
9)

22
.8

56

40

57.8 Range of movement
(204°)

12
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Dimensions

	yWith the adjustable bracket (OP-88636)

M
in

. 5
6.

5

M
in

. 5
6.

5

50

17
.8

47

Range of movement
(240°)

Center of light reception

28

73
.3

88
.3

77
96.3

7
(1

86
)(1

74
)

φ12 (           )+0.04
-0.06

	yWith the built-in amplifier type polarizing filter (OP-88640/OP-88641)

27

φ 51.5

(54.6)

50

Center of light reception

47.3

7
5.5

12
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12-18 IV3 Series User’s Manual (PC Software)

Dimensions

	yWith the AI Lighting unit (IV3-L4C/IV3-L4M/IV3-L5C/IV3-L5M/IV3-L6C/IV3-L6M)
100

12
7.

4

42
.5

45.3

	yWith the AI Lighting unit (IV3-L4C/IV3-L4M/IV3-L5C/IV3-L5M/IV3-L6C/IV3-L6M), common mounting bracket (OP-88634)

Center of light reception

59

6
45

.3

35

42.5

M
in

. 5
6.

5

M
in

. 5
6.

5
24

.2

5.
5

40

40

85

309.
5

φ 4.5

R2
.2

5

φ 3.4

7.9

(1
69

)

(1
81

)

11
.7

Center 
of light 
reception

R1.7

	yWith the AI Lighting unit (IV3-L4C/IV3-L4M/IV3-L5C/IV3-L5M/IV3-L6C/IV3-L6M), biaxial adjustment mounting bracket (OP-88635)

M
in

. 5
6.

5

M
in

. 5
6.

5

12
2.

2

11
0.

2

70
.5

11
3 Center of light 

reception

25
°

(R45.8)

91.6

R2
.2

5

67.6

108.6

40

12
.5

45
.3

54.3

R
an

ge
 o

f m
ov

em
en

t
(3

9)
22

.8

56

40

57.8
Range of movement
(204°)

78
(1

81
)

(1
93

)

12
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Dimensions

	yWith the AI Lighting unit (IV3-L4C/IV3-L4M/IV3-L5C/IV3-L5M/IV3-L6C/IV3-L6M), adjustable bracket (OP-88636)

M
in

. 5
6.

5

M
in

. 5
6.

5

42
.5

12
7.

4

(116.3)

Center of 
light 
reception

Range of movement
(240°)

47

28

73
.388

.3

77

(96.3)

7.
2

(1
74

)

(1
86

)

φ12 (           )+0.04
-0.06

	yWith the AI Lighting unit (IV3-L4C/IV3-L4M/IV3-L5C/IV3-L5M/IV3-L6C/IV3-L6M), polarizing filter for the AI Lighting unit 
(OP-88644/OP-88645)

104

10
0.

8

44
.5

52
Center of 
light 
reception

30.2

12
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Dimensions

	yWith the Dome Attachment (IV3-D10)

10
8.8

135.1
10

.6

18

122

140.4

2xM4
(Depth 4.1mm)

54.8

46.1

13
5.1 38
.540

40

58.5

4xM2.5
(Depth 3.3mm)

4xM2.5
(Depth 3.4mm)

16
15

10

67.5

107.9

Min. 56.5

119.9
Min. 56.5

Center of
light reception

3.640.6

22
9

24
1

When the connector is rotated 90°

	yWith the Dome Attachment (IV3-D10), common mounting bracket (OP-88634)

Center of
light reception

6
11

4.8

11
.7

5.8

35

135.1

67
.6

42.5
85
97

4.5

5
5φ4.5

18
.3

38
.7

18
1

19
3

Center of
light reception

Mi
n. 

56
.5

Mi
n. 

56
.5

12
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Dimensions

	yWith the Dome Attachment (IV3-D10), biaxial adjustment mounting bracket (OP-88635)

(R
an

ge
 o

f m
ov

em
en

t  
20

4°
)

13
8.

1

25
°

91.6
108.6R2.25

12
.5

10
8.

8

40

135.1

M
in

. 5
6.

5

M
in

. 5
6.

5

(1
41

.3
)

(1
22

)

(1
10

)

	yWith the Dome Attachment (IV3-D10), adjustable bracket (OP-88636)

67
.6

19
3 18

1

Center of
light reception

28

13
6.815

1.8

114.6
133.9

135.1

47
17

.8

50

7.2

17
4

18
6

φ12 (           )+0.04
-0.06

(Range of movement  204°)

Mi
n. 

56
.5 Mi
n. 

56
.5

12
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Dimensions

Options for the built-in amplifier type

AI Lighting unit
	y IV3-L4C/IV3-L4M/IV3-L5C/IV3-L5M/IV3-L6C/IV3-L6M

100

90 98
.8

27.6

Polarizing filter
	yFor the sensor (OP-88640/OP-88641)

φ50.6

49.1

5.5

13.7

16
.2

φ2.7

47.2

Center of light 
reception

	yPolarizing filter for the AI Lighting unit  
(OP-88644/OP88645)

104

94

44
.5

52 Center of light 
reception

17.7
5.6

Dome Attachment
	y IV3-D10

63
.5 76

.4

135.1

Sensor head
Distance from 
WD reference surface

φ 134

67

135.1

12
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Dimensions

Cable

Power I/O cable
	yOP-88654 (2m) 	yOP-88655 (5m) 	yOP-88656 (10m)

φ6
.5

47

φ1
5

135
165

10
10

2000
5000
10000

Conversion connector for power I/O cable
	yOP-88631 (M12 A12pin - A4pin male)

φ 1
6

50.9

	yOP-88632 (M12 A12pin - L5pin male)

φ 1
6

50.9

Conversion connector for the Ethernet cable
	yOP-88633 (M12 X8pin - D4pin female)

50.9

φ 1
6

Mounting bracket

Common mounting bracket (also for the 
ultra-compact model)
	yOP-88634

17
.5

17
.5

97

63

85

49

30

5.
5

22
.5

45
.5

9.
5

R2.25

9.
5

7.9

φ 4.5

R1
.7

R2
.2

5

φ 3
.4

φ 3
.4

6

Biaxial adjustable bracket
	yOP-88635

(108.6)23.5

40
61.6
(76.4)

10
4056

φ 
3.

4

Range of 

movement

(204°)

R10

Ra
ng

e 
of

 
m

ov
em

en
t (

39
)

29.5

12.5

22
.8

(5
6)

78

40

25
°

91.6

29
.5

R2.25

(R45.8)

R10

12
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12-24 IV3 Series User’s Manual (PC Software)

Dimensions

Adjustable bracket
	yOP-88636

10
40

5
40

68

50
R1.7 11.4

77

20

25

28
43

7.
5

30

9

30

R1
3

24
0°

R3.25

* Strut φ12 is not supplied 
  with the OP-88636

φ12 (           )+0.04
-0.06

Communication cable (option)

Ethernet cable (dedicated for the built-in amplifier type)
	yOP-88664 (2 m) 	yOP-88665 (5 m) 	yOP-88666 (10 m)

φ6.5

φ14.8

16
.8

13.6 44.5

2000
5000
10000 47.3

LAN cable
	yOP-87950 (1 m) 	yOP-87951 (3 m)
	yOP-87952 (5 m) 	yOP-87953 (10 m)

44.2 44.2

10000

1000
3000
5000

φ6
.2

15
.5

13.6 13.6

15
.5

12
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A-2 IV3 Series User’s Manual (PC Software)

Status Table

Status Table

Status Screen 
type

Sensor (built-in amplifier)/ 
Sensor amplifier (ultra-compact model) indicator light Input Output

PWR/ERR
(Ultra-compact 

model)

Status indicator light 
(built-in amplifier 

type) (ultra-compact 
model head part)

OUT TRIG External 
trigger

Switching  
programs

Ext. Master 
Save Clear Error BUSY

Total Status / Total Status NG /  
Each Tool / Each Logic /  
Part Type / Pos. Adj.*1

RUN Error

Starting up - Lighting (green) Blink (green) Blink 
(green) OFF × × × × OFF OFF OFF OFF

Running*2

Waiting for a trigger

RUN Lighting (green)
*3 *3

OFF ü ü ü

×

OFF
*4

ON OFF
Judgment processing *5

*6
*7 *8

ONSwitching programs
*9 *9 OFF

*10 *11
*12

Registering the external master image *11 *10

Setting

Limit Adjustment TEST

Blink (green) Blink (green) OFF

*5 ü

× × ×

Same 
as while 
running

OFF
OFF

OFF

Trigger Options, Master 
Registration, etc.

LIVESmart Image Optimization/
Automatically adjusting the brightness *13

×
*13

Setup Adjustment *14 OFF
I/O Monitor

- OFF
*15 ← ← ← ← ← ←

Others × × × × OFF OFF OFF

Error

Trigger error
Running RUN

Blink (red)
Blink (red)

Same as normal Same as normal ü Same as normal
ON

Setting LIVE
External master registration error

-System error
Lighting (red) OFF OFF × × × ×

OFF OFF
OFF

Startup memory readout error *16 *16 *16

ü/× indicates enable/disable of the input.	
ON/OFF indicates the following status. The operation differs according to the output setting (N.O./N.C).

	yWhen N.O.	 ON	 : Indicates ON for output.
	 OFF	 : Indicates OFF for output.

	yWhen N.C.	 ON	 : Indicates OFF for output.
	 OFF	 : Indicates ON for output.
*1	 Turns ON if the judgment is OK. Turns OFF if it is NG.
	 When the total status result is OK, the total status output turns ON.
	 When the total status result is NG, the total status NG output turns ON.
	 The total status conditions can be selected from [All Tools OK], [Any Tool OK] and [Logic 1] to [Logic 4].
	  “Total Status Conditions” (page 4-150)
	 When the position adjustment is NG, the status of each tool becomes NG.
*2	� The sensor continues running even during the operation of the [Run/Learned Img. History]/ [I/O Settings]/[Advanced 

Settings] screen in the run screen.
*3	 Indicates the overall status result of the previous judgment process. OK: Lighting (green), NG: Lighting (red)
*4	 Outputs the status result of the previous judgment process.
*5	 Lights (one-shot) according to the input of a trigger (external/internal).
	 When a trigger delay has been set, it lights before the delay.
*6	 Disregards the input. A trigger error occurs.
*7	 Stops the judgment process and switches over.
*8	 Stops the judgment process and registers the previously taken image as a master image.
*9	 �Turns off the light before the process is completed. Until the light turns off, the previous status result will be displayed.
*10	 After the current process is completed, a new input begins.
*11	 Do not use. The processing order becomes indeterminate.
*12	 Turns OFF before the process is completed. Outputs the previous status result until this turns OFF.
*13	 The internal trigger is issued automatically and the image is updated. The Busy output operates.
*14	� The internal trigger is issued automatically and the image is updated.
*15	 �While the I/O monitor function is used, only the operation of the I/O lines is confirmed. The assigned functions will 

not operate.
*16	� The output turns OFF regardless of the output settings (N.O./N.C.) and the polarity (NPN/PNP) settings.

Additionally, refer to  “Chapter 11 Controlling with the Input/Output Line” (page 11-1).

Status Table
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Status Table

Status Table

Status Screen 
type

Sensor (built-in amplifier)/ 
Sensor amplifier (ultra-compact model) indicator light Input Output

PWR/ERR
(Ultra-compact 

model)

Status indicator light 
(built-in amplifier 

type) (ultra-compact 
model head part)

OUT TRIG External 
trigger

Switching  
programs

Ext. Master 
Save Clear Error BUSY

Total Status / Total Status NG /  
Each Tool / Each Logic /  
Part Type / Pos. Adj.*1

RUN Error

Starting up - Lighting (green) Blink (green) Blink 
(green) OFF × × × × OFF OFF OFF OFF

Running*2

Waiting for a trigger

RUN Lighting (green)
*3 *3

OFF ü ü ü

×

OFF
*4

ON OFF
Judgment processing *5

*6
*7 *8

ONSwitching programs
*9 *9 OFF

*10 *11
*12

Registering the external master image *11 *10

Setting

Limit Adjustment TEST

Blink (green) Blink (green) OFF

*5 ü

× × ×

Same 
as while 
running

OFF
OFF

OFF

Trigger Options, Master 
Registration, etc.

LIVESmart Image Optimization/
Automatically adjusting the brightness *13

×
*13

Setup Adjustment *14 OFF
I/O Monitor

- OFF
*15 ← ← ← ← ← ←

Others × × × × OFF OFF OFF

Error

Trigger error
Running RUN

Blink (red)
Blink (red)

Same as normal Same as normal ü Same as normal
ON

Setting LIVE
External master registration error

-System error
Lighting (red) OFF OFF × × × ×

OFF OFF
OFF

Startup memory readout error *16 *16 *16

ü/× indicates enable/disable of the input.	
ON/OFF indicates the following status. The operation differs according to the output setting (N.O./N.C).

	yWhen N.O.	 ON	 : Indicates ON for output.
	 OFF	 : Indicates OFF for output.

	yWhen N.C.	 ON	 : Indicates OFF for output.
	 OFF	 : Indicates ON for output.
*1	 Turns ON if the judgment is OK. Turns OFF if it is NG.
	 When the total status result is OK, the total status output turns ON.
	 When the total status result is NG, the total status NG output turns ON.
	 The total status conditions can be selected from [All Tools OK], [Any Tool OK] and [Logic 1] to [Logic 4].
	  “Total Status Conditions” (page 4-150)
	 When the position adjustment is NG, the status of each tool becomes NG.
*2	� The sensor continues running even during the operation of the [Run/Learned Img. History]/ [I/O Settings]/[Advanced 

Settings] screen in the run screen.
*3	 Indicates the overall status result of the previous judgment process. OK: Lighting (green), NG: Lighting (red)
*4	 Outputs the status result of the previous judgment process.
*5	 Lights (one-shot) according to the input of a trigger (external/internal).
	 When a trigger delay has been set, it lights before the delay.
*6	 Disregards the input. A trigger error occurs.
*7	 Stops the judgment process and switches over.
*8	 Stops the judgment process and registers the previously taken image as a master image.
*9	 �Turns off the light before the process is completed. Until the light turns off, the previous status result will be displayed.
*10	 After the current process is completed, a new input begins.
*11	 Do not use. The processing order becomes indeterminate.
*12	 Turns OFF before the process is completed. Outputs the previous status result until this turns OFF.
*13	 The internal trigger is issued automatically and the image is updated. The Busy output operates.
*14	� The internal trigger is issued automatically and the image is updated.
*15	 �While the I/O monitor function is used, only the operation of the I/O lines is confirmed. The assigned functions will 

not operate.
*16	� The output turns OFF regardless of the output settings (N.O./N.C.) and the polarity (NPN/PNP) settings.

Additionally, refer to  “Chapter 11 Controlling with the Input/Output Line” (page 11-1).
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Status Table

Displaying and outputting the status result

Status

Status of the tool/part type Total Status*2

Display
Output Display

Total Status  
OK Output

Total Status  
NG OutputJudgment

Matching 
rate*1

Waiting for a trigger
(Not judged) *3 -- --- OFF -- OFF*7 OFF*7

Judge is OK OK*5 0 to 100 ON OK*6 ON*7 OFF*7

Judge is NG NG 0 to 100 OFF NG OFF*7 ON*7

Unable to judge*4 -- --- OFF NG OFF*7 ON*7

*1	 When the setting scale is changed for the Color Area/Area tool, 0 to 200/0 to 999 can be selected.
	yWhen the setting scale is changed for the Width/Diameter/Pitch tool, 0 to 100/0 to 999 can be selected.
	yThe matching rate of the Edge tool is the number of detected edges. The scales shown below can be selected.
0 to 2/0 to 5/0 to 10/0 to 20/0 to 50/0 to 128/0 to 256/0 to 320
	yThe matching rate of the Blob Count tool is the number of counts of detected blobs. The scales shown below can 
be selected.
0 to 5/0 to 10/0 to 20/0 to 50/0 to 100/0 to 200
	yThe matching rate when the scaling function is used with the Width/Diameter/Pitch tool is based on the scaling 
settings.
	yThe cut-off process (Page A-6) may be performed for the Outline tool and Position Adjustment tool.
	y If all the text and date matches, the matching rate for the OCR tool will be displayed as 100. If either the text or 
date does not match, 0 is displayed. If you set Shade Contrast to [Enable], the matching rate is linked to the text 
and date shading.

*2	� The total status conditions can be selected from [All Tools OK], [Any Tool OK] and [Logic 1] to [Logic 4].
	  “Total Status Conditions” (page 4-150)
*3	� In this status, there has been no trigger input after the power turned ON, after the program number has changed, 

after the master image registered, after the status output reset, or after a shift from the setting mode to the run 
mode.

*4	� At the time of using the position adjustment/High-Speed Position Adjustment tool, when the judgment of each tool 
cannot be determined, the tool becomes “Unable to judge”. For details, refer to  “Displaying and outputting the 
status result at the time of position adjustment” (page A-5).

*5	 Displays the part type (master) number in sorting mode.
*6	 Displays the part type (master) name and part type (master) in sorting mode.
*7	 In standard mode only. The total status output cannot be selected in sorting mode.
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Status Table

Displaying and outputting the status result at the time of position adjustment

Position 
adjustment 

result

Window  
protrusion*1

Display/
output

Status of the tool/Part

Total Status*2 

(standard 
mode only)

Total Status 
NG  

(standard 
mode only)

Pos. Adj./ 
Hi-Sp.Adj

Outline

Learning/Color 
Area/ 

Area/Width/
Diameter/ 

Edge/ 
Pitch/OCR/ 
EdgePixels/ 
Blob Count

Succeeded

No

View 
judgment OK OK/NG OK/NG OK/NG*3

Status 
output ON ON/OFF ON/OFF *4 *5

View 
matching 

rate
0 to 100 0 to 100 0 to 100*6

Yes 

View 
judgment OK OK/NG -- *7 OK/NG*3

Status 
output ON ON/OFF OFF *4 *5

View 
matching 

rate
0 to 100 0 to 100*8 ---- *7

Failed

View 
judgment NG -- -- NG

Status 
output OFF OFF OFF OFF ON

View 
matching 

rate
0 to 100 --- ---

*1	� This is an operation for if the adjusted position of the tool window is protruded from the imaging area at the time that 
position adjustment succeeded.

	 For details, refer to  “Matching rate at the time of protrusion” (page A-6).
*2	� The total status conditions can be selected from [All Tools OK], [Any Tool OK] and [Logic 1] to [Logic 4].
	  “Total Status Conditions” (page 4-150)
*3	 Displays the Part (master) number, Part (master) name, or NG in the sorting mode.
*4	 When the total status result is OK, the total status OK output turns ON. This cannot be selected in sorting mode.
*5	 When the total status result is NG, the total status NG output turns ON. This cannot be selected in sorting mode.
*6	 Setting scale can be changed.
	 The scales shown below are selectable.

	yColor Area/Area/Width/Diameter/Pitch/Edge Pixel: 0 to 100/0 to 200/0 to 999
	yEdge: 0 to 2/0 to 5/0 to 10/0 to 20/0 to 50
	yOCR (when shade contrast is [Enable]): 0 to 100
	yBlob Count: 0 to 5/0 to 10/0 to 20/0 to 50/0 to 100/0 to 200

	� When the scaling function is used with the Width/Diameter/Pitch tool, the matching rate is based on the scaling 
settings.

*7	 The judgment cannot be determined if the adjusted position of the tool window is protruded from the imaging area.
*8	� For details on the target’s outline which is protruded from the search region, refer to  “Matching rate at the time of 

protrusion” (page A-6).
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Matching Rate of the Outline Tool and Position Adjustment Tool

Matching Rate of the Outline Tool and Position 
Adjustment Tool
Matching rate at the time of protrusion

	z When the matching rate decreases in 
proportion to the protrusion amount

	yWith the [Search Range] of the Outline tool set to 
[Entire]
	yWith the [Search Range] of the Position Adjustment 
set to [Entire] and with the [Search Algorithm] set to 
[High Speed]

When the target outline protrudes from the imaging 
area, the protruding outline is excluded from the target 
in regards to calculating the matching rate.
The matching rate decreases in proportion to the 
protrusion amount.
If the target is being protruded from the imaging area, 
the matching rate will decrease depending on how 
much the target is protruded from the imaging area.

Protruding outline
(excluded from the target for 
calculating the matching rate)

Outline to be targeted 
for calculating the 
matching rate

Tool window

Imaging area

	z When searching for outline within a partial 
search area.

	yWith the [Search Range] of the Outline tool set to 
[Partial]
	yWith the [Search Range] of the Position Adjustment 
set to [Partial] and with the [Search Algorithm] set to 
[High Speed]
	yWith the [Search Algorithm] of the Position Adjustment 
set to [High Accuracy]

The sensor searches the outline of the target that is in 
the search range. The matching rate of the target being 
out of search range will be “0”.

When the tool window after position adjustment 
is protruded from the imaging area, the judgment 
display of the Learning/Color Area/Area/
ColorAverage/Brightness Average/Width/Diameter/
Edge/Pitch/OCR/EdgePixels tool/Blob Count 
becomes -- (Unable to judge) and the status output 
turns OFF.

Cut-off process of the matching rate
The cut-off process means the process where the outline 
detection process is ended when no outline exceeding a 
certain matching rate (cut-off value) below the threshold 
value is found.
A matching rate which has been cut off becomes 0. 
Because the cut-off value is linked to the threshold, the 
cutoff value is also changed when the threshold is changed.

Current 
matching rate

Limit(Cut-off value)

Cut-off processing range
(Range where the matching rate 
becomes 0)

Match
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Troubleshooting

Symptom Check point Remedy Ref.

The PWR/ERR indicator light of the 
sensor amplifier is on or blinking in 
red.

An error has occurred. Check the 
errors indicated by the lighting or 
blinking.

Refer to “Error Message”. A-9
The status indicator light is blinking 
in red. (Built-in amplifier type)

The power of the sensor does not 
turn on.

Is the power cable correctly 
connected? Connect the power cable correctly. 2-15

	yDoes the voltage or capacity 
of the power source meet the 
specification?
	yHas the voltage dropped due to the 
power cable conductor resistance?

	yUse a power source of the correct 
rating.
	yChoose a power cable with 
consideration to a voltage drop.

12-2

The image does not display on 
the IV3-Navigator. or the image is 
abnormal.

Is the installed distance of the target 
correct?

Place a target at the correct installed 
distance. The installed distance 
depends on the sensor type.

2-2

Is the sensor view correct?
Place the sensor in such a way that 
the sensor view matches the target 
size.

2-2

Is the focus adjustment correct? Adjust the focusing position (focus) of 
the sensor. 4-12

Is the brightness adjustment correct? Adjust the brightness of the sensor. 4-12

Is the target or the sensor vibrating? Implement anti-vibration measures etc.
-Is the multiple imaging set when 

imaging a moving target? Set the image optimization again.

Does ambient light affect the image?

Mount the AI Lighting unit. 2-6

Use brightness correction. 4-24

Implement a shield to prevent the 
incident of ambient light. -

Is the front cover dirty or damaged?
Clean the front cover.
If it is damaged, contact your nearest 
KEYENCE office.

-

The image or the status result is not 
updated.

Is the system in the setting mode?
	y Start run mode
	y Turn on the power of the sensor 
again.

5-2

Is the trigger correctly input?

If a target is to be imaged using an 
external trigger, input the external 
trigger. When NPN is selected in the 
Polarity, the circuit becomes a non-
voltage input circuit. When PNP is 
selected in the Polarity, the circuit 
becomes a voltage input circuit. Check 
the cables.

4-10

All or part of the settings necessary 
for running have not been completed.

Complete the settings in Settings 
Navigator. 4-1

The NG Hold function is used. Set [NG Hold Function] to [Disable]. 5-16

Image update is slow.
(during operation/setting)

Is the network connected to the 
inplant LAN?

The network may be affected by the 
traffic in the in-plant LAN. Configure a 
local network and confirm the network 
connection only for the IV3 Series.

-

Troubleshooting
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Troubleshooting

Symptom Check point Remedy Ref.

The device cannot be operated with 
the IV3-Navigator.

Is the input screen for the unlock 
password displayed?

Sensor security is enabled. Input the 
unlock password. 7-22

The password is lost and cannot 
unlock.

Contact your nearest KEYENCE 
office. -

The status result is not output.

Is the output line correctly 
connected?

Correctly connect to the external 
devices. 2-15

Is the output setting correctly set? Set the output line and output settings 
correctly in the Settings Navigator. 4-147

Is the system in the setting mode? Start run mode 5-2

Is the threshold correctly set? Set the threshold correctly. 6-15

Is the tool correctly set?
	y Set the judgment tool correctly.
	y Set the position adjustment tool 
correctly.

4-28
4-121

Is the Polarity correctly set? Set NPN or PNP according to the 
circuits of the external devices. 7-17

Are the N.O. and N.C. correctly set?
Set N.O. (normally open) or N.C. 
(normally closed) according to the 
circuits of the external devices.

7-15

An external trigger cannot be input.

Is the trigger condition set to 
[External Trigger]?

Select [External Trigger] in Trigger 
Options. 4-10

Is the input line correctly connected? Correctly connect to the external 
devices. 2-15

Has the input setting been made 
correctly?

Adjust the input line and input settings 
correctly in [Input Assignment]. 7-14

Is the Polarity correctly set?

When NPN is selected in the Polarity, 
the circuit becomes a non-voltage 
input circuit. When PNP is selected 
in the Polarity, the circuit becomes a 
voltage input circuit. Check the cables.

7-17

The program number cannot be 
changed with the input line.

Has the switching method for the 
programs been correctly set?

Set the [Program Switching Method] 
to [External Input]. 7-14

Is the input line correctly connected? Correctly connect to the external 
devices. 2-15

Has the input setting been made 
correctly?

Adjust the input line and input settings 
correctly in [Input Assignment]. 7-14

Is the Polarity correctly set?

When NPN is selected in the Polarity, 
the circuit becomes a non-voltage 
input circuit. When PNP is selected 
in the Polarity, the circuit becomes a 
voltage input circuit. Check the cables.

7-17

When using P032 to P127, is the SD 
card correctly inserted?

Insert the SD card correctly and close 
the cover. 8-9

Is the program expansion function 
correctly set? Set the [SD Card Access] to [Enable]. 8-11

IV3-Navigator cannot connect to the 
sensor. Check the cables and settings.

Refer to “Remedy when the Monitor 
cannot be Connected with the Sensor” 
(Page A-16).

A-15

Image data cannot be transferred via 
FTP/SFTP. Check the cables and settings. Refer to “Remedy when data transfer 

via FTP/SFTP is unavailable” A-21

Image data cannot be transferred to 
the SD card.

Check if the settings are correct and 
if the SD card is correctly inserted.

Refer to “Remedy when data transfer 
to the SD card is unavailable” A-14
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Error Messages

Error Messages

Checking errors by observing the PWR/ERR indicator light and status indicator light

	� Ultra-compact model
For the ultra-compact model, the causes of and remedies for an error can be checked by observing the indicator light.

PWR/ERR indicator light

The indicator light on the sensor head blinks (red) when the light on the sensor amplifier is ON (red) or blinking (red).

PWR/ERR  
indicator light 

status
Cause Remedy

Green

ON Operation is in progress. -

Blink

Setting in progress.
Operation stopped. -

If the light turns off periodically, the power supply 
rating may be insufficient. 	yUse a power source of the correct rating.

Red

ON

A system error occurred.
	yCycle the power of this device.
	y If the same error occurs, contact your nearest 
KEYENCE office.

A startup memory read error occurred.
	y A data abnormality occurred due to noise or 
because the power switched OFF while writing 
was in progress.

	y Initialize the settings.
	y If the same error occurs, contact your nearest 
KEYENCE office.

An error occurred in switching the advanced 
program at the time of startup or during operation.

Refer to  “Checking error messages on the IV3-
Navigator” (page A-11).

Blink

A trigger error occurred. The judgment process is 
not performed.
An external trigger is input when [Trigger Accept 
Timing] is set to [Send after BUSY Output OFF] 
and the busy output is ON. Otherwise, the internal 
trigger interval is faster than the processing time.

	y A trigger error can be fixed using one of the following 
procedures.

	yNext normal trigger input
	yClear Error input
	y Switching the program number
	y Proceeding to the settings screen of the sensor

	y Set the trigger interval of the internal trigger to a value 
that is longer than the processing time (calculate the 
data transfer time when [BUSY Output Configuration] 
is set to [Until Data Transfer is Complete]).
	y An error will not occur if the Trigger Error is set to 
[Disable] described in output assignment for the 
Settings Navigator (Page 4-147).

An error occurred in switching the advanced 
program during setup.

Refer to  “Checking error messages on the IV3-
Navigator” (page A-11).

An external master image registration error (with 
no registered master image) occurred. The master 
image is not updated.

	y The image to be registered as a master image 
was not imaged.
	y The work memory is insufficient.

	y An external master image registration error can be 
fixed using one of the following procedures.

	y Successful in next external master image registration
	yClear Error input
	y Switching the program number
	y Proceeding to the settings screen of the sensor

	y Taking an image to be registered as a master image 
and registering it as an external master image.
	yDeleting one or more detection tools.
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Error Messages

PWR/ERR  
indicator light 

status
Cause Remedy

Red Blink

An external master image registration error (with 
registered master image) occurred. The following 
errors occurred even though the image was 
updated and registered as a master image.

	y For the new master image, the outline cannot 
be extracted with the outline tool.
	y For the new master image, the area cannot be 
extracted with the Color Area/Area tool.
	y For the new master image, the edge cannot be 
extracted with the Width/Diameter/Edge/Pitch/
Edge Pixel tool.
	yWhen the learning tool (including sorting mode) 
is set, the external master image registration 
cannot be used.

	y An external master image registration error can be 
fixed using one of the following procedures.

	y Successful in next external master image registration
	yClear Error input
	y Switching the program number
	y Proceeding to the settings screen of the sensor

	yChecking that the image to be registered and the 
detection tools/position adjustment settings are 
applicable.

An SD card error occurred. The following errors 
occurred.

	y Accessing the SD card has failed.
	y Transfer to the SD card failed.

Refer to  “Remedy when data transfer to the SD card is 
unavailable” (page A-14).

An FTP error occurred. The following errors 
occurred.

	yConnection with the FTP/SFTP server failed.
	y Tranfer to the transfer destination folder failed.
	y The transfer speed could not catch up to the 
sensor processing speed.

An FTP error can be fixed using one of the following 
procedures.

	y Press [OK] on the Error screen
	yClear Error input
	yResolve the causes of transfer failure.

OFF Power is not supplied to this device. 	yConnect the power cable correctly.
	yUse a power source of the correct rating.

Errors in a state that the PWR/ERR indicator light lights in red or blinks in red turn the error output ON.
 “Cables” (page 2-15)
 “4. Output Assignment (Setting Details of Outputting to Output Line)” (page 4-147)

	� Built-in amplifier type
For the built-in amplifier type, the status indicator light blinks in red when an error occurs.

Status indicator light

Status of the 
status  

indicator light
Cause Remedy

Green

ON The total status result and part type discrimination 
are OK. -

Blink

Under startup or setting in progress.
Operation stopped. -

If the light turns off periodically, the power supply 
rating may be insufficient. 	yUse a power source of the correct rating.

Red

ON The total status result and part type discrimination 
are NG. -

Blink

An error has occurred.
The Status indicator light on the build-in amplifier 
type blinking in red means the same as when the 
PWR/ERR indicator light of the ultra-compact model 
lights or blinks in red.

For the causes of and remedies for this error, refer 
to those of the PWR/ERR indicator light of the ultra-
compact model.

 “Ultra-compact model” (page A-9)

OFF Power is not supplied to this device. 	yConnect the power cable correctly.
	yUse a power source of the correct rating.

Errors in the status indicator light blinks in red turn the error output ON.
 “Cables” (page 2-15)
 “4. Output Assignment (Setting Details of Outputting to Output Line)” (page 4-147)
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Error Messages

Checking error messages on the IV3-Navigator

Message Cause Remedy Output/ 
Indicator

A system error occurred on the sensor.

Turn on the power of the sensor again.
If not turned on,  
contact local  
service center.

A system error occurred in the 
sensor.

	y It is possible that a fault occurred 
inside the sensor.

	y Turn on the power of the sensor 
again.
	y If the same error occurs, contact 
your nearest KEYENCE office. *1

Failed to read nonvolatile memory  
at sensor startup.

Turn on the sensor power again or  
initialize the sensor.
After this message is closed,  
the [Initialize] button will be displayed.

A memory read error occurred when 
the sensor started.

	y A data error occurred.
	y It is possible that the power was 
switched OFF during writing, or 
noise was picked up.

	y Initialize the settings following the 
instructions on the screen.
	y Turn on the power of the sensor 
again.
	yDo not turn OFF the power while 
saving the settings.
	y If the same error occurs, contact 
your nearest KEYENCE office.

*1

Initialization is necessary because  
sensor program xx is corrupt.

After this message is closed,  
the [Initialize] button for program  
xx will be displayed.

A memory read error occurred when 
the sensor started.

	y A data error occurred during the 
execution of program number xx.
	y It is possible that the power was 
switched OFF during writing, or 
noise was picked up.

	y Initialize the settings following the 
instructions on the screen.
	y Turn on the power of the sensor 
again.
	yDo not turn OFF the power while 
saving the settings.
	y If the same error occurs, contact 
your nearest KEYENCE office.

*1

Trigger error A trigger error occurred. Judgment 
processing has not been executed.

	y If a target is to be imaged using an 
external trigger, the external trigger 
was input during a BUSY status.
	y If a target is to be imaged using an 
internal trigger, the trigger interval 
was shorter than the processing 
time.

	y A trigger error can be fixed using 
one of the following procedures.

	yNext normal trigger input
	yClear Error input
	y Switching the program number
	y Proceeding to the settings 
screen of the sensor

	yDo not input the external trigger 
during a BUSY status.
	y Set the trigger interval of the 
internal trigger to a value that is 
longer than the processing time.
	y An error will not occur if the Trigger 
Error is set to [Disable] described 
in output assignment for the 
Settings Navigator (Page 4-147).

*2

Some tools can not be  
judged correctly because of insufficient 
outline extraction amount
as a result of
“Ext. Master Save”.
(Matching rate is 0.)
Check tool configuration.

An external master image registration 
error (with registered master image) 
occurred. The following errors 
occurred even though the image was 
updated and registered as a master 
image.

	y For the new master image, the 
outline cannot be extracted with 
the outline tool.
	y For the new master image, the 
area cannot be extracted with the 
Color Area/Area tool.
	y For the new master image, the 
edge cannot be extracted with the 
Width/Diameter/Edge/Pitch/Edge 
Pixel tool.
	y The brightness correction cannot 
be performed correctly for the new 
master image.
	yWhen the learning tool (including 
sorting mode) is set, the external 
master image registration cannot 
be used.

	y An external master image 
registration error can be fixed using 
one of the following procedures.

	y Successful in next external 
master image registration
	yClear Error input
	y Switching the program number
	y Proceeding to the settings 
screen of the sensor

	yChecking that the image to be 
registered and the detection tools/
position adjustment settings are 
applicable.
	y Adjusting the brightness of the 
image to be registered properly.

*2

Some tools can not be  
judged correctly because area is 0 as a  
result of “Ext. Master Save”.
(Matching rate is 0.)
Check tool configuration.

Some tools can not correctly judged 
because the edge extraction amount as 
a result of the “Ext. Master Save” is not 
sufficient.
(Matching rate is 0.)
Check tool configuration.
Brightness adjustment area is not adjustable 
as a result of “Ext. Master Save”.
Check configuration of brightness 
adjustment.
External master registration failed because 
the learning tool is set to the program.
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Error Messages

Message Cause Remedy Output/ 
Indicator

External master registration failed  
because the image has not been captured.

An external master image 
registration error (with no registered 
master image) occurred. The master 
image is not updated.

	y The image to be registered as a 
master image was not imaged.
	y The work memory is insufficient.

	y An external master image 
registration error can be fixed using 
one of the following procedures.

	y Successful in next external 
master image registration
	yClear Error input
	y Switching the program number
	y Proceeding to the settings 
screen of the sensor

	y Taking an image to be registered 
as a master image and registering 
it as an external master image.
	y Deleting one or more detection tools.

*2
External master registration failed  
due to insufficient work memory.

An application error  
occurred.

An application failure occurred. 	y Reinstall the IV3-Navigator (IV3-H1).
	yReplace the PC.
	y If the same error occurs, contact 
your nearest KEYENCE office.

Registry access  
failed.

A failure of the registry information 
occurred.

	yRestart the PC.
	y Reinstall the IV3-Navigator (IV3-H1).

Network adapter not found 	y Ethernet cable is not connected to 
the PC.
	y The network adapter is not 
correctly connected to the PC.

Refer to  “Remedy when the 
Software cannot be Connected with 
the Sensor” (page A-15).

Sensor cannot be found. Searching the sensor failed.
Data transfer to sensor fails. Connection is not possible because 

data transmission to the sensor has 
failed.

Communication timeout to sensor occurred. Connection is not possible because 
there is no response from the sensor.

Network connection to sensor can not be 
performed.

Connection is not possible because 
the IV-Navigator is not correctly 
connected with the sensor.

The connection with the sensor will be cut 
in order to connect with another panel or 
PC.

The connected sensor has been 
disconnected, because it was 
connected from another control 
panel or PC.

Reconnect to the sensor when it is 
ready to connect.

Failed to write file. Saving the file to the specified save 
destination has failed.

	y Specify the save destination 
correctly.
	yConfirm the access privileges of 
the save destination.

Failed to access  
the file or folder.

Accessing to the specified file or 
folder failed.

	yConfirm the access privileges of 
the save destination.
	yChange the attribute of the 
readonly folder.

Disk space is insufficient. Saving is not possible because the 
amount of free space in the specified 
save destination is insufficient.

Delete a file to make an enough 
space for the save destination.

FTP Connection Error Connection with the FTP/SFTP 
server failed.

Refer to  “Remedy when 
data transfer via FTP/SFTP is 
unavailable” (page A-21).

*2

FTP Transfer Error (Transfer Failed) Data transfer to the transfer 
destination folder failed.

FTP Transfer Error (Insufficient Data Buffer) Data which is larger than the 
remaining storage of the FTP/SFTP 
buffer has been created and the 
transfer failed.

No server found. Connection with the SFTP server 
failed.

Does not match the server settings.
Review those settings as well as other 
related settings.
(Key exchange algorithm)
Does not match the server settings.
Review those settings as well as other 
related settings.
(Host key algorithm)
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Error Messages

Message Cause Remedy Output/ 
Indicator

Does not match the server settings.
Review those settings as well as other 
related settings.
(Cryptographic algorithm)

Connection with the SFTP server 
failed.

Refer to  “Remedy when 
data transfer via FTP/SFTP is 
unavailable” (page A-21).

*2
Does not match the server settings.
Review those settings as well as other 
related settings.
(MAC algorithm)
The sensor head and sensor amplifier are 
not compatible with each other. Connect the 
correct sensor head and sensor amplifier.

A sensor head of the IV and IV2 
Series has been connected with the 
sensor amplifier of the IV3 Series.

Connect the IV3 Series sensor head.

The sensor head is not connected to the 
sensor amplifier.  
Connect the sensor head to the sensor 
amplifier,  
and then turn the power on again.  
If not turned on, contact local  
service center.

The sensor head is not connected. Connect the sensor head.

A connection cannot be  
established with number **.  
Check the following items.  
- The correct sensor IP address is specified.  
- Power supply for the sensor.  
- Network connection.  
- PC network settings.

Connection with the sensor failed. Check the following items.
	y Specify the correct IP address of 
the sensor.
	y Power supply for the sensor.
	yNetwork connection.
	y PC network settings.

The system will return to the sensor setup 
menu because the program file selected by 
external input cannot be found.

* The program number will change to P000.
To start operation,
set a valid program number for the 
destination program or
change the program switching method.

An error occurred in switching the 
advanced program (external input) 
at the time of startup.

Clear the error message. The error is 
cleared and the system moves to the 
setting screen. Thereafter, perform 
the following operations:

	yMake the system re-recognize the 
SD card that stores the correct 
advanced program.
	y Select between P000 and P031 by 
external input.

*3

The system will return to the sensor setup 
menu because the program file selected 
previously cannot be found.
* The program number will change to P000.

An error occurred in switching 
the advanced program (panel/
PC/communication) at the time of 
startup.

Clear the error message. The error 
is cleared and the system moves to 
the setup or run screen. Thereafter, 
perform the following operations:

	yMake the system re-recognize the 
SD card that stores the correct 
advanced program.
	y Select between P000 and P031.
	yWhen clearing the error message, 
operation can be selected to 
continue with P000 or move to the 
setting screen.

*3

The system will return to the sensor setup 
menu because the selected program file 
cannot be found.

* The program number will change to P000.
To start operation,
set a valid program number for the 
destination program or
change the program switching method.

An error occurred in switching the 
advanced program during operation.

Clear the error message. The error is 
cleared and the system moves to the 
setting screen. Thereafter, perform 
the following operations:

	yMake the system re-recognize the 
SD card that stores the correct 
advanced program.
	y Select between P000 and P031.

*1

As the previously selected program file 
cannot be found,
The program number will change to P000.

A setup error of the advanced 
program occurred during setup.

Make the system re-recognize the 
SD card that stores the correct 
advanced program.

*2

Accessing the data in the SD card failed. Accessing the data in the SD card 
failed.

Refer to  “Remedy when data 
transfer to the SD card is 
unavailable” (page A-14).

*2

SD card transfer error
(Transfer failure)

Data transfer to the transfer 
destination folder failed.

SD card transfer error
(Insufficient data buffer)

Data which is larger than the 
remaining storage of the transfer 
buffer has been created and the 
transfer failed.

*1	� Error output from the sensor: ON, PWR/ERR indicator light of the sensor: ON (red), Status indicator light: Blinking (red)
*2	� Error output from the sensor: ON, PWR/ERR indicator light of the sensor: Blinking (red), Status indicator light: blinking (red)
*3	� Error output from the sensor: Does not operate, PWR/ERR indicator light of the sensor: ON (red), Status indicator light: 

blinking (red)
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Remedy when data transfer to the SD card is unavailable

Remedy when data transfer to the SD card is 
unavailable

Status Remedy

Accessing the data in the SD card failed.

	yDo not remove the SD card while it is being accessed.
	y Format the SD card.
	yReplace the SD card.
	y There may be influence from noise.

Data transfer to the transfer destination folder 
failed.

	yCheck the amount of free space.
	y Remove the SD card from the SD card slot, re-insert it, and then close the 
cover. Check that the SD card indicator light is on.

Data which is larger than the remaining 
storage of the transfer buffer has been created 
and the transfer failed.

	y Increase the trigger cycle of the sensor.
 “Setting the Trigger Options” (page 4-10)

	yControl the trigger using the busy output. In doing do, set the timing of busy 
output to “Until Data Transfer is Complete.”

 “BUSY Output Configuration” (page 7-16)
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Remedy when the Software cannot be Connected with the Sensor

Remedy when connection via a network is unavailable

Status Remedy

Connection is not possible even by pressing 
[Connect] in the Activation Menu.

	y Press [OK] and close the message.
	y Setup the network adapter correctly in the PC.
	y Supply power to the sensor and the network equipment.
	yCorrectly connect with the sensor and the network equipment.

	� “Connecting the sensor and PC” (page 2-21)
	yOn the Network connection screen, select the correct network adapter.
	y Press [Search Sensor] and search a sensor.

	� “Searching for a Sensor to be Connected” (page 3-6)
If the connection cannot be established, refer to  “When the connection 
cannot be established by searching for the sensor” (page A-16).
	y Input the IP address of the sensor to be connected and press [Connect] to 
connect.

	 �“Specifying Sensor to be Connected by IP Address” (page 3-7)
If the connection cannot be established, refer to  “When the connection 
cannot be established by specifying the sensor” (page A-16).
	y The PC firewall (Windows firewall or commercially-available security 
software) may be blocking IV3-Navigator communications. Disable the 
firewall or allow IV3-Navigator communications.

Connection is not possible even by pressing 
[Connect] in the Network connection screen.

Connection became impossible after 
connection was established.

Remedy when the Software cannot be Connected 
with the Sensor
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Remedy when the Software cannot be Connected with the Sensor

Status Remedy

The sensor was not found using the [Search 
Sensor] button on the Network connection 
screen.

When the connection cannot be established by searching for the sensor
	y Supply power to the sensor and the network equipment.
	yCorrectly connect with the sensor and the network equipment.

	� “Connecting the sensor and PC” (page 2-21)
	yConfirm that the IP address of the PC does not coincide with that of the 
sensor or another device. Also, correctly set the subnet mask and the default 
gateway.

	 �“Confirming/Setting the IP address of the PC” (page A-19)
	yOn the Network connection screen, select the correct network adapter.
	y The PC firewall (Windows firewall or commercially-available security 
software) may be blocking IV3-Navigator communications. Disable the 
firewall or allow IV3-Navigator communications.
	yConfirm that the IP address of the sensor does not coincide with that of 
the PC or another device. Also, reset (initialize) the network setting for the 
sensor.

	� “Operation for Initial Startup of the IV3-Navigator” (page 3-6)
	 �“Confirming/Setting the IP address of the sensor” (page A-19)
	� “Initializing the Network Settings (IP Reset Switch)” (page A-23)

	y The following conditions are required for a successful sensor search.
	y The subnet masks of the sensor and PC are matched.
	y The sensor network setting is not set or the IP address is not duplicated.

Connection is not possible even by inputting 
the IP address into the Network connection 
screen and pressing [Connect].

When the connection cannot be established by specifying the sensor
	y Supply power to the sensor and the network equipment.
	yCorrectly connect with the sensor and the network equipment.

	� “Connecting the sensor and PC” (page 2-21)
	y Specify the correct IP address of the sensor.
	y If the sensor IP address has not been set, establish a connection using the 
[Search Sensor] button.

	� “Searching for a Sensor to be Connected” (page 3-6)
	yConfirm that the IP address of the PC does not coincide with that of the 
sensor or another device. Also, correctly set the subnet mask and the default 
gateway.

	 �“Confirming/Setting the IP address of the sensor” (page A-19)
	yOn the Network connection screen, select the correct network adapter.
	y The PC firewall (Windows firewall or commercially-available security 
software) may be blocking IV3-Navigator communications. Disable the 
firewall or allow IV3-Navigator communications.
	yConfirm that the IP address of the sensor does not coincide with that of the 
PC or another device. Also, correctly set the subnet mask and the default 
gateway.
Also, reset (initialize) the network setting for the sensor.

	� “Operation for Initial Startup of the IV3-Navigator” (page 3-6)
	 �“Confirming/Setting the IP address of the sensor” (page A-19)
	� “Initializing the Network Settings (IP Reset Switch)” (page A-23)
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Remedy when the Software cannot be Connected with the Sensor

Confirming the status by observing the indicator light of the sensor

LINK/ACT (link/activity) indicator light
Displays the link status with the network.

LINK/ACT indicator light

Built-in amplifier type

LINK/ACT indicator light

Ultra-compact model amplifier

LINK/ACT  
indicator light 

status
Status Remedy

Green

ON Correct link with the PC or the Ethernet 
switch. Link is normal.

When connection to the IV3-Navigator is not possible, check the 
STATUS indicator light.Blink

Correct link with the PC or the Ethernet 
switch.
Data is being sent and received.

OFF

Incorrect link with the PC or the Ethernet 
switch.

	y Power is not supplied to this unit or the 
connection target.
	y The cable is not connected correctly.

	y Supply power to the sensor.
	y Supply power to the PC or the Ethernet switch of the 
connection target.
	yConnect the cable correctly.

A



A-18 IV3 Series User’s Manual (PC Software)

Remedy when the Software cannot be Connected with the Sensor

STATUS indicator light
Indicates the connection status with the IV3-Navigator.
Confirm that the LINK/ACT indicator light is green (lighting) or green (blinking) and then check the STATUS indicator light.

STATUS indicator light

Built-in amplifier type

STATUS indicator light

Ultra-compact model amplifier

STATUS
Status of the 
indicator light

Status Remedy

Green

ON

The IV3-Navigator is connected correctly to 
the sensor amplifier.
Connection with the IV3-Navigator has 
been established by acquiring the IP 
address.

-

Blink

No correct connection with the PC.
The sensor IP address has been acquired, 
but connection with the IV3-Navigator has 
not been established.

 “Remedy when connection via a network is unavailable” (page 
A-15)

OFF

The sensor amplifier is not correctly 
connecting to the PC.
The IP address of the sensor has not been 
acquired.

 “Remedy when connection via a network is unavailable” (page 
A-15)

If the light is ON (red), the IP address coincides or a network loop is detected.

	y The communication timeout time is 1 minute.
	yDuring the timeout interval after an error has occurred, the screen may fail to refresh while the STATUS indicator light 
is on or may not accept an operation.
	yDuring the timeout interval, devices other than the previously connected PC cannot be connected.
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Remedy when the Software cannot be Connected with the Sensor

Other methods for confirmation

Confirming the existence of the sensor from 
the PC

Whether or not the sensor is correctly connected can be 
confirmed by sending a ping command from the PC to the 
sensor to be connected.

1	Select [Windows System] → [Command Prompt] 
from the [Start] menu of Windows.
The Command Prompt screen opens.

2	Input “pingΔ(IP address of the sensor)” (Δ 
indicates a “space”) and press the [Enter] key.

3	Confirm the sent result of the ping command.

	z If correctly connected with a target sensor
The responded time from the sensor (input IP address) 
will be displayed, and [0% loss] will be displayed.

	z If not connected with a target sensor
A message which indicates failure in sending the ping 
command will be displayed, and [100% loss] will be 
displayed.

4	After the confirmation, close the Command 
Prompt screen.

	yNote that when the ping command is 
executed to a device other than a sensor, 
the confirmation will succeed if there is a 
response to the ping command.
	yConfirmation is not possible for a direct 
connection.

Confirming/Setting the IP address of the PC
	y For details of how to confirm/set the IP address of the PC, 
refer to  “Changing the PC Settings (IP Address Setting)” 
(page 2-24).
	yConfirm that the IP addresses of the PC/sensor/other 
network device do not coincide with each other. Also, confirm 
that the subnet mask and default gateway are correctly set.

Confirming/Setting the IP address of the 
sensor
Confirms the IP address of the sensor connected to the PC 
and the network.

1	Press [Program].

The confirmation screen opens.

2	Press [OK].
The IV3-Navigator switches to the main screen in 
[Program].

3	Press [Advanced Settings].

The Advanced Sensor Settings screen opens.

4	Select the [Device Settings] tab and press 
[Change Network Settings].

The Network Settings screen opens.
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Remedy when the Software cannot be Connected with the Sensor

5	Confirm the IP address of the sensor.

	yWhen the IP address of the sensor is to be changed, 
set an arbitrary IP address and press [OK].
	yConfirm that the IP addresses of the sensor/PC/other 
network device do not coincide with each other. Also, 
confirm that the subnet mask and default gateway are 
correctly set.
	yWhen [Reset] is pressed, the setup values for the [IP 
Address], [Subnet Mask], and [Default Gateway] will 
be reset and [Not Set] will be displayed. [PORT] will 
be 63000.

6	Press [OK] and exit from the network settings.

7	Exit the IV3-Navigator.

8	Turn OFF the sensor power, and turn it ON again.

9	Start the IV3-Navigator, and connect the IV-3 
Navigator with the sensor.

	z If the IV-3 Navigator can be connected with the 
sensor
The run screen opens.

	z If the IV-3 Navigator cannot be connected with 
the sensor
The sensor setup menu screen opens. Set the 
connection method etc. and connect it with the sensor.

 “Remedy when connection via a network is unavailable” 
(page A-15)

Checking the router settings
When a router is used, confirm that the following port is 
opened.
Sensor: 63000 (default value)

For the setting methods of the sensor port number, 
refer to the following.

 �“Changing the Network Settings” (page 7-21)
	y The FTP/SFTP port number can be changed on 
the server. It is generally 20 and 21 for the FTP 
port, and 22 for the SFTP port.
	yConfirm the firewall software on the PC whether 
the port is available or not.

Checking the firewall settings
	y If the Windows Security Alert dialog box opens and the 
IV3-Navigator is blocked by the Windows firewall, press 
[Allow access].
	yConfirm that the application or port to be used are 
enabled in the firewall software of the PC. To allow the 
port number to be used, refer to  “Checking the router 
settings” (page A-20).
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Remedy when data transfer via FTP/SFTP is unavailable

Status Remedy

Connection with the FTP/SFTP server failed.

	yConfirm the IP address of the FTP/SFTP server and set it correctly.
	yConfirm the port number of the FTP/SFTP server and set it correctly.
	yMoreover, confirm the firewall software on the PC whether the port is 
available or not.
	yConfirm the user name for logging in to the FTP/SFTP server and set it 
correctly.
	yConfirm the password for logging in to the FTP/SFTP server and set it 
correctly.

	� “Setting the Connection Destination” (page 9-3)

Data transfer to the transfer destination folder 
failed.

	y Authorization for accessing the transfer destination folder is not granted. 
Acquire the access authorization of the transfer destination folder and 
perform the operation again.
	yConfirm that there is no file with the same name as the transfer destination 
folder name which has been set. If a file with the same name exists, change 
the file name or change the transfer destination folder.

	� “Setting the Transfer Destination Folder and File Names” (page 9-6)
	yWhen the PC was switched from the [Run] screen to the [Program] screen, 
the screen is switched to the [Program] screen after the transfer of data has 
finished.

Pressing [Cancel] during transfer will forcibly finish the transfer.

Data which is larger than the remaining 
storage of the FTP/SFTP buffer has been 
created and the transfer failed.

	yChange the trigger cycle of the sensor.
 “Setting the Trigger Options” (page 4-10)

	yConfirm the stress status of the network.

Connection with the SFTP server failed.

	yConfirm the IP address of the SFTP server and set it correctly.
	yConfirm the port number of the SFTP server and set it correctly.
	yMoreover, confirm the firewall software on the server whether the port is 
available or not.
	yConfirm the user name for logging in to the SFTP server and set it correctly.
	yConfirm the password for logging in to the SFTP server and set it correctly.
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Remedy when the Software cannot be Connected with the Sensor

Status Remedy

Connection with the SFTP server failed.

	yReview the SFTP server setting of the key exchange algorithm 
(KexAlgorithms).

Connection with the SFTP server failed.

	yReview the SFTP server setting of the host key algorithm 
(HostKeyAlgorithms).

Connection with the SFTP server failed.

	yReview the SFTP server setting of the cryptographic algorithm (Ciphers).

Connection with the SFTP server failed.

	yReview the SFTP server settings of the MAC algorithm (Macs).
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Initializing the Network Settings (IP Reset Switch)

Initializing the Network Settings (IP Reset Switch)

The network settings such as the IP address can be 
initialized to the factory default by means of the IP reset 
switch of the sensor. In addition, a fixed IP address can be 
assigned.

	y The IP reset switch is used when joining a 
sensor used in another network to a new 
network, or when trouble occurs during 
connection.
	yDo not initialize a correctly connected sensor. 
The connection will be interrupted.

Settings after initialization

	z The factory default settings
The settings are initialized to the factory default. Normally, 
the initialization to the factory default will be performed.

Setting Items Settings after initialization

Communication speed 1000/100 Mbps 
Automatically switches

IP address setting 
method UDP (User Datagram Protocol)

IP Address 0.0.0.0*1, *2

Subnet Mask 0.0.0.0*2

Default Gateway 0.0.0.0*2

*1	 Do not assign an IP address except through the IV3-
Navigator.

*2	 In the Network Settings screen of the sensor, [Not 
Set] is displayed.

	 �“Changing the Network Settings” (page 7-21)

	z Fixed IP address
Assigns the fixed IP address (192.168.10.10). This is used 
when the sensor amplifier cannot be searched because the 
factory default settings are blocked by firewalls, etc.

Setting Items Settings after initialization

Communication speed 1000/100 Mbps 
Automatically switches

IP Address 192.168.10.10

Subnet Mask 255.255.255.0

Default Gateway 0.0.0.0

	y Set an IP address of the PC to be connected (IV3-Navigator) 
to the IP address of the same network. (e.g., 192.168.10.1)
	y To assign an arbitrary IP address, perform initialization with 
the fixed IP address (192.168.10.10), then connect the IV3-
Navigator and change it to a desired IP address.

 “Changing the Network Settings” (page 7-21)
	yDo not connect multiple sensor amplifiers to the same 
network and initialize them at the same time. IP address 
overlapping will occur.
	yConfirm that no device with IP address 192.168.10.10 is 
connected to the same network. IP address overlapping 
will occur.

Initializing the network settings

1	Insert a long and thin pin (1 to 2 mm in diameter) 
and press the IP reset switch for about 3 seconds 
with the power on.

STATUS 
indicator 

light

Long and thin pin

Built-in amplifier type

Ultra-compact model amplifier

STATUS 
indicator 

light

Long and thin pin

	z The factory default settings
Press the switch for about 3 seconds. The STATUS 
indicator light will blink twice (orange) and then turn off. The 
settings are initialized to the factory default.

	z Fixed IP address
Press the switch for about 10 seconds. Continue to 
press and hold the switch even after the factory settings 
have been initialized after about 3 seconds. After about 
10 seconds, the STATUS indicator light will blink twice 
in orange and then blink in green. The fixed IP address 
(192.168.10.10) will be assigned.
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Initializing the Network Settings (IP Reset Switch)

MEMO
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/*
 *  Copyright (C) 2020 Texas Instruments Incorporated - http://www.ti.com/
 *
 *
 *  Redistribution and use in source and binary forms, with or without
 *  modification, are permitted provided that the following conditions
 *  are met:
 *
 *    Redistributions of source code must retain the above copyright
 *    notice, this list of conditions and the following disclaimer.
 *
 *    Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in the
 *    documentation and/or other materials provided with the
 *    distribution.
 *
 *    Neither the name of Texas Instruments Incorporated nor the names of
 *    its contributors may be used to endorse or promote products derived
 *    from this software without specific prior written permission.
 *
 *  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
 *  "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
 *  LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
 *  A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
 *  OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
 *  SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
 *  LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
 *  DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
 *  THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
 *  (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
 *  OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
*/

This software is based in part on the work of the Independent JPEG Group.

 Copyright (C)2009-2020 D. R. Commander.  All Rights Reserved.

 Redistribution and use in source and binary forms, with or without
 modification, are permitted provided that the following conditions are met:

 - Redistributions of source code must retain the above copyright notice,
   this list of conditions and the following disclaimer.
 - Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.
 - Neither the name of the libjpeg-turbo Project nor the names of its
   contributors may be used to endorse or promote products derived from this
   software without specific prior written permission.

 THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS",
 AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
 ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
 LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
 SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
 INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
 CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
 ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
 POSSIBILITY OF SUCH DAMAGE.
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HAL module driver

COPYRIGHT(c) 2016 STMicroelectronics

Redistribution and use in source and binary forms, with or without modification, 
are permitted provided that the following conditiorns are met: 
1. Redistributions of source code must retain the above copyright notice, 
    this list of conditions and the following disclaimer. 
2. Redistributions in binary form must reproduce the above copyright notice, 
    this list of conditions and the following disdlaimer in the documenration 
    and/or other materials provided with the distribution. 
3. Neither the name of STMicroelectronics nor the names of its contributors 
    may be used to endorse or promote products derived from this software 
    without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABlLITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

CMSIS License

Copyright(c) 2010 - 2018 ARM LIMITED

All rights reserved. 
Redistribution and use in souroe and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 
- Redistributions of source code must retain the above copyright notice, this list of 
  conditions and the following disclaimer. 
- Redislri butions in binary form must reproduce the above copyright notice, this list of 
  conditions and the following disclaimer in the documentation and/or other materials 
  provided with the distribution.
- Neither the name of ARM nor the names of its contributors may be used to endorse 
  or promote products derived from this software without specific prior written 
  permission.
*
THlS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTliCULAR PURPOSE ARE 
DlSCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND 
CONTRlBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSlNESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILlTY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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jQuery v3.1.1
(c) jQuery Foundation
jquery.org/license

Chart.js
http://chartjs.org/
Version: 2.5.0
Copyright 2017 Nick Downie
Released under the MIT license
https://github.com/chartjs/Chart.js/blob/master/LICENSE.md

Bootstrap v3.3.7 (http://getbootstrap.com)
Copyright 2011-2017 Twitter, Inc.
Licensed under MIT (https://github.com/twbs/bootstrap/blob/master/LICENSE)

[js-sha256]{@link https://github.com/emn178/js-sha256}
version 0.9.0
author Chen, Yi-Cyuan [emn178@gmail.com]
copyright Chen, Yi-Cyuan 2014-2017
license MIT

Font license info

## Font Awesome
Copyright (C) 2016 by Dave Gandy
Author: Dave Gandy
License: SIL ()
Homepage: http://fortawesome.github.com/Font-Awesome/

## Fontelico
Copyright (C) 2012 by Fontello project
Author: Crowdsourced, for Fontello project
License: SIL (http://scripts.sil.org/OFL)
Homepage: http://fontello.com

## Entypo
Copyright (C) 2012 by Daniel Bruce
Author: Daniel Bruce
License: SIL (http://scripts.sil.org/OFL)
Homepage: http://www.entypo.com

## Lato
Copyright (c) 2010-2014 by tyPoland Lukasz Dziedzic (team@latofonts.com) with Reserved Font Name “Lato”
This Font Software is licensed under the SIL Open Font License, Version 1.1.
This license is copied below, and is also available with a FAQ at:
http://scripts.sil.org/OFL
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WARRANTIES AND DISCLAIMERS

(1)	� KEYENCE warrants the Products to be free of defects in materials and workmanship for a period of one (1) year 
from the date of shipment. If any models or samples were shown to Buyer, such models or samples were used 
merely to illustrate the general type and quality of the Products and not to represent that the Products would 
necessarily conform to said models or samples. Any Products found to be defective must be shipped to KEYENCE 
with all shipping costs paid by Buyer or offered to KEYENCE for inspection and examination. Upon examination by 
KEYENCE, KEYENCE, at its sole option, will refund the purchase price of, or repair or replace at no charge any 
Products found to be defective. This warranty does not apply to any defects resulting from any action of Buyer, 
including but not limited to improper installation, improper interfacing, improper repair, unauthorized modification, 
misapplication and mishandling, such as exposure to excessive current, heat, coldness, moisture, vibration or 
outdoors air. Components which wear are not warranted.

(2)	 �KEYENCE is pleased to offer suggestions on the use of its various Products. They are only suggestions, and it 
is Buyer’s responsibility to ascertain the fitness of the Products for Buyer’s intended use. KEYENCE will not be 
responsible for any damages that may result from the use of the Products.

(3)	� The Products and any samples (“Products/Samples”) supplied to Buyer are not to be used internally in humans, for 
human transportation, as safety devices or fail-safe systems, unless their written specifications state otherwise. Should 
any Products/Samples be used in such a manner or misused in any way, KEYENCE assumes no responsibility, and 
additionally Buyer will indemnify KEYENCE and hold KEYENCE harmless from any liability or damage whatsoever 
arising out of any misuse of the Products/Samples.

(4)	� OTHER THAN AS STATED HEREIN, THE PRODUCTS/SAMPLES ARE PROVIDED WITH NO OTHER 
WARRANTIES WHATSOEVER. ALL EXPRESS, IMPLIED, AND STATUTORY WARRANTIES, INCLUDING, 
WITHOUT LIMITATION, THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
AND NON-INFRINGEMENT OF PROPRIETARY RIGHTS, ARE EXPRESSLY DISCLAIMED. IN NO EVENT SHALL 
KEYENCE AND ITS AFFILIATED ENTITIES BE LIABLE TO ANY PERSON OR ENTITY FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, PUNITIVE, SPECIAL OR CONSEQUENTIAL DAMAGES (INCLUDING, WITHOUT 
LIMITATION, ANY DAMAGES RESULTING FROM LOSS OF USE, BUSINESS INTERRUPTION, LOSS OF 
INFORMATION, LOSS OR INACCURACY OF DATA, LOSS OF PROFITS, LOSS OF SAVINGS, THE COST OF 
PROCUREMENT OF SUBSTITUTED GOODS, SERVICES OR TECHNOLOGIES, OR FOR ANY MATTER ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR INABILITY TO USE THE PRODUCTS, EVEN IF KEYENCE OR 
ONE OF ITS AFFILIATED ENTITIES WAS ADVISED OF A POSSIBLE THIRD PARTY’S CLAIM FOR DAMAGES OR 
ANY OTHER CLAIM AGAINST BUYER. In some jurisdictions, some of the foregoing warranty disclaimers or damage 
limitations may not apply.

BUYER’S TRANSFER OBLIGATIONS:
If the Products/Samples purchased by Buyer are to be resold or delivered to a third party, Buyer must provide such 
third party with a copy of this document, all specifications, manuals, catalogs, leaflets and written information provided 
to Buyer pertaining to the Products/Samples.
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